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What's New 

Version 6.10 

Note: If you have a parameter file from an earlier version, and you are using behaviors that have 

been updated in version 6.10, load your file and save it. SORTIE-ND will automatically make 

any needed adjustments to your parameter file. 

 

New in version 6.10: 

 SORTIE now uses Java version 6. You'll need to download this version if you do not 

already have it.  



 New allometry functions for crown shape - non-spatial density dependent calculates 

crown shape as a function of overall plot density, and NCI calculates crown shape as a 

function of local neighborhood composition. 

 The Lagged post harvest growth behavior incorporates a lag period after a harvest during 

which tree growth is slowed. 

 The Michaelis Menton with negative growth behavior uses a modified Michaelis Menton 

function that allows for negative height growth. 

 The Michaelis Menton with photoinhibition behavior uses a modified Michaelis Menton 

function that allows additional control over the influence of light levels on growth. 

 Michaelis Menton relative growth can now be used in height growth with the Relative 

growth - height only behavior. 

 The Post harvest skidding mortality behavior provides an increase in tree mortality after 

harvesting due to skidding damage or other effects. 

 The Masting non spatial disperse behavior behavior adds masting and inter year variation 

to basic seed rain. 

 The Foliar chemistry behavior calculates various leaf chemical components as a function 

of DBH. 

 You can now use height growth functions as your principle growth functions with the aid 

of the Allometric diameter growth behavior. 

 The NCI growth and NCI Mortality behaviors are now more flexible - all of the 

modifying effects are now optional to allow you to use only the ones you need. 

 The Quadrat-based GLI light behavior now has a flag to force calculation of GLI in every 

grid cell to allow this behavior to double as a light map creator even when trees to which 

the behavior is applied are not present. 

 The values of a tree's crown radius and depth are now available as output variables. 

 The tree map now displays DBH values at actual size at all scales. 

 A new crown radius output display map shows crown radii at actual size, allowing 

visualization of crown overlaps. 

 SORTIE now uses the GNU Scientific Library for mathematical calculations, thus 

expanding the range of possible function forms and probability distributions support 

 The Functional response seed predation and Neighborhood seed predation behaviors can 

now be linked together so that the number of seed predators can determine the number of 

seeds eaten, and neighborhood can determine where seeds are eaten. 

 

What's New archive 

 

Last updated: 16-Oct-2009 01:00 PM  

What's New Archive 

Version 6.09, released February 1, 2008 

Note: If you have a parameter file from an earlier version, and you are using behaviors that have 

been updated in version 6.09, load your file and save it. SORTIE-ND will automatically make 

http://www.gnu.org/software/gsl/


any needed adjustments to your parameter file. 

 

New in version 6.09: 

 The new Storm Direct Killer behavior kills trees as a direct result of storm intensity, 

without resorting to a separate damage step. This behavior can be used for seedlings. 

 The new Detailed Substrate behavior uses a greatly expanded log decay model. 

 The new Competition Harvest behavior removes trees based on their competitive effects 

on their neighbors. 

 The new Ripley's K and Relative Neighborhood Density Calculator behaviors provide 

new spatial indexes. 

 You can now schedule a specific set of storms for the Storm disturbance behavior, either 

alone or in combination with a storm regime. 

 Tree maps can be added as a link to a text file rather than imported into the parameter 

file. This allows easier use of very large tree maps. 

 Several more components have been added to the Partitioned DBH Biomass behavior, 

and there is now a line graph chart option for the Partitioned Biomass grid. 

 The Storm Light behavior now uses trees that died of natural mortality in addition to 

storm damage in its calculations of light levels. 

 Storm results for the Storm disturbance behavior now have a table option in the data 

visualization system for detailed output files. 

 

Minor changes and bug fixes: 

 You can now change the cell resolution when defining subplots. 

 There were several bug fixes related to creating and using detailed output files. 

 The Harvest Interface behavior now stores its results in the Harvest Results grid, allowing 

reporting and compatibility with certain other behaviors. 

 Storm events were made more independent for the Storm disturbance behavior. 

 The Random Browse behavior can now vary its browse probabilities each timestep 

according to a normal distribution. 

Version 6.08 released May 24, 2007 

Note: If you have a parameter file from an earlier version, and you are using behaviors that have 

been updated in version 6.08, load your file and save it. SORTIE-ND will automatically make 

any needed adjustments to your parameter file. 

 

New in version 6.08: 

 The new behavior Snag Decay Class Dynamics introduces a new method for simulating 

snag decay and fall 

 The new behavior Random browse simulates herbivory 

 The new Browsed relative growth behaviors simulate the effects of herbivory on tree 

growth 



 The new Browsed Stochastic Mortality behavior simulates the effects of herbivory on 

tree mortality 

 The new Masting spatial disperse behavior simulates periodic masting in seed dispersal 

 The new Neighborhood seed predation behavior simulates seed predation as a function of 

neighborhood and recent masting events 

 The addition of browse to Height-GLI Weibull Mortality with Browse allows this 

behavior to simulate the effects of herbivory on tree mortality 

 The new analysis behaviors Storm Killed Partitioned DBH Biomass and Storm Killed 

Partitioned Palm Biomass allow the tracking of biomass killed in storm events 

 You can copy a species, including all its behaviors and parameters, using the Tree setup 

window 

 You can change the order of species using the Tree setup window 

 The Storm disturbance behavior now includes optional cyclicity in storm patterns 

 The Storm Light behavior now uses a proportion of trees with damage instead of a 

straight count when figuring light levels 

 The Basal Area Light behavior now searches a neighborhood with a defined radius rather 

than just the trees within a grid cell 

 

Minor changes and bug fixes: 

 Hovering the mouse over a cell in a grid map will cause the value at that point to be 

displayed 

 You can now remove the "Total" line from line graphs 

 The output for histograms is now written in table format when saving a text file for the 

entire run 

 When creating a batch file, you can now select and add multiple files at once 

 The size of DBH circles on the XY Tree Map change size to match zooming 

 The summary output file plot table now has a "go to timestep" control 

 The values in the Dispersed Seeds grid are now available for output 

 Fixed bugs relating to the adding, removing, and renaming of species 

 Fixed a bug with how the Planting behavior dealt with plot edges 

Version 6.07 released November 30, 2006 

Note: If you have a parameter file from an earlier version, and you are using behaviors that have 

been updated in version 6.05, load your file and save it. SORTIE-ND will automatically make 

any needed adjustments to your parameter file. 

 

New in version 6.07: 

 You can now track subplots for detailed output files 

 The File menu now has an option for setting a working directory 

 New analysis behavior - Partitioned DBH Biomass, which calculates biomass separated 

out by branch, leaf, and bole 



 New analysis behavior - Partitioned Palm Biomass, which calculates biomass separated 

out by leaf and bole 

 New light behavior - Average Light, which averages together existing GLI calculations 

 New disturbance behavior - Harvest Interface, which provides a link between SORTIE 

and a separate application for doing harvests 

 New mortality behavior - Aggregated Mortality, which clumps together tree death in both 

time and space 

 New mortality behavior - Exponential Growth and Resource-Based Mortality, which 

calculates mortality as a probability of growth and a second resource 

 New light behavior - Constant GLI, which provides the same value of GLI to every tree 

(this behavior replaces the Constant full GLI behavior) 

 Added the possibility of cyclicity in storm frequency and intensity through time to 

Windstorm 

 

Minor changes and bug fixes: 

 Clicking on an output graph to bring it to the front causes its legend to come to the front 

as well 

 The extra step of clicking a button to save a file has been eliminated when editing a batch 

file 

 The XY Tree Map now has a minimum display DBH control 

 If multiple output files are open and you choose "File->Close output file" from the main 

menu, you will have an option to close all of the files at once 

 The Tree setup window has a new button for adding a tree map to the current parameter 

file 

 If multiple behaviors use the same grid, that grid will display correctly for entering grid 

maps 

 The Grid value edit window now correctly saves the last value entered even if the cell is 

still in edit mode 

 Fixed bug that caused changes to output settings for members of grids to become new 

entries rather than replacement entries; this also caused the output settings for grids and 

trees to behave in the same way 

 Fixed a bug allowing Puerto Rico semi-stochastic growth to set a negative tree DBH in 

some circumstances 

 Fixed a bug that caused designing complicated subplots to slow and eventually crash 

when too many cells were clicked 

 Changed the way neighbor storm damage was treated for NCI growth and NCI mortality 

Version 6.06 released March 31, 2006 

Note: If you have a parameter file from an earlier version, and you are using behaviors that have 

been updated in version 6.05, load your file and save it. SORTIE-ND will automatically make 

any needed adjustments to your parameter file. 

 

New in version 6.06: 



 New allometry equation for saplings - the power diameter-height relationship 

 Updated allometry equation - the DBH - diameter at 10 cm relationship now has an 

intercept term 

 New seed survival behavior - Storm Light Dependent Seed Survival, which works with 

the light levels produced by the Storm Light behavior 

 New mortality behavior - Stochastic Bi-Level Mortality, which uses two different 

mortality rates in high and low light 

 New disturbance behavior - Windstorm, which follows a given storm regime to produce 

storms and kill trees as a result 

 New growth behavior - Basal Area NCI Growth, which calculates tree growth as a 

function of neighborhood basal area 

 New light behavior - Basal Area Light, which calculates light levels as a function of 

neighborhood basal area of angiosperms and conifers 

 New disturbance behavior - Storm Killer - that kills trees damaged in storms. This 

behavior takes over and expands a function previously performed by the Storm Damage 

Applier behavior 

 New analysis behavior - Tree Age, which tracks tree ages 

 New mortality behavior - Height-GLI Weibull Mortality, which calculates tree mortality 

as a function of tree height and light levels 

 New growth behavior - Puerto Rico Storm Bi-Level Growth, which uses two functions to 

calculate growth before and after storms 

 New analysis behavior - Merchantable Timber Value, which calculates the value of 

merchantable timber in a plot 

 New analysis behavior - Carbon Value, which calculates the amount of carbon in a plot 

and its value 

 Stand and Stock output tables now display species-specific values as well as plot total 

values 

 The Storm Light behavior has an updated equation for light calculation 

 The main window is now equipped with scroll bars, to allow you to use more space when 

viewing charts and graphs 

 The Tree Setup window is now capable of changing the name of a species 

 The Density Dependent Seed Survival behavior's survival area has been standardized to 

per square meter 

 The Relative Michaelis-Menton growth behaviors now have an additional exponent on 

diameter 

 The Substrate behavior uses a new equation for decayed log decay 

 Developers: The C++ model code has been ported to the GCC compiler set and the 

Eclipse development environment 

Version 6.05 released August 3, 2005 

Note: If you have a parameter file from an earlier version, and you are using behaviors that have 

been updated in version 6.04, load your file and save it. SORTIE-ND will automatically make 

any needed adjustments to your parameter file.  

New in version 6.05: 



 The Substrate behavior has been rewritten to combine all current substrate models into 

one behavior 

 New establishment behavior - Establishment with Microtopography - that allows 

seedlings to have a rooting height above the ground 

 Two new allometry equations for crown shape - the Chapman-Richards function 

 The stock and stand tables for detailed output now have a mean DBH column 

 The equation for mean annual increment in the stock table has changed 

 Bug fix - seedlings that use either the GLI light or Sail light behaviors automatically use a 

top-of-crown fisheye photo point 

 Changes have been made to the Parameters window to make parameter editing easier 

 Changes have been made to output table formatting to make them easier to read 

Version 6.04 released May 16, 2005 

Note: If you have a parameter file from an earlier version, and you are using behaviors that have 

been updated in version 6.04, load your file and save it. SORTIE-ND will automatically make 

any needed adjustments to your parameter file.  

New in version 6.04: 

 You can now choose the appropriate allometry equation for each species for each life 

history stage 

 You can now set the height boundary between seedlings and saplings for trees 

 The establishment behaviors have been restructured, allowing you to mix and match seed 

survival effects 

 The Storm damage applier behavior can create tip-ups from storm-killed trees 

 New harvest behavior - Selection harvest - that allows SORTIE-ND to decide when to 

perform harvests based on target basal area levels 

 New behavior - GLI Points File Creator - which calculates GLI at certain specific points 

 New light behavior - Storm Light behavior - that uses storm damage as a proxy for 

finding light levels 

 New growth behavior - Puerto Rico semi-stochastic growth 

 New growth behavior - Linear bi-level growth - that can grow trees with two sets of 

parameters based on light level 

 New growth behavior - Lognormal bi-level growth - that can grow trees with two sets of 

parameters based on light level 

 New mortality behavior - Logistic Bi-Level Mortality - that can use two sets of 

parameters based on light level 

 NCI growth and NCI Mortality now each have a flag for whether or not to include snags 

in NCI calculations 

 Refinement of substrate dynamics for snags, allowing them to tip-up at different rates 

from live trees 

Version 6.03 released April 6, 2005 

New in version 6.03: 



 New function form for the NCI Mortality behavior 

 New mortality behavior which calculates mortality as a function of neighbor density - the 

Density Self-Thinning Mortality behavior 

 New format for tab-delimited tree maps, which can be prepared in any spreadsheet 

program and added to SORTIE-ND 

 New data visualization chart type - histograms for grid values 

 New behavior for calculating tree volume - the Tree bole volume calculator behavior 

 Updated Substrate behavior documentation 

 New behavior for calculating tree biomass - the Dimension analysis behavior 

 New feature for running batches 

 NCI behaviors (NCI Mortality and NCI growth) now have a parameter for minimum 

DBH of crowding neighbors 

 The Storm damage applier behavior now can kill trees immediately as a result of storm 

damage 

 Changes to the File menu options 

Version 6.02 released March 10, 2005 

New in version 6.02: 

 New tree data members for Light level and Diameter Growth 

 New behavior for creating GLI maps - Gap Light behavior. 

 New line graphs in data visualization for relative volume and absolute volume. 

 Seedling initial density can now be controlled by three height classes. 

 New growth-based mortality behavior - Competition Mortality. 

 New mortality as a function of growth and a second resource - Growth and Resource-

Based Mortality. 

 New function form for the NCI growth behaviors. 

 New growth functions using a double Michaelis-Menton function of light and a second 

resource - Double resource relative growth. 

 New light behavior which simplifies GLI calculations for extremely competitive gap 

dynamics - Gap Light behavior. 

 New growth behavior for simulating extremely competitive gap dynamics - Stochastic 

gap growth. 

 Snag size classes for the Weibull snag mortality behavior are now species-specific. 

Getting started with SORTIE 

In this document:  

How does SORTIE work?  

How do I start working with SORTIE?  

How does SORTIE work? 



It is important when starting with SORTIE to understand a little bit about how SORTIE works. 

SORTIE is a program designed to simulate the life cycles of individual trees and assess the 

impacts of various external events on them. SORTIE does this by creating individual virtual trees 

and allowing certain processes chosen by the user to act on these trees. These processes are 

called behaviors and usually correspond to biological processes. For instance, a simulation might 

consist of three behaviors: a behavior to calculate light levels for trees, one to determine the 

amount of tree growth as a result of the amount of light, and one to select trees to die if they 

grow too slowly. The behaviors have a certain order in which they act. When all of the behaviors 

have acted once, that's a single timestep. The process is repeated for the number of timesteps that 

you set, and that's a single simulation, or run.  

Different species have different requirements, of course, and trees undergo different processes at 

various points within their life cycle. Behaviors can be applied to very specific tree subsets and 

you can use different versions of a similar behavior to get the effects you wish to achieve.  

How do I start working with SORTIE? 

First, you may want to familiarize yourself with the various parts of the simulation engine. Read 

about trees, behaviors, and grids (a kind of data structure). Read a little about how a run 

progresses. Then, you should read about parameter files, which is the way that you input your 

settings into SORTIE.  

Once you've done that, you are ready to start building a parameter file. To create a file from 

scratch, read the topic creating a parameter file from scratch. Once you have a parameter file, 

you can read about advanced additions to it in the topic adding to a parameter file.  

Once you have a parameter file, you simply load it using the File menu, then choose "Model-

>Run". That's all there is to it! Wait for the simulation to end, then look at your output files using 

the model's data visualization capabilities.  

Getting started - users of previous versions of 

SORTIE 

If you have used SORTIE before, you're in luck. You can probably start doing runs right away. 

The early versions of SORTIE-ND were designed to be backwards compatible; your old files 

should load and run. Newer versions of SORTIE-ND can then use the files created by the earlier 

versions.  

Before you do a run, you may want to familiarize yourself with what's new. First, read about 

behaviors. They replace submodels. When before you might choose the "BC juvenile growth" 

submodel, for instance, now you will choose a growth behavior. All submodels from the old 

model have been translated to behaviors in the new model. They may have been slightly 

generalized and given different names, but when you read the documentation on the individual 

behaviors you should be able to find the ones you want.  



Then, read about the new parameter files. Read about your output options with the topics on 

summary output files and detailed output files.  

You can load an old parameter file into SORTIE-ND up to version 6.04. Download and install a 

version, and load your old parameter file using the File menu. You can then save it in a new 

format. This file will then be readable by newer versions of SORTIE-ND. If you need help, each 

version of SORTIE-ND has its own user manual that will guide you through.  

Last updated: 07-Jun-2005 02:37 PM  

Run setup and progression 

A run is a single model simulation. It starts at time zero and continues until its defined endpoint 

is reached. A run is defined by its parameter file. This tells the model how long to run, and what 

to do during the run.  

The basic time unit in the run is the timestep. You set the length and number of the timesteps. 

Each timestep, the model asks each behavior to do its work, whatever that work may be. The 

behaviors are run in the order in which they are listed in the parameter file. The model counts off 

the timesteps until it has finished the specified number, then cleans up its memory and shuts 

down.  

Run parameters 

 Number of timesteps The number of timesteps for which to run the model. 

 Number of years per timestep The length of the timestep, in years. It is recommended 

that this value be a whole number. 

 Random seed An integer to use as the seed for SORTIE's random number generator. 

Zero means that SORTIE chooses its own new seed every time, and repeat runs with the 

same parameter file will come out different. Any non-zero value triggers one particular 

sequence of random numbers. In that case, repeat runs with the same parameter file will 

be the same.  

Plot 

In this document:  

The SORTIE coordinate system  

The Torus Forest  

Plot parameters  

The plot in SORTIE is the simulation of the physical space in which the model runs. You can 

think of the plot as a rectangle (although it's not really - more on that later). You tell the plot 

what its east-west and north-south dimensions are. It's useful to keep your plot size in mind when 

you are setting up your parameters and viewing your output, since many SORTIE values are per 



hectare units. The size of your plot also makes a difference in run time - the larger the plot, the 

longer the run. The absolute minimum size of a plot is 100 meters by 100 meters; 200 meters by 

200 meters is a more realistic minimum. It is a careful balance to find a plot size big enough to 

see the effects you are interested in but not so big that your runs take too long to be practical. 

Since the length of the run depends on many other factors in addition to plot size, you may need 

to tweak plot size a bit until you've found a good value.  

The SORTIE Coordinate System 

SORTIE uses X-Y coordinates, starting at (0, 0), which is at the southwest corner of the plot. 

Positive Y coordinates increase to the north; positive X coordinates increase to the east. There 

are no negative plot location values. The coordinate values are in meters. IMPORTANT: The 

new coordinates are different from the older versions of SORTIE, in which the axes were 

switched. When the new version converts older files, the coordinate conversions are made 

automatically.  

 

The Torus Forest 

When you are working with the plot, you think of it as a rectangle. In fact, it is a torus (donut). 

Each edge connects to the edge on the opposite side. To picture this, imagine a sheet of paper. 

Roll the sheet of paper into a tube, then bend the tube around so its ends meet. This is what the 

SORTIE forest looks like. The purpose of this shape is to eliminate edges in the forest. Trees 

near the "edges" of the plot torus "see" trees on the far "edge" as being right next to them.  

The torus shape is what controls the minimum plot size in SORTIE. Some processes in SORTIE 

require searching a portion of the plot - for instance, to find all the trees in a given circle. If that 

search took place over too great an area compared to the size of the plot, it would run the risk of 

searching "around the world." It would work its way around the torus and back to (and past) the 

place it started, finding the same trees multiple times.  

Plot parameters 

 Plot Length in the X (E-W) Direction, in meters The length of the plot in the east-west 

direction, in meters. 

 Plot Length in the Y (N-S) Direction, in meters The length of the plot in the north-

south direction, in meters. 



 Plot Latitude, in decimal degrees The plot latitude, expressed in degrees and partial 

degrees (i.e. 39.10). 
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Creating a parameter file 

This topic covers creating a parameter file from scratch. To make a basic parameter file, you 

need to define the tree population, choose the list of behaviors that will run, and enter parameter 

values for your file. You can save your work at any point in the process and come back to it later. 

In this document:  

 

Setting up the tree population  

Setting up the behavior list  

Setting parameter values  

Other options  

Setting up the tree population 

You can use the File menu and choose the option "New parameter file" for a short wizard that 

will get you started. First you will see the Tree setup window. At a minimum, you must create a 

list of tree species. If you want to define the initial conditions of your tree population using 

densities in size classes, and you know what you want your size classes to be, you can set them 

up at this point. Otherwise, you can always come back to this window by choosing "Edit->Tree 

setup".  

Setting up the behavior list 

After your tree population is defined, the wizard will take you to the Edit simulation flow 

window so you can set up the list of behaviors for your run. You can approach this from either 

the tree perspective by setting up the list of behaviors for each tree type, or from the behavior 

perspective by starting with a list of behaviors and assigning each to specific groups of trees. See 

the link above for detailed instructions on choosing behaviors. Again, you can always come back 

to this window to make changes by choosing the menu option "Edit->Model flow". At this point 

the new parameter file wizard ends.  

Setting parameter values 

You must complete the steps above before you can edit parameters, because it is the tree 

population and the list of behaviors that defines what parameters are needed. Once those steps 

are complete, you can enter your parameter values by choosing the menu option "Edit-

>Parameters", which will open the Parameters window. You may want to only display and edit 



one category of parameter at a time, since all values in the parameter window must be valid 

before you can save your changes.  

Other options 

Once you have completed the three steps above, you have created a basic parameter file. For 

more options on adding to a parameter file, see the topic Adding to a parameter file.  

Adding to a parameter file 

This topic covers the additions you can make to a parameter file. For more on how to create a 

basic parameter file from scratch, see the topic Creating a parameter file. Otherwise, you can 

start with an existing parameter file and modify it.  

A basic parameter file has the tree population list of species defined, the run behaviors list 

assembled, and the parameters entered. Once that's complete, here's some extra additions you 

might make.  

 

Output  

Tree maps  

Grid setup  

Replicating a point in another run  

Output 

A basic parameter file creates no output by default. You can perform a run with it but you will 

not be able to see any of the results, since SORTIE-ND's data visualization can only occur on run 

output. There are two kinds of output files: summary output files and detailed output files. You 

can set up either or both of these using the Edit->Output options menu command from the main 

SORTIE-ND window.  

Tree maps 

You can set up an initial tree population using density values in size classes using the Parameters 

window. You can also input a known list of trees in a tree map using the "File->Open file" 

command. There are two kinds of tree maps: those from detailed output files, and those you 

create directly in tab-delimited text. For more on entering the maps from a detailed output file 

(the most likely source), see the detailed output file topic. For more on the tab-delimited tree map 

file format, see the tab-delimited tree map topic. You can combine these methods of defining tree 

initial conditions or use any one alone.  

Grid setup 



You can manipulate the settings for grids to further optimize your run. For many grids, you can 

set the sizes of the grid cells using the Grid setup window. When you have a group of related 

behaviors sharing a group of related grids, you can assign them the same grid cell size or even 

multiples of a size to ensure efficient data transfer between them with fewer approximations.  

You can also add grid maps to set the initial conditions for some grids using the "File->Open 

file" command. For more on entering the maps from a detailed output file (the most likely 

source), see the detailed output file topic. You can also use the Grid layer setup window to 

directly edit the values of grid maps.  

Replicating a point in another run 

You can replicate a point in another run in your parameter file in order to have it as the starting 

point in a new run. You might do this to create a "branch point" where you determine what might 

have happened if the parameters in the first run had been a little different, or perhaps you did a 

run solely to create mature-forest initial conditions for a new run. The first run should have saved 

a detailed output file with as much data as possible. The new parameter file should be compatible 

with the first - it should have a common species set and most of the same behaviors. You can 

then load the data from any timestep of the previous run as initial conditions in the current 

parameter file. For more on entering the maps from a detailed output file (the most likely 

source), see the detailed output file topic.  

Last updated: 30-Mar-2005 02:44 PM  

Output in SORTIE 

By default, no output occurs during a SORTIE run. You set up output files and choose what data 

should be saved in them in order to perform data analysis.  

There are two kinds of output files, summary output files and detailed output files. Summary 

output files save high-level data for a run, like population density and basal area. Detailed output 

files save more detailed data - in fact, as much detail as you want to have; they are very flexible.  

To set up output, choose "Edit->Output options". Once you have produced output files, you can 

ask SORTIE to display charts and graphs using the data visualization features. You can also use 

certain kinds of output as initial conditions in subsequent runs.  

Output strategies in SORTIE 

Choosing what output to save is a bit of an art form. Save too much data, and your files will be 

too large and very slow to process. Save too little, and you won't have the data you need after 

your run. Here are some strategies to help you decide what to save.  

What you save depends on what you want to look at. Each chart that SORTIE can display 

requires a specific set of information. You can see a list of chart types and what they require 



here. Also be aware that, for overall data, the summary output file is a better choice than the 

detailed output file. It loads much faster and contains raw data in a format you can use outside of 

SORTIE without any kind of conversion. If you want to look at changes in tree basal area and 

density through time, save a summary output file and use it to look at these charts.  

When you are first setting up new runs, you are likely to be testing your parameters to make 

sure they are all right. You will probably be doing several short runs until you are confident that 

you have chosen the correct behaviors and entered your parameters correctly. At this point you 

will might to save a lot of data and run for small numbers of timesteps so you can examine all 

aspects of a run to make sure it is progressing the way you want. Create a detailed output file, 

and have it save at least X, Y, and diameter information for all trees; save grids for things such as 

substrate conditions and dispersed seeds so you can look at maps; and save a summary output 

file so you can quickly examine line graphs and tables of basal area and density through time. Do 

short runs and examine output until you are confident that your parameter file is set up correctly.  

When you are doing a set of research runs, OR you are doing long runs, save the bare 

minimum of data that you require in order to make your output files as small as possible and to 

make working with them quicker and easier. If all you care about is plotwide amounts of basal 

area and density, use a summary file only. If you want that plus a DBH distribution, save only 

DBH for saplings and adults. If you want to keep tabs on a type of data but you don't need a lot 

of detail, consider saving this data less often than every timestep. Use a summary file to get 

plotwide information instead of a detailed output file where possible.  

When you are interested in spatial variation,, such as when you are working with harvest 

treatments, you might wish to get statistics on just one area within the plot. You can create 

subplots in either summary output or detailed output files. This is also helpful if you have an 

extremely large plot but you want a lot of detail. In that case, the detailed output file can become 

too large to work with. A representative subplot may give you the information you need.  

To study an interesting effect that you wish to be able to reproduce, you may want to save a 

detailed output file that you can use as initial conditions in a subsequent run. In this case, you 

would use the "Save everything" button in the Setup detailed output file window. This file is 

likely to be extremely large, but can be very useful. As an example: you find that around 

timestep 15, the curve of sapling density curves up sharply in a very unexpected way. You want 

to be able to experiment with the growth parameters at timestep 15 to see if you can find what 

conditions that curve is sensitive to. You could "Save everything" for a run of 20 or so timesteps. 

You could create a parameter file with new growth parameters, find the timestep in the previous 

run where the interesting curve shape started, then use that timestep as initial conditions to your 

new run. For your new run, you would save less data. (For more information on using detailed 

output output as initial conditions, see the detailed output files topic.)  

 

18-May-2006 12:51 PM  

Batch runs 



SORTIE-ND can do simulations one at a time, or in groups. A group of simulations is a batch 

run. A batch run consists of simulations performed on one or more parameter files, with each 

parameter file running one or more times.  

Setting up a batch run 

A batch run is defined using a batch file. You work with batch files using the Batch file setup 

window. A batch file is an XML file which lists a set of parameter files to run, and the number of 

times to run each file.  

Before you begin a batch run, prepare all of your parameter files. Save them all to an appropriate 

place. If you are saving output in your parameter files, make sure that the directory(ies) that the 

output will be written to already exist. It doesn't matter where you put your parameter files, or 

where you write your output; but if you move parameter files around, SORTIE-ND may not be 

able to find them when it runs your batch.  

Once all of your parameter files are ready, create and save your batch file.  

Batch runs and output 

Parameter files being run in batches can write output files. If you are running a parameter file 

more than once, SORTIE-ND will automatically rename each run's output files so that they will 

be numbered sequentially. For instance, if your parameter file saves a file called my_out.out, 

and you use a batch to run the file three times, you will get the following output files: 

my_out_1.out, my_out_2.out, and my_out_3.out.  

Running a batch 

Once you have created a batch file, you can run it by choosing "Model->Run Batch...". This 

allows you to select the batch file you have created. Once you have selected it, SORTIE-ND will 

begin running your batch. You do not have to have a parameter file of any kind loaded into 

SORTIE-ND to begin a batch run. If you have a parameter file currently loaded, it will have no 

effect on the batch run.  

You cannot view output during a batch run, like you can with a single run. This is because of the 

difficulty SORTIE-ND would have in managing the many possible output files. You also cannot 

pause a batch run, only stop it. However, if you do stop a batch run, any output that was created 

before you stopped it will still be present and available.  

If a simulation within a batch fails for some reason, SORTIE-ND will attempt to skip that 

simulation and complete the others specified in the file.  

 

Last updated: 01-Apr-2005 01:29 PM  



File menu 

New parameter file. Use this option to be led through the first steps of creating a new parameter 

file from scratch. You start with the Tree setup window, then move to the Edit simulation flow 

window. Once you have completed these steps, you can save your new file and then enter 

parameters for it. For more on creating a new parameter file, see Creating a parameter file.  

New batch file. Use this option to create a new batch file. You can read more about batch runs 

here. This option opens the batch file setup window.  

Open file. Use this option to open parameter and data files in SORTIE-ND. You can open 

parameter files this way, and then add map files or detailed output files to the run. You can load 

files that may not be complete or valid for a run. To check a file, you can save it, or open the 

Parameters window and then click OK to trigger a file validation.  

Save parameter file. Use this option to save a parameter file. You have to specify the filename 

each time. The filename of the file currently loaded is visible in the bottom left corner of the 

main SORTIE window. You can save a parameter file, even if it is not complete or is incorrect. 

If this is the case, you will get a warning message that tells you of the file's problem and asks you 

if you want to continue with the save. Clicking yes will save the file.  

Set working directory. Choosing this option allows you to give SORTIE a directory you wish to 

work in. Then all windows for working with files will automatically open to this directory.  

Open run output. Use this option to use the data visualization functions to graphically view the 

output of a run. You can open either short output files or detailed output files this way.  

Exit. Quit SORTIE.  

 

Last updated: 15-Nov-2006 06:53 AM  

Batch file setup window 

This window is reached from the menu option "File->New batch file" in the main SORTIE-ND 

window, or by opening a batch file using "File->Open file". It allows you to set up a new batch 

file. For more information on batch runs, see the batch runs topic.  

Batch files define a set of runs that you want SORTIE-ND to do at one time. The batch file can 

list multiple different parameter files, and can run each file more than once.  

Working with a batch file does not in any way affect any parameter files you may also be 

working on. You can work with batch files without having a parameter file loaded. However, all 

the parameter files you want to include in your batch file should be complete before you begin.  



Batch file name. This is the path and file name of the batch file you are working with.  

Add a new parameter file. This section adds a new parameter file to the batch.  

Parameter file name. The path and file name to the parameter file(s) to add. You should make 

this a fully qualified name (i.e. "C:\my files\parameter file 1.xml" rather than 

"parameter file 1.xml"). (Using the "Browse" button causes this to happen automatically.) 

This ensures that the model will be able to find the file when it comes time to run the batch. Of 

course, it also means that you should have your parameter files in the right locations before 

preparing your batch file, for greatest ease.  

Number of times to run this file. The number of times to run this parameter file during the 

batch.  

Add new parameter file. This button adds a parameter file and a number of times to run to the 

batch list.  

Current parameter files in this batch:. This displays the current parameter files in the batch 

list, along with the number of times each should be run.  

Remove. Use this button to remove one or more parameter files from the batch list.  

Once the batch list is the way you want it, click OK to write the file.  

Last updated: 23-May-2007 09:37 AM  

Edit menu 

Parameters. Use this option to edit parameter values for the run. The parameters needing values 

changes depending on the behaviors for the run. For more details on this option, see the 

Parameters window topic. For details on individual parameters, see the behavior to which they 

belong.  

Episodic events. Use this option to edit planned episodic events, such as silvicultural treatments 

and episodic mortality. For more details on this option, see the Edit Episodic Events Window 

topic.  

Harvest interface. Use this option to set up the Harvest Interface behavior.  

Schedule storms. Use this option to schedule storm events. For more details on this option, see 

the Edit scheduled storms window topic.  

Tree population - set allometry functions window. Use this option to set the allometry 

functions for tree species and life history stage. For more details on this option, see the Edit 

allometry functions window topic.  



Tree population - edit species list window. Use this option to add, rename, or remove tree 

species. For more details on this option, see the Edit species list window topic.  

Tree population - edit initial density size classes window. Use this to change the size classes 

for tree initial densities. For more details on this option, see the Edit size classes window topic.  

Tree population - manage tree maps window. Use this to add and remove tree maps. For more 

details on this option, see the Manage tree maps window topic.  

Grid layer setup. Use this option to edit the basics of the currently loaded grids. For more 

details on this option, see the Grid setup window topic.  

Model flow. Use this option to edit the list of behaviors, their order in the run, and the trees to 

which they are assigned. For more details on this option, see the Edit simulation window topic.  

Output options. Use this option to set up output for a run. By default, no output is saved. This 

controls both short output files and detailed output files. For more details on this option, see the 

Output setup window topic.  

29-Feb-2008 02:10 PM  

Parameters window 

This window is reached using the menu option "Edit->Parameters" from the main SORTIE 

window. It allows you to edit the parameter values for your run. In this window:  

Choose which parameters to display  

Editing values  

Saving the values to a file for review  

Error messages when you click "OK"  

Choose which parameters to display 

This is a small window that appears before the main window to allow you to choose what you 

want to see displayed. There may not be parameters for all choices that you see on the list. 

Choose any subset of parameters to display, or choose "All" to see everything.  

Editing values 

The main parameter display window shows you your chosen parameter groups. Only those 

parameters that are applicable to the behaviors that are currently active in the run are shown. To 

edit a value, double-click its cell. You can copy and paste back and forth from Excel, and within 

the parameter window itself. You can use the menu commands on the parameter window "Edit-

>Copy" and "Edit->Paste", or the keyboard shortcuts Ctrl-C for copy and Ctrl-V for paste.  

Saving the values to a file for review 



You can save the parameter window you are currently viewing as a tab-delimited text file for 

your own reference. Choose "File->Save window as file". You can then open the file you have 

saved in any spreadsheet or text editor program. The file that you save cannot be used as input to 

SORTIE.  

Error messages when you click "OK" 

When you click "OK" in the parameter window, the data in the window is checked to make sure 

it is complete and valid. If there is a problem, you are given an error message and the opportunity 

to correct the problem. You are not allowed to save invalid data changes. For more on what an 

individual piece of data is and what limitations may be placed on it, consult the individual 

behavior documentation (find it by looking at the header that the piece of data is under).  

 

16-Nov-2004 06:47 AM  

Edit Harvest Interface Window 

This window is reached from the Edit menu by selecting "Harvest Interface". It allows you to set 

up the Harvest interface behavior.  

Path and filename of the executable: This is the full path and filename of the executable that 

SORTIE will call to perform harvests. The filename and file extension must be something that 

the operating system can recognize and treat as an executable. Be sure to provide the complete 

filename; SORTIE makes no assumptions about the file.  

Tree file that SORTIE will write: This is the full path and filename of the file that SORTIE 

writes each harvest timestep with the list of trees eligible to be harvested. Input the filename and 

extension as the executable expects to find it.  

Tree harvest file that the executable will write: This is the full path and filename of the file 

that the executable writes with the list of trees to be harvested. Input the filename and extension 

as it will be written by the executable.  

How often to harvest, in years: How often SORTIE will perform the harvest process. This 

number must be a positive integer value.  

Behavior currently assigned to: This is the tree types and species to which the harvest interface 

behavior are applied. Only these trees will be written to the text file that is passed to the 

executable. Use the "Edit" button to add or remove from the list.  

File columns: The columns in the text files written by both SORTIE and the executable, in the 

order that they will appear. The text in this list matches the text in the column headers.  



Parameters file for batch run (optional): If you want SORTIE to manage input files for the 

executable when in SORTIE batch mode, this is the full path and filename of the file that 

contains the executable's input parameters for each run in the entire batch.  

Single-run parameters file for batch run (optional): If you want SORTIE to manage input 

files for the executable when in SORTIE batch mode, this is the full path and filename of the file 

that SORTIE will write with the executable's input parameters for a single run in the batch.  

Arguments to pass to the executable (optional): SORTIE will pass this string value to the 

executable when launching it.  

Tree update file that the executable will write: If extra tree data members have been created 

for the executable to control, this is the full path and filename of the file the executable will write 

with updates to these data members. If there is an update file, there must also be new tree data 

members in the New tree data members to add section.  

New tree data members to add: Extra tree data members to be created for the executable to 

control, if desired. The names can be up to 9 characters long, must not match the name of any 

existing data member, and must not contain parentheses. If there are new tree data members, 

there must also be an update file.  

24-Oct-2006 09:10 AM  

Edit Scheduled Storms Window 

This window is reached from the Edit menu by selecting "Scheduled Storms". It allows you to 

schedule storms for the Storm disturbance behavior. See that behavior's documentation for more 

on how scheduled storms work.  

Year of storm (not timestep): The year the storm should occur.  

Storm minimum severity (0-1): The minimum severity of the storm.  

Storm maximum severity (0-1): The maximum severity of the storm.  

After entering the data for a storm, click the "add" button to add it to the list. The order of the 

storms on the list does not matter since they each have a time associated with them. To remove 

storms from the list, select one or more and click "Remove".  

12-Dec-2007 01:07 PM  

Edit Allometry Functions Window 



This allows you to set the allometry functions for each tree species and life history stage. This 

window is reached by choosing "Edit->Tree Population->Set allometry functions". The functions 

are described on the Allometry page.  

Functions 

 Adult Crown Height-Height Function The allometric relationship used to relate tree 

height (in m) and height (or length) of the crown (in m) for adult trees. 

 Adult Crown Radius-Diameter Function The allometric relationship used to relate 

DBH (in cm) and crown radius (in m) for adult trees. 

 Adult Height-Diameter Function The allometric relationship used to relate DBH and 

height for adult trees. 

 Sapling Crown Height-Height Function The allometric relationship used to relate tree 

height (in m) and height (or length) of the crown (in m) for saplings. 

 Sapling Crown Radius-Diameter Function The allometric relationship used to relate 

DBH (in cm) and crown radius (in m) for saplings. 

 Sapling Height-Diameter Function The allometric relationship used to relate DBH and 

height for saplings. 

 Seedling Height-Diameter Function The allometric relationship used to relate diameter 

at 10 cm and height for seedlings. 

29-Feb-2008 02:42 PM  

Edit species list window 

This window is reached from the menu option "Edit->Tree Population->Edit species list" in the 

main SORTIE-ND window. It allows you to the species list of the tree population.  

The box under the heading "Edit list of species" contains the list of current species. Changes you 

make are not final until you click "OK". If you edit the species list beyond just renaming species, 

you will lose any currently loaded tree map and grid map data.  

Add To add a new species, type its name in the box labeled "New species", and click the button 

marked "Add".  

Rename To change the name of a species, first select it in the species list. Then type the new 

name in the box marked "New species:", and click "Rename".  

Copy... This lets you make one species a copy of another species. It opens a window where you 

can select a species and one or more species to make a copy of that species. If you want to make 

a new species that is a copy of an existing species, first create the new species using the "Add" 

button, then use the copy button to select the species it should be a copy of.  

Any existing behavior settings and parameters for a species that becomes a copy of another 

species are removed, and replaced by settings and parameters identical to the species being 



copied. If the species that becomes a copy was the only species assigned to a behavior, that 

behavior is removed from the run.  

Up and Down This lets you change the order of species in the list. Select one or more species 

and click the buttons to move them.  

Remove To remove a species, select a species in the list and click the button marked "Remove".  

Last updated: 29-Feb-2008 02:39 PM  

Edit size classes window 

This window is reached from the menu option "Edit->Tree Population->Edit initial density size 

classes" in the main SORTIE-ND window. It allows you to edit the size classes for the tree 

population. Size classes help you define an initial tree population for your run. When you have 

size classes set up, you can specify an initial density of trees in each size class in the Parameters 

window. You can have as many size classes as you want. The upper DBH bound of a size class 

is its number. The lower bound of the size class is the size class below it, or zero if there is no 

lower class. This means you may need one extra class in order to define a lower bound for your 

smallest class if you want its lower bound to be greater than zero.  

The list of currently defined size classes is in the list at the left of the window. To add a new size 

class, type in its upper DBH bound in the box and click "Add". To remove an existing class, 

select it in the list to the left and click "Remove". To define a size class for seedlings, add a size 

class with an upper limit of "0".  

29-Feb-2008 02:42 PM  

Manage tree maps 

This window is reached from the menu option "Edit->Tree Population->Manage tree maps" in 

the main SORTIE-ND window. This allows you to manage tree maps as an addition to the tree 

population.  

Add tree map. This lets you load a tab-delimited tree map file and add it to your current 

parameter file. These trees will add to any tree maps already loaded. You will be given the 

option of adding the file to the parameter file, or keeping it separate. The first method is almost 

always preferred. However, sometimes a very large map file will make the parameter file too big 

for SORTIE to read. In this case, the text file can be kept as a separate file and only its filename 

can be added. SORTIE-ND will then read the file directly when the run begins.  

Remove tree map trees. If there is a tree map loaded, then the button marked "Remove tree map 

trees" is enabled. If you want to remove all currently loaded tree map trees, click this button. 

This action cannot be undone.  



Write tree map to text file. If there is a tree map loaded, then the button marked "Write tree 

map to text file" is enabled. Click this button to write the contents of the currently loaded tree 

map to a tab-delimited text file, which you can open in a spreadsheet or text editor. Files created 

this way are only for your own use. SORTIE-ND cannot accept them as run input. However, you 

can transform them yourself into a tab-delimited map file that SORTIE-ND can accept; see the 

Tab-delimited tree map topic.  

29-Feb-2008 02:30 PM  

Grid Setup Window 

This window is reached using the main SORTIE window menu option "Edit->Grid layer setup". 

It allows you to work with grids for your run. It has the following options:  

 

Choosing a grid to work with  

Cell length in X (E-W) direction, in m  

Cell length in Y (N-S) direction, in m  

Apply cell size changes  

View/edit/save grid values...  

Clear grid map  

Choosing a grid to work with 

The first step is to choose the grid you would like to work with. The active grids appear in the 

drop-down list that shows the option "---Please select grid---" when the window is first 

displayed. The grids that appear in that list depends on the list of behaviors for this run (editable 

using the Edit simulation flow window). If none of the behaviors with which a grid is associated 

are enabled, then the grid won't show up in the list. When you are finished with a grid, you can 

choose another from this list.  

Cell length in X (E-W) direction, in m 

Displays and sets the size of the grid in the X (E-W) direction, in meters. Some grids do not 

allow you to change their cell size (consult the documentation for individual grids for any 

limitations or recommendations). You can enter any number that you wish, between 0 and the 

length of the plot in the X direction. The number does not have to be an integer. Once you have 

entered your desired value, you must click "Update this grid" to save your changes.  

Cell length in Y (N-S) direction, in m 

Displays and sets the size of the grid in the Y (N-S) direction, in meters. Some grids do not allow 

you to change their cell size (consult the documentation for individual grids for any limitations 

or recommendations). You can enter any number that you wish, between 0 and the length of the 



plot in the Y direction. The number does not have to be an integer. Once you have entered your 

desired value, you must click "Update this grid" to save your changes.  

Apply cell size changes 

Use this button to update the current grid with any changes you have made to the cell size. If you 

do not click this button, your changes will be lost. You must click this button for each grid you 

wish to update.  

View/edit/save grid values... 

Use this button to open the Grid Value Edit window. This window allows you to view and 

change values for grid maps and write them out to tab-delimited text files.  

Clear grid map 

If there is a map loaded for this grid, then the button marked "Clear grid map" is enabled. If you 

want to remove a currently loaded map, click this button. This erases all map values for the 

current grid. This action cannot be undone, even if you click "Cancel" for the window.  

 

15-Sep-2004 02:45 PM  

Grid Value Edit Window 

This window allows you to directly work with the data in the grid maps for a single grid. You 

can look at the values for maps loaded from a parameter or detailed output file, make changes to 

existing maps, or enter new values to use as initial conditions. You reach this window from the 

Grid Setup window.  

When you open this window, you will notice that it is composed of one or more tables. There is 

one table for each grid data member (see the individual grid documentation for what each grid 

data member represents). If a table is completely blank, that means that there is currently no map 

loaded for this grid, or at least for that data member. If there is a map loaded, you will see values 

in the tables. (You load grid maps using the "File->Open file" command. For more on entering 

the maps from a detailed output file (the most likely source), see the detailed output file topic.)  

Editing map values 

To edit a value, double-click its cell. You can copy and paste back and forth from Excel, and 

within the window itself. You can use the menu commands on the parameter window "Edit-

>Copy" and "Edit->Paste", or the keyboard shortcuts Ctrl-C for copy and Ctrl-V for paste. If 

there is a cursor blinking in a cell when you click "OK", the value for that cell might not save. 

Whenever you're done entering data, it's a good idea to click outside the last cell so that this 

won't happen.  



Saving grid map as text 

The window can be saved as tab-delimited text for your own review in a spreadsheet or text 

editor program. Choose "File->Save window as file". Each value for each data member in the 

map is saved separately, and there will be a heading for it, even if there were no values in the 

map. For an explanation of the values that were saved, consult the documentation for individual 

grids.  

Saving the window view to a file is not the same as saving the values in SORTIE. You still need 

to click "OK" to save any changes you've made. The tab-delimited text file is just for your 

review. It cannot be used as input to SORTIE directly, although you could copy and paste values 

from it.  

 

16-Sep-2004 10:04 AM  

Model flow window 

This window is reached using the main SORTIE window menu option "Edit->Model flow". It 

allows you to choose the behaviors for a run, put them in a particular order, and assign them to 

trees. The current behaviors and their tree assignments is displayed in a hierarchical structure. 

You can view the data in three structures ordered by different hierarchies so that you can quickly 

find the information you want. Clicking on different parts of the structure bring up windows to 

edit those options.  

You will find that there are multiple ways to find, view, and edit the same information. Once you 

have experience with this window, you may use different methods to edit behaviors depending 

on the nature of the edit you need to do.  

This window has the following options:  

View by behavior  

View by data - species first  

View by data - type first  

View by behavior 

This button changes the view to a hierarchical structure that shows behaviors at the top level. 

Each behavior for the current run is listed in order. Expanding the tree under a behavior shows 

the grids and trees to which it applies. Clicking on the name of any behavior brings up the 

Current run behaviors window, where you can edit the list of behaviors, their order, and to what 

trees they apply. Clicking on any grid name brings up the Grid setup window, where you can set 

options for grids. Expanding trees shows you the tree types to which the behavior is assigned, 

first by tree type and then by species. Clicking on a species name brings up the tree behavior 

window, which you can use to set up the behaviors applied to the chosen tree type and species 

combination.  



View by data - species first 

This button changes the view to a hierarchical structure that shows grids and trees at the top 

level. In the tree structure portions, species is shown at a higher level and tree type (life history 

stage) is shown beneath. Expanding a tree or grid branching shows what behaviors, in order, 

apply. Clicking on any grid name brings up the Grid setup window, where you can set options 

for grids. Clicking on a tree type below a species name brings up the tree behavior window, 

which you can use to set up the behaviors applied to the chosen tree type and species 

combination. Clicking on the name of any behavior brings up the Current run behaviors window, 

where you can edit the list of behaviors, their order, and to what trees they apply.  

View by data - type first 

This button changes the view to a hierarchical structure that shows grids and trees at the top 

level. In the tree structure portions, tree type (life history stage) is shown at a higher level and 

species is shown beneath. Expanding a tree or grid branching shows what behaviors, in order, 

apply. Clicking on any grid name brings up the Grid setup window, where you can set options 

for grids. Clicking on a tree species name below a tree type brings up the tree behavior window, 

which you can use to set up the behaviors applied to the chosen tree type and species 

combination. Clicking on the name of any behavior brings up the Current run behaviors window, 

where you can edit the list of behaviors, their order, and to what trees they apply.  

Current run behaviors window 

This window is reached through the Edit simulation flow window. It edits the set of behaviors 

for a run, the order they are in, and the trees to which they apply (if it is appropriate for them to 

apply to trees). The current list of behaviors, in order, appears in the box labeled "Current 

behavior order". In this window:  

Adding new behaviors  

Changing behavior order - the "Up" and "Down" buttons  

Removing behaviors - the "Remove" button  

Changing behavior assignments - the "Modify assigned data" button  

Adding new behaviors 

The left-hand side of the window is devoted to choosing new behaviors for this run. Begin by 

choosing an overall behavior grouping using the drop-down list that shows "---Please select a 

behavior group" when the window is first opened. When you have chosen a group, a list of 

individual behaviors for that grouping shows in the box underneath. Select the one you wish to 

add, then click the button marked ">>" to add it to the list. It automatically places itself with 

other behaviors in its group, or in the correct place between other groups if it is the first of its 

group. (Behavior groups are separated by dashed lines.) At this time, you must add new 

behaviors one at a time. It is possible to select multiple individual behaviors, but the ">>" button 

will apply to only the first one selected. If you have chosen a behavior that is already on the list, 

nothing happens.  



Certain special behaviors cannot be added this way. If you try to add them, you will see a 

message saying "---Use this behavior's own dialog". This means that it has options that can be set 

up through a window accessible from the main SORTIE menu. You can, however, remove these 

special behaviors from the run from this dialog.  

Changing behavior order - the "Up" and "Down" buttons 

You can change the behavior order within the overall behavior groupings. Behavior groups are 

separated by dashed lines. To change a behavior's position in the list, select it in the list labeled 

"Current behavior order", then click "Up" or "Down" to move it. You cannot move it past a 

dashed line. This ensures behavior orders that make sense.  

Removing behaviors - the "Remove" button 

To remove a behavior from the run, select it in the list labeled "Current behavior order" and click 

the button marked "Remove".  

Changing behavior assignments - the "Modify assigned data" button 

This button changes the trees to which a behavior applies, if the behavior is of a kind applied to 

trees (and most are). Select a behavior in the list labeled "Current behavior order" and then click 

the "Modify assigned data" button. This brings up the Tree assignments window, to allow you to 

modify the assignments.  

Tree behavior edit window 

This window is reached through the Edit simulation flow window. It edits the list of behaviors 

for a given tree combination of species and type (life history stage). The combination being 

edited is displayed in the top of the window. The current list of behaviors, in order, appears in 

the box labeled "Assigned behaviors". In this window:  

Adding new behaviors  

Removing behaviors  

Apply to (species) (type)  

Apply to all (type)  

Adding new behaviors 

The left-hand side of the window is devoted to choosing new behaviors to apply to this tree 

type/species combination. Begin by choosing an overall behavior grouping using the drop-down 

list that shows "---Please select a behavior group" when the window is first opened. When you 

have chosen a group, a list of individual behaviors for that grouping shows in the box 

underneath. Select the one you wish to add, then click the button marked ">>" to add it to the 

list. It automatically inserts itself in the correct place in the behavior list, based on the order of 

the master behavior list. (Use the Current run behaviors window to edit the order of the 

behaviors in a run.) At this time, you must add new behaviors one at a time. It is possible to 



select multiple individual behaviors, but the ">>" button will apply to only the first one selected. 

If you have chosen a behavior that is already on the list, nothing happens.  

Not all behaviors can be assigned to all species/type combinations. If you have made an invalid 

choice, you will see an error message when you click an "Apply to..." button, and you will be 

given the opportunity to change it. See the documentation for individual behaviors for 

information on how they can be applied.  

Certain special behaviors cannot be added using this window. If you try to add them, you will 

see a message saying "---Use this behavior's own dialog". This means that it has options that can 

be set up through a window accessible from the main SORTIE menu.  

Removing behaviors 

To remove a behavior from the list assigned to this species/type combination, select it in the list 

labeled "Assigned behaviors" and click the button marked "Remove". This does not affect the 

behavior's assignment to any other trees.  

Apply to (species) (type) 

There is a button marked "Apply to (species) (type)" to apply your changes to the tree 

type/species combination (for instance, "Apply to Species 1 Saplings"). Behaviors you have 

added to the list are applied to that species/type combination. Behaviors you have removed have 

that species/type combination deleted from their list. If a tree-dependent behavior no longer 

applies to anything as a result of your choice, it is removed from the run. If you have made an 

invalid behavior assignment, you will receive an error message and be given the opportunity to 

correct your choices.  

Apply to all (type) 

There is a button marked "Apply to (type)" to apply your changes to all species of the specified 

tree type. All existing behavior applications for any species of the specified type are deleted and 

replaced with the behavior choices listed. If a tree-dependent behavior no longer applies to 

anything as a result of your choice, it is removed from the run. If you have made an invalid 

behavior assignment, you will receive an error message and be given the opportunity to correct 

your choices.  

Tree assignments window 

This window is reached from the Current run behaviors window or from the Edit harvest 

interface window. It modifies the trees to which a behavior is applied.  

The current list of tree species/type combinations is shown on the right-hand side of the window. 

The left-hand side allows you to choose a new species/type combination. Choose the appropriate 



combination where it says "--Please choose a species" and "--Please choose a tree type". Then 

click the button marked ">>" to add your choice to the list.  

You can remove a choice by selecting it in the list on the right, then clicking the "Remove" 

button.  

Not all behaviors can be assigned to all species/type combinations. If you have made an invalid 

choice, you will see an error message when you click the "OK" button, and you will be given the 

opportunity to change it. See the documentation for individual behaviors for information on how 

they can be applied.  

23-Oct-2006 11:27 AM  

Edit Episodic Events Window 

This window is reached using the menu option "Edit->Episodic events" from the main window. 

This window allows you to set up silvicultural treatments and planned mortality episodes.  

In this document:  

Window layout  

Displaying current episodic events  

Creating new episodic events  

Editing existing episodic events  

Deleting existing episodic events  

Episodic events edit windows  

Window layout 

The purpose of the main window is to display episodic events which have already been defined, 

and to provide the starting point for creating new episodic events or editing existing ones. On the 

left is a panel with three tabs labeled "Harvests", "Plantings", and "Mortality Episodes". (For 

more on harvests and planned mortality episodes, see the Disturbance Behaviors topic. For more 

on Plantings, see the Planting Behaviors topic.) On the right is a map of the plot. On this map is 

displayed the plot grid cells to which a episodic event is applied. In addition, if there has been a 

tree map defined, existing trees are also displayed. The color key for these trees is at the far right.  

Note to users of previous versions of SORTIE: In the past, trees would be displayed on the 

harvest plot if they had been either created by tree map or by size class initial densities. This was 

because, since the interface and the core model were completely integrated, the initial density 

data had already been used to create the initial population of trees. Now the interface and the 

core model are separated; there are no trees produced from initial density data until the core 

model executes when "Model->Run" is chosen from the main model window.  



If you need to know the initial tree population and distribution in order to create your episodic 

events, use a tree map. If you want to create a tree map with a random distribution of trees from 

size class data, do the following:  

1. Load your parameter file without episodic event information.  

2. Enter the appropriate size classes using "Edit->Tree Setup", and the appropriate initial 

density information using "Edit->Parameters".  

3. In the parameters, set the length of the run to be 1 timestep.  

4. Using "Edit->Output Options", create a detailed output file with the X, Y, and DBH of 

the saplings and adults of each species.  

5. Save the parameter file under a different name.  

6. Choose "Model->Run" from the main SORTIE window, or run one timestep. This causes 

the model to be run. A tree map of the initial density data you entered is then created.  

7. Load your original parameter file again.  

8. Use the instructions in the detailed output files topic to get the detailed output timestep 

file for timestep 0 and add it to the parameter file.  

9. Proceed to enter your episodic events.  

Displaying current episodic events 

To display existing episodic events, choose the tab of the type of episodic event you would like 

to see. The episodic events are numbered in the order that they were entered. You will see the 

currently displayed episodic event and what its number is of the total (for example, "Showing 

harvest 3 of 5"). Use the backward and forward buttons to move back and forth through the 

current episodic events. On the left, you will see information about the episodic event. On the 

map to the right, the current episodic event cells are displayed in color. Untreated plot cells are 

white.  

For more on what displayed information means, see the topics on episodic event entry, below.  

Creating new episodic events 

Choose the tab of the type of episodic event you would like to create. Then click "New". A new 

window will come up where you can enter the episodic event. For more on how to enter the 

episodic event, see the topics on episodic event entry, below.  

Editing existing episodic events 

Choose the tab of the type of episodic event you would like to edit. Use the backward and 

forward buttons to navigate through the episodic events and display the one you want to edit. 

Then click "Edit". A new window will come up displaying the episodic event. Edit it as you 

wish. For more, see the topics on episodic event entry, below.  

Deleting existing episodic events 



Choose the tab of the type of episodic event you would like to delete. Use the backward and 

forward buttons to navigate through the episodic events and display the one you want to delete. 

Then click "Delete".  

Episodic events edit windows 

For more on how to enter episodic events, see the individual episodic event edit topics.  

Edit Harvest  

Edit Mortality Episode  

Edit Planting  

Edit planting diameter at 10 cm  

04-Jun-2004 02:30 PM  

Edit Harvest Window 

This window is reached from the Edit Episodic Events Window by clicking on the "Harvest" tab 

and selecting "New" or "Edit".  

This window is where you create a new harvest event or edit an existing one. Along the left 

portion of the window, you enter data about the harvest. On the map in the center, you select the 

area of the plot to which to apply your harvest. If a tree map has been entered, those trees are 

displayed on the map and the species key is to the right. (For more on tree maps and episodic 

events, see the Edit Episodic Events Window topic.)  

In this document:  

Entering data about the harvest  

Choosing the area to which to apply the harvest  

Entering data about the harvest 

Timestep. Enter the timestep in which you wish the harvest to occur. You can create more than 

one harvest per timestep.  

Species applied to. Put a checkbox next to each species to which this harvest is to apply. If a 

species is not checked, no trees of that species will be cut. You can cut the same species more 

than once in a timestep, but if the cut areas of the two harvests overlap, there is no attempt to 

consolidate them and you may not get the results you expect.  

Cut type. Select the type of cut you are performing. The cut type makes no difference to the way 

that trees are selected for harvest. Its main effect is to change the substrate composition of the 

plot. If you want to select multiple size classes for cutting, select "Partial cut".  

Cut amount type. This only applies if you have selected "Partial cut" under "Cut type". Enter 

how you intend to specify the amount to cut in each size class you want to cut. The same cut 

amount type applies to all size classes. 



 % of density. You intend to specify cut amounts as a percentage of total density to 

remove, from 0 to 100. The trees removed will be randomly distributed between the 

minimum and maximum diameters in the size class. For small tree populations, the 

amount actually removed may not be exactly what was entered. 

 Amt. density (#/ha). You intend to specify cut amounts as a number of trees per hectare 

to remove. SORTIE will calculate the actual number of trees to remove by multiplying 

this number by the area to which the harvest is applied. The trees are removed in size 

order, starting with the tallest in the size class, until the target number has been reached 

or there are no more trees in that size class. 

 % of basal area. You intend to specify cut amounts as a percentage of total basal area to 

remove, from 0 to 100. SORTIE will add up the basal area in the size class in the cut area 

and take the percentage in order to figure out how much to cut. SORTIE will work its 

way down the trees in the cut area in size order, removing each one that brings the 

amount of basal area removed closer to the target amount without going over. If the size 

class range and the cut area are both large, the amount of basal area removed is likely to 

be very close to the target.  

 Amt. basal area (m
2
/ha). You intend to specify cut amounts as an amount of basal area 

to remove, in square meters per hectare. SORTIE will calculate the actual amount of 

basal area to remove by multiplying the cut amount by the area to which the harvest is 

applied. SORTIE will work its way down the trees in the cut area in size order, removing 

each one that brings the amount of basal area removed closer to the target amount 

without going over. If the size class range and the cut area are both large, the amount of 

basal area removed is likely to be very close to the target.  

Diameter Range(s) to cut. Enter the size class ranges you are cutting. You must enter at least 

one, but in order to enter more than one, you must specify "Partial cut" under "Cut type". For 

each size class, enter the minimum and maximum DBH, and the amount to cut in that range. The 

units of amount to cut will depend on what you have entered in "Cut amount type". Cut ranges 

may not overlap.  

Choosing the area to which to apply the harvest 

To specify the plot area to which to apply the harvest, select the appropriate cells on the map. 

Cells are each 8 meters by 8 meters. Selected cells will show up in color, and unselected cells 

will be white. You can click and drag to mark out an area, or click on individual cells. Clicking 

or dragging on selected (colored) cells causes them to become unselected (white).  

07-Dec-2004 10:27 AM  

Edit Mortality Episode Window 

This window is reached from the Edit Episodic Events Window by clicking on the "Mortality 

Episodes" tab and selecting "New" or "Edit".  



This window is where you create a new planned mortality episode or edit an existing one. Along 

the left portion of the window, you enter data about the planned mortality episode. On the map in 

the center, you select the area of the plot to which to apply your planned mortality episode. If a 

tree map has been entered, those trees are displayed on the map and the species key is to the 

right. (For more on tree maps and episodic events, see the Edit Episodic Events Window topic.)  

In this document:  

Entering data about the planned mortality episode  

Choosing the area to which to apply the planned mortality episode  

Entering data about the planned mortality episode 

Timestep. Enter the timestep in which you wish the planned mortality episode to occur. You can 

create more than one planned mortality episode per timestep.  

Species applied to. Put a checkbox next to each species to which this planned mortality episode 

is to apply. If a species is not checked, no trees of that species will be killed. You can kill trees of 

the same species more than once in a timestep, but if the areas of the two planned mortality 

episodes overlap, there is no attempt to consolidate them and you may not get the results you 

expect.  

Amount of mortality type. Enter how you intend to specify the amount of trees to kill in each 

size class to which the planned mortality episode applies. The same amount type applies to all 

size classes. 

 % of density. You intend to specify kill amounts as a percentage of total density, from 0 

to 100. The trees killed will be randomly distributed between the minimum and 

maximum diameters in the size class. For small tree populations, the amount actually 

killed may not be exactly what was entered. 

 Amt. density (#/ha). You intend to specify kill amounts as a number of trees per hectare. 

SORTIE will calculate the actual number of trees to kill by multiplying this number by 

the area to which the planned mortality episode is applied. The trees are removed in size 

order, starting with the tallest in the size class, until the target number has been reached 

or there are no more trees in that size class. 

 % of basal area. You intend to specify kill amounts as a percentage of total basal area, 

from 0 to 100. SORTIE will add up the basal area in the size class in the cut area and take 

the percentage in order to figure out how much to kill. SORTIE will work its way down 

the trees in the disturbed area in size order, killing each one that brings the amount of 

basal area killed closer to the target amount without going over. If the size class range 

and the disturbed area are both large, the amount of basal area killed is likely to be very 

close to the target.  

 Amt. basal area (m
2
/ha). You intend to specify kill amounts as an amount of basal area, 

in square meters per hectare. SORTIE will calculate the actual amount of basal area to 

kill by multiplying this number by the area to which the planned mortality episode is 

applied. SORTIE will work its way down the trees in the disturbed area in size order, 

killing each one that brings the amount of basal area killed closer to the target amount 



without going over. If the size class range and the disturbed area are both large, the 

amount of basal area killed is likely to be very close to the target.  

Diameter Range(s) to kill. Enter the size class ranges you are killing. You must enter at least 

one. For each size class, enter the minimum and maximum DBH, and the amount to kill in that 

range. The units of amount to kill will depend on what you have entered in "Amount of mortality 

type". Kill ranges may not overlap.  

Choosing the area to which to apply the planned mortality episode 

To specify the plot area to which to apply the planned mortality episode, select the appropriate 

cells on the map. Cells are each 8 meters by 8 meters. Selected cells will show up in color, and 

unselected cells will be white. You can click and drag to mark out an area, or click on individual 

cells. Clicking or dragging on selected (colored) cells causes them to become unselected (white).  

07-Dec-2004 10:55 AM  

Edit Planting Window 

This window is reached from the Edit Episodic Events Window by clicking on the "Plantings" 

tab and selecting "New" or "Edit".  

This window is where you create a new planting event or edit an existing one. Along the left 

portion of the window, you enter data about the planting. On the map in the center, you select the 

area of the plot to which to apply your planting. If a tree map has been entered, those trees are 

displayed on the map and the species key is to the right. (For more on tree maps and episodic 

events, see the Edit Episodic Events Window topic.)  

In this document:  

Entering data about the planting  

Choosing the area to which to apply the planting  

Entering data about the planting 

Timestep. Enter the timestep in which you wish the planting to occur. You can create more than 

one planting per timestep.  

Percentage of each species. For each species, enter the percentage of total trees planted that 

should be of that species, as a value between 0 and 100. Enter zero in order to not plant a species. 

Values should add up to 100. When SORTIE plants a seedling, it compares a random number to 

these values to determine its species. This ensures a random distribution of species in the planted 

population, but it also means that, if the number of seedlings to plant is small, the actual 

percentages of each species planted may not exactly match the entered values.  



Plant spacing. Select the seedling spacing. If you select "Gridded", the seedlings are placed at a 

fixed distance from each other. If you select "Random", the seedlings are randomly scattered 

around the plant area.  

# total trees/ha. You enter this value if the "Plant spacing" is set to "Random". This is the total 

number of seedlings to plant, as a value per hectare. SORTIE determines the actual number to 

plant by multiplying this value by the planting area.  

Spacing (m). You enter this value if the "Plant spacing" is set to "Gridded". This is the distance, 

in meters, between newly planted seedlings in an 8 meter by 8 meter plot grid cell. If this 

distance is larger than 4, only one seedling per grid cell will be planted.  

Choosing the area to which to apply the planting 

To specify the plot area to which to apply the planting, select the appropriate cells on the map. 

Cells are each 8 meters by 8 meters. Selected cells will show up in color, and unselected cells 

will be white. You can click and drag to mark out an area, or click on individual cells. Clicking 

or dragging on selected (colored) cells causes them to become unselected (white).  

07-Dec-2004 10:26 AM  

Edit Harvest Interface Window 

This window is reached from the Edit menu by selecting "Harvest Interface". It allows you to set 

up the Harvest interface behavior.  

Path and filename of the executable: This is the full path and filename of the executable that 

SORTIE will call to perform harvests. The filename and file extension must be something that 

the operating system can recognize and treat as an executable. Be sure to provide the complete 

filename; SORTIE makes no assumptions about the file.  

Tree file that SORTIE will write: This is the full path and filename of the file that SORTIE 

writes each harvest timestep with the list of trees eligible to be harvested. Input the filename and 

extension as the executable expects to find it.  

Tree harvest file that the executable will write: This is the full path and filename of the file 

that the executable writes with the list of trees to be harvested. Input the filename and extension 

as it will be written by the executable.  

How often to harvest, in years: How often SORTIE will perform the harvest process. This 

number must be a positive integer value.  

Behavior currently assigned to: This is the tree types and species to which the harvest interface 

behavior are applied. Only these trees will be written to the text file that is passed to the 

executable. Use the "Edit" button to add or remove from the list.  



File columns: The columns in the text files written by both SORTIE and the executable, in the 

order that they will appear. The text in this list matches the text in the column headers.  

Parameters file for batch run (optional): If you want SORTIE to manage input files for the 

executable when in SORTIE batch mode, this is the full path and filename of the file that 

contains the executable's input parameters for each run in the entire batch.  

Single-run parameters file for batch run (optional): If you want SORTIE to manage input 

files for the executable when in SORTIE batch mode, this is the full path and filename of the file 

that SORTIE will write with the executable's input parameters for a single run in the batch.  

Arguments to pass to the executable (optional): SORTIE will pass this string value to the 

executable when launching it.  

Tree update file that the executable will write: If extra tree data members have been created 

for the executable to control, this is the full path and filename of the file the executable will write 

with updates to these data members. If there is an update file, there must also be new tree data 

members in the New tree data members to add section.  

New tree data members to add: Extra tree data members to be created for the executable to 

control, if desired. The names can be up to 9 characters long, must not match the name of any 

existing data member, and must not contain parentheses. If there are new tree data members, 

there must also be an update file.  

24-Oct-2006 09:10 AM  

Edit diameter at 10 cm 

This window is reached through the Edit Episodic Events Window by clicking on the "Plantings" 

tab and clicking the button marked "Edit initial diameter at 10 cm."  

When planting seedlings (see more on the planting behavior or the Edit Planting Window), you 

can allow their size to default to the value in the "New seedling diameter at 10 cm" parameter of 

the tree population, or you can specify values for each species. All plantings for a run share the 

same set of values.  

For each species, enter the diameter at 10 cm value for newly planted seedlings of that species. 

Actual values will be slightly randomized around these values.  

07-Dec-2004 10:55 AM  

Output setup window 



This window is reached using the "Edit->Output options" choice on the menu of the main 

SORTIE window. It is a gateway to managing the output options for a run. What you save for 

output depends on what data you want to be available to you after the run. For more on output in 

SORTIE, including a guide on what to save, see the Output in SORTIE topic. For a list of data 

visualization options and what you need to save to use them, see the Data Visualization topic.  

Save Summary Output File (.out) 

This button opens the Summary output file setup window for saving short, or summary, output 

files. As a quick check, the text just below this button will tell you if there are currently summary 

output file save settings.  

Save Detailed Output File 

This button opens the Setup detailed output file window for saving detailed output files. As a 

quick check, the text just below this button will tell you if there are currently detailed output file 

save settings.  

 

25-Jan-2005 12:50 PM  

Setup detailed output file window 

This window is reached from the Output setup window. It is the first step in setting up a detailed 

output file. What you save for output depends on what data you want to be available to you after 

the run. For a list of data visualization options and what you need to save to use them, see the 

Data Visualization topic.  

Output file name. Enter your output file name here. You can use the "Browse" button to help 

you enter a path. If you don't use a path your file may be hard to find. Detailed output files end 

up with a ".gz.tar" extension.  

Save everything. This saves all possible data. The resulting detailed output file will probably be 

quite large. This option is handy when you are still tweaking your parameter file. You can save 

everything, run for a few timesteps, and review the data using the data visualization tools. This 

option is also a good one when you wish to have the complete state of the model at every 

timestep, perhaps to use as input to new runs.  

This option takes effect right away and cannot be canceled.  

Clear everything. Erases all detailed output settings. This option takes effect right away and 

cannot be canceled.  



Trees. Sets options for saving trees by opening the Setup tree save options window. The text just 

below this button will tell you if there are currently any tree save settings. You are not required 

to save tree data.  

Grid data layers. Sets options for saving grids by opening the Setup grid save options window. 

The text just below this button will tell you if there are currently any grid save settings. You are 

not required to save grid data.  

Set up subplots.... Sets up subplots for tree data by opening the Edit subplots window. Subplots 

are regions within the plot as a whole that will have data saved separately. You can find more 

information in the detailed output file topic. You are not required to create subplots.  

 

Last updated: 18-May-2006 12:55 PM  

Setup tree save options window 

For more on the different tree types, see the trees topic. For more on the data available to save, 

see the tree data member list topic.  

This window is reached from the Setup detailed output file window. It allows you to choose 

options for tree data for a detailed output file. What you save for output depends on what data 

you want to be available to you after the run. For a list of data visualization options and what you 

need to save to use them, see the Data Visualization topic.  

There are four tabs at the top of the window, one each for seedlings, saplings, adults, and snags. 

For each of these tree types, you choose each piece of data that you want to save, and how often 

you want to save it. Some of the data always apply and will always be available. Other types of 

data only exist when certain behaviors that need them have been chosen for the current run. Each 

piece of data may not be available for all species. The window will sort out and ignore any 

invalid combination.  

You can work through the process below as many times as you like until you have your settings 

the way you want them.  

Select one or more species. Begin here by choosing the species of the data you want to save. 

You can Ctrl + click to select multiple species at once.  

For each tree save. For the species that you have selected, click on what you want to save for 

each tree of that species. You can Ctrl + click to select multiple data at once.  

Save every X timesteps. Choose how often, in timesteps, you want to save the data. The number 

1 saves every timestep. The number 0 saves only the first and last timesteps. Any other number 

X saves data every X timesteps.  



Add. Use the Add button once you have chosen your data and how often you wish to save it.  

What's being saved. This is a list of all of the save settings that are currently set up for this tree 

type. If it is not displayed here, it won't be saved.  

Remove. If you would like to erase a setting, select it in the "What's being saved" box and click 

"Remove".  
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Set up grid save options 

This window is reached from the Setup detailed output file window. It allows you to choose 

options for grid data for a detailed output file. Each grid has different data associated with it, so 

you must choose them separately. You choose each piece of data you want to save, and how 

often you want to save it. You can work through the process below as many times as you like 

until you have your settings the way you want them. What you save for output depends on what 

data you want to be available to you after the run. For a list of data visualization options and 

what you need to save to use them, see the Data Visualization topic.  

Select a grid. Choose one of the current run's active grids from this drop-down list. The grids 

that appear in that list depends on the list of behaviors for this run (editable using the Edit 

simulation flow window). If none of the behaviors with which a grid is associated are enabled, 

then the grid won't show up in the list.  

Save every X timesteps. Choose how often, in timesteps, you want to save this grid's data. The 

number 1 saves every timestep. The number 0 saves only the first and last timesteps. Any other 

number X saves data every X timesteps.  

For this grid save. Choose the data to save for this grid. Ctrl + click to select multiple items. For 

an explanation of what each grid's data is, see the individual grid documentation.  

Add. Use the Add button once you have chosen your data and how often you wish to save it.  

What's being saved. This is a list of all of the save settings that are currently set up for all grids.  

Remove. If you would like to erase a setting, select it in the "What's being saved" box and click 

"Remove".  
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Summary output file setup window 



This window is reached from the Output setup window. It allows you to set options for a 

summary output file. Only one of these files may be saved per run. What you save for output 

depends on what data you want to be available to you after the run. For a list of data visualization 

options and what you need to save to use them, see the Data Visualization topic.  

Output File Name. Enter your output file name here, or choose the "Browse" button to navigate 

to a path. If you do not enter a path, the file may be hard to find after the run. The extension that 

will be added, if you haven't added it already, is ".out".  

Set up subplots.... Opens the Edit Subplots window.  

The other options allow you to choose saving options for different types (life history stages) of 

trees. For the definition of seedling, sapling, adult, and snag, see the trees topic.  

Save absolute density. Saves the density of trees of each species of that type, in number per 

hectare.  

Save relative density. Saves the density of trees of each species of that type, as a proportion of 

total tree density for that type.  

Save absolute basal area. Saves the amount of basal area of trees of each species of that type, in 

square meters per hectare.  

Save relative basal area. Saves the amount of basal area of trees of each species of that type, as 

a proportion of total tree basal area for that type.  
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Edit Subplots Window 

You reach this window by clicking the "Set up subplots..." button on either the Summary output 

file setup window or the Setup detailed output file window. This window allows you to define 

subplots for output. Subplots are subareas of the plot for which statistics will be tracked 

separately. They can be as small as a single plot grid cell or as large as the entire plot. They do 

not have to be continuous in area - you could define several separate patches and put them 

together in a single subplot. You can define up to five separate subplots. Subplots can overlap.  

In the center of the window is a map displaying the subplots. At the right is the legend for any 

tree map trees which may exist. Along the left panel of the window, you will see a space for the 

names of five subplots. The colored squares indicate in what color that subplot will show up on 

the map in the center of the window. At the bottom left are some controls for displaying 

additional useful information that may help you in defining your subplots.  

Defining a subplot 



Begin by clicking the radio button for the subplot you want to define (for instance, "Subplot # 

1"). Type a name for this subplot. Then choose the squares on the map which define the subplot's 

area. You can click single squares, or click and drag to select a rectangle. You can unselect a 

square by clicking it again. The selected cells will show up in the current subplot's color. 

Everything you click on the map is assumed to apply to the subplot that is currently selected, 

until you select a new one.  

If two subplots overlap, only one of the subplot's colors will show up (the one with the greater 

number). The hidden subplot still exists; it is okay for subplots to overlap. However, the entire 

map is still active even for a subplot that is partly covered up. Say you select a subplot and then 

click cells that are covered by a subplot with a higher number. Your clicks are still selecting and 

de-selecting cells for the subplot with the lower number, but you won't be able to see your 

selections because the subplot with the higher number is covering them up. To avoid mistakes, 

you should completely finish each subplot before creating a new one, especially if their areas 

will overlap. If you need to make changes to a partially hidden subplot, you might want to erase 

the higher subplot areas and then put them back in when you're done.  

If you are setting up both summary and detailed output, and you want to use the same subplots 

for both, there is a button to copy subplots already defined for the other file type to the current 

file type.  

Displaying additional information 

Subplots are often used to analyze the effects of specific episodic events such as silvicultural 

treatments. (To input episodic events, use the Edit Episodic Events Window.) To help you with 

this, the subplots window will display episodic events for you on the map. You can display 

harvest, planned mortality episodes, and planting events. You scroll through the events in the 

same order in which they were created in the edit windows. The button colors match the colors in 

which the events will display on the map. Note that subplots will cover up episodic events that 

have the same area, and episodic events may cover each other as well. If you are having trouble 

seeing an episodic event, use the buttons to set all the other episodic events to display the event 

number 0.  
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Model menu 

Run. Runs the model with the currently loaded parameter file. A file must be complete and all 

data in it valid if the run is to succeed, so the file will be validated before the run occurs. You 

will get an error message if there is something wrong with the parameter file. If there are 

unsaved changes to the current file, a temporary file is written so that the model runs with those 

changes included. Keep an eye on the status bar at the bottom of the SORTIE screen. It will 

display the status messages from the running model.  



Run Batch... Allows you to select a batch file and then run the batch. You can read more about 

batch runs here. You create batch setup files using the batch file setup window. You can run 

batch files without having a parameter file loaded.  

Pause. If there is a run in progress, you can pause it with this option. You can resume the run by 

choosing "Run" again. This does not apply to batch runs. They cannot be paused, only stopped.  

Stop run. If there is a run in progress, this will stop it.  
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Help menu 

Contents. Accesses the SORTIE help.  

Trees 

In this document:  

Tree life history stages  

Tree life history stage transitioning - growth and death  

Tree organization  

Tree population initial conditions - densities and maps  

Tree parameters  

The basic unit of data in the model is the tree. Each tree is a discrete individual with a location in 

space and attributes which describe its size and shape. More information about how tree size is 

measured and how different aspects of tree shape are calculated can be found in the Allometry 

topic. In addition, a tree may carry data added to it by Behaviors to help simulate different 

processes. 

Tree life history stages 

Tree life history stage (also referred to as tree type), along with species, is the basic way to 

classify trees. When you set up behaviors for a run, you tell each behavior which trees to act on 

by species and type. There is support for seven tree life history stages in the model: 

 Seed. The seed life history stage is currently not used by any behavior, but is available if 

there is a need to model seeds as individuals. 

 Seedling. Seedlings are defined as trees less than the height set in the parameter Max 

Seedling Height (meters) (normally 1.35 meters, thus seedlings have no DBH). Their 

primary size measurement is the diameter at 10 cm height. 



 Sapling. Saplings are defined as having a DBH greater than 0 and less than the Minimum 

adult DBH defined in the tree parameters. Seedlings and saplings are sometimes referred 

to collectively as "juveniles". 

 Adult. Adults are defined as having a DBH equal to or greater than the Minimum adult 

DBH defined in the tree parameters. 

 Stump. Stumps are saplings or adults that have been cut by the Harvest behavior. Stumps 

exist only for the timestep in which they were created, and then disappear. 

 Snag. Snags are standing dead trees. They can be produced when saplings and adults die 

due to normal tree mortality or a disturbance event, such as disease. Only adult trees 

become snags. See below for more on how trees become snags.  

 Woody debris. Woody debris comes from fallen snags. Currently, no behavior uses 

woody debris and it is not actually created. 

Tree life history stage transitioning - growth and death 

Trees transition between life history stages as they grow. When a seedling reaches the maximum 

height set for its species, it becomes a sapling. The diam10 value is converted to a DBH value, 

which is then used to calculate the rest of the sapling's new dimensions. Since height is re-

calculated with a different equation and input parameters, there may be a discontinuity in height 

values right around the seedling/sapling transition point. If a species uses different allometric 

relationships for its saplings and adults, another discontinuity may occur at the time of this 

transition as well. For more on the allometric relationships and how they are calculated, see the 

Allometry topic. (The automatic updating of these allometric relationships during the growth 

phase can be overridden. For more, see the Growth behaviors topic.)  

Death also produces tree life history stage transitions. Behaviors can request to a tree population 

that a tree be killed. How the tree population responds to this request depends on the type of tree, 

the reason for death, and the type of run. The reasons why a tree is killed are natural causes, 

harvest, insects, fire, and disease (there may not be behaviors set up to create tree death for all of 

these reasons).  

There are life history stages for dead trees, but a run may not be set up to handle them. The tree 

population takes this into account. It examines the run to see if any behaviors directly deal with 

stumps and snags. If either is the case, the run is classified as "stump aware" and/or "snag 

aware".  

Here's what happens to a tree to be killed in different situations:  

 If a tree is a seedling, it is deleted from memory no matter why it died.  

 If a tree is a sapling or adult killed in a harvest, and the run is "stump aware", the tree is 

converted to a stump.  

 Saplings killed for any other reason, or by harvest in a run that is not "stump aware", are 

deleted from memory.  

 If the tree is an adult killed by harvest and the run is not "stump aware", it is deleted from 

memory.  



 If the tree is an adult killed for any reason other than harvest, and the run is "snag aware", 

the tree is converted to a snag.  

 If the tree is an adult killed for any reason other than harvest, and the run is NOT "snag 

aware", the tree is removed from memory.  

 If the tree is already a snag, it is removed from memory.  

Tree organization 

Trees are organized by location and size in what is called the tree population. The tree population 

indexes trees into 8 m by 8 m areas, lined up by height. The population acts as a librarian for 

behaviors that wish to find certain sets of trees upon which to act. 

Tree population initial conditions - densities and maps 

When setting up a simulation, a key part is to define the initial tree population. There are two 

ways to add trees at the beginning of the run, and they can be used together or separately. The 

first is to ask the model to create trees for you by describing a particular pattern of densities by 

species and size range (size class). You define size classes in the Tree setup window, and enter 

densities in the Parameters window. The second way is to directly list a particular set of trees in a 

tree map within the parameter file.  

Tree maps are lists of particular trees. You can add one or more maps to your parameter file. The 

maps can come from detailed output files from other runs, or you can make your own tab-

delimited tree maps. The preferred method of incorporating a tree map to a run is to add it 

directly into a parameter file. However, if the number of trees is very large, it may make the 

XML file too big to read. In this case, a text tree file's filename can be added to the parameter file 

instead and SORTIE can read the trees directly from the file.  

Tree parameters 

 Initial Densities The density of trees, in number per hectare, for that size class. Trees are 

randomly placed within the chosen size range, which starts at the value of the size class 

beneath (or 0 if there is none) and ends at the value for the current size class. The aim is 

for an even distribution. You can also set up a size class for seedlings. Seedlings set up 

this way are given a slightly randomized value of "New seedling diameter at 10 cm", 

below. You can further specify seedling initial densities using the seedling height class 

parameters. You can set up size classes in the Tree setup window. 

 Initial Density (#/ha) - Seedling Height Class 1 Number of seedlings per hectare to 

create in the first seedling height class (not required). The lower bound of this class is 0 

cm and the upper bound is the value in the Seedling Height Class 1 Upper Bound, in 

cm parameter. 

 Initial Density (#/ha) - Seedling Height Class 2 Number of seedlings per hectare to 

create in the second seedling height class (not required). The lower bound of this class is 

the value in the Seedling Height Class 1 Upper Bound, in cm parameter and the upper 

bound is the value in the Seedling Height Class 2 Upper Bound, in cm parameter. 



 Initial Density (#/ha) - Seedling Height Class 3 Number of seedlings per hectare to 

create in the third seedling height class (not required). The lower bound of this class is 

the value in the Seedling Height Class 2 Upper Bound, in cm parameter and the upper 

bound is 135 cm (the tallest possible seedling height). 

 Minimum Adult DBH The minimum DBH at which trees are considered adults. (See 

more about tree life history stages, above.) 

 Max Seedling Height (meters) The maximum seedling height, in meters. Trees taller 

than this height are saplings. (See more about tree life history stages, above.) 

 New Seedling Diameter at 10 cm The average diameter at 10 cm height value for newly 

created seedlings, when another size is not specified. Actual values are randomized 

slightly around this value. 

 Seedling Height Class 1 Upper Bound, in cm The upper bound of the first seedling 

height class, in cm, for specifying seedling initial densities (not required). The lower 

bound of the size class is 0. 

 Seedling Height Class 2 Upper Bound, in cm The upper bound of the second seedling 

height class, in cm, for specifying seedling initial densities (not required). The lower 

bound of the size class is the Seedling Height Class 2 Upper Bound, in cm parameter. 

There is a third size class, whose lower bound is this parameter's value and whose upper 

bound is 135 cm. 

 Tree Map To Add As Text Tree maps can be added 

In addition to the values listed in the parameter window, the tree population also keeps the list of 

species and size classes. These can be edited in the Tree setup window. 
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Allometry 

In this document:  

Allometry parameters  

The "standard" crown depth and radius relationships  

The "Chapman-Richards" crown depth and radius relationships  

The non-spatial density dependent crown depth and radius relationships  

The NCI crown depth and radius relationships  

DBH - diameter at 10 cm relationship  

The "standard" diameter-height relationships  

The "linear" diameter-height relationship  

The "reverse linear" diameter-height relationship  

The "power" diameter-height relationship  

Allometry is the relationships between various aspects of a tree's size and shape. A tree may use 

different relationships for different life history stages.  



You can choose the relationship used by each life history stage of each species. These can be 

freely mixed-and-matched. Use the Edit Allometry Functions window to set the allometry 

functions.  

Definitions: DBH (diameter at breast height) is the diameter of a tree trunk at 1.35 meters above 

the ground. Diameter at 10 cm, or diam10, is the diameter of a tree trunk 10 cm above the 

ground.  

In general, crowns are modeled as cylinders, with a radius and a height. Specific behaviors may 

make different assumptions but if so they should be clearly stated in that behavior's 

documentation.  

Seedlings in SORTIE-ND do not have crowns. Saplings and adults (and, in some cases, snags) 

all use the same relationships to describe crown shape.  

Allometry parameters 

 Adult Linear Function Intercept The intercept of the adult linear function for DBH and 

height. 

 Adult Linear Function Slope The slope of the adult linear function for DBH and height. 

 Adult Reverse Linear Function Intercept The intercept of the adult reverse linear 

function for DBH and height. 

 Adult Reverse Linear Function Slope The slope of the adult reverse linear function for 

DBH and height. 

 Chapman-Richards Asymptotic Crown Height The asymptotic crown depth (or 

length), in m, of the Chapman-Richards crown depth equation. 

 Chapman-Richards Asymptotic Crown Radius The asymptotic crown radius, in m, of 

the Chapman-Richards crown radius equation. 

 Chapman-Richards Crown Height Intercept The intercept of the Chapman-Richards 

crown depth equation. This represents the crown depth, in m, of the smallest possible 

sapling. 

 Chapman-Richards Crown Height Shape 1 (b) The first shape parameter, b, of the 

Chapman-Richards crown depth equation. 

 Chapman-Richards Crown Height Shape 2 (c) The second shape parameter, c, of the 

Chapman-Richards crown depth equation. 

 Chapman-Richards Crown Radius Intercept The intercept of the Chapman-Richards 

crown radius equation. This represents the crown radius, in m, of the smallest possible 

sapling. 

 Chapman-Richards Crown Radius Shape 1 (b) The first shape parameter, b, of the 

Chapman-Richards crown radius equation. 

 Chapman-Richards Crown Radius Shape 2 (c) The second shape parameter, c, of the 

Chapman-Richards crown radius equation. 

 Crown Height Exponent The exponent in the standard equation for calculating crown 

depth. 

 Crown Radius Exponent The exponent in the standard equation for determining the 

crown radius. 



 Intercept of DBH to Diameter at 10 cm Relationship The intercept of the linear 

relationsip between the DBH, in cm, and the diameter at 10 cm height, in cm, in small 

trees. Used by all species. 

 Maximum Tree Height, in meters The maximum tree height for a species, in meters. 

No tree, no matter what allometric function it uses, is allowed to get taller than this. Used 

by all species. 

 NCI Crown Depth - Alpha NCI function exponent. Used to calculate NCI crown depth. 

 NCI Crown Depth - Beta NCI function exponent. Used to calculate NCI crown depth. 

 NCI Crown Depth - Crowding Effect "n" Crowding effect exponent. Used to calculate 

NCI crown depth. 

 NCI Crown Depth - Gamma NCI function exponent. Used to calculate NCI crown 

depth. 

 NCI Crown Depth Lambda for Species X Neighbors The competitive effect of 

neighbors of species X. Used to calculate NCI crown depth. 

 NCI Crown Depth - Max Potential Depth (m) The maximum possible value for crown 

depth, in m. Used to calculate NCI crown depth. 

 NCI Crown Depth - Max Search Distance for Neighbors (m) The maximum distance, 

in m, at which a neighboring tree has competitive effects on a target tree. Used to 

calculate NCI crown depth. 

 NCI Crown Depth - Minimum Neighbor DBH (cm) The minimum DBH for trees of 

that species to compete as neighbors. Values are needed for all species. Used to calculate 

NCI crown depth. 

 NCI Crown Depth - Size Effect "d" Size effect function exponent. Used to calculate 

NCI crown depth. 

 NCI Crown Radius - Alpha NCI function exponent. Used to calculate NCI crown 

radius. 

 NCI Crown Radius - Beta NCI function exponent. Used to calculate NCI crown radius. 

 NCI Crown Radius - Crowding Effect "n" Crowding effect exponent. Used to 

calculate NCI crown radius. 

 NCI Crown Radius - Gamma NCI function exponent. Used to calculate NCI crown 

radius. 

 NCI Crown Radius Lambda for Species X Neighbors The competitive effect of 

neighbors of species X. Used to calculate NCI crown radius. 

 NCI Crown Radius - Max Potential Radius (m) The maximum possible value for 

crown radius, in m. Used to calculate NCI crown radius. 

 NCI Crown Radius - Max Search Distance for Neighbors (m) The maximum distance, 

in m, at which a neighboring tree has competitive effects on a target tree. Used to 

calculate NCI crown radius. 

 NCI Crown Radius - Minimum Neighbor DBH (cm) The minimum DBH for trees of 

that species to compete as neighbors. Values are needed for all species. Used to calculate 

NCI crown radius. 

 NCI Crown Radius - Size Effect "d" Size effect function exponent. Used to calculate 

NCI crown radius. 

 Non-Spatial Density Dep. Inst. Crown Height "a" The "a" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 



 Non-Spatial Density Dep. Inst. Crown Height "b" The "b" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "c" The "c" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "d" The "d" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "e" The "e" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "f" The "f" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "g" The "g" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "h" The "h" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "i" The "i" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Density Dep. Inst. Crown Height "j" The "j" term in the instrumental 

crown depth equation, used to calculate crown radius for the non-spatial exponential 

density dependent function. 

 Non-Spatial Exp. Density Dep. Crown Radius "D1" The "D1" term in the non-spatial 

exponential density dependent crown radius function. 

 Non-Spatial Exp. Density Dep. Crown Radius "a" The "a" term in the non-spatial 

exponential density dependent crown radius function. 

 Non-Spatial Exp. Density Dep. Crown Radius "b" The "b" term in the non-spatial 

exponential density dependent crown radius function. 

 Non-Spatial Exp. Density Dep. Crown Radius "c" The "c" term in the non-spatial 

exponential density dependent crown radius function. 

 Non-Spatial Exp. Density Dep. Crown Radius "d" The "d" term in the non-spatial 

exponential density dependent crown radius function. 

 Non-Spatial Exp. Density Dep. Crown Radius "e" The "e" term in the non-spatial 

exponential density dependent crown radius function. 

 Non-Spatial Exp. Density Dep. Crown Radius "f" The "f" term in the non-spatial 

exponential density dependent crown radius function. 

 Non-Spatial Density Dep. Inst. Crown Radius "a" The "a" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 



 Non-Spatial Density Dep. Inst. Crown Radius "b" The "b" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "c" The "c" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "d" The "d" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "e" The "e" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "f" The "f" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "g" The "g" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "h" The "h" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "i" The "i" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Density Dep. Inst. Crown Radius "j" The "j" term in the instrumental 

crown radius equation, used to calculate crown depth with the non-spatial logistic density 

dependent function. 

 Non-Spatial Log. Density Dep. Crown Height "a" The "a" term in the non-spatial 

logistic density dependent crown depth function. 

 Non-Spatial Log. Density Dep. Crown Height "b" The "b" term in the non-spatial 

logistic density dependent crown depth function. 

 Non-Spatial Log. Density Dep. Crown Height "c" The "c" term in the non-spatial 

logistic density dependent crown depth function. 

 Non-Spatial Log. Density Dep. Crown Height "d" The "d" term in the non-spatial 

logistic density dependent crown depth function. 

 Non-Spatial Log. Density Dep. Crown Height "e" The "e" term in the non-spatial 

logistic density dependent crown depth function. 

 Non-Spatial Log. Density Dep. Crown Height "f" The "f" term in the non-spatial 

logistic density dependent crown depth function. 

 Non-Spatial Log. Density Dep. Crown Height "g" The "g" term in the non-spatial 

logistic density dependent crown depth function. 

 Power Function "a" The "a" parameter in the power function for the height-diameter 

relationship. 

 Power Function Exponent "b" The exponent, or "b" parameter, in the power function 

for the height-diameter relationship. 



 Sapling Linear Function Intercept The intercept of the sapling linear function for DBH 

and height. 

 Sapling Linear Function Slope The intercept of the sapling linear function for DBH and 

height. 

 Sapling Reverse Linear Function Intercept The intercept of the sapling reverse linear 

function for DBH and height. 

 Sapling Reverse Linear Function Slope The slope of the sapling reverse linear function 

for DBH and height. 

 Seedling Linear Function Intercept The intercept of the seedling linear function for 

DBH and height. 

 Seedling Linear Function Slope The slope of the seedling linear function for DBH and 

height. 

 Seedling Reverse Linear Function Intercept The intercept of the seedling reverse 

linear function for DBH and height. 

 Seedling Reverse Linear Function Slope The slope of the seedling reverse linear 

function for DBH and height. 

 Slope of Asymptotic Crown Height Slope of the standard equation for determining 

crown depth. 

 Slope of Asymptotic Crown Radius Slope of the standard equation for determining 

crown radius. 

 Slope of Asymptotic Height Exponential decay term in the adult and sapling standard 

function for DBH and height. 

 Slope of DBH to Diameter at 10 cm Relationship The slope of the linear relationsip 

between the DBH, in cm, and the diameter at 10 cm height, in cm, in small trees. Used by 

all species. 

 Slope of Height-Diameter at 10 cm Relationship The slope of the seedling standard 

function for diameter at 10 cm and height. 

The "standard" crown depth and radius relationships 

Crown radius is calculated as:  

rad = C1 * DBH 
a
 

where:  

 rad is the crown radius, in meters 

 C1 is the Slope of Asymptotic Crown Radius parameter 

 a is the Crown Radius Exponent parameter 

 DBH is the tree's DBH, in cm 

Crown radius is limited to a maximum of 10 meters.  

Crown depth is calculated as  

ch = C2 * height 
b
 



where  

 ch is the distance from the top to the bottom of the crown cylinder, in meters 

 C2 is the Slope of Asymptotic Crown Height parameter 

 height is the tree's height in meters 

 b is the Crown Height Exponent parameter 

The "Chapman-Richards" crown depth and radius 

relationships 

The Chapman-Richards equation for calculating crown radius is:  

rad = i + a (1 - e 
-b * DBH

) 
c
  

where  

 rad is the crown radius, in meters 

 DBH is the tree's DBH, in cm 

 i is the Chapman-Richards Crown Radius Intercept parameter, which represents the 

crown radius of the smallest possible sapling 

 a is the Chapman-Richards Asymptotic Crown Radius parameter 

 b is the Chapman-Richards Crown Radius Shape 1 (b) parameter 

 c is the Chapman-Richards Crown Radius Shape 2 (c) parameter 

The Chapman-Richards equation for calculating crown depth is:  

ch = i + a (1 - e 
-b * H

) 
c
  

where  

 ch is the distance from the top to the bottom of the crown cylinder, in meters 

 H is the tree's height, in m 

 i is the Chapman-Richards Crown Height Intercept parameter, which represents the 

crown depth of the smallest possible sapling 

 a is the Chapman-Richards Asymptotic Crown Height parameter 

 b is the Chapman-Richards Crown Height Shape 1 (b) parameter 

 c is the Chapman-Richards Crown Height Shape 2 (c) parameter 

The non-spatial density dependent crown depth and radius 

relationships 

The density dependent equations for crown radius and crown depth use non-spatial measures of 

density to influence crown radius and crown depth. Density is measured across the plot as a 

whole, not locally (thus "non-spatial").  



In addition to the use of density variables, the density dependent equations for crown width uses 

an estimate of crown depth as a dependent variable (and vice versa). This estimated value of 

crown width and crown depth (radi and chi) used in the density dependent equations come from 

the instrumental variable equations. Calculating the instrumental variables equations avoids 

"uncoupling" the crown radius - crown depth relationship.  

The non-spatial exponential density dependent crown radius function is:  

rad = D1 * DBH 
a
 * Height 

b
 * chi 

c
 * STPH 

d
 * BAPH 

e
 * BAL 

f
 

where:  

 rad is the crown radius, in meters 

 D1 is the Non-Spatial Exp. Density Dep. Crown Radius "D1" parameter 

 a is the Non-Spatial Exp. Density Dep. Crown Radius "a" parameter 

 b is the Non-Spatial Exp. Density Dep. Crown Radius "b" parameter 

 c is the Non-Spatial Exp. Density Dep. Crown Radius "c" parameter 

 d is the Non-Spatial Exp. Density Dep. Crown Radius "d" parameter 

 e is the Non-Spatial Exp. Density Dep. Crown Radius "e" parameter 

 f is the Non-Spatial Exp. Density Dep. Crown Radius "f" parameter 

 DBH is the tree's DBH, in cm 

 Height is the tree height, in meters 

 chi is the instrumental crown depth of the target tree, in meters, calculated using the 

function below 

 STPH is number of stems per hectare of adult trees within the entire plot 

 BAPH is the basal area, in m
2
 per hectare, of adult trees within the entire plot 

 BAL is the sum of the basal area of all trees taller than the height of the target tree, in m
2
 

per hectare 

The instrumental equation for calculating chi is as follows:  

chi = a + b * DBH + c * Height + d * DBH 
2
 + e * Height 

2
 + f / DBH + g * STPH + h * BAPH 

+ i * BAL + j * (Height / DBH) 

where:  

 a is the Non-Spatial Density Dep. Inst. Crown Height "a" parameter 

 b is the Non-Spatial Density Dep. Inst. Crown Height "b" parameter 

 c is the Non-Spatial Density Dep. Inst. Crown Height "c" parameter 

 d is the Non-Spatial Density Dep. Inst. Crown Height "d" parameter 

 e is the Non-Spatial Density Dep. Inst. Crown Height "e" parameter 

 f is the Non-Spatial Density Dep. Inst. Crown Height "f" parameter 

 g is the Non-Spatial Density Dep. Inst. Crown Height "g" parameter 

 h is the Non-Spatial Density Dep. Inst. Crown Height "h" parameter 

 i is the Non-Spatial Density Dep. Inst. Crown Height "i" parameter 

 j is the Non-Spatial Density Dep. Inst. Crown Height "j" parameter 



 DBH is the tree's DBH, in cm 

 Height is the tree height, in meters 

 STPH is number of stems per hectare of adult trees within the entire plot 

 BAPH is the basal area, in m
2
 per hectare, of adult trees within the entire plot 

 BAL is the sum of the basal area of all trees taller than the height of the target tree, in m
2
 

per hectare 

The non-spatial logistic density dependent crown depth function is:  

 

where:  

 ch is the crown depth, in meters 

 height is the tree's height, in m 

 a is the Non-Spatial Log. Density Dep. Crown Height "a" parameter 

 b is the Non-Spatial Log. Density Dep. Crown Height "b" parameter 

 c is the Non-Spatial Log. Density Dep. Crown Height "c" parameter 

 d is the Non-Spatial Log. Density Dep. Crown Height "d" parameter 

 e is the Non-Spatial Log. Density Dep. Crown Height "e" parameter 

 f is the Non-Spatial Log. Density Dep. Crown Height "f" parameter 

 g is the Non-Spatial Log. Density Dep. Crown Height "g" parameter 

 DBH is the tree's DBH, in cm 

 radi is the instrumental crown radius of the target tree, in meters, calculated using the 

function below 

 STPH is number of stems per hectare of adult trees within the entire plot 

 BAPH is the basal area, in m
2
 per hectare, of adult trees within the entire plot 

 BAL is the sum of the basal area of all trees taller than the height of the target tree, in m
2
 

per hectare 

The instrumental equation for calculating radi is as follows:  

radi = a + b * DBH + c * Height + d * DBH 
2
 + e * Height 

2
 + f / DBH + g * STPH + h * 

BAPH + i * BAL + j * (Height / DBH) 

where:  

 a is the Non-Spatial Density Dep. Inst. Crown Radius "a" parameter 

 b is the Non-Spatial Density Dep. Inst. Crown Radius "b" parameter 

 c is the Non-Spatial Density Dep. Inst. Crown Radius "c" parameter 

 d is the Non-Spatial Density Dep. Inst. Crown Radius "d" parameter 

 e is the Non-Spatial Density Dep. Inst. Crown Radius "e" parameter 

 f is the Non-Spatial Density Dep. Inst. Crown Radius "f" parameter 

 g is the Non-Spatial Density Dep. Inst. Crown Radius "g" parameter 



 h is the Non-Spatial Density Dep. Inst. Crown Radius "h" parameter 

 i is the Non-Spatial Density Dep. Inst. Crown Radius "i" parameter 

 j is the Non-Spatial Density Dep. Inst. Crown Radius "j" parameter 

 DBH is the DBH of the tree, in cm  

 Height is the tree height, in meters  

 STPH is number of stems per hectare of adult trees within the entire plot 

 BAPH is the basal area, in m
2
 per hectare, of adult trees within the entire plot 

 BAL is the sum of the basal area of all trees taller than the height of the target tree, in m
2
 

per hectare 

The NCI crown depth and radius relationships 

This calculates crown dimensions as a function of tree size and local crowding. The equations 

are the same for crown depth and crown radius, but they each have separate parameters.  

The crown dimensions are calculated as:  

CR / CD = [Max CR / Max CD] * Size Effect * Crowding Effect 

where:  

 CR is the crown radius, in m 

 CD is the crown depth, in m 

 Max CR is the NCI Crown Radius - Max Potential Radius (m) parameter 

 Max CD is the NCI Crown Depth - Max Potential Depth (m) parameter 

Size Effect is calculated as:  

SE = 1 - exp(-d * DBH) 

where: 

 SE is the size effect, between 0 and 1 

 d is either the NCI Crown Depth - Size Effect "d" parameter or the NCI Crown 

Radius - Size Effect "d" parameter 

 DBH is the tree's DBH, in cm 

Crowding Effect is calculated as:  

CE = exp(-n * NCI) 

where: 

 CE is the crowding effect, between 0 and 1 

 n is the NCI Crown Radius - Crowding Effect "n" parameter or the NCI Crown 

Depth - Crowding Effect "n" parameter 



 NCI is calculated as below 

NCI is calculated as: 

 

where: 

 the calculation sums over j = 1...S species and k = 1...N neighbors of each species of at 

least a DBH of NCI Crown Radius - Minimum Neighbor DBH or NCI Crown Depth 

Minimum Neighbor DBH, in cm, out to a distance of NCI Crown Radius - Max 

Search Distance for Neighbors (m) or NCI Crown Radius - Max Search Distance for 

Neighbors (m) 
 α is the NCI Crown Radius - Alpha parameter or the NCI Crown Depth - Alpha 

parameter  

 β is the NCI Crown Radius - Beta parameter or the NCI Crown Depth - Beta 

parameter  

 γ is the NCI Crown Radius - Gamma parameter or the NCI Crown Depth - Gamma 

parameter  

 ιik is the NCI Crown Radius Lambda for Species X Neighbors parameter or the NCI 

Crown Depth Lambda for Species X Neighbors for the target species relative to the kth 

neighbor's species 

 DBHjk is the DBH of the kth neighbor, in cm 

 DBHt is the DBH of the target tree for which to calculate crown dimensions, in cm 

 distanceik is distance from target to neighbor, in m 

DBH - diameter at 10 cm relationship 

Seedlings use the diameter at 10 cm as their primary indicator of size, and have no DBH. 

Saplings use both DBH and diam10. The use of both measurements by saplings helps to maintain 

continuity between the seedling and adult life history stages. Adults use only DBH.  

DBH and diam10 are related as follows:  

DBH = (diam10 * R) + I 

where  

 DBH is the DBH in cm 

 diam10 is the diameter at 10 cm height, in cm 

 R is the Slope of DBH to Diameter at 10 cm Relationship parameter 

 I is the Intercept of DBH to Diameter at 10 cm Relationship parameter 



The "standard" diameter-height relationships 

"Standard" is one of the names used to describe a set of allometric functions relating height to 

diameter. There is one for adults and saplings, and one for seedlings. These are called "standard" 

because they were the original SORTIE functions and until recently were the only choices.  

The standard sapling and adult DBH - height function is:  

height = 1.35 + (H1 - 1.35)(1 - e
-B*DBH

) 

where:  

 height is tree height in meters 

 H1 is the Maximum Tree Height, in m parameter 

 B is the Slope of Asymptotic Height parameter 

 DBH is tree DBH in cm 

In some articles, B (Slope of Asymptotic Height) is a published parameter. Other articles 

instead use H1 and another parameter, H2, which was called the DBH to height relationship. In 

this case, B can be calculated from published values as B = H2/H1.  

The standard seedling diam10 - height function is:  

height = 0.1 + 30*(1 - e
(-α * diam

10
)
) 

where:  

 height is tree height in meters 

 α is the Slope of Height-Diameter at 10 cm Relationship parameter 

 diam10 is tree diameter at 10 cm height, in cm 

The "linear" diameter-height relationship 

The linear diameter-height relationship is the same for all life history stages, but each stage can 

use a different set of parameter values.  

The linear diam - height function is:  

height = a + b * diam 

where:  

 height is tree height, in m 

 a is the appropriate linear intercept parameter (either Adult Linear Function Intercept, 

Sapling Linear Function Intercept, or Seedling Linear Function Intercept) 



 b is the appropriate linear slope parameter (either Adult Linear Function Slope, Sapling 

Linear Function Slope, or Seedling Linear Function Slope) 

 diam is DBH (in cm) for saplings and adults, or diam10 (in cm) for seedlings 

The "reverse linear" diameter-height relationship 

The reverse linear diameter-height relationship is the same for all life history stages, but each 

stage can use a different set of parameter values. The name comes from the fact that it is almost 

the same as the linear function, but with height and diameter switched. In other words, in the 

linear function, height is a linear function of diameter. In the reverse linear function, diameter is 

a linear function of height.  

The reverse linear diam - height function is:  

height = (diam - a) / b 

where:  

 height is tree height, in m 

 a is the appropriate reverse linear intercept parameter (either Adult Reverse Linear 

Function Intercept, Sapling Reverse Linear Function Intercept, or Seedling Reverse 

Linear Function Intercept) 

 b is the appropriate reverse linear slope parameter (either Adult Reverse Linear 

Function Slope, Sapling Reverse Linear Function Slope, or Seedling Reverse Linear 

Function Slope) 

 diam is DBH (in cm) for saplings and adults, or diam10 (in cm) for seedlings 

The "power" diameter-height relationship 

The power diameter-height relationship relates height and diameter with a power function. Since 

it uses diameter at 10 cm, NOT DBH, it is active for saplings only.  

The power diam - height function is:  

height = a * d10 
b
 

where:  

 height is tree height, in m 

 a is the Power Function "a" parameter 

 b is the Power Function Exponent "b" parameter 

 d10 is diameter at 10 cm (in cm) 
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Tree data member list 

This is a list of the possible data that a tree can have. You can save this data in a detailed output 

file by using the Setup tree save options window.  

Data that is always present 

Some data are fundamental to a tree and are always available for saving. They are:  

 X. The coordinate of the tree, in meters, on the X axis in the SORTIE plot. 

 Y. The coordinate of the tree, in meters, on the Y axis in the SORTIE plot. 

 DBH. The diameter at breast height of a tree, in cm. This does not apply to seedlings. 

 Diameter at 10 cm (diam10). The tree's diameter at 10 cm height, in cm. This applies 

only to seedlings and saplings. 

 Height. The tree's height in meters. 

 Crown Radius. The tree's crown radius in meters. Note that this value is updated only on 

an as-needed basis. This means that the value may show up as -1, meaning that the tree's 

crown radius was not requested this time step. Also, this value will almost certainly 

reflect the tree's size at the beginning of the timestep, when crown dimension calculations 

are made, rather than the end of the timestep, as with the other tree dimensions. This does 

not apply to seedlings. 

 Crown Depth. The tree's crown depth in meters. The same warning applies as with 

crown radius. This does not apply to seedlings. 

 Age. The time since death, in years. Only for snags. 

Behavior-specific data 

Certain sets of behaviors require additional information about a tree. One of the ways in which 

behaviors communicate with one another is by defining new pieces of data for trees and then 

setting and reading values for those data. A piece of data created by a behavior is only attached 

to those tree species and tree types to which the behavior is applied.  

The name in parentheses is the name SORTIE uses.  

 Light level (Light). Light level for the tree. This could be GLI, or percent shade (if Sail 

Light is used). This is created by any of the light behaviors except the Beer's Law light 

filter. 

 Diameter growth (Growth). Amount of diameter growth per year in mm. This is created 

by any of the growth behaviors that increment diameter growth. 

 Light filter respite counter (lf_count). Created by the Beer's law light filter behavior. It 

contains the years of respite for a new seedling from the effects of the light filter. 

 Rooting height (z). The height, in mm, above ground level at which a seedling is rooted. 

Created by the Beer's law light filter behavior. 

 Years released (ylr). The length of the current release period, in years. Created by the 

absolute growth behaviors. 



 Years suppressed (yls). The length of the current suppression period, in years. Created 

by the absolute growth behaviors. 

 Dead flag (dead). An integer flag for whether a tree has died. 0 = not dead. Created by 

any of the mortality behaviors. This is used by the dead tree remover behavior to find the 

trees it should remove. 

 Storm Damage Value (stm_dmg). An integer value with the damage level of a storm 

and how long it has been damaged. A value of 0 means no damage; a value starting with 

1 means medium damage; a value starting with 2 means complete damage. The digits at 

the end count how many years since the damaging event. For example, a value of 1005 is 

a tree that received medium damage 5 years ago. Created by the Storm damage applier 

behavior. 

 Tree Bole Volume (Bole Vol). The volume of a tree, in cubic feet. Created by the Tree 

bole volume calculator behavior. 

 Tree Volume (Volume). Volume of the tree, in cubic meters. Created by the Tree 

volume calculator behavior. 

 Tree Biomass (Biomass). Biomass of the tree, in metric tons (Mg). Created by the 

Dimension analysis behavior. 

 Tree Age (Tree Age). Age of the tree, in years. Created by the Tree age behavior. 

 Snag Decay Class (SnagDecayClass). Snag decay class. Created by the Snag Decay 

Class Dynamics behavior. 

 New Break Height (NewBreakHeight). Snag break height, if the break occurred this 

timestep. -1 if the snag is unbroken. Created by the Snag Decay Class Dynamics 

behavior. 

 Snag Old Break Height (SnagOldBreakHeight). Snag break height, if the break 

occurred in a previous timestep. -1 if the snag is unbroken.Created by the Snag Decay 

Class Dynamics behavior. 

 Fall (Fall). Whether a tree that has died this timestep has fallen (true), or remains 

standing as a snag (false). Created by the Snag Decay Class Dynamics behavior. 

 Pre-harvest growth (PreHarvGr). Growth prior to the last harvest. Created by the 

Lagged post harvest growth behaviors. 

 Crown Radius (Crown_Radius). A tree's crown radius in meters. Created by the Crown 

Radius Reporter behavior. Deprecated.  
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Behaviors 

In this document:  

Defining the scope of a behavior's actions  

Behavior order and dependencies  

Behavior data  

Links to individual behavior documentation  



Behaviors perform all the action when a simulation is running. Each behavior represents a step in 

the overall simulation. It retrieves data, manipulates it, and stores the result. Usually, a behavior 

roughly corresponds to a biological process, such as tree growth. When you define a simulation, 

the most important step is to choose which behaviors will run, to what data they will apply, and 

in what order they will run.  

Defining the scope of a behavior's actions 

Behaviors act on data to achieve a result. The data in the model is trees and grids. For those 

behaviors that act on trees, you must tell them what trees to act on. For instance, if you had a 

behavior which applied a Michaelis-Menton growth function to trees, you may tell it to act on 

saplings of species 1, 2, and 3; adults of those species may have a different growth behavior 

applied to them. The individual behavior documentation tells you how each behavior can be 

applied.  

Behaviors often have some rules about how they can be applied, but these tend to be limited in 

the interests of maximum flexibility. The model doesn't try to second-guess what you are doing 

or warn you against things that don't make sense. Therefore, it is important to carefully check the 

behavior setup yourself before starting a run. Common mistakes include applying two different 

behaviors of the same type to the same set of trees, and failing to provide a complete set of 

behaviors to a particular type of tree. These types of situations make "computer" sense, and a 

simulation can be run when they occur. However, they do not make scientific sense and 

unexpected results may occur.  

To choose which behaviors to include in the run and how to apply them, use the Model flow 

window.  

Behavior order and dependencies 

The parameter file specifies which behaviors to include in the simulation, and in which order 

they should be run. Theoretically it is possible to put behaviors in any order, but of course, most 

simulations constructed that way would not make sense. When you structure a run, the behaviors 

are placed in functional groups. To prevent nonsensical simulations, you cannot move a behavior 

outside of its functional group in the overall run order; however, you can re-order behaviors 

within the functional groups. Sometimes this will have an effect on the overall simulation 

outcome, and sometimes it won't. Refer to the documentation for individual behaviors to learn 

how run order might affect a behavior.  

Behaviors work on data in sequence. Some behaviors require that a specific step has been taken 

before they can do their job. This means that, in order to use some behaviors, you must also use 

certain other behaviors. The individual behavior documentation will tell you about its 

requirements.  

To change the order in which behaviors act, use the Model flow window.  

Behavior data 



Behaviors help define trees and grids based on the work they need to do. They will create a grid 

if they need one, or they may attach a new piece of data to the trees to which they are applied. 

Other behaviors rely on the presence of the grids and tree data members in order to read the 

results of previous behaviors and make their own calculations. For specifics on these data and 

what behaviors create them, see the list of grids that can be created and list of tree data members 

that can be added. To view this data, save a detailed output file.  

Usually, a behavior also needs settings and inputs from you to do its job. This data is included in 

the parameter file. To edit settings for behaviors, use the Parameters window. If a behavior does 

not have all of the data it requires, you will receive an error message.  

Links to individual behavior documentation 
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Disturbance behaviors 

Disturbance behaviors simulate different kinds of forest disruption. These behaviors cause tree 

damage and death due to a variety of processes.  

In this document:  

Disturbance parameters  

Competition Harvest  

Harvest  

Harvest interface  

Planned episodic mortality  

Random browse  

Storm disturbance  

Storm damage applier  

Storm damage killer  

Storm direct killer  



Selection harvest  

Windstorm  

Disturbance parameters 

Note: the Harvest and Planned episodic mortality behaviors do not have their parameters entered 

through the Parameters Window. Set up these behaviors using the Edit Episodic Events Window.  

 Competition Harvest: Amount of Harvest Per Species (0 - 1) Trees to harvest can be 

treated as a common pool where species identity is not a factor in selecting trees for 

harvest. In this case, all values should be set to 1.0. Otherwise, species can be harvested 

at a fixed proportion. In this case, set the proportion to harvest for each species as a value 

between 0 and 1, with all values adding up to 1. Used by the Competition Harvest 

behavior. 

 Competition Harvest: Amount to Harvest Amount to harvest, depending on the harvest 

type. If this is a fixed interval harvest (the value in Competition Harvest: Harvest Type 

is set to "Fixed Interval"), this is the basal area of the plot after harvesting, in m
2
/ha; if 

this is a fixed basal area threshold harvest with a fixed amount to cut ("Fixed BA Amt"), 

this is the amount of basal area to cut, in m
2
/ha; if this is a fixed basal area threshold 

harvest with proportion of total to cut ("Fixed BA %"), this is the proportion of the total 

plot's basal area to cut between 0 and 1. Used by the Competition Harvest behavior. 

 Competition Harvest: C The slope of the curve "C" of the competitive effect of a target 

on a neighbor of each species. Used by the Competition Harvest behavior. 

 Competition Harvest: D The steepness of the curve "D" of the competitive effect of a 

target on a neighbor of each species. Used by the Competition Harvest behavior. 

 Competition Harvest: DBH Effect of Targets (alpha) Exponent controlling the effect 

of a target's DBH on neighbors. Used by the Competition Harvest behavior. 

 Competition Harvest: Distance Effect of Targets (beta) Exponent controlling the 

effect of distance between target and neighbors. Used by the Competition Harvest 

behavior. 

 Competition Harvest: Filename for List of Harvested Trees Optional. If there is a 

value in this field, the Competition Harvest behavior will write a tab-delimited text file of 

this name with all the trees cut during the run. In batch runs this will get overwritten and 

only contain the last run's list. Used by the Competition Harvest behavior. 

 Competition Harvest: Fixed BA Harvest Threshold (m2/ha) For fixed basal area 

threshold harvests (the value in Competition Harvest: Harvest Type is set to either 

"Fixed BA %" or "Fixed BA Amt"), this is the amount of basal area that the plot must 

have before a harvest occurs. This value is ignored if the harvest type is "Fixed Interval". 

Used by the Competition Harvest behavior. 

 Competition Harvest: Fixed Interval Harvest Interval (yr) For fixed basal area 

threshold harvests (the value in Competition Harvest: Harvest Type is set to "Fixed 

Interval"), this is the number of years between harvests. This value is ignored if the 

harvest type is "Fixed BA %" or "Fixed BA Amt". Used by the Competition Harvest 

behavior. 

 Competition Harvest: Harvest Type The type of harvest to perform. "Fixed BA %" 

means that there is a harvest every time the plot reaches a fixed basal area threshold, and 



the amount cut is a proportion of the total basal area; "Fixed BA Amt" means that there is 

a harvest every time the plot reaches a fixed basal area threshold, and the amount to cut is 

a fixed amount of basal area; "Fixed Interval" means that there is a harvest every X years, 

with the plot being harvested until it is cut back to a certain amount of basal area. Used 

by the Competition Harvest behavior. 

 Competition Harvest: Minimum DBH to Harvest The minimum DBH, in cm, of trees 

that can be harvested. Used by the Competition Harvest behavior. 

 Competition Harvest: Min Years Between Fixed BA Harvests For fixed basal area 

threshold harvests (the value in Competition Harvest: Harvest Type is set to either 

"Fixed BA %" or "Fixed BA Amt"), this is the minimum number of years that must pass 

between harvests, even if the plot basal area is over the harvesting threshold. This value 

is ignored if the harvest type is "Fixed Interval". Used by the Competition Harvest 

behavior. 

 Competition Harvest: Maximum DBH to Harvest The maximum DBH, in cm, of trees 

that can be harvested. Used by the Competition Harvest behavior. 

 Competition Harvest: Max Radius of Competitive Effects (m)The maximum radius in 

meters at which a target tree of that species competitively affects other trees. Used by the 

Competition Harvest behavior. 

 Competition Harvest: Species i Target Lambda The competitive effect of targets of 

Species i on neighbors of every other species. Used by the Competition Harvest behavior. 

 Competition Harvest: Size Sensitivity (gamma) The effect of a neighbor tree's size on 

its sensitivity to competition. Used by the Competition Harvest behavior. 

 Competition Harvest: Target DBH Divisor The value by which target DBHs are 

divided when calculating competitive effects. This can be used to make units 

adjustments. Used by the Competition Harvest behavior. 

 Minimum DBH for Storm Damage, in cm The minimum DBH for trees that can be 

damaged or killed by storms. Trees smaller than this are never damaged no matter what 

storms occur. Used by the Storm damage applier and Storm damage killer behaviors. 

 Number of Years Damaged Trees Take to Heal The number of years it takes a 

damaged tree to heal. After this time it is considered undamaged. Used by the Storm 

damage applier behavior. 

 Number of Years Storm-Damaged Snags Last The number of years snags damaged in 

storms last before disappearing. If snags are not used in a run, this is not required. Used 

by the Storm damage killer behavior. 

 Plot Storm Susceptibility Pattern How storm damage susceptibility varies across the 

plot. If "Uniform", then all locations in the plot have an equal susceptibility. If "Mapped", 

then a map is used to show the way locations in the plot vary in susceptibility. Used by 

the Storm disturbance behavior. 

 Random Browse - Annual Browse Probability (0-1) The annual probability, from 0 to 

1, of being browsed. This is the mean probability if the probability is being varied each 

timestep. Used by the Random Browse behavior. 

 Random Browse - Probability PDF The PDF used to vary the browse probability. 

"None" means the same probability is always used. "Normal" means that each timestep, 

for each species, a new probability is drawn from a normal distribution. Used by the 

Random Browse behavior. 



 Random Browse - Browse Probability Standard Deviation If the probability is being 

varied each timestep according to a normal distribution, this is the standard deviation of 

that distribution. This value is ignored if the probability is not being varied. Used by the 

Random Browse behavior. 

 Return Interval for Severity Storm Class 0 - 0.1 The return interval, in years, of storms 

of severity 0 - 0.1. Set this to 0 to turn off storms of this severity. Used by the Storm 

disturbance behavior. 

 Return Interval for Severity Storm Class 0.1 - 0.2 The return interval, in years, of 

storms of severity 0.1 - 0.2. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.2 - 0.3 The return interval, in years, of 

storms of severity 0.2 - 0.3. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.3 - 0.4 The return interval, in years, of 

storms of severity 0.3 - 0.4. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.4 - 0.5 The return interval, in years, of 

storms of severity 0.4 - 0.5. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.5 - 0.6 The return interval, in years, of 

storms of severity 0.5 - 0.6. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.6 - 0.7 The return interval, in years, of 

storms of severity 0.6 - 0.7. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.7 - 0.8 The return interval, in years, of 

storms of severity 0.7 - 0.8. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.8 - 0.9 The return interval, in years, of 

storms of severity 0.8 - 0.9. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Return Interval for Severity Storm Class 0.9 - 1.0 The return interval, in years, of 

storms of severity 0.9 - 1.0. Set this to 0 to turn off storms of this severity. Used by the 

Storm disturbance behavior. 

 Selection Harvest Cut Range 1 Lower DBH (cm) The lower bound of the first DBH 

cut range, in cm. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 1 Upper DBH (cm) The upper bound of the first DBH cut 

range, in cm. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 1 Target Basal Area (m2/ha) The target basal area, in 

square meters per hectare, of the first cut range. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 2 Lower DBH (cm) The lower bound of the second DBH 

cut range, in cm. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 2 Upper DBH (cm) The upper bound of the second DBH 

cut range, in cm. Used by the Selection harvest behavior. 



 Selection Harvest Cut Range 2 Target Basal Area (m2/ha) The target basal area, in 

square meters per hectare, of the second cut range. Used by the Selection harvest 

behavior. 

 Selection Harvest Cut Range 3 Lower DBH (cm) The lower bound of the third DBH 

cut range, in cm. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 3 Upper DBH (cm) The upper bound of the third DBH 

cut range, in cm. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 3 Target Basal Area (m2/ha) The target basal area, in 

square meters per hectare, of the third cut range. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 4 Lower DBH (cm) The lower bound of the fourth DBH 

cut range, in cm. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 4 Upper DBH (cm) The upper bound of the fourth DBH 

cut range, in cm. Used by the Selection harvest behavior. 

 Selection Harvest Cut Range 4 Target Basal Area (m2/ha) The target basal area, in 

square meters per hectare, of the fourth cut range. Used by the Selection harvest 

behavior. 

 Selection Harvest Initial Age The initial age. Used by the Selection harvest behavior. 

 Standard Deviation (lognormal or normal) If the Storm Damage Application 

parameter is set to "Stochastic" and the Stochastic Pattern Damage Distribution is set 

to either "Normal" or "Lognormal", this is the standard deviation used when randomizing 

storm severity across the plot. This parameter is ignored if the Storm Damage 

Application parameter is not set to "Stochastic" and the Stochastic Pattern Damage 

Distribution is not set to either "Normal" or "Lognormal". Used by the Storm 

disturbance behavior. 

 Stochastic Pattern Damage Distribution If the Storm Damage Application parameter 

is set to "Stochastic", this is the probability distribution function to use for randomizing 

storm severity across the plot. This parameter is ignored if the Storm Damage 

Application parameter is not set to "Stochastic". Used by the Storm disturbance 

behavior. 

 Storm Damage Application How storm damage is applied to different locations across 

the plot. If "Deterministic", the storm's severity is applied equally to all locations. If 

"Stochastic", the storm's severity is randomized across the plot according to your chosen 

probability distribution function. Used by the Storm disturbance behavior. 

 Storm Damage Intercept (a) for Medium Damage The storm damage intercept 

parameter (a) for the equation calculating the probability of medium damage. Used by the 

Storm damage applier behavior. 

 Storm Damage Intercept (a) for Heavy Damage The storm damage intercept parameter 

(a) for the equation calculating the probability of heavy damage. Used by the Storm 

damage applier behavior. 

 Storm DBH Coefficient (d) The storm DBH coefficient (d) for the equations calculating 

the probability of damage. Used by the Storm damage applier behavior. 

 Storm Direct Killer - a The "a" value in the probability of mortality logit function. Used 

by the Storm direct killer behavior. 

 Storm Direct Killer - b The "b" value in the probability of mortality logit function. Used 

by the Storm direct killer behavior. 



 Storm Heavy Damage Survival Prob Intercept (a) The "a" value in the probability of 

survival logit function for trees with heavy damage. Used by the Storm damage killer 

behavior. 

 Storm Heavy Damage Survival Prob DBH Coeff. (b) The "b" value in the probability 

of survival logit function for trees with heavy damage. Used by the Storm damage killer 

behavior. 

 Storm Intensity Coefficient (b) The storm intensity coefficient (b) for the equations 

calculating probability of damage. Used by the Storm damage applier behavior. 

 Storm Medium Damage Survival Prob Intercept (a) The "a" value in the probability 

of survival logit function for trees with medium damage. Used by the Storm damage 

killer behavior. 

 Storm Medium Damage Survival Prob DBH Coeff. (b) The "b" value in the 

probability of survival logit function for trees with medium damage. Used by the Storm 

damage killer behavior. 

 Storm - Prop. Heavy Damage Dead Trees that Tip Up The proportion of those heavily 

damaged trees that are killed in the storm that tip up, as a value between 0 and 1. For how 

a tipped-up tree is treated, see the behavior description. Used by the Storm damage killer 

behavior. 

 Storm - Storm Cyclicity Sine Curve d Parameter that controls the cyclicity of storm 

frequency. For no cyclicity, set this value to 0. This value is part of the sine curve term 

and controls the sine amplitude. Used by the Storm disturbance behavior. 

 Storm - Storm Cyclicity Sine Curve f Parameter that controls the cyclicity of storm 

frequency. This value is part of the sine curve term and controls the sine frequency. Used 

by the Storm disturbance behavior. 

 Storm - Storm Cyclicity Sine Curve g Parameter that controls the cyclicity of storm 

frequency. This value is part of the sine curve term and controls where on the sine curve 

storms start occurring. Used by the Storm disturbance behavior. 

 Storm - Storm Cyclicity Trend Function Intercept (i) Parameter that controls the trend 

of cyclicity of storm frequency. This value is part of the trend term and is the intercept of 

the function controlling the increase or decrease of overall frequency cycling. For no 

cyclicity at all, set this term to 1. For no trend in cyclicity, set this term to 0. Used by the 

Storm disturbance behavior. 

 Storm - Storm Cyclicity Trend Function Slope (m) Parameter that controls the trend of 

cyclicity of storm frequency. This value is part of the trend term and is the slope at which 

frequency cycling increases or decreases. For no cyclicity, or no trend in cyclicity, set 

this term to 0. Used by the Storm disturbance behavior. 

 Windstorm - DBH Exponent (b) The "b" value in the equation used to determine the 

mortality of an individual tree as a result of a storm. Used by the Windstorm behavior. 

 Windstorm - Minimum DBH for Windstorm Mortality The minimum DBH for trees 

to be killed in storm events. Used by the Windstorm behavior. 

 Windstorm - Mortality Intercept (a) The "a" value in the equation used to determine 

the mortality of an individual tree as a result of a storm. Used by the Windstorm 

behavior. 

 Windstorm - Sea Surface Temperature Cyclicity Period (Years) Parameter that 

controls the cyclicity of storm frequency. This value cannot be 0. Used by the Windstorm 

behavior. 



 Windstorm - Severity for 1 Year Return Interval Storm The severity of storms with a 

1 year return interval, as a value between 0 (no mortality) and 1 (complete devastation). 

Used by the Windstorm behavior. 

 Windstorm - Severity for 5 Year Return Interval Storm The severity of storms with a 

5 year return interval, as a value between 0 (no mortality) and 1 (complete devastation). 

Used by the Windstorm behavior. 

 Windstorm - Severity for 10 Year Return Interval Storm The severity of storms with 

a 10 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 20 Year Return Interval Storm The severity of storms with 

a 20 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 40 Year Return Interval Storm The severity of storms with 

a 40 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 80 Year Return Interval Storm The severity of storms with 

a 80 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 160 Year Return Interval Storm The severity of storms 

with a 160 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 320 Year Return Interval Storm The severity of storms 

with a 320 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 640 Year Return Interval Storm The severity of storms 

with a 640 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 1280 Year Return Interval Storm The severity of storms 

with a 1280 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Severity for 2560 Year Return Interval Storm The severity of storms 

with a 2560 year return interval, as a value between 0 (no mortality) and 1 (complete 

devastation). Used by the Windstorm behavior. 

 Windstorm - Storm Cyclicity Sine Curve d Parameter that controls the cyclicity of 

storm frequency. For no cyclicity, set this value to 0. This value is part of the sine curve 

term and controls the sine amplitude. Used by the Windstorm behavior. 

 Windstorm - Storm Cyclicity Sine Curve f Parameter that controls the cyclicity of 

storm frequency. This value is part of the sine curve term and controls the sine frequency. 

Used by the Windstorm behavior. 

 Windstorm - Storm Cyclicity Sine Curve g Parameter that controls the cyclicity of 

storm frequency. This value is part of the sine curve term and controls where on the sine 

curve storms start occurring. Used by the Windstorm behavior. 

 Windstorm - Storm Cyclicity Trend Function Intercept (i) Parameter that controls the 

trend of cyclicity of storm frequency. This value is part of the trend term and is the 

intercept of the function controlling the increase or decrease of overall frequency cycling. 



For no cyclicity at all, set this term to 1. For no trend in cyclicity, set this term to 0. Used 

by the Windstorm behavior. 

 Windstorm - Storm Cyclicity Trend Function Slope (m) Parameter that controls the 

trend of cyclicity of storm frequency. This value is part of the trend term and is the slope 

at which frequency cycling increases or decreases. For no cyclicity, or no trend in 

cyclicity, set this term to 0. Used by the Windstorm behavior. 

 Windstorm - Storm Intensity Coefficient (c) The "c" value in the equation used to 

determine the mortality of an individual tree as a result of a storm. Used by the 

Windstorm behavior. 

 Windstorm - Timestep to Start Storms The first timestep that storms are allowed to 

occur. Used by the Windstorm behavior. 

Competition Harvest 

Competition Harvest performs harvests in a way that preferentially removes the most 

competitive individuals in a plot. It also decides when and how much to harvest based on criteria 

you give it.  

How it works 

Competition Harvest performs harvests when specific conditions are met in the plot. The amount 

harvested is also based on conditions in the plot. There are three ways to specify the timing and 

amount of harvesting. The desired method is set in the Competition Harvest: Harvest Type 

parameter. The harvest types are:  

 Fixed basal area threshold, cutting a specific amount of basal area. (Set the harvest type 

parameter to "Fixed BA Amt".) A harvest occurs whenever the plot's basal area exceeds a 

certain threshold, set in the Competition Harvest: Fixed BA Harvest Threshold 

(m2/ha) parameter. The same amount of basal area is harvested every time, set in the 

Competition Harvest: Amount to Harvest parameter. To make sure that harvests do 

not happen too frequently, set a minimum interval between harvests in the Competition 

Harvest: Min Years Between Fixed BA Harvests parameter. 

 Fixed basal area threshold, cutting a proportion of the plot basal area. (Set the harvest 

type parameter to "Fixed BA %".) This is the same as the first harvest type, except the 

amount to harvest is different. This harvest removes a set proportion of the plot's basal 

area. Set this proportion (between 0 and 1) in the Competition Harvest: Amount to 

Harvest parameter. 

 Fixed interval, cutting plots back to a basal area threshold. Harvests occur at a fixed 

interval, set in the Competition Harvest: Fixed Interval Harvest Interval (yr) 

parameter. The first timestep will have a harvest. Harvests remove trees until the plot 

reaches a specific amount of basal area, set in the Competition Harvest: Amount to 

Harvest parameter. 

Competition Harvest uses these criteria to determine when and how much to cut. Harvests occur 

over the the entire plot area.  



During a harvest, Competition Harvest calculates how much basal area it needs to cut. It can 

select trees without regard to species, or it can remove trees in a set ratio. Species ratio is set in 

the Competition Harvest: Amount of Harvest Per Species (0 - 1) parameter. If all values are 

set to 1, this means that species identity is ignored when selecting individuals for harvesting. 

Otherwise, the species are cut in the proportions entered. The values should add up to one. For 

example, if Species 1 is set to 0.25 and Species 2 is 0.75, then Competition Harvest will try to 

make 25% of the basal area removed come from Species 1 individuals and 75% come from 

Species 2. Of course, there are trade-offs between removing the most competitive individuals 

and making sure specific species targets are met.  

When selecting trees for harvesting, Competition Harvest removes the individuals that have the 

greatest competitive effects on their neighbors. The neighbors of an individual are all sapling and 

adult trees within the radius specified in the Competition Harvest: Max Radius of 

Competitive Effects (m) parameter. (Seedlings, snags, and dead trees never count as neighbors.) 

The competitive effect (COE) of tree i on the N neighbors surrounding it is:  

 

where:  

 C is the Competition Harvest: C parameter for the species of neighbor j 

 D is the Competition Harvest: D parameter for the species of neighbor j 

 α is the Competition Harvest: DBH Effect of Targets (alpha) parameter for the species 

of neighbor j 

 β is the Competition Harvest: Distance Effect of Targets (beta) parameter for the 

species of neighbor j 

 γ is the Competition Harvest: Size Sensitivity (gamma) parameter for the species of 

neighbor j 

 DBHj is the DBH, in cm, of neighbor j 

 ι is the Competition Harvest: Species i Target Lambda parameter for the species of 

neighbor j, where Species i is the target's species 

 DBHi is the DBH, in cm, of target i 

 dist is the distance between target and neighbor, in meters 

Competition Harvest removes the tree with the highest COE value in the plot, then updates the 

COE of each tree in the vicinity so that the removed tree is no longer a neighbor. This process is 

repeated until the harvest cut target has been reached. If removing a tree will cause the harvest to 

overshoot its cutting target, a random number is compared to the amount of overshoot to 

determine if the tree will be removed, then harvest ends. If species are to be cut in a certain 

proportion, then separate cut targets are maintained for each species. If the highest COE 



individual is of a species whose cut target has been reached, it is not cut and Harvest 

Competition searches for the highest COE individuals of other species.  

Only trees to which you have applied the Competition Harvest behavior are considered for 

harvesting. You can only apply the behavior to saplings and adults. You can specify a size range 

to cut using the Competition Harvest: Minimum DBH to Harvest and Competition Harvest: 

Maximum DBH to Harvest parameters.  

The Competition Harvest behavior stores how much it actually cut each timestep in the 

Competition Harvest Results grid. Additionally (and optionally), you can give the behavior a 

filename with the Competition Harvest: Filename for List of Harvested Trees parameter. If a 

filename is present, Competition Harvest will write to this file a list of the individuals harvested 

each timestep for the entire run. The file is a tab-delimited text file, with a header line, and five 

columns: X, Y, Species, DBH, and Timestep cut.  

How to apply it 

Apply this behavior to saplings and/or adults of any species.  

Behavior reference string: Competition Harvest  

Harvest 

How it works 

SORTIE can implement complex silvicultural treatments. Harvest events are defined by species, 

timestep, amount to remove, type of cut, and area of the plot. You can define as many harvest 

events as you wish. For information on planting new seedlings, see the Planting behaviors topic.  

There are three types of harvest: gap cut, partial cut, and clear cut. The primary function of 

entering the harvest type is to control substrate composition after the harvest occurs. In a partial 

cut harvest, though, you have more flexibility in choosing which trees are cut. You can define up 

to four size classes, and specify the amount of trees to remove in one of four ways: as a 

percentage of total basal area, as an absolute amount of basal area, as a percentage of total tree 

density, or as an absolute amount of tree density. Trees of any size except seedlings can be cut.  

The Harvest behavior selects the trees to remove in the same way for all three harvest types. 

When it is determining which trees to remove, it starts by finding the largest tree in the area of 

the plot affected by the harvest. It works its way through the trees from largest to smallest, 

assessing whether to cut each one until it either runs out of trees or reaches its cut target. This 

process preferentially removes the largest trees in each size range, unless the harvest is a 

percentage of density cut, in which case all trees in the target size ranges have an equal 

probability of being cut. If Harvest is cutting a percentage of basal area or an absolute amount of 

basal area, it will only cut a tree if its basal area will not cause the total to be more than the 

target. This means that, for basal-area-defined cuts, the Harvest behavior may skip some bigger 

trees and cut smaller ones in order to more exactly cut its target. Each species is cut separately. 



So, a request to remove 20% of three species will remove 20% of each of them, no matter what 

their relative proportions to each other.  

Trees that are harvested are removed immediately. When light is calculated for that timestep, 

gaps opened up by the harvest will be visible. If there are behaviors which apply to stumps, a 

stump is created for each logged tree. Otherwise, the tree completely disappears.  

The actual amount of tree harvest may not be exactly what was specified, since the Harvest 

behavior can't remove part of a tree to get the numbers right. The behavior stores how much it 

actually cut each timestep in the Harvest Results grid. To optimize the accuracy of the Harvest 

behavior, use larger cut ranges and high proportions of the plot area to make sure there is a big 

pool of trees to choose from.  

How to apply it 

To add harvesting to a SORTIE run, use the Edit Episodic Events Window.  

Behavior reference string: harvest  

Episodic Mortality 

How it works 

The Episodic Mortality behavior allows you to replicate tree-killing events with the same level of 

control you have when defining Harvest events. A planned mortality episode can simulate 

disease, an insect outbreak, fire, or the like. The main difference between Harvest and Episodic 

Mortality is that the Episodic Mortality behavior can create snags, or standing dead trees. A large 

snag proportion can significantly affect the light and substrate dynamics of a SORTIE run.  

Defining a mortality episode is like defining a partial cut harvest. (Mortality episodes have no 

automatic impact on substrate dynamics like harvest events do, although the newly dead trees 

may be a source of harvest input.) You can define up to four size classes, and specify the amount 

of trees to kill in one of four ways: as a percentage of total basal area, as an absolute amount of 

basal area, as a percentage of total tree density, or as an absolute amount of tree density. Trees of 

any size except seedlings can be cut.  

When the Episodic Mortality behavior is determining which trees to remove, it starts by finding 

the largest tree in the area of the plot affected by the mortality episode. It works its way through 

the trees from largest to smallest, assessing whether to kill each one until it either runs out of 

trees or reaches its cut target. This process preferentially removes the largest trees in each size 

range, unless the event is defined by a percentage of density, in which case all trees in the target 

size ranges have an equal probability of being killed. If Episodic Mortality is removing a 

percentage of basal area or an absolute amount of basal area, it will only kill a tree if its basal 

area will not cause the total to be more than the target. This means that, for basal-area-defined 

cuts, the behavior may skip some bigger trees and cut smaller ones in order to more exactly cut 



its target. Each species is cut separately. So, a request to remove 20% of three species will 

remove 20% of each of them, no matter what their relative proportions to each other.  

What happens to dead trees depends on the rest of the run. If there are other behaviors in the run 

that deal directly with snags or create them, then the run is "snag-aware". In this case, all adult 

trees killed are turned into snags (saplings never become snags). If the run is not "snag-aware", 

then the trees are marked as dead. When/if the dead tree remover behavior runs, the dead trees 

will be removed at that time. These dead trees are available as input to Substrate.  

The actual amount of trees killed may not be exactly what was specified, since the Episodic 

Mortality behavior can't remove part of a tree to get the numbers right. The behavior stores how 

much it actually cut each timestep in the Mortality Episode Results grid. To optimize the 

accuracy of the behavior, use larger kill ranges and high proportions of the plot area to make sure 

there is a big pool of trees to choose from.  

How to apply it 

To define planned mortality episodes, use the Edit Episodic Events Window.  

Behavior reference string: episodic mortality  

Storm disturbance 

This behavior simulates the effects of wind damage from storms. Its function is to assess whether 

or not storms have occurred in the current timestep, and if they have, how much damage they 

have caused. This behavior does not actually cause any trees to be damaged; that is the function 

of the Storm damage applier behavior.  

How it works 

There are two ways storms can occur: randomly according to a storm regime of your choosing, 

or scheduled at certain timesteps. Both methods can be used together.  

Random storms according to a storm regime 
Storm severity is assessed on a scale from 0 (no damage) to 1 (total damage). This interval of 

storm severity values is subdivided into ten storm severity classes. You assign each storm 

severity class a return interval. The reciprocal of the return interval gives the annual probability 

of each type of storm.  

The overall frequency of storms can remain constant, or it can change through time. It has been 

reported in Goldenburg et al 2001 that storm activity in the North Atlantic cycles along with sea 

surface temperature. This behavior can thus change the storm frequency over time, using either a 

sinusoidal pattern, a constant linear change, or both together. In the figure below, curve 1 is a 

basic sine wave. Curve 2 has a sinusoidal pattern plus an upwards trend.  



 

The actual probability of an individual storm that takes place in a storm regime with a cyclical 

frequency is:  

P'(Fi) = P(Fi) * ([d * sin( π * (x-g) / (2f) )] + [mx + i]) 

 

Note that the new probability is a baseline probability, P(Fi), multiplied by a value that adjusts 

the probability according to where the model is at the given time in the frequency cycle. The 

frequency cycle multiplier is itself made up of two terms added together. The first term is the 

sine curve cycling, and the second term is the overall trend upwards or downwards.  

Terms in the equation:  

 P'(Fi) is this timestep's annual probability of a storm of the ith return interval, adjusted 

according to the frequency cyclicity 

 P(Fi) is the baseline probability of a storm of the ith return interval; that is, the reciprocal 

of the values specified in the Return Interval for Severity Storm Class X parameters 

 x = 4 * t / Sr, where t is the number of years since the run started and Sr is the Storm - 

Sea Surface Temperature Cyclicity Period (Years) parameter 

 d is the Storm - Storm Cyclicity Sine Curve d parameter, which controls the sine 

curve's amplitude 

 f is the Storm - Storm Cyclicity Sine Curve f parameter, which controls the sine curve's 

frequency 

 g is the Storm - Storm Cyclicity Sine Curve g parameter, which controls where on the 

sine curve storms start occurring 

 m is the Storm - Storm Cyclicity Trend Function Slope (m) parameter 

 i is the Storm - Storm Cyclicity Trend Function Intercept (i) parameter 

To turn off all cyclicity and use constant storm probabilities, set Storm - Storm Cyclicity Sine 

Curve d to 0, Storm - Storm Cyclicity Trend Function Slope (m) to 0, and Storm - Storm 

Cyclicity Trend Function Intercept (i) to 1. (The other values are unimportant.) To use only 

the sine portion with no trend line, set both Storm - Storm Cyclicity Trend Function Slope (m) 



and Storm - Storm Cyclicity Trend Function Intercept (i) to 0. To use only the trend portion, 

set Storm - Storm Cyclicity Sine Curve d to 0.  

To decide whether storms occur, the behavior compares a random number to the annual 

probability of each storm severity class. For timesteps that are longer than one year, the behavior 

repeats the random number test for each year in the timestep. This process is repeated for each 

storm severity class separately. This means that multiple storms can occur in a single timestep, 

and if the timestep is longer than one year, there can be multiple storms in the same severity 

class.  

Scheduled storms 
You can also schedule storms to occur at certain timesteps. Use the Edit Scheduled Storms 

window to do this. You specify the year (NOT the timestep) you want the storm to occur, and a 

minimum and maximum severity for each. The actual storm severity will be a random number 

between the maximum and minimum. You can schedule as many as you want, including multiple 

storms per timestep. If there is also a storm regime present (non-zero values for the return 

intervals), those storms can also occur. The storm regime storms can also happen between 

scheduled storms.  

If a storm occurs, the behavior calculates the amount of damage that occurs. A storm's damage 

index (severity) is randomly chosen within the boundaries of its severity class. The damage is 

stored in a grid called Storm Damage. The final output of the behavior is a map of storm damage 

(severity) across the plot, as an index between 0 and 1. If multiple storms occur, each storm's 

severity is recorded separately.  

The way storm damage is calculated depends on two things: the pattern of storm susceptibility 

across the plot (entered in the Plot Storm Susceptibility Pattern parameter), and the method of 

storm damage application (entered in the Storm Damage Application parameter). Storm 

susceptibility is measured on a scale from 0 (not susceptible to damage) to > 1 (highly 

susceptible to damage). The pattern of storm susceptibility can be either "Uniform", meaning all 

locations within the plot have a susceptibility of 1, or "Mapped", meaning that you will provide a 

map with a susceptibility for each location in a grid called Storm Susceptibility. The method of 

storm damage application can be either "Deterministic", meaning that each location receives the 

storm's severity index, or "Stochastic", meaning that the storm's severity index provides a mean 

around which individual location severities are randomized.  

There are two possible probability distribution functions for stochastic damage application: 

normal and lognormal.  

The normal distribution is:  

 



where σ is the function standard deviation. Mean is zero in this equation; the final value is 

reached by adding the function result to the mean.  

The lognormal distribution is:  

 

where ζ is the function mean and σ is the standard deviation.  

Combining these two parameters provides four possibilities for the way a storm's damage is 

applied:  

1. Mapped Deterministic. The damage index for a location equals the susceptibility of that 

location multiplied by the storm's severity index. 

2. Mapped Stochastic. The storm severity for each location is determined by performing a 

random draw on a probability distribution function, with the overall storm severity 

providing the function mean. Each location's severity is multiplied by its susceptibility to 

arrive at the final storm damage index for that location. 

3. Uniform Deterministic. All plot locations are directly assigned the storm's severity index. 

4. Uniform Stochastic. The storm damage index for each location is determined by 

performing a random draw on a probability distribution function, with the overall storm 

severity providing the function mean. 

How to apply it 

Add the behavior to the behavior list for your run. A few rules:  

 If you set the Plot Storm Susceptibility Pattern parameter equal to "Mapped", you must 

provide a map of plot susceptibility values. You do this by using the Grid Value Edit 

Window to enter values 0 or greater for each cell of the grid called Storm Susceptibility. 

 If you set the Storm Damage Application parameter equal to "Stochastic", you must 

choose a probability function in the Stochastic Pattern Damage Distribution. If you 

choose "Lognormal" or "Normal", you must provide a function standard deviation in the 

Standard Deviation (lognormal or normal) parameter.  

 If you do not also enable the Storm damage applier behavior, storms may occur but 

nothing else will happen; trees won't suffer any damage as a result. You can also set all 

storm return intervals to 0 to turn off storms. 

Behavior reference string: storm  

Random browse 

This behavior simulates random browsing from herbivores.  



How it works 

The trees eligible for browsing are those trees to which this behavior is applied. Each species has 

a probability of browse that is the same for all members of that species. Each timestep, for each 

eligible tree, a random number is used against its species probability to decide whether the tree is 

browsed.  

The probability of browse for a species can be constant, or it can vary each timestep. If it is 

constant, the probability of browse is always the value in the Random Browse - Annual Browse 

Probability (0-1) parameter. If the probability is to vary, a new value is drawn from a random 

distribution, using the value in Random Browse - Annual Browse Probability (0-1) parameter 

as the mean and the value in Random Browse - Browse Probability Standard Deviation as the 

standard deviation. This draw happens once per species per timestep; all individuals of a species 

always face the same probability of browse in a given timestep.  

If the timestep length is more than one year, the annual probability of browse is turned into a 

timestep probability using TP = 1 - (1 - AP)
N
, where TP is the timestep probability of browse, 

AP is the annual probability, and N is the length of a timestep, in years.  

Trees that are chosen as browsed are marked as browsed. This behavior does nothing else to 

them. Other behaviors, such as growth and mortality, may use this information.  

How to apply it 

Apply this behavior to any species and type of tree.  

Behavior reference string: random browse  

Storm damage applier 

The purpose of this behavior is to apply storm damage to individual trees. This behavior decides 

which trees are damaged when a storm has occurred and how badly. It also keeps track of the 

time since damage for damaged trees, and after a "healing period" returns them to healthy 

(undamaged) status.  

There are three possible damage categories for a tree: no damage, medium damage, and heavy 

damage. Other behaviors can use the damage categories to determine what effects the storm 

damage had on a tree (slow growth, death, etc).  

How it works 

The behavior Storm disturbance determines whether a storm has occurred. When it does, an 

individual tree can either get no damage, medium damage, or heavy damage. The tree's 

probability of damage in a given damage category is:  



 

where:  

 i is the damage category, either medium or heavy 

 ai is the storm damage intercept for that tree's species for that damage category, either the 

Storm Damage Intercept (a) for Medium Damage parameter or the Storm Damage 

Intercept (a) for Heavy Damage parameter 

 b is the Storm Intensity Coefficient (b) parameter for that tree's species 

 c is the storm's severity at the tree's location, between 0 and 1, as calculated by the Storm 

disturbance behavior 

 d is the Storm DBH Coefficient (d) parameter for that tree's species 

This behavior uses a random number to determine what damage category a tree falls in. If the 

random number is less than the probability for medium damage, the tree is undamaged. If the 

random number is greater than the probability for medium damage but less than the probability 

for heavy damage, the tree gets medium damage. If the random number is greater than the 

probability for heavy damage, the tree gets heavy damage.  

If a tree is damaged, a counter is set for time since damage. This behavior checks this counter 

every timestep. When the amount of time specified in the Number of Years Damaged Trees 

Take to Heal has passed, the tree is considered healed and no longer has a record of storm 

damage.  

If a damaged tree is damaged again in a new storm, it gets the most severe damage category that 

can apply to it and must go through the maximum healing time again in order to become 

undamaged.  

How to apply it 

Apply this behavior to the trees that can receive storm damage. You may not apply this behavior 

to seedlings. If you wish to use the Storm damage killer behavior to create snags from storm-

killed trees, you must apply this behavior to the snag tree type. Along with this behavior, you 

must also add the Storm disturbance behavior.  

Behavior reference string: storm damage applier  

Storm damage killer 

This behavior kills trees damaged in storms. It decides which damaged trees die, and if they 

become snags, it manages the snag population by causing snag tip-up and removal. This behavior 

does not decide which trees get damaged in a storm; that is the job of the Storm damage applier 

behavior.  



How it works 

Trees that have received medium or heavy damage from the Storm damage applier behavior have 

a certain probability of survival. (Undamaged trees, and any trees with a DBH smaller than the 

values set in the Minimum DBH for Storm Damage, in cm parameter, are ignored.) The 

probability is:  

 

where:  

 p is the tree's probability of survival, between 0 and 1 

 ai is either the Storm Medium Damage Survival Prob Intercept (a) or the Storm 

Heavy Damage Survival Prob Intercept (a) parameter, depending on the tree's damage 

category 

 b is either the Storm Medium Damage Survival Prob DBH Coeff. (b) or the Storm 

Heavy Damage Survival Prob DBH Coeff. (b) parameter, depending on the tree's 

damage category 

 DBH is the tree's DBH, in cm 

Once the survival probability has been calculated, this behavior uses a random number to 

determine whether it lives or dies. Damaged trees are only at risk of dying at the time of the 

storm that damages them; if they survive it, this behavior will not try to kill them again even if 

they are still damaged. A certain proportion of heavily damaged trees that die create tip-ups. The 

probability of this is in the parameter Storm - Prop. Heavy Damage Dead Trees that Tip Up.  

If snags are used in this run, those trees that die in either damage category (except for tip-ups) 

become snags. A time-since-damage counter is set for each of these snags. After the amount of 

time specified in the Number of Years Storm-Damaged Snags Last has passed, this behavior 

will remove those snags, "killing" them. They are not available for later processes such as 

substrate. This behavior will not do anything to any snag that it did not kill. If snags are not used 

in this run, trees that die have a flag set indicating that they are dead. They are available during 

the timestep in which they die to substrate and other processes, in exactly the same manner as 

trees that die due to natural mortality. They will be subject to the same cleanup and removal 

processes as well.  

If a heavily-damaged dead tree tips up, and snags are used in the run, the tip-up becomes a snag 

that has its "dead" flag set to true. It is available during the timestep in which it dies to substrate 

and other processes, in exactly the same manner as other snags that die due to natural mortality. 

It is subject to the same cleanup and removal processes as well. If snags are not used in the run, 

then tip-ups are treated like all other storm-killed trees.  

Saplings that are killed in storms never become snags. They are killed in the manner described 

above for trees that die in a non-snag run. Existing snags are never at risk for storm damage or 



mortality, but the behavior must be applied to the snag tree type in order to cause storm-killed 

adults to become snags.  

How to apply it 

Apply this behavior to the trees that can be killed in storms. You must also apply the Storm 

damage applier behavior to the same trees. You may not apply this behavior to seedlings. If you 

wish to have storm-killed trees become snags, you must apply this behavior to the snag tree type. 

This may cause snags to appear due to natural mortality and other causes; you must use other 

behaviors to manage these snags.  

You must also have any kind of mortality behavior applied to each tree species and life history 

stage to which this behavior is applied.  

Behavior reference string: storm killer  

Storm direct killer 

This behavior kills trees based on storm severity, without an intervening damage step.  

How it works 

When storms occur, trees to which this behavior are applied have the following probability of 

mortality:  

 

where:  

 p is the tree's probability of mortality, between 0 and 1 

 a is the Storm Direct Killer - a parameter 

 b is the Storm Direct Killer - b parameter 

 D is the storm damage at the tree's location 

Once the mortality probability has been calculated, this behavior uses a random number to 

determine whether it lives or dies. If more than one storm has occurred in the current timestep, 

each storm gets a separate, independent chance to kill trees.  

Trees that die have a "dead" flag set to true and are treated in the rest of the run like trees that 

have died due to natural mortality.  

How to apply it 



Apply this behavior to the trees that can be killed in storms. You must also use the Storm 

disturbance behavior and have any kind of mortality behavior applied to each tree species and 

life history stage to which this behavior is applied.  

Behavior reference string: storm direct killer  

Selection harvest 

This behavior allow you to specify target basal areas for a tree population as a method of harvest 

input, instead of designing specific harvest events.  

How it works 

You can specify up to four DBH ranges. You provide the lower and upper DBH bounds of these 

ranges, and the target amount of basal area for each. Each timestep, this behavior calculates the 

amount of basal area in each of these ranges. If it is greater than the target, this behavior signals 

to the Harvest behavior that it should remove enough basal area to bring each range back down 

to its target basal area. Since Harvest actually does the tree removal, see that behavior's 

documentation for the method used. If the amount of basal area in any given range is less than 

the target, no trees are cut in that range.  

How to apply it 

Add this behavior to your run. Harvest is also needed in the run, and should be placed after 

Selection Harvest in the behavior order.  

Behavior reference string: SelectionHarvest  

Windstorm 

Windstorm kills trees due to storm events. It is similar to the other storm behaviors, with a few 

key differences. For those long-time users of SORTIE, this is the same as the Windstorm 

submodel in the pre-6 versions of SORTIE.  

How it works 

Using the parameters, you provide a general "shape" of storm intensity. SORTIE then decides 

which storms occur each timestep, and which trees die as a result.  

This behavior defines 11 storm return intervals: 1, 5, 10, 20, 40, 80, 160, 320, 640, 1280, and 

2560 years. Each has a set annual probability: for example, an 80-year return interval storm has 

an annual probability of 1/80, or 0.0125. For each year of each timestep, for each return interval, 

SORTIE generates a random number to decide whether a storm of that return interval will occur. 

This means that there can be multiple storms in a timestep, or no storms at all. In a multi-year 

timestep, a storm of a given return interval can happen more than once.  



You give each return interval a storm severity value, between 0 and 1. These are defined in the 

Windstorm - Severity for X Year Return Interval Storm parameters. A severity of 0 means 

no tree mortality; a severity of 1 approaches 100% mortality.  

The overall frequency of storms can remain constant, or it can change through time. It has been 

reported in Goldenburg et al 2001 that storm activity in the North Atlantic cycles along with sea 

surface temperature. This behavior can thus change the storm frequency over time, using either a 

sinusoidal pattern, a constant linear change, or both together. In the figure below, curve 1 is a 

basic sine wave. Curve 2 has a sinusoidal pattern plus an upwards trend.  

 

The actual probability of an individual storm that takes place in a storm regime with a cyclical 

frequency is:  

P'(Fi) = P(Fi) * ([d * sin( π * (x-g) / (2f) )] + [mx + i]) 

 

Note that the new probability is a baseline probability, P(Fi), multiplied by a value that adjusts 

the probability according to where the model is at the given time in the frequency cycle. The 

frequency cycle multiplier is itself made up of two terms added together. The first term is the 

sine curve cycling, and the second term is the overall trend upwards or downwards.  

Terms in the equation:  

 P'(Fi) is this timestep's annual probability of a storm of the ith return interval, adjusted 

according to the frequency cyclicity 

 P(Fi) is the baseline probability of a storm of the ith return interval; that is, the inverse of 

the values specified in the Windstorm - Severity for X Year Return Interval Storm 

parameters 

 x = 4 * t / Sr, where t is the number of years since storms started and Sr is the 

Windstorm - Sea Surface Temperature Cyclicity Period (Years) parameter 

 d is the Windstorm - Storm Cyclicity Sine Curve d parameter, which controls the sine 

curve's amplitude 



 f is the Windstorm - Storm Cyclicity Sine Curve f parameter, which controls the sine 

curve's frequency 

 g is the Windstorm - Storm Cyclicity Sine Curve g parameter, which controls where on 

the sine curve storms start occurring 

 m is the Windstorm - Storm Cyclicity Trend Function Slope (m) parameter 

 i is the Windstorm - Storm Cyclicity Trend Function Intercept (i) parameter 

To turn off all cyclicity and use constant storm probabilities, set Windstorm - Storm Cyclicity 

Sine Curve d to 0, Windstorm - Storm Cyclicity Trend Function Slope (m) to 0, and 

Windstorm - Storm Cyclicity Trend Function Intercept (i) to 1. (The other values are 

unimportant.) To use only the sine portion with no trend line, set both Windstorm - Storm 

Cyclicity Trend Function Slope (m) and Windstorm - Storm Cyclicity Trend Function 

Intercept (i) to 0. To use only the trend portion, set Windstorm - Storm Cyclicity Sine Curve 

d to 0.  

For each storm that occurs, Windstorm decides what trees will die as a result. A tree's probability 

of mortality is calculated as follows:  

 

where:  

 p is the tree's probability of mortality 

 a is the Windstorm - Mortality Intercept (a) parameter 

 c is the Windstorm - Storm Intensity Coefficient (c) parameter 

 b is the Windstorm - DBH Exponent (b) parameter 

 DBH is the tree's DBH, in cm 

 s is the storm's severity, set in the parameter for its return interval 

Below severity 0.1, the model becomes unreliable; so in that case, the severity is treated as a 

straight probability of mortality for all trees. For example, if a storm occurs of severity 0.05, all 

trees have the same 5% chance of dying. If a storm return interval's severity is set to 0, then that 

storm never occurs.  

It is possible for a storm to occur and kill no trees, especially if it is a very mild storm or the 

forest has no large trees. Unlike the other SORTIE storm behaviors, there is no damaged-but-

alive state. After a windstorm a tree is either dead or in perfect health.  

Storm events happen "independently". Every time a storm happens, all eligible trees have a 

separate chance of mortality. Of course, the storms can never truly be independent. A storm can 

only kill the trees that another storm hasn't already killed.  

Trees killed in a windstorm are treated like trees killed in natural mortality. They will form snags 

if the run uses snags, and are available for processes such as substrate.  



Seedlings and snags are never killed by storms. For adults and saplings, only those trees to which 

the Windstorms behavior has been applied will be considered for storm mortality; and of those 

trees, only those trees with a DBH larger than the value in the Windstorm - Minimum DBH for 

Windstorm Mortality parameter can be killed.  

You can delay the introduction of windstorms into the run using the Windstorm - Timestep to 

Start Storms parameter. If this value is greater than 0, no storms will occur until that timestep is 

reached.  

Information on what storms occurred during a run is saved in the Windstorm Results grid. This 

grid lists how many storms occurred each timestep, and the basal area and density killed of each 

species in that storm.  

How to apply it 

Add this behavior to your run and apply it to saplings and/or adults of any species. If you wish to 

get results on storm events, save the Windstorm Results grid data in a detailed output file. You 

can then view the contents of this grid as a table using SORTIE's data visualization system.  

Behavior reference string: Windstorm  

Harvest interface 

The harvesting interface allows SORTIE to work directly with another program. SORTIE tells 

the other program what trees are eligible for harvesting, and the other program replies with its 

choices. This lets users write code for harvesting without having to modify SORTIE itself.  

Warning - this link between SORTIE and another program is inefficient. It may be very slow 

when there are large numbers of trees. It is for convenience, not speed.  

How it works 

You set up the Harvest Interface behavior using the Edit->Harvest Interface window. Parameters 

in this documentation are defined by their names on that screen.  

You either create or find a separate program (an executable) that reads a text file of trees, makes 

decisions about which to kill, then writes those trees to kill to another text file. You tell SORTIE 

where to find this executable using Path and filename of the executable on the Edit Harvest 

Interface window.  

Each harvest timestep, SORTIE writes a text file with a list of trees eligible for harvest. The trees 

in the list are those to which the Harvest Interface behavior is applied. You choose which trees 

those are in Behavior currently assigned to on the Edit Harvest Interface window. Once the file 

is written, SORTIE then launches your executable. Your executable writes a file in response with 

the list of trees it wishes SORTIE to kill.  



Trees that are cut are treated exactly like those in SORTIE harvest. That is, they disappear 

completely and do not become snags. See the documentation on Harvest for more details. The 

cut details for each timestep are written to the Harvest Results grid. (Warning - if you put both 

the Harvest and Harvest Interface behavior in the same run, they will overwrite each other's 

results in the grid.)  

Because the process can be slow, you can set harvests to occur less often than every timestep. To 

do this, use How often to harvest, in years on the Edit Harvest Interface window.  

Optionally, you can also add new tree data members that are controlled by the executable. The 

executable can write a file with a list of trees to update, and the new values for those variables 

for each tree.  

File formats 

Each harvesting timestep, SORTIE begins by writing a file of all trees eligible for harvest. You 

give SORTIE the path and name of that file in Tree file that SORTIE will write on the Edit 

Harvest Interface window. SORTIE does not care what the filename nor file extension is. The 

file is tab-delimited text. It has the following format:  

Line 1, two columns: Current timestep, total number of timesteps 

Line 2, column names, 6+n columns: "X", "Y", "Species", "Type", "Diam", "Height", [...] 

Subsequent lines, 6+n columns, one line per tree: X, Y, species number, type number, 

DBH/diam10, height, [...].  

Species is given as a number from 0 to x - 1, where x is the number of species. The number 

counts the species in the order in which they are listed in the parameter file, which is the same as 

the order they are listed in the Tree Setup window.  

Type is given as a number as well. The type numbers are:  

1. Seedling 

2. Sapling 

3. Adult 

4. Stump 

5. Snag 

Stumps are not available for harvesting.  

The "Diam" value is diameter at 10 cm if the tree type is seedling, and DBH in all other cases. 

Both of these values are in cm.  

The "Height" value is the height of the tree in meters.  

The [...] represents additional columns that you can ask SORTIE to include. You set this up 

using the File columns section of the Edit Harvest Interface window. You can choose any other 



tree data member that applies to all of the kinds of trees to which the harvest interface is applied, 

including new ones that you add. The list of tree data members depends on the other behaviors in 

the run. The column header matches the internal SORTIE name of the data member (which is 

what is displayed to you when you choose new data members). You cannot change the first six 

default columns.  

The executable writes a file in response with the trees that it wishes to harvest (Tree harvest file 

that the executable will write on the Edit Harvest Interface window). If you have set up new 

tree data members, the executable also writes a second file with a list of live trees to update 

(Tree update file that the executable will write on the Edit Harvest Interface window). All 

trees in both of these files must come from the tree list that SORTIE wrote for that timestep. No 

tree may appear in both files.  

The file format of the user response files is identical to that of the SORTIE file, with the same 

columns in the same order.  

Each harvest timestep, all these files are overwritten.  

If there are no trees eligible for harvesting, SORTIE still writes a file with only the first two 

header lines (no individual tree lines). It expects the executable to do the same if it does not want 

trees harvested or updated.  

Adding new variables 

You can request that SORTIE create new data members under the executable's control for the 

trees to which this behavior applies. Set this up in the New tree data members to add section of 

the Edit Harvest Interface window. You can create as many as you want. You can give them any 

name up to 9 characters long. They each hold a float value. The values are uninitialized in newly 

created trees.  

If you want the new data members to be written to the file that SORTIE writes, make sure you 

put them in the list of file columns.  

If new data members have been created, SORTIE expects the executable, each time it is called, 

to write a file with the list of trees it wishes to update, and the new values for these data 

members. You can only make changes to the new data members that you create. You cannot 

change any other attribute of a tree.  

The user executable 

The user executable launches, runs, and quits once per harvest timestep. SORTIE waits for it to 

finish before resuming. This means it must do any necessary initialization and setup each harvest 

timestep.  



The executable can be written in any language, and can do anything it wishes. The only two 

requirements is that it be a standalone executable, and that it produce the file of trees to harvest 

that SORTIE expects.  

The executable should be prepared for the condition that there are no trees in the file SORTIE 

writes, and should write empty files if it doesn't want any trees harvested or updated.  

SORTIE's behavior cannot be guaranteed in the event of a crash in the user executable.  

The executable probably has its own input data for setup. If it takes arguments during launch, 

you can give SORTIE a string to pass to the executable in Arguments to pass to the executable 

on the Edit Harvest Interface window.  

SORTIE provides a convenience feature for those executables that read setup parameters from a 

file. You may wish to set up a SORTIE batch run where your executable uses different 

parameters for each run. You can give SORTIE a file of all the parameters for the entire batch in 

a text file, and for each run, it will separate out that run's parameters and write them to a file for 

your executable. The parameters for a single run must be on a single line of the entire batch file, 

and will be written to a one-line file for the individual run. Specify the entire-batch parameters 

file in Parameters file for batch run, and the single-run file in Single-run parameters file for 

batch run on the Edit Harvest Interface window.  

For example, suppose there is an executable that takes three parameters. It reads these parameters 

from a one-line file named "par.txt", like this:  

par1 par2 par3 

You can set up a batch of three runs, then set up all the parameters in a single file, like this:  

par1_1 par2_1 par3_1 

par1_2 par2_2 par3_2 

par1_3 par2_3 par3_3 

You give SORTIE this file, and tell it to write "par.txt" for each run. The first run in the batch, 

SORTIE will write the first line to "par.txt"; the second run in the batch, it will write the second 

line to "par.txt", etc.  

Tips: 

If you are having trouble with SORTIE not finding your code's output file, try explicitly writing 

out directories in your code (i.e. "C:\sortie\file.txt" instead of just "file.txt").  

How to apply it 



It is easiest if you add the harvest interface after the rest of your parameter file is complete, so 

that you have full access to data members. Open Edit->Harvest Interface and complete the setup. 

This adds the harvest interface behavior to your run. To remove it, use the Model flow window.  

Behavior reference string: Harvest Interface  
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Light behaviors 

In this document:  

Snags in light calculations  

Light parameters  

Average Light behavior  

Basal Area Light behavior  

Beer's law light filter behavior  

Constant GLI behavior  

Gap Light behavior  

GLI light behavior  

GLI Map Creator behavior  

GLI Points File Creator behavior  

Quadrat-based GLI light behavior  

Sail light behavior  

Storm Light behavior  

Light is the key resource for trees in the SORTIE model. A tree's growth, and therefore its 

probability of mortality and reproductive ability, is a function of the amount of light it receives. 

Consequently, great care is taken in SORTIE to calculate the amount of light that each tree gets - 

in fact, these calculations take up more processing time than any other during model runs.  

There are two basic light index types used by SORTIE to describe the amount of light a tree 

receives. The first is the Global Light Index, or GLI. GLI is the percentage of full sun received at 

a point. The second index is the Sail Light index, which is the proportion of shade seen at a 

point, from none to total. (The name Sail Light comes from the fact that the shape of shading 

neighbor tree crowns is approximated by a 2D rectangle, like a sail).  

How light calculations work 

In order to calculate the amount of light a tree gets, SORTIE simulates taking a fisheye 

photograph over each tree to determine which parts of the sky are blocked by taller trees nearby. 

SORTIE determines how much light comes from different parts of the sky and takes this into 

account, so shading neighbors in different directions will have different impacts on the total 

amount of light a tree gets.  



The fisheye photo can be taken at one of two positions - either at the top of the crown or at mid-

crown. The major difference between the two is that when the photograph is taken at mid-crown, 

trees near the same height as the target tree will be included in the shading effects. This can 

make a big difference in even-age stands.  

Sky Simulation 

At the beginning of a run, if light behaviors are being used, the amount of light coming from 

each part of the sky for the plot's location is calculated. The sun's position in the sky is tracked 

throughout the growing season. Diffuse radiation, assumed to be isotropic (coming equally from 

all directions), is then added to the direct beam radiation. Below the minimum solar angle, it is 

assumed that no light comes from those portions of the sky because of the density of the 

surrounding forest. (It is wise not to set this angle too low - otherwise SORTIE must look very 

far away for shading neighbors.)  

To determine the amount of sun coming from each portion of the sky, the sky is first divided into 

a hemispheric grid. For GLI calculations, the grid cells are equal-area segments of a user-settable 

resolution. For Sail Light calculations, the sky is divided into one-degree-sized grid cells. For 

each day in the growing season, the times of sunrise and sunset are calculated, and then the sun's 

position in the sky grid is tracked at 5-minute intervals throughout the day. (The equations are 

below.) At each solar position, the amount of direct beam radiation received from the sun at that 

position is calculated, taking into account atmospheric effects. Each sky segment keeps track of 

the total amount of direct beam radiation coming from it for the duration of the growing season.  

The total amount of light in the sky is the amount of direct beam radiation plus the amount of 

diffuse radiation. Once the total amount of direct beam radiation is known, the amount of diffuse 

radiation is calculated accordingly and added equally to all portions of the sky. Each sky segment 

is then relativized to hold the percentage of total light coming from that segment.  

Determining a tree's light index 

For each timestep, SORTIE calculates the amount of light each tree receives by simulating a 

fisheye photograph. To "take" the photo, the model looks at the hemisphere of sky around and 

above a tree and determines which portions of it are blocked by neighboring trees. It then totals 

up how much light is left to reach the tree.  

Only tree crowns block light in the model. Trunks do not shade. Because seedlings are modeled 

as sticks with no crowns, they don't shade either.  

The first step in creating the simulated fisheye photo is to determine how far from the tree to 

search for shading neighbors. For GLI, this is done by comparing the height of the fisheye photo 

to the maximum possible tree height and determining how far away a tree of this height could be 

and still have its crown appear in the sky above the minimum solar angle. All trees within this 

search radius that are taller than the height of the fisheye photo (and thus can be "seen" by it) are 

added into the "photo." For Sail Light, the search distance is specified by the user.  



To add a shading neighbor to the photo, the light behavior determines the amount and location of 

sky covered by its crown. In a GLI calculation, neighbor crowns are approximated as cylinders. 

In a Sail Light calculation, neighbor crowns are approximated as 2-D rectangles with a width 

equal to their crown diameter and a height equal to their crown height (or, as an added 

simplification, the behavior can assume the crowns of shading neighbors extend all the way to 

the ground).  

The amount of radiation received from the portion of the sky blocked by the shading neighbor is 

multiplied by the light transmission coefficient for the neighbor's species. The effects of multiple 

neighbors blocking the same patch of sky are multiplicative.  

Once all shading neighbors have been added to the fisheye photo, the amount of light that can 

still be seen from each region of the sky is totaled up into the appropriate index.  

Sky Simulation Equations 

All equations are from Iqbal, 1983.  

At a given (solar) time, the sun's zenith angle is calculated by:  

cos ζ = sin δ sinυ + cos δ cos υ cos ω 

and its azimuth angle is calculated by: 

cos ψ = (sin α sin υ - sin δ)/cos α cos υ 

where: 

 ζ = angle from zenith, in degrees 

 δ = solar declination, in degrees 

 υ = Plot Latitude, in decimal degrees parameter (from Plot) 

 α = the solar altitude (angle from horizon), in degrees 

 ω = the hour angle (solar time). 

Azimuth here is south zero, east positive. 

Solar declination is calculated by 

δ = 0.006918 - 0.399912 cos Γ + 0.070257 sin Γ - 0.006758 cos 2Γ + 0.000907 sin 2Γ - 

0.002697 cos 3Γ + 0.00148 sin 3Γ 

where δ = solar declination in radians and Γ is the day angle, in radians.  

The day angle is calculated by Γ = 2π(d - 1)/365 where Γ is the day angle in radians and d is the 

Julian day number (day of the year between 1 and 365).  



So, once we finally have the azimuth and altitude angles for the sun's position in the sky, we can 

calculate the amount of direct beam radiation coming from it and add it to the appropriate grid 

cell. The direct beam radiation equation is  

I = E0*τ
m
*cos(ζ) 

where 

 I is the beam radiation 

 E0 is the earth's eccentricity 

 τ is the Clear Sky Transmission Coefficient parameter 

 m is the optical mass of the atmosphere 

 ζ is the zenith angle of the sun. 

Eccentricity is calculated by 

E0 = 1.000110 + 0.034221 cos Γ + 0.001280 sin Γ + 0.000719 cos 2Γ + 0.000077 sin 2Γ 

where Γ is the day angle (equation above). 

Optical mass of the atmosphere is calculated by 

m = sec(ζ) 

where ζ is the zenith angle of the sun. SORTIE uses a numerical approximation method instead 

of the sec to correct at low altitudes.  

This process is repeated for each day in the growing season. The growing season starts with the 

First Day of Growing Season parameter and ends with the Last Day of Growing Season 

parameter.  

Snags in light calculations 

Snags are standing dead trees (more in the trees topic). They can block light like live trees do. 

For SORTIE purposes, snag crowns are frozen in the shape they had when the tree died, but they 

transmit more and more light as they lose branches. SORTIE tracks a snag's age in order to 

replicate this decay. You define three snag age classes and a light transmission coefficient for 

each. For as long as a snag stands, it will block the light of neighboring trees, but to a lesser 

degree through time.  

You don't have to include snags in light calculations. If you do not have any behaviors in your 

run that either create snags or directly work with them, then your run is classified as "snag-

unaware" and snags will not be created. In this case, the snag parameters are not required. 

However, if your run is "snag-aware" and snags may be created, you must supply the snag light 

transmission parameters.  



Light parameters 

 Amount Canopy Light Transmission (0-1) Fraction of light transmitted through the 

tree crown for each species. Expressed as a fraction between 0 and 1. A value must be 

provided for all species, even if they don't all use light. 

 Basal Area Light - Angiosperm "b" Parameter The "b" value used to calculate mean 

GLI from angiosperm basal area. Used by the Basal Area Light behavior. 

 Basal Area Light - Angiosperm "c" Parameter The "c" value used to calculate mean 

GLI from angiosperm basal area. Used by the Basal Area Light behavior. 

 Basal Area Light - Conifer "b" Parameter The "b" value used to calculate mean GLI 

from conifer basal area. Used by the Basal Area Light behavior. 

 Basal Area Light - Conifer "c" Parameter The "c" value used to calculate mean GLI 

from conifer basal area. Used by the Basal Area Light behavior. 

 Basal Area Light - Lognormal PDF Sigma Sigma value for the lognormal probability 

distribution. Used by the Basal Area Light behavior. 

 Basal Area Light - Mean GLI "a" Parameter The "a" value used to calculate mean 

GLI from basal area. Used by the Basal Area Light behavior. 

 Basal Area Light - Minimum BA Change for New GLI (m2) The amount by which 

total basal area (angiosperm plus conifer), in square meters, must change in order to 

trigger a new GLI calculation in a grid cell. Used by the Basal Area Light behavior. 

 Basal Area Light - Minimum DBH for Trees The minimum DBH, in cm, of trees that 

count towards basal area. Used by the Basal Area Light behavior. 

 Basal Area Light - Search Radius for Neighbors (m) The radius, in meters, of the 

circle that is searched for neighbors. Used by the Basal Area Light behavior. 

 Basal Area Light - Species Type Whether each species is a conifer or an angiosperm, 

for the purposes of light calculations. Used by the Basal Area Light behavior. 

 Beam Fraction of Global Radiation The fraction of total solar radiation that is direct 

beam radiation (as opposed to diffuse). Expressed as a value between 0 and 1. Used by all 

behaviors making GLI or Sail Light calculations. See equations above for more on how 

this is used. 

 Calculated Crown Depth When the shape of a tree's shading neighbors is assessed to 

see how much light each blocks, their crowns can either conform to each neighbor's true 

crown height or they can be approximated at the full height of the tree. Used only by the 

Sail light behavior. 

 Clear Sky Transmission Coefficient Used to determine the amount of solar radiation 

seen at the plot location. Applies to all behaviors making GLI or Sail Light calculations. 

See equations above for more on how this is used. 

 Constant GLI - Constant GLI Value (0-100) The GLI value assigned to all trees. Used 

by the Constant GLI behavior behavior. 

 First Day of Growing Season The first day of the growing season, as a Julian day 

(number between 1 and 365). Trees only get light during the growing season. Used by all 

behaviors making GLI or Sail light calculations. 

 GLI Points Input File The file containing the points for which to calculate GLI. This file 

will overwrite any existing points. For best results, enter a fully-qualified pathname (i.e. 

"c:\sortie\my_file.txt"). File format is below. Used by the GLI Points File Creator 

behavior. 



 GLI Points Output File The file to which the GLI Points File Creator behavior will 

write its results each timestep. Any existing data in this file will be overwritten at the start 

of the run. 

 Height at Which GLI is Calculated for GLI Map, in meters Height at which the GLI 

Map Creator behavior calculates GLI.  

 Height at Which GLI is Calculated for Quadrats, in meters Height at which the 

Quadrat-based GLI light behavior calculates GLI. 

 Height of Fisheye Photo When a fish-eye photo is simulated for a tree, this positions the 

photo at either the top of the crown or at mid-crown. Applies to all behaviors making GLI 

or Sail light calculations. Seedlings always get fisheye photos at top-of-crown no matter 

what this value is. 

 Height of Light Filter, in m Height, in meters, at which the Beer's law light filter hangs. 

Only applies to the Beer's law light filter behavior. 

 Last Day of Growing Season The last day of the growing season, as a Julian day 

(number between 1 and 365). Trees only get light during the growing season. Used by all 

behaviors making GLI or Sail light calculations. 

 Light Filter Light Transmission Coefficient Amount of light that is blocked by the 

light filter. Only applies to the Beer's law light filter behavior. 

 Minimum Solar Angle for GLI Light, in rad This is the minimum angle at which 

sunlight is seen, in radians. Below this value the sky is assumed to be dark due to shading 

neighbors. This value applies to the GLI light behavior. 

 Minimum Solar Angle for GLI Map Creator, in rad This is the minimum angle at 

which sunlight is seen, in radians. Below this value the sky is assumed to be dark due to 

shading neighbors. This value applies to the GLI Map Creator behavior. 

 Minimum Solar Angle for GLI Points Creator, in rad This is the minimum angle at 

which sunlight is seen, in radians. Below this value the sky is assumed to be dark due to 

shading neighbors. This value applies to the GLI Points File Creator behavior. 

 Minimum Solar Angle for Quadrat Light, in rad This is the minimum angle at which 

sunlight is seen, in radians. Below this value the sky is assumed to be dark due to shading 

neighbors. This value applies to the Quadrat-based GLI light behavior, if the value should 

be different from the value being used by the GLI light behavior. 

 Number of Altitude Sky Divisions for GLI Light Calculations Number of grid cells 

into which the sky is divided from horizon to zenith, for the purpose of calculating light 

direction. Used by the GLI light behavior, as well as the Quadrat-based light behavior if a 

different value is not specified for it. 

 Number of Altitude Sky Divisions for GLI Map Creator Calculations Number of grid 

cells into which the sky is divided from horizon to zenith, for the purpose of calculating 

light direction. Used by the GLI Map Creator behavior. If the GLI light behavior is also 

used, this value is not required. 

 Number of Altitude Sky Divisions for GLI Points Creator Number of grid cells into 

which the sky is divided from horizon to zenith, for the purpose of calculating light 

direction. Used by the GLI Points File Creator behavior. If the GLI light behavior is also 

used, this value is not required. 

 Number of Altitude Sky Divisions for Quadrat Light Calculations Number of grid 

cells into which the sky is divided from horizon to zenith, for the purpose of calculating 



light direction. Used by the Quadrat-based light behavior. If the GLI light behavior is also 

used, this value is not required. 

 Number of Azimuth Sky Divisions for GLI Light Calculations Number of grid cells 

into which the sky is divided around the horizon, for the purpose of calculating light 

direction. Used by the GLI light behavior, as well as the Quadrat-based light and GLI 

Map Creator behaviors if different values are not specified for them. 

 Number of Azimuth Sky Divisions for GLI Map Creator Calculations Number of 

grid cells into which the sky is divided around the horizon, for the purpose of calculating 

light direction. Used by the GLI Map Creator behavior. If the GLI light behavior is also 

used, this value is not required. 

 Number of Azimuth Sky Divisions for GLI Points Creator Number of grid cells into 

which the sky is divided around the horizon, for the purpose of calculating light direction. 

Used by the GLI Points File Creator behavior. If the GLI light behavior is also used, this 

value is not required. 

 Number of Azimuth Sky Divisions for Quadrat Light Calculations Number of grid 

cells into which the sky is divided around the horizon, for the purpose of calculating light 

direction. Used by the Quadrat-based light behavior. If the GLI light behavior is also 

used, this value is not required. 

 Quadrat GLI - Always Calculate All GLIs Whether or not the Quadrat-based light 

behavior should always calculate a GLI for all cells in the Quadrat GLI grid. If false, 

GLIs are only calculated when needed by a tree. Set this value to true if you are planning 

to save and use maps of the Quadrat GLI grid. If not, leaving it to false makes SORTIE 

run faster. 

 Sail Light Maximum Shading Neighbor Distance, in meters The radius, in meters, 

from a tree for which neighbors will be searched who can shade that tree. Used only in 

the Sail Light behavior. 

 Sail Light Minimum Solar Angle, in degrees The azimuth angle, in degrees, below 

which it is assumed trees will see no light. Used only by the Sail Light behavior. 

 Snag Age Class 1 Amount Canopy Light Transmission (0-1) Fraction of light 

transmitted through the snag tree crown for each species. Applies to those snags whose 

age is less than or equal to "Upper Age (Yrs) of Snag Light Transmission Class 1". 

Expressed as a fraction between 0 and 1. If your run does not work with snags, you can 

ignore this. Otherwise, a value must be provided for all species. Used by all behaviors 

making GLI or Sail Light calculations. 

 Snag Age Class 2 Amount Canopy Light Transmission (0-1) Fraction of light 

transmitted through the snag tree crown for each species. Applies to those snags whose 

age is greater than "Upper Age (Yrs) of Snag Light Transmission Class 1", but is less 

than or equal to "Upper Age (Yrs) of Snag Light Transmission Class 2". Expressed as a 

fraction between 0 and 1. If your run does not work with snags, you can ignore this. 

Otherwise, a value must be provided for all species. Used by all behaviors making GLI or 

Sail Light calculations. 

 Snag Age Class 3 Amount Canopy Light Transmission (0-1) Fraction of light 

transmitted through the snag tree crown for each species. Applies to those snags whose 

age is greater than "Upper Age (Yrs) of Snag Light Transmission Class 2". Expressed as 

a fraction between 0 and 1. If your run does not work with snags, you can ignore this. 



Otherwise, a value must be provided for all species. Used by all behaviors making GLI or 

Sail Light calculations. 

 Storm Light - Intercept of Light Function Intercept of the function to determine light 

level. Used by the Storm Light behavior. 

 Storm Light - Max Radius (m) for Damaged Neighbors The maximum distance, in 

meters, within which the Storm Light behavior searches for damaged trees. Used by the 

Storm Light behavior. 

 Storm Light - Max Years Damaged Trees Affect Light The maximum amount of time, 

in years, after storm damage that a tree will still be counted in the number of damaged 

trees. Used by the Storm Light behavior. 

 Storm Light - Max Years Snags Affect Light The maximum amount of time, in years, 

after death that a snag will still be counted in the number of damaged trees. Used by the 

Storm Light behavior. 

 Storm Light - Minimum Trees For Full Canopy The minimum number of adult trees 

and snags within the value in Storm Light - Max Radius (m) for Damaged Neighbors 

for the point to be considered under full canopy. Used by the Storm Light behavior. 

 Storm Light - Slope of Light Function Slope of the function to determine light level. 

Used by the Storm Light behavior. 

 Storm Light - Standard Deviation If the value in the Storm Light - Stochasticity 

parameter is "Normal" or "Lognormal", the standard deviation of the probability 

distribution function. If stochasticity is "Deterministic", this value is ignored. Used by the 

Storm Light behavior. 

 Storm Light - Stochasticity What method to use for randomizing light values, if desired. 

Used by the Storm Light behavior. 

 Upper Age (Yrs) of Snag Light Transmission Class 1 The upper age limit, in years, 

defining the first age class of snag light transmission. Snags with an age less than or 

equal to this age have a light transmission coefficient matching "Snag Age Class 1 Light 

Transmission Coefficient". If your run does not work with snags, you can ignore this. 

Used by all behaviors making GLI or Sail Light calculations. 

 Upper Age (Yrs) of Snag Light Transmission Class 2 The upper age limit, in years, 

defining the second age class of snag light transmission. Snags with an age greater than 

the upper limit for size class 1, but less than or equal to this age, have a light transmission 

coefficient matching "Snag Age Class 2 Light Transmission Coefficient". Snags with an 

age greater than this value are in age class three. If your run does not work with snags, 

you can ignore this. Used by all behaviors making GLI or Sail Light calculations. 

Average Light 

This behavior averages GLI values to produce a set of values with a coarser spatial resolution.  

How it works 

This behavior does not actually calculate GLI. It averages the GLI values in the GLI Map grid, 

which is created by the GLI Map Creator behavior.  



This behavior creates its own map, called Average Light. The value for each cell in this grid is an 

average of the cells of GLI Map in the same area. If the size of the cells of Average Light is an 

exact multiple of the size of the cells of GLI Map, then a straight average is calculated. If the size 

is not an exact multiple, each Average Light cell value is an average of the values of all the cells 

of GLI Map that overlap it in area, even if only partially.  

Trees to which this behavior are applied get the value of their location in the Average Light grid.  

How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species. The GLI Map 

Creator behavior must also be used, and must come before Average Light in the run order. Once 

both behaviors have been added to your run, set up the cell sizes of the two grids the way you 

want them using the Grid Setup window.  

Behavior reference string: Average Light  

Basal Area Light behavior 

This behavior calculates light levels as a function of the basal area of trees in a neighborhood. 

The light levels are randomized using a lognormal probability distribution. Because of this 

random element, to ensure some continuity through time, light levels only change when the local 

neighborhood tree basal area has changed by a certain amount.  

How it works 

This behavior uses a grid called Basal Area Light to manage light levels. Light levels are 

calculated for each cell in the grid; trees to which this behavior are assigned receive the light 

level of the cell in which they are located.  

The behavior begins by calculating the total basal area and angiosperm basal area in the 

neighborhood of each Basal Area Light grid cell. The neighborhood is a circle with its center on 

the center of the grid cell, and a radius given in the Basal Area Light - Search Radius for 

Neighbors (m) parameter. Whether a neighborhood tree counts as angiosperm or conifer 

depends on what its species is set to in the Basal Area Light - Species Type parameter. 

Seedlings and snags are never included in these basal area totals. Other trees are only included if 

their DBH is equal to or greater than the value set in the Basal Area Light - Minimum DBH for 

Trees parameter. Once the basal areas are calculated, the behavior adds them together to create a 

total basal area, and compares this value to the previous timestep's total basal area. If the value 

has not changed by more than the amount set in the Basal Area Light - Minimum BA Change 

for New GLI (m2) parameter, no further action is taken. The previous timestep's GLI and basal 

area values are kept.  

For each grid cell in which a new GLI is to be calculated, a mean GLI value is calculated as 

follows:  



 

where:  

 GLIm is the mean GLI value, as a value between 0 and 100 

 a is the Basal Area Light - Mean GLI "a" Parameter 

 ba is the Basal Area Light - Angiosperm "b" Parameter  

 ca is the Basal Area Light - Angiosperm "c" Parameter 

 BAa is the angiosperm basal area for that grid cell, in square meters 

 bc is the Basal Area Light - Conifer "b" Parameter  

 cc is the Basal Area Light - Conifer "c" Parameter 

 BAc is the conifer basal area for that grid cell, in square meters 

This mean GLI is translated into a ζ value for the lognormal random draw as follows:  

δ = ln(GLIm) - (σ 
2
/2) 

where GLIm is the mean GLI value calculated above, and σ is the Basal Area Light - 

Lognormal PDF Sigma parameter.  

This value is then used to produce a random lognormally distributed number, from the following 

distribution:  

 

where δ is the value calculated above, and σ is the Basal Area Light - Lognormal PDF Sigma 

parameter. This number is the GLI value, between 0 and 100.  

Once each Basal Area Light grid cell has gotten a GLI value, trees to which this behavior applies 

get the value of GLI from the grid cell in which they are located.  

How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: Basal Area Light  

Beer's law light filter 



How it works 

This behavior simulates a filter that reduces light according to Beer's Law.  

Imagine a fog that hangs out on the forest floor and ends abruptly at a certain height. All trees 

shorter than the top of the fog layer will have their light attenuated but not blocked completely. 

The closer they get to the top of the fog the more light is let in. The amount of light which 

actually gets through is calculated according to Beer's Law, where transmission = e
-az

, where a is 

the Light Filter Light Transmission Coefficient parameter and z = thickness of the filter, in 

meters (which is the distance from the light point to the top of the filter - the Height of Light 

Filter, in m parameter). This filter behavior can be used to, for instance, replicate the effects of 

an herbaceous layer in reducing light to young seedlings. The height of the filter is randomized 

slightly each time the thickness of the filter over the light point is calculated to introduce a 

stochastic element.  

Trees can be given a respite from the effects of the filter. This behavior does not set the respite 

counter but it will respect any values which another behavior has put in.  

Trees can be given a rooting height in addition to their normal height. This value is added to their 

existing height to get their effective height, which is what will be applied when determining the 

thickness of the filter overhead. Again, this behavior does not set this height but will use it if 

another behavior sets it.  

This behavior DOES NOT ACTUALLY CALCULATE LIGHT LEVELS. Any tree species and 

types to which this filter is applied must also have one of the other light behaviors assigned to it. 

This behavior assumes the value is a GLI value; using Sail Light will probably not produce good 

results.  

This behavior only affects tree types and species to which it is applied in the behavior list of the 

parameter file. It will ignore all other trees, even if they are short enough to be beneath the filter 

level.  

How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: light filter  

Constant GLI 

How it works 

This assigns a constant GLI value to all trees to which it is assigned. This value is set in the 

Constant GLI - Constant GLI Value (0-100) parameter.  



How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: Constant GLI  

GLI light 

For more on what GLI is and how it is calculated, see above.  

How it works 

This behavior calculates a Global Light Index (GLI) value for each individual of each tree type 

to which it is assigned. GLI values range from 0 (no sun) to 100 (full sun).  

How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: glilight  

Quadrat-based GLI light 

For more on what GLI is and how it is calculated, see above.  

How it works 

This behavior uses a grid object, called Quadrat GLI, to help it assign GLI values to the trees to 

which it is assigned. The grid cells are the quadrats, in this case; this is a throwback to old 

SORTIE terminology. Each grid cell in which there is a tree to which this behavior applies has a 

GLI value calculated at its center, at a height that the user specifies. All other trees to which this 

behavior applies that are in that same grid cell get that same GLI value. This behavior saves 

having to calculate a different GLI value for each tree. GLI values range from 0 (no sun) to 100 

(full sun).  

For efficiency, this behavior does not calculate the value of a grid cell if there are no trees in that 

cell. In this case, the light value of the cell is -1. To force it to always calculate all GLIs (useful if 

you intend to save maps of the Quadrat GLI grid), set the Quadrat GLI - Always Calculate All 

GLIs parameter to true.  

How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: quadratlight  



Sail light 

For more on what the Sail Light index is and how it is calculated, see above.  

How it works 

This behavior calculates a Sail Light index value for each individual of each tree type to which it 

is assigned. Sail Light values go from 0 (full sun) to 1 (full shade).  

How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: saillight  

GLI Map Creator 

For more on what GLI is and how it is calculated, see above.  

How it works 

This behavior calculates a GLI value for each cell in a grid object called GLI Map. The height at 

which this GLI value is calculated is set by the Height at Which GLI is Calculated for GLI 

Map, in meters parameter. These values are not used by any other behavior. You can save the 

values in the GLI Map grid into a detailed output file and view the map data later.  

How to apply it 

Add the behavior to the run. Be sure to save the GLI Map grid in the detailed output file in order 

to be able to view the results.  

Behavior reference string: GLI Map Creator  

Gap Light behavior 

This behavior shortcuts the light calculation process by considering GLI to be binary: either full 

light (100%) or no light (0%). This simulates a simplified version of gap light dynamics.  

How it works 

This behavior uses a grid object called Gap Light to determine the basic position of plot gaps. If 

a grid cell contains no adult trees, it is considered a gap. If there are any adults of any species, 

then it is non-gap.  



The trees to which this behavior has been applied get their GLI values based on the gap status of 

the grid cell in which they are located. If the gap status is TRUE, then they receive a GLI value 

of 100%. If it is FALSE, they receive a value of 0%.  

How to apply it 

This behavior may be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: Gap Light  

Storm Light behavior 

This behavior calculates light levels as a function of number of trees damaged in storms. Light 

levels are stored in a grid for later retrieval by other behaviors; this behavior does not directly 

assign light to trees.  

How it works 

This behavior uses a grid called Storm Light to manage light levels. Each timestep, it calculates 

the light level at the center of each grid cell and places it in the grid.  

The light level is calculated as follows:  

GLA = ((1 - T/M) * 100) + (a + b * N) 

where:  

 GLA is the light level, as a value between 0 and 100 

 T is the number of adult trees and snags within the search radius 

 M is the Storm Light - Minimum Trees For Full Canopy parameter 

 a is the Storm Light - Intercept of Light Function parameter 

 b is the Storm Light - Slope of Light Function parameter 

 N is the proportion of trees that are dead or were heavily damaged in recent storms 

This behavior calculates the light levels at the center of each grid cell by examining the trees 

within the distance given in the Storm Light - Max Radius (m) for Damaged Neighbors 

parameter.  

The first term in the equation, ((1 - T/M) * 100), corrects the light level if the point is not under 

full canopy. All adults and snags, no matter what storm damage, are counted up and assigned to 

T. If T >= M, then the first term is set to 0 and only the second part, (a + b * N), is evaluated. If 

T < M, then the first term adds to the linear portion the proportion of full sun equal to the 

proportion of trees missing from the full canopy.  

For the second, linear term, the behavior counts the number of dead and heavily damaged trees 

as a proportion of all adults and snags. Trees count as heavily damaged if they are either snags 



that were created as a result of a storm killing an adult tree, or live adults with heavy storm 

damage. All storm damaged trees have a time-since-damage counter; only those eligible trees 

with a counter value less than or equal to the value in the Storm Light - Max Years Damaged 

Trees Affect Light parameter are counted. Saplings and seedlings never count. All snags count, 

whether they were created by a tree or another mortality process. Their age as a snag must also 

be less than the Storm Light - Max Years Snags Affect Light parameter.  

The GLA value can be used as-is, or it can be used as the mean in a PDF to introduce a 

stochastic element. You can choose either "Normal" or "Lognormal" in the Storm Light - 

Stochasticity parameter, then supply a standard deviation in the Storm Light - Standard 

Deviation parameter. Using "Deterministic" as the stochasticity causes the GLA to be used as-is.  

How to apply it 

You do not need to apply this behavior to individual trees. While it is recommended that you also 

include the Storm damage applier behavior in your run, this is not required.  

Behavior reference string: Storm Light  

GLI Points File Creator behavior 

This behavior calculates GLI values for individual points in the plot.  

How it works 

You provide, as input, a file that contains the list of points for which you would like GLI values. 

The file is tab-delimited text, and has the following format:  

X Y Height (m) 

12.4 36.5 1.2 

128.7 19.5 0.68 

The first row is assumed to be a header row and is ignored. Each subsequent row is a single point 

for which to calculate GLI. You can include as many as you wish. The first column is the point's 

X coordinate; the second is the Y coordinate; and the third column is the height above the 

ground, in meters. Name the file whatever you wish. Put the file name for the points file in the 

GLI Points Input File parameter. It is best to use a fully-qualified path name (i.e. 

"c:\sortie\my_points.txt"). SORTIE-ND will load the points into the parameter file. If you are 

working with a parameter file that already contains GLI points because they were saved into it 

previously, you do not need to enter another file and can leave the GLI Points Input File 

parameter blank.  

Each timestep, this behavior calculates GLI at each of the points specified. It then writes the 

results to another tab-delimited text file. You enter the filename of this file in the GLI Points 



Output File parameter. It should be fully-qualified (i.e. "c:\sortie\points_output.txt") and should 

have a ".txt" extension. If the file already exists when the SORTIE-ND run begins, the contents 

will be overwritten. This means that this behavior cannot successfully be used in batch runs 

where a parameter file will be run multiple times.  

How to apply it 

This behavior does not need to be applied to trees. It can stand alone as the only light behavior if 

you wish.  

Behavior reference string: GLI Point Creator  
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Growth behaviors 

In this document:  

How growth is applied  

Growth parameters  

Absolute growth behaviors  

--Absolute growth limited to radial increment behavior - diam with auto height  

--Absolute growth limited to radial increment behavior - diam only  

--Absolute growth limited to basal area increment behavior - diam with auto height  

--Absolute growth limited to basal area increment behavior - diam only  

--Non-limited absolute growth behavior - diam with auto height  

--Non-limited absolute growth behavior - diam only  

Allometric diameter growth - diam only  

Allometric height growth  

Basal area NCI growth - diam with auto height  

Basal area NCI growth - diam only  

Constant basal area growth behavior - diam with auto height  

Browsed relative growth behavior - diam with auto height  

Browsed relative growth behavior - diam only  

Constant basal area growth behavior - diam only  

Constant radial growth behavior - diam with auto height  

Constant radial growth behavior - diam only  

Double resource relative growth - diam with auto height  

Double resource relative growth - diam only  

Lagged post harvest growth - diam with auto height  

Lagged post harvest growth - diam only  

Linear growth - height only  

Linear growth - diam with auto height  

Linear growth - diam only  



Linear bi-level growth - diam with auto height  

Linear bi-level growth - diam only  

Linear growth w/ exponential shade reduction - height only  

Linear growth w/ exponential shade reduction - diam with auto height  

Linear growth w/ exponential shade reduction - diam only  

Logistic growth - height only  

Logistic growth - diam with auto height  

Logistic growth - diam only  

Logistic growth w/ size dependent asymptote - height only  

Logistic growth w/ size dependent asymptote - diam with auto height  

Logistic growth w/ size dependent asymptote - diam only  

Lognormal bi-level growth - height only  

Lognormal with exponential shade reduction - height only  

Lognormal with exponential shade reduction - diam with auto height  

Lognormal with exponential shade reduction - diam only  

Michaelis Menton with negative growth - height only  

Michaelis Menton with photoinhibition - height only  

NCI growth behavior - diam with auto height  

NCI growth behavior - diam only  

Power growth - height only  

Puerto Rico semi-stochastic - diam only  

Puerto Rico storm bi-level growth - diam with auto height  

Relative growth behaviors  

--Relative growth limited to radial increment behavior - diam with auto height  

--Relative growth limited to radial increment behavior - diam only  

--Relative growth limited to basal area increment behavior - diam with auto height  

--Relative growth limited to basal area increment behavior - diam only  

--Non-limited relative growth behavior - diam with auto height  

--Non-limited relative growth behavior - diam only  

--Relative growth - height only  

Stochastic gap growth  

How growth is applied 

Growth behaviors increase the size of a tree. A tree has two basic size dimensions: diameter and 

height. A growth behavior can increase tree size using one of three methods.  

In the first method, the behavior calculates an amount of diameter increase, and then adds this 

amount to the tree's diameter. The tree's new height is calculated from the new diameter using 

the appropriate allometry equation. This is the way that growth has been applied in all previous 

versions of SORTIE, and is the method you should choose if you are in doubt about which one 

you want. Behaviors using this method have the tag "diam with auto height" in their name.  

In the second method, the behavior calculates an amount of diameter increase, and then adds this 

amount to the tree's diameter. The height is not allowed to change. The rationale behind this is 

that tree diameter and height are not always strictly coupled by the allometry equations; 



sometimes, diameter and height should be allowed to vary independently. If you use a growth 

behavior of this type, it is required that you pair it with a separate behavior incrementing height. 

Behaviors using this method have the tag "diam only" in their name.  

In the third method, the behavior calculates an amount of height increase, and then adds this 

amount to the tree's height. The diameter is not allowed to change. The rationale is the same as 

that for the second method. If you use a growth behavior of this type, it is required that you pair 

it with a separate behavior incrementing diameter. Behaviors using this method have the tag 

"height only" in their name.  

Growth behaviors using the second and third method must work together in pairs. Behaviors 

using the first method work alone. If you pair a behavior using method one with a behavior using 

method three, the height-incrementing behavior will be ignored.  

When incrementing a tree's diameter with new growth, seedlings and saplings have the amount 

of growth increase applied to their diameter at 10 cm. Adults have the amount applied to their 

DBH. For more on tree types and their measurements, see the trees topic. For more on tree size 

relationships, including how trees transition between life history stages, see the allometry topic.  

Note: All behaviors convert growth to diameter growth in cm for internal consistency. The 

equations below reflect this. Some behaviors may take parameters in mm, or for radial 

growth. Take careful note of your behavior's parameters.  

It is important to be careful when mixing different growth methods for different life history 

stages of a tree species. For instance: if tree seedlings or saplings get separate diameter and 

height increments, then their diameters and heights will be "uncoupled." This means that you 

cannot use one of the size dimensions to predict the other through an allometric equation. Trees 

with the same diameter will have different heights, and vice versa. Say that you do not have data 

on separate diameter and height growth for adults, so you assign the adults to a behavior that 

increments diameter and then automatically updates height according to the allometry equations. 

You are likely to notice strange results for new adult trees. You will lose the variability in 

height/diameter ratio that was developed. Suddenly, all trees with the same diameter will have 

the same height again, and vice versa. This means that individuals may suddenly jump in height, 

or even shrink.  

The "Allometric height growth" and "allometric diameter growth" behaviors were developed to 

help bridge this gap. When used with a behavior that only increments diameter or height, they 

will preserve height or diameter differences that have developed across individuals in a species.  

Growth parameters 

 Adult Constant Area Growth in sq. cm/yr The constant amount of basal area by which 

to increase a tree's basal area. Used in basal-area-increment-limited behaviors and 

constant basal area growth behaviors. 



 Adult Constant Radial Growth in mm/yr The constant value by which to increase a 

tree's radius at breast height. Used in radial-increment-limited-growth behaviors and 

constant radial increment behaviors. 

 Asymptotic Diameter Growth (A) Asymptote of the Michaelis-Menton growth function 

at high light in absolute and relative growth behaviors - A in the equations below. Used 

in absolute and relative growth behaviors. 

 Asymptotic Height Growth (A) Asymptote of the Michaelis-Menton growth function at 

high light - A in the equations below. Used in the Relative growth - height only behavior. 

 Basal Area NCI - BA Divisor The value by which to divide neighbor basal area. Used in 

the Basal area NCI growth behaviors. 

 Basal Area NCI - Use Only Larger Neighbors Whether to use all neighbors larger than 

the minimum DBH (false) or only neighbors larger than the target tree (true). Used in the 

Basal area NCI growth behaviors. 

 Browsed Asymptotic Diameter Growth (A) Asymptote of the Michaelis-Menton 

growth function at high light when a plant has been browsed. Used by the Browsed 

relative growth behavior - diam with auto height and Browsed relative growth behavior - 

diam only behaviors. 

 Browsed Slope of Growth Response (S) Slope of the Michaelis-Menton growth 

function at zero light when a plant has been browsed. Used by the Browsed relative 

growth behavior - diam with auto height and Browsed relative growth behavior - diam 

only behaviors. 

 Browsed Diameter Exponent The diameter exponent for growth when a plant has been 

browsed. Used by the Browsed relative growth behavior - diam with auto height and 

Browsed relative growth behavior - diam only behaviors. 

 Double resource - Influence of Resource (C) The parameter governing the influence of 

the second resource on the double-resource Michaelis-Menton equation. Used by the 

Double resource relative growth - diam with auto height and Double resource relative 

growth - diam only behaviors. 

 Include Snags in NCI Calculations Whether or not to include snags when finding 

competitive neighbors for NCI. Used in the NCI growth behavior - diam with auto height 

and NCI growth behavior - diam only behaviors. 

 Length of Current Release Factor Controls the magnitude of the effects of release. 

Used in absolute growth behaviors. 

 Length of Last Suppression Factor Controls the magnitude of the effects of 

suppression. Used in absolute growth behaviors. 

 Linear Bi-Level - Intercept for High-Light Growth (a) The intercept of the linear 

growth function used in high-light conditions. Used in the Linear bi-level growth - diam 

with auto height and Linear bi-level growth - diam only behaviors. 

 Linear Bi-Level - Intercept for Low-Light Growth (a) The intercept of the linear 

growth function used in low-light conditions. Used in the Linear bi-level growth - diam 

with auto height and Linear bi-level growth - diam only behaviors. 

 Linear Bi-Level - Slope for High-Light Growth (b) The slope of the linear growth 

function used in high-light conditions. Used in the Linear bi-level growth - diam with 

auto height and Linear bi-level growth - diam only behaviors. 



 Linear Bi-Level - Slope for Low-Light Growth (b) The slope of the linear growth 

function used in low-light conditions. Used in the Linear bi-level growth - diam with auto 

height and Linear bi-level growth - diam only behaviors. 

 Linear Bi-Level - Threshold for High-Light Growth (0 - 100) The threshold between 

low-light and high-light parameters, as a value between 0 and 100. Used in the Linear bi-

level growth - diam with auto height and Linear bi-level growth - diam only behaviors. 

 Logistic - Asymptotic Diam Growth - Full Light in mm/yr (a) Asymptotic annual 

growth at full light, in mm/yr. Used by the Logistic growth - diam with auto height and 

Logistic growth - diam only behaviors. 

 Logistic - Asymptotic Height Growth - Full Light in cm/yr (a) Asymptotic annual 

growth at full light, in cm/yr. Used by the Logistic growth - height only behavior. 

 Logistic - Diam Shape Param 1 (b) Shape parameter 1. Used by the Logistic growth - 

diam with auto height and Logistic growth - diam only behaviors. 

 Logistic - Diam Shape Param 2 (c) Shape parameter 2. Used by the Logistic growth - 

diam with auto height and Logistic growth - diam only behaviors. 

 Logistic - Height Shape Param 1 (b) Shape parameter 1. Used by the Logistic growth - 

height only behavior. 

 Logistic - Height Shape Param 2 (c) Shape parameter 2. Used by the Logistic growth - 

height only behavior. 

 Lognormal Bi-Level - Max Growth in High Light (m) The maximum height growth, in 

meters, under high-light conditions. Used by the Lognormal bi-level growth - height only 

behavior. 

 Lognormal Bi-Level - Max Growth in Low Light (m) The maximum height growth, in 

meters, under low-light conditions. Used by the Lognormal bi-level growth - height only 

behavior. 

 Lognormal Bi-Level - X0 for High-Light Growth The X0 parameter to use under high-

light growth conditions. Used by the Lognormal bi-level growth - height only behavior. 

 Lognormal Bi-Level - X0 for Low-Light Growth The X0 parameter to use under low-

light growth conditions. Used by the Lognormal bi-level growth - height only behavior. 

 Lognormal Bi-Level - Xb for High-Light Growth The Xb parameter to use under high-

light growth conditions. Used by the Lognormal bi-level growth - height only behavior. 

 Lognormal Bi-Level - Xb for Low-Light Growth The Xb parameter to use under low-

light growth conditions. Used by the Lognormal bi-level growth - height only behavior. 

 Lognormal Bi-Level - Threshold for High-Light Growth (0 - 100) Used by the 

Lognormal bi-level growth - height only behavior. 

 Lognormal - Diam Effect of Shade (c) Effect of shade. Used by the Lognormal with 

exponential shade reduction - diam with auto height and Lognormal with exponential 

shade reduction - diam only behaviors. 

 Lognormal - Diam Growth Increment at Diam 36, in mm/yr (a) Annual growth 

increment at diameter 36, in mm/yr. Used by the Lognormal with exponential shade 

reduction - diam with auto height and Lognormal with exponential shade reduction - 

diam only behaviors. 

 Lognormal - Diam Shape Parameter (b) Shape parameter. Used by the Lognormal 

with exponential shade reduction - diam with auto height and Lognormal with 

exponential shade reduction - diam only behaviors. 



 Lognormal - Height Effect of Shade (c) Effect of shade. Used by the Lognormal with 

exponential shade reduction - height only behavior. 

 Lognormal - Height Growth Increment at Diam 36, in cm/yr (a) Annual growth 

increment at diameter 36, in cm/yr. Used by the Lognormal with exponential shade 

reduction - height only behavior. 

 Lognormal - Height Shape Parameter (b) Shape parameter. Used by the Lognormal 

with exponential shade reduction - height only behavior. 

 Michaelis-Menton with Negative Growth - Alpha Alpha parameter. Used by the 

Michaelis Menton with negative growth - height only behavior. 

 Michaelis-Menton with Negative Growth - Beta Beta parameter. Cannot be equal to 

zero. Used by the Michaelis Menton with negative growth - height only behavior. 

 Michaelis-Menton with Negative Growth - Gamma Gamma parameter. Used by the 

Michaelis Menton with negative growth - height only behavior. 

 Michaelis-Menton with Negative Growth - Phi Phi parameter. Used by the Michaelis 

Menton with negative growth - height only behavior. 

 Michaelis-Menton with Photoinhibition - Alpha Alpha parameter. Used by the 

Michaelis Menton with photoinhibition - height only behavior. 

 Michaelis-Menton with Photoinhibition - Beta Beta parameter. Cannot be equal to 

zero. Used by the Michaelis Menton with photoinhibition - height only behavior. 

 Michaelis-Menton with Photoinhibition - D D parameter. Used by the Michaelis 

Menton with photoinhibition - height only behavior. 

 Michaelis-Menton with Photoinhibition - Phi Phi parameter. Used by the Michaelis 

Menton with photoinhibition - height only behavior. 

 Mortality Threshold for Suppression Defines the growth rate for suppressed status in 

terms of tree mortality. The value is expressed as the proportion of trees which die at the 

growth rate which defines suppressed status, expressed as a fraction between 0 and 1. For 

instance, if this value is 0.1, the growth rate for suppressed status is one at which 10% of 

trees die with that growth. Used in absolute growth behaviors. 

 NCI Alpha NCI function exponent. Used in the NCI growth behavior - diam with auto 

height and NCI growth behavior - diam only behaviors. 

 NCI Beta NCI function exponent. Used in the NCI growth behavior - diam with auto 

height and NCI growth behavior - diam only behaviors. 

 NCI Crowding Effect Slope (C) The slope of the curve for the crowding effect equation. 

Used in the NCI growth behavior - diam with auto height and NCI growth behavior - 

diam only behaviors. 

 NCI Crowding Effect Steepness (D) The steepness of the curve for the crowding effect 

equation. Used in the NCI growth behavior - diam with auto height and NCI growth 

behavior - diam only behaviors. 

 NCI Damage Effect - Complete Storm Damage (0-1) The fraction by which a tree's 

growth rate is reduced when it has sustained complete storm damage. Set this to 1 if you 

are not including storms in your run. Used in the NCI growth behavior - diam with auto 

height and NCI growth behavior - diam only behaviors. 

 NCI Damage Effect - Medium Storm Damage (0-1) The fraction by which a tree's 

growth rate is reduced when it has sustained medium storm damage. Set this to 1 if you 

are not including storms in your run. Used in the NCI growth behavior - diam with auto 

height and NCI growth behavior - diam only behaviors. 



 Species i NCI lambda neighbors The competitive effect of neighbors of species i on the 

target tree species's growth, between 0 and 1. Used in the NCI growth behavior - diam 

with auto height and NCI growth behavior - diam only behaviors. 

 NCI Maximum Crowding Distance, in meters The maximum distance, in m, at which a 

neighboring tree has competitive effects on a target tree. Used in the NCI growth 

behavior - diam with auto height and NCI growth behavior - diam only behaviors. 

 NCI Maximum Potential Growth, cm/yr Maximum potential diameter growth for a 

tree, in cm/yr. Used in the NCI growth behavior - diam with auto height and NCI growth 

behavior - diam only behaviors. 

 NCI Minimum Neighbor DBH, in cm The minimum DBH for trees of that species to 

compete as neighbors. Used for all species, not just those using NCI growth. Used in the 

NCI growth behavior - diam with auto height and NCI growth behavior - diam only 

behaviors.  

 NCI DBH Divisor (q) The value by which neighbor DBHs are divided when calculating 

NCI. This can be used to make units adjustments. Used in the NCI growth behavior - 

diam with auto height and NCI growth behavior - diam only behaviors. 

 NCI Neighbor Storm Damage (eta) - Complete (0-1) The fraction to which a 

neighbor's competitive effect is reduced when the neighbor has sustained complete storm 

damage. Set this to 1 if you are not including storms in your run. Used in the NCI growth 

behavior - diam with auto height and NCI growth behavior - diam only behaviors. 

 NCI Neighbor Storm Damage (eta) - Medium (0-1) The fraction to which a neighbor's 

competitive effect is reduced when the neighbor has sustained medium storm damage. 

Set this to 1 if you are not including storms in your run. Used in the NCI growth behavior 

- diam with auto height and NCI growth behavior - diam only behaviors. 

 NCI Shading Effect Coefficient (m) The coefficient in the shading effect equation. Set 

this value to 0 if you do not wish to use shading. Used in the NCI growth behavior - diam 

with auto height and NCI growth behavior - diam only behaviors. 

 NCI Shading Effect Exponent (n) The exponent in the shading effect equation. If you 

set the NCI Shading Effect Coefficient (m) parameter to 0, this value is ignored. Used 

in the NCI growth behavior - diam with auto height and NCI growth behavior - diam only 

behaviors. 

 NCI Size Effect Mode, in cm (X0) The mode of the size effect curve. Used in the NCI 

growth behavior - diam with auto height and NCI growth behavior - diam only behaviors. 

 NCI Size Effect Variance, in cm (Xb) The variance of the size effect curve. Used in the 

NCI growth behavior - diam with auto height and NCI growth behavior - diam only 

behaviors. 

 NCI Size Sensitivity to NCI (gamma) The sensitivity of a tree's growth rate to its DBH. 

Set this to 0 to remove the DBH term altogether. Used in the NCI growth behavior - diam 

with auto height and NCI growth behavior - diam only behaviors. 

 Post Harvest Growth - DBH Growth Effect The effect of DBH on growth. Used in the 

Lagged post harvest growth - diam with auto height and Lagged post harvest growth - 

diam only behaviors. 

 Post Harvest Growth - DBH NCI Effect The effect of DBH on the neighborhood 

competition index. Used in the Lagged post harvest growth - diam with auto height and 

Lagged post harvest growth - diam only behaviors. 



 Post Harvest Growth - Max Growth Constant Maximum annual radial growth, in mm. 

Used in the Lagged post harvest growth - diam with auto height and Lagged post harvest 

growth - diam only behaviors. 

 Post Harvest Growth - NCI Constant A constant adjusting the effects of NCI. Used in 

the Lagged post harvest growth - diam with auto height and Lagged post harvest growth - 

diam only behaviors. 

 Post Harvest Growth - NCI Distance (m) The maximum distance at which neighboring 

trees can have competitive effects. Used in the Lagged post harvest growth - diam with 

auto height and Lagged post harvest growth - diam only behaviors. 

 Post Harvest Growth - Time Since Harvest Rate Param A parameter controlling the 

rate at which the actual growth approaches the potential growth after a harvest. Used in 

the Lagged post harvest growth - diam with auto height and Lagged post harvest growth - 

diam only behaviors. 

 PR - "a" Parameter for Deterministic Growth "a" parameter used to calculate 

deterministic growth when a tree is below the stochastic height threshold. Used in the 

Puerto Rico semi-stochastic - diam only behavior. 

 PR - "b" Parameter for Deterministic Growth "b" parameter used to calculate 

deterministic growth when a tree is below the stochastic height threshold. Used in the 

Puerto Rico semi-stochastic - diam only behavior. 

 PR - DBH Standard Deviation for Stochastic Growth Standard deviation for DBH 

values when a tree uses stochastic growth. This is the standard deviation of the DBH 

value, NOT the amount of growth. Used in the Puerto Rico semi-stochastic - diam only 

behavior. 

 PR - Height Threshold for Stochastic Growth (m) The tree height threshold, in meters, 

between deterministic and stochastic growth. Used in the Puerto Rico semi-stochastic - 

diam only behavior. 

 PR - Mean DBH (cm) for Stochastic Growth The mean for DBH values, in cm, when a 

tree uses stochastic growth. This is the mean of the DBH value, NOT the amount of 

growth. Used in the Puerto Rico semi-stochastic - diam only behavior. 

 PR Storm Bi-Level - Threshold for High-Light Growth (0 - 100) The threshold 

between low-light and high-light equations, as a value between 0 and 100. Used in the 

Puerto Rico storm bi-level growth - diam with auto height behavior. 

 PR Storm Bi-Level - High-Light "a" The "a" value in the high-light growth function. 

Used in the Puerto Rico storm bi-level growth - diam with auto height behavior. 

 PR Storm Bi-Level - High-Light "b" The "b" value in the high-light growth function. 

Used in the Puerto Rico storm bi-level growth - diam with auto height behavior. 

 PR Storm Bi-Level - Intercept for Low-Light Growth (a) The intercept of the linear 

growth function used in low-light conditions. Used in the Puerto Rico storm bi-level 

growth - diam with auto height behavior. 

 PR Storm Bi-Level - Slope for Low-Light Growth (b) The slope of the linear growth 

function used in high-light conditions. Used in the Puerto Rico storm bi-level growth - 

diam with auto height behavior. 

 Relative Michaelis-Menton Growth - Diameter Exponent The exponent to be used 

with diameter when calculating relative growth. Used in the Relative growth behaviors. 



 Relative Michaelis-Menton Growth - Height Exponent The exponent to be used with 

height when calculating relative growth. Used in the Relative growth - height only 

behavior. 

 Shaded Linear - Diam Intercept in mm/yr (a) Intercept of the size dependent growth 

potential, in mm/yr. Used by the Linear growth w/ exponential shade reduction - diam 

with auto height and Linear growth w/ exponential shade reduction - diam only 

behaviors. 

 Shaded Linear - Diam Shade Exponent (c) Effect of shading. Used by the Linear 

growth w/ exponential shade reduction - diam with auto height and Linear growth w/ 

exponential shade reduction - diam only behaviors. 

 Shaded Linear - Diam Slope (b) Slope of the size dependent annual growth potential. 

Used by the Linear growth w/ exponential shade reduction - diam with auto height and 

Linear growth w/ exponential shade reduction - diam only behaviors. 

 Shaded Linear - Height Intercept in cm/yr (a) Intercept of the size dependent growth 

potential, in cm/yr. Used by the Linear growth w/ exponential shade reduction - height 

only behavior. 

 Shaded Linear - Height Shade Exponent (c) Effect of shading. Used by the Linear 

growth w/ exponential shade reduction - height only behavior. 

 Shaded Linear - Height Slope (b) Slope of the size dependent annual growth potential. 

Used by the Linear growth w/ exponential shade reduction - height only behavior. 

 Simple Linear - Diam Intercept in mm/yr (a) Intercept of the linear growth function, or 

growth at no light, in mm/yr. Used by the Linear growth - diam with auto height and 

Linear growth - diam only behaviors. 

 Simple Linear - Diam Slope (b) Slope of the linear growth function. Used by the Linear 

growth - diam with auto height and Linear growth - diam only behaviors. 

 Simple Linear - Height Intercept in cm/yr (a) Intercept of the linear growth function, 

or growth at no light, in cm/yr. Used by the Linear growth - height only behavior. 

 Simple Linear - Height Slope (b) Slope of the linear growth function. Used by the 

Linear growth - height only behavior. 

 Size Dep. Logistic - Diam Intercept (a) Intercept of the size dependent annual growth 

potential. Used by the Logistic growth w/ size dependent asymptote - diam only and 

Logistic growth w/ size dependent asymptote - diam with auto height behaviors. 

 Size Dep. Logistic - Diam Shape Param 1 (c) Shape parameter 1 for shade reduction of 

annual growth. Used by the Logistic growth w/ size dependent asymptote - diam only and 

Logistic growth w/ size dependent asymptote - diam with auto height behaviors. 

 Size Dep. Logistic - Diam Shape Param 2 (d) Shape parameter 2 for shade reduction of 

annual growth. Used by the Logistic growth w/ size dependent asymptote - height only 

and Logistic growth w/ size dependent asymptote - diam with auto height behaviors. 

 Size Dep. Logistic - Diam Slope (b) Slope of the size dependent annual growth 

potential. Used by the Logistic growth w/ size dependent asymptote - diam only and 

Logistic growth w/ size dependent asymptote - diam with auto height behaviors. 

 Size Dep. Logistic - Height Intercept (a) Intercept of the size dependent annual growth 

potential. Used by the Logistic growth w/ size dependent asymptote - height only 

behavior. 



 Size Dep. Logistic - Height Shape Param 1 (c) Shape parameter 1 for shade reduction 

of annual growth. Used by the Logistic growth w/ size dependent asymptote - height only 

behavior. 

 Size Dep. Logistic - Height Shape Param 2 (d) Shape parameter 2 for shade reduction 

of annual growth. Used by the Logistic growth w/ size dependent asymptote - height only 

behavior. 

 Size Dep. Logistic - Height Slope (b) Slope of the size dependent annual growth 

potential. Used by the Logistic growth w/ size dependent asymptote - height only 

behavior. 

 Slope of Growth Response (S) Slope of the Michaelis-Menton growth function at zero 

light for relative and absolute growth behaviors - S in the equations below. Used in 

absolute and growth behaviors. 

 Slope of Height Growth Response (S) Slope of the Michaelis-Menton growth function 

at zero light - S in the equations below. Used in the Relative growth - height only 

behavior. 

 Years Exceeding Threshold Before a Tree is Suppressed The number of years for 

which a tree's growth must be below the defined suppression threshold before it is 

considered to be suppressed. Used in absolute growth behaviors. 

Relative growth behaviors 

Several behaviors apply a relative growth version of the Michaelis-Menton function. Relative 

growth is calculated with the equation: 

 
 

where:  

 Y is the amount of annual relative growth 

 A is the Asymptotic Diameter Growth (A) or Asymptotic Height Growth (A) 

parameter 

 S is the Slope of Growth Response (S) or Slope of Height Growth Response (S) 

parameter 

 GLI is the global light index, calculated by a light behavior 

Diameter growth is compounded over multiple timesteps with the equation: 

G = ((Y + 1)
T
 - 1) * diam 

X
 

where:  

 G is the amount of diameter growth for the timestep, in cm 

 diam is the diameter of the tree in cm (at 10 cm height if seedling or sapling, or DBH if 

adult) 



 T is the number of years per timestep 

 X is the Relative Michaelis-Menton Growth - Diameter Exponent parameter 

Relative height growth is calculated slightly differently. The details are discussed in the section 

for the Relative growth - height only behavior below. Relative growth is discussed in Pacala et al 

1996. 

 

Relative growth limited to radial increment - diam with auto 

height 

How it works 

This behavior calculates an amount of diameter growth according to the relative growth 

equation. Growth is limited to a maximum of the constant radial growth increment for the 

species of tree to which it is being applied. The increment is calculated as described in the 

"Constant radial growth" behavior. Tree height is allowed to update automatically according to 

the allometry equations. Note that the increment parameter specifies radial growth; the behavior 

makes all necessary conversions.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: relradial  

Relative growth limited to radial increment - diam only 

How it works 

This behavior calculates an amount of diameter growth according to the relative growth 

equation. Growth is limited to a maximum of the constant radial growth increment for the 

species of tree to which it is being applied. The increment is calculated as described in the 

"Constant radial growth" behavior. Note that the increment parameter specifies radial growth; 

the behavior makes all necessary conversions.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 



Behavior reference string: relradial diam only  

Relative growth limited to basal area increment - diam with 

auto height 

How it works 

This behavior calculates an amount of diameter growth according to the relative growth 

equation. Growth is limited to a maximum of a constant basal area increment. The amount of 

diameter increase is calculated by dividing the annual basal area increment of the tree's species 

by the diameter of the tree. The increment is calculated as described in the "Constant basal area 

growth" behavior. Tree height is allowed to update automatically according to the allometry 

equations. 

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: relba  

Relative growth limited to basal area increment - diam only 

How it works 

This behavior calculates an amount of diameter growth according to the relative growth 

equation. Growth is limited to a maximum of a constant basal area increment. The amount of 

diameter increase is calculated by dividing the annual basal area increment of the tree's species 

by the diameter of the tree. The increment is calculated as described in the "Constant basal area 

growth" behavior. 

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 

Behavior reference string: relba diam only  

Non-limited relative growth - diam with auto height 

How it works 



The amount of increase returned by the relative growth equation is applied to the tree. Tree 

height is allowed to update automatically according to the allometry equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: relunlim  

Non-limited relative growth - diam only 

How it works 

The amount of increase returned by the relative growth equation is applied to the tree.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 

Behavior reference string: relunlim diam only  

Relative growth - height only 

This behavior uses the Michaelis-Menton function to do height growth.  

How it works 

After the Michaelis-Menton function is used to calculate Y as described in the section above, the 

amount of height growth is calculated as:  

G = Y * Height 
X
 

where:  

 G is the amount of height growth for one year, in cm 

 Height is the height of the tree in cm 

 X is the Relative Michaelis-Menton Growth - Height Exponent parameter 

If the timestep is more than one year long, growth is recalculated for each year of the timestep, 

increasing the height each time.  

How to apply it 



This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter 

growth behavior applied. 

Behavior reference string: relative michaelis-menton height growth  

Allometric diameter and height growth 

How it works 

These behaviors are designed to be secondary growth behaviors. If you have a behavior that 

primarily updates one tree dimension (diameter or height), one of these behaviors can be used on 

the other dimension to ensure even growth. These behaviors calculate a growth amount based on 

the allometry equations. The amount of growth is:  

Y = f(Xt+1) - f(Xt) 

where Y is the amount of growth calculated by this behavior, f(X) is the allometry equation 

relating diameter and height, X t is the other tree dimension (either height or diameter) before the 

primary growth is applied, and X t+1 is the other tree dimension after primary growth is applied. 

The allometric diameter growth behavior can be paired with any height-only growth behavior, 

and the allometric height growth behavior can be paired with any diam-only growth behavior.  

How to apply it 

These behaviors can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a growth behavior applied that 

grows the opposite tree dimension.  

Behavior reference string: diameter incrementer and height incrementer  

Double resource relative growth - diam with auto height 

This behavior uses a double Michaelis-Menton function to calculate relative growth based on 

two resources: light and a second resource. The identity of the second resource is unimportant 

and could be anything, from exchangeable calcium levels to soil moisture. Relative growth is 

calculated with the equation: 

 
 

where:  



 Y is the amount of annual relative growth 

 A is the Asymptotic Diameter Growth (A) parameter 

 S is the Slope of Growth Response (S) parameter 

 C is the Double resource - Influence of Resource (C) parameter, in units appropriate to 

the value of R 

 R is the amount of the second resource, in units appropriate to the value of C 

 GLI is the global light index, calculated by a light behavior 

Growth is compounded over multiple timesteps with the equation: 

G = ((Y + 1)
T
 - 1) * diam 

where:  

 G is the amount of diameter growth for the timestep, in cm 

 diam is the diameter of the tree in cm (at 10 cm height if seedling or sapling, or DBH if 

adult) 

 T is the number of years per timestep 

Note that setting the C parameter in the equation above to 0 eliminates the second resource and 

makes this equivalent to the "Non-limited relative growth" behavior.  

How it works 

The amount of the second resource is captured in a grid object called Resource. Currently it is up 

to you to enter a map of the values for this resource grid; for instructions on how to do this, see 

the Grid Setup Window topic. This behavior does not in any way alter the values in this grid.  

Once growth has been calculated and applied to the tree's diameter, tree height is allowed to 

update automatically according to the allometry equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. You 

must also enter a map of second resource values into the Resource grid.  

Behavior reference string: Double resource relative growth - diam with auto height  

Double resource relative growth - diam only 

How it works 

This behavior calculates growth exactly like the "Double resource relative growth - diam with 

auto height" behavior. Height is updated separately using another behavior.  



How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. You must also enter a map of second resource values into 

the Resource grid.  

Behavior reference string: Double resource relative growth - diam only  

Absolute growth behaviors 

Several behaviors apply an absolute growth version of the Michaelis-Menton function. Absolute 

growth is calculated with the equation: 

 
 

where  

 Y = log10(radial growth + 1) 

 SF is the suppression factor 

 A is the Asymptotic Diameter Growth (A) parameter  

 S is the Slope of Growth Response (S) parameter  

 GLI is the global light index, calculated by a light behavior 

Amount of diameter growth per timestep is calculated as  

growth = (((10
Y
 - 1) * 2 )/ 10) * T 

 

where T is the number of years per timestep.  

The absolute growth behaviors also take into account suppression status. A tree is considered 

suppressed if its growth rate for the previous timestep falls below a certain threshold. That 

threshold is the rate of growth at which X% of juveniles die, where X is a user-settable 

parameter. The threshold is calculated for each species by solving the BC mortality equation for 

G (growth), where m is the threshold growth rate.  

A tree's suppression state is a multiplicative factor in its growth rate. If a tree is not suppressed, 

the suppression factor in the growth equation is set to 1 (no effect on growth). If the tree is 

suppressed, the suppression factor is calculated as follows: 

SF = e
((g*YLR) - (d*YLS))

 

 

where:  



 SF is the suppression factor 

 g is the Length of Current Release Factor parameter 

 YLR is the length of the last (or current) period of release, in years 

 d is the Length of Last Suppression Factor parameter 

 YLS is the length of the last (or current) period of suppression, in years 

Details of this model are published in Wright et al 2000.  

Absolute growth limited to radial increment - diam with 

auto height 

How it works 

This behavior calculates an amount of diameter growth according to the absolute growth 

equation. Growth is limited to a maximum of the constant radial increment for the species of tree 

to which it is being applied. The increment is calculated as described in the "Constant radial 

growth" behavior. Tree height is allowed to update automatically according to the allometry 

equations. Note that the increment parameter specifies radial growth; the behavior makes all 

necessary conversions. 

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: absradial  

Absolute growth limited to radial increment - diam only 

How it works 

This behavior calculates an amount of diameter growth according to the absolute growth 

equation. Growth is limited to a maximum of the constant radial increment for the species of tree 

to which it is being applied. The increment is calculated as described in the "Constant radial 

growth" behavior. Note that the increment parameter specifies radial growth; the behavior 

makes all necessary conversions. 

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 

Behavior reference string: absradial diam only  



Absolute growth limited to basal area increment - diam with 

auto height 

How it works 

This behavior calculates an amount of diameter growth according to the absolute growth 

equation. Growth is limited to a maximum of a constant basal area increment. The amount of 

diameter increase is calculated by dividing the annual basal area increment of the tree's species 

by the diameter of the tree. The increment is calculated as described in the "Constant basal area 

growth" behavior. Tree height is allowed to update automatically according to the allometry 

equations. 

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: absba  

Absolute growth limited to basal area increment - diam only 

How it works 

This behavior calculates an amount of diameter growth according to the absolute growth 

equation. Growth is limited to a maximum of a constant basal area increment. The amount of 

diameter increase is calculated by dividing the annual basal area increment of the tree's species 

by the diameter of the tree. The increment is calculated as described in the "Constant basal area 

growth" behavior. 

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 

Behavior reference string: absba diam only  

Non-limited absolute growth - diam with auto height 

How it works 

The amount of diameter increase returned by the absolute growth equation is applied to the tree. 

Tree height is allowed to update automatically according to the allometry equations.  



How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: absunlim  

Non-limited absolute growth - diam only 

How it works 

The amount of diameter increase returned by the absolute growth equation is applied to the tree.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 

Behavior reference string: absunlim diam only  

Constant basal area growth - diam with auto height 

How it works 

The amount of diameter increase is calculated from a constant basal area increment. The increase 

is calculated as follows: 

Y = (g / diam) * 100 * T 

where  

 Y is the amount of diameter increase, in cm  

 g is the Adult Constant Area Growth in sq. cm/yr parameter  

 diam is the tree's diameter, in cm  

 T is the number of years per timestep  

Tree height is allowed to update automatically according to the allometry equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: constbagrowth  



Constant basal area growth - diam only 

How it works 

The amount of diameter increase is calculated from a constant basal area increment. The increase 

is calculated as follows: 

Y = (g / diam) * 100 * T 

where  

 Y is the amount of diameter increase, in cm  

 g is the Adult Constant Area Growth in sq. cm/yr parameter  

 diam is the tree's diameter, in cm  

 T is the number of years per timestep  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 

Behavior reference string: constbagrowth diam only  

Constant radial growth - diam with auto height 

How it works 

The amount of diameter increase is calculated from the constant radial increment. The increase is 

calculated as follows:  

Y = (g4 / 10) * 2 * T 

where  

 Y is the amount of diameter growth, in cm, to add to the tree  

 g4 is the Adult Constant Radial Growth in mm/yr parameter  

 T is the number of years per timestep  

Tree height is allowed to update automatically according to the allometry equations. Note that 

the increment parameter specifies radial growth; the behavior makes all necessary conversions 

to diameter growth.  

How to apply it 



This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied. 

Behavior reference string: constradialgrowth  

Constant radial growth - diam only 

How it works 

The amount of diameter increase is calculated from the constant radial increment. The increase is 

calculated as follows: 

Y = (g4 / 10) * 2 * T 

where  

 Y is the amount of diameter growth, in cm, to add to the tree  

 g4 is the Adult Constant Radial Growth in mm/yr parameter  

 T is the number of years per timestep  

Note that the increment parameter specifies radial growth; the behavior makes all necessary 

conversions to diameter growth.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-

incrementing growth behavior applied. 

Behavior reference string: constradialgrowth diam only  

NCI growth - diam with auto height 

This behavior uses the effects of neighbor competitiveness to influence growth rates ("NCI" 

stands for neighborhood competition index). A tree's maximum potential growth rate is reduced 

due to competitiveness and several other possible factors. You can use certain parameter values 

to turn these influences on and off to reflect the conditions appropriate for your run.  

How it works 

For a tree, the amount of growth per year is calculated as:  

 

Growth = Max Growth * Size Effect * Shading Effect * Crowding Effect * Damage Effect 

 



Max Growth is the maximum diameter growth the tree can attain, in cm/yr, entered in the NCI 

Maximum Potential Growth, cm/yr parameter. Size Effect, Shading Effect, Crowding Effect, 

and Damage Effect are all optional factors which act to reduce the maximum growth rate and 

will vary depending on the conditions a tree is in. Each of these effects is a value between 0 and 

1.  

Size Effect is calculated as:  

 

where:  

 DBH is of the target tree, in cm 

 X0 is the NCI Size Effect Mode, in cm (X0) parameter 

 Xb is the NCI Size Effect Variance, in cm (Xb) 

Shading Effect is calculated as:  

 

where:  

 m is the NCI Shading Effect Coefficient (m) parameter 

 n is the NCI Shading Effect Exponent (n) parameter 

 S is the amount of shade cast by neighbors, from 0 (no shade) to 1 (full shade). This value 

should come from the Sail light behavior. 

This effect is not required. To omit the Shading Effect, set the NCI Shading Effect Coefficient 

(m) parameter to 0.  

Crowding Effect is calculated as:  

 

where:  

 C is the NCI Crowding Effect Slope (C) parameter 

 DBH is of the target tree, in cm 

 γ is the NCI Size Sensitivity to NCI (gamma) parameter for the target tree's species 

 D is the NCI Crowding Effect Steepness (D) parameter 

 NCI is this tree's NCI value (equation below) 



The NCI value sums up the competitive effect of all neighbors with a DBH at least that of the 

NCI Minimum Neighbor DBH, in cm parameter, out to a maximum distance set in the NCI 

Max Radius of Crowding Neighbors, in m parameter. The competitiveness of a neighbor 

increases with the neighbor's size and decreases with distance and storm damage to the neighbor 

(optional). The neighbor's species also matters; the effect depends on the relationship between 

the target species and the neighbor species. Seedlings never compete. You set whether or not 

snags compete in the Include Snags in NCI Calculations parameter.  

The crowding effect is optional. You can omit it by setting either the NCI Crowding Effect 

Slope (C) or NCI Max Radius of Crowding Neighbors, in m parameters to 0.  

NCI is calculated as:  

 

where:  

 the calculation sums over j = 1...S species and k = 1...N neighbors of each species of at 

least a DBH of NCI Minimum Neighbor DBH, in cm, out to a distance of NCI Max 

Radius of Crowding Neighbors, in m 
 εk is the storm damage parameter of the kth neighbor, depending on the damage status 

(optional). If the neighbor is undamaged, the value is 1. If the neighbor has medium 

damage, the value is the NCI Neighbor Storm Damage (eta) - Medium (0-1) parameter 

for the target species. If the neighbor has complete damage, the value is the NCI 

Neighbor Storm Damage (eta) - Complete (0-1) parameter for the target species. To 

omit the storm damage term, set all values for the above two parameters to 1. 

 α is the NCI Alpha parameter for the target tree's species 

 β is the NCI Beta parameter for the target tree's species 

 DBHjk is the DBH of the kth neighbor, in cm 

 q is the NCI DBH Divisor (q) parameter. Set this to a value greater than 1 to rescale the 

competitive effects of neighbors 

 ιik is the Species j NCI Lambda parameter for the target species relative to the kth 

neighbor's species  

 distanceik is distance from target to neighbor, in m 

The value of Damage Effect is optional. If you elect not to use storms in your run, set all values 

in the NCI Damage Effect - Medium Storm Damage (0-1) and NCI Damage Effect - 

Complete Storm Damage (0-1) parameters to 1. If you are using storms, then the value of 

Damage Effect depends on the tree's damage category. If the tree is undamaged, Damage Effect 

equals 1. If the tree has medium storm damage, the value is the NCI Damage Effect - Medium 

Storm Damage (0-1) parameter. If the tree has complete storm damage, the value is the NCI 

Damage Effect - Complete Storm Damage (0-1) parameter.  



The amount of growth is in cm/year. For multi-year timesteps, the behavior will calculate total 

growth with a loop. Each loop iteration will increment DBH for one year. For each year, any 

portion of the growth equation with DBH as a term is recalculated with the previous year's 

updated DBH value.  

The final total growth amount is added to the tree's DBH. Height is calculated according to the 

appropriate allometric equation.  

How to apply it 

This behavior can be applied to saplings and adults of any species. It cannot be applied to 

seedlings.  

If the Shading Effect term is activated in the growth equation, then the trees to which this 

behavior is applied must also have a light behavior applied - the Sail light behavior is the one 

designed to work with the NCI behavior. The use of any other light behavior is at your own risk.  

If any storm damage parameters are set to anything other than 1, it is recommended (but not 

required) that you have the Storm damage applier behavior applied.  

Behavior reference string: ncigrowth  

NCI growth - diam only 

This behavior works exactly like the "NCI growth - diam with auto height" behavior to calculate 

an amount of diameter increase. 

How to apply it 

This behavior can be applied to saplings and adults of any species. It cannot be applied to 

seedlings.  

If the Shading Effect term is activated in the growth equation, then the trees to which this 

behavior is applied must also have a light behavior applied - the Sail light behavior is the one 

designed to work with the NCI behavior. The use of any other light behavior is at your own risk.  

If any storm damage parameters are set to anything other than 1, it is recommended (but not 

required) that you have the Storm damage applier behavior applied.  

Behavior reference string: ncigrowth diam only  

Basal area NCI growth - diam with auto height 

This behavior uses the effects of neighbor competitiveness to influence growth rates ("NCI" 

stands for neighborhood competition index). In this case, the NCI is based on the basal area of 



neighboring trees. A tree's maximum potential growth rate is reduced due to competitiveness and 

several other possible factors.  

How it works 

For a tree, the amount of growth per year is calculated as:  

Growth = Max Growth * Size Effect * Crowding Effect 

Max Growth is the maximum diameter growth the tree can attain, in cm/yr, entered in the NCI 

Maximum Potential Growth, cm/yr parameter. Size Effect and Crowding Effect are factors 

which act to reduce the maximum growth rate and will vary depending on the conditions a tree is 

in. Each of these effects is a value between 0 and 1.  

Size Effect is calculated as:  

 

where:  

 DBH is of the target tree, in cm 

 X0 is the NCI Size Effect Mode, in cm (X0) parameter 

 Xb is the NCI Size Effect Variance, in cm (Xb) 

Crowding Effect is calculated as:  

CE = exp(-C * (DBH 
γ
 * BAn / BADiv) 

D
) 

where:  

 C is the NCI Crowding Effect Slope (C) parameter 

 DBH is of the target tree, in cm 

 γ is the NCI Size Sensitivity to NCI (gamma) parameter for the target tree's species 

 D is the NCI Crowding Effect Steepness (D) parameter 

 BAn is the sum of the basal areas, in square cm, of eligible neighbors 

 BADiv is the Basal Area NCI - BA Divisor parameter 

When calculating BAn, this behavior uses neighbors of all species out to the distance set in the 

NCI Max Radius of Crowding Neighbors, in m parameter. The neighbors must have a DBH 

larger than the values set in the NCI Minimum Neighbor DBH, in cm parameter. If the Basal 

Area NCI - Use Only Larger Neighbors parameter is set to true, they must also have a DBH 

larger than the target tree's DBH. Seedlings and snags never contribute to BAn.  



The amount of growth is in cm/year. For multi-year timesteps, the behavior will calculate total 

growth with a loop. Each loop iteration will increment DBH for one year. For each year, any 

portion of the growth equation with DBH as a term is recalculated with the previous year's 

updated DBH value.  

The final total growth amount is added to the tree's DBH. Height is calculated according to the 

appropriate allometric equation.  

How to apply it 

This behavior can be applied to saplings and adults of any species. It cannot be applied to 

seedlings.  

Behavior reference string: ncibagrowth  

Basal area NCI growth - diam only 

This behavior works exactly like the "Basal area NCI growth - diam with auto height" behavior 

to calculate an amount of diameter increase. 

How to apply it 

This behavior can be applied to saplings and adults of any species. It cannot be applied to 

seedlings.  

Behavior reference string: ncibagrowth diam only  

Linear growth - height only 

How it works 

This behavior calculates an amount of height growth as:  

Y = (a + (b * GLI)) * T 

where  

 Y = amount of height increase, in cm  

 a = Simple Linear - Height Intercept in cm/yr (a) parameter  

 b = Simple Linear - Height Slope (b) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

How to apply it 



This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter-

only growth behavior applied.  

Behavior reference string: simple linear growth height only  

Linear growth - diam with auto height 

How it works 

This behavior calculates an amount of diameter growth as:  

Y = (a + (b * GLI)) * T 

where  

 Y = amount of diameter increase, in mm  

 a = Simple Linear - Diam Intercept in mm/yr (a) parameter  

 b = Simple Linear - Diam Slope (b) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

After applying the amount of diameter increase, tree height is allowed to update automatically 

according to the allometry equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied.  

Behavior reference string: simple linear growth  

Linear growth - diam only 

How it works 

This behavior calculates an amount of diameter growth as:  

Y = (a + (b * GLI)) * T 

where  

 Y = amount of diameter increase, in mm  

 a = Simple Linear - Diam Intercept in mm/yr (a) parameter  



 b = Simple Linear - Diam Slope (b) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-only 

growth behavior applied.  

Behavior reference string: simple linear growth diam only  

Linear growth w/ exponential shade reduction - height only 

How it works 

This behavior calculates an amount of height growth as:  

Y = (a + (b * diam)) * (GLI/100)
c
 * T 

where  

 Y = amount of height increase, in cm  

 a = Shaded Linear - Height Intercept in cm/yr (a) parameter  

 b = Shaded Linear - Height Slope (b) parameter  

 c = Shaded Linear - Height Shade Exponent (c) parameter  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

In order to find the total amount of height increase for a timestep, the behavior takes as an input 

the amount of diameter growth increase. Assume that the number of years per timestep is X. The 

amount of diameter increase is divided by X. Then the logistic growth equation is calculated X 

times, with the diameter incremented by the amount of diameter increase per timestep each time. 

The total height increment is the sum of the X individual height increments.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter-

only growth behavior applied.  

Behavior reference string: shaded linear growth height  



Linear growth w/ exponential shade reduction - diam with 

auto height 

How it works 

This behavior calculates an amount of diameter growth as:  

Y = (a + (b * diam)) * (GLI/100)
c
 * T 

where  

 Y = amount of diameter increase, in mm  

 a = Shaded Linear - Diam Intercept in mm/yr (a) parameter  

 b = Shaded Linear - Diam Slope (b) parameter  

 c = Shaded Linear - Diam Shade Exponent (c) parameter  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

After applying the amount of diameter increase, tree height is allowed to update automatically 

according to the allometry equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied.  

Behavior reference string: shaded linear growth  

Linear growth w/ exponential shade reduction - diam only 

How it works 

This behavior calculates an amount of diameter growth as:  

Y = (a + (b * diam)) * (GLI/100)
c
 * T 

where  

 Y = amount of diameter increase, in mm  

 a = Shaded Linear - Diam Intercept in mm/yr (a) parameter  

 b = Shaded Linear - Diam Slope (b) parameter  

 c = Shaded Linear - Diam Shade Exponent (c) parameter  



 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-only 

growth behavior applied.  

Behavior reference string: shaded linear growth diam only  

Logistic growth - height only 

How it works 

The amount of height increase is calculated as:  

 

where  

 Y = amount of height increase, in cm  

 a = Logistic - Asymptotic Height Growth - Full Light in cm/yr (a)  

 b = Logistic - Height Shape Param 1 (b) parameter  

 c = Logistic - Height Shape Param 2 (c) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter-

only growth behavior applied.  

Behavior reference string: logistic growth height only  

Logistic growth - diam with auto height 

How it works 



The amount of diameter increase is calculated as:  

 

where  

 Y = amount of diameter increase, in mm  

 a = Logistic - Asymptotic Diam Growth - Full Light in mm/yr (a) parameter  

 b = Logistic - Diam Shape Param 1 (b) parameter  

 c = Logistic - Diam Shape Param 2 (c) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  

After applying the amount of diameter increase, tree height is allowed to update automatically 

according to the allometry equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied.  

Behavior reference string: logistic growth  

Logistic growth - diam only 

How it works 

The amount of diameter increase is calculated as:  

 

where  

 Y = amount of diameter increase, in mm  

 a = Logistic - Asymptotic Diam Growth - Full Light in mm/yr (a) parameter  

 b = Logistic - Diam Shape Param 1 (b) parameter  

 c = Logistic - Diam Shape Param 2 (c) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 T = number of years per timestep  



How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-only 

growth behavior applied.  

Behavior reference string: logistic growth diam only  

Logistic growth w/ size dependent asymptote - height only 

How it works 

This behavior calculates annual height increases as:  

 

where  

 Y = amount of height increase, in cm  

 a = Size Dep. Logistic - Height Intercept (a) parameter  

 b = Size Dep. Logistic - Height Slope (b) parameter  

 c = Size Dep. Logistic - Height Shape Param 1 (c) parameter  

 d = Size Dep. Logistic - Height Shape Param 2 (d) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

In order to find the total amount of height increase for a timestep, the behavior takes as an input 

the amount of diameter growth increase. Assume that the number of years per timestep is X. The 

amount of diameter increase is divided by X. Then the logistic growth equation is calculated X 

times, with the diameter incremented by the amount of diameter increase per timestep each time. 

The total height increment is the sum of the X individual height increments.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter-

only growth behavior applied.  

Behavior reference string: size dependent logistic growth height  

Logistic growth w/ size dependent asymptote - diam with 

auto height 



How it works 

This behavior calculates annual diameter increases as:  

 

where  

 Y = amount of diameter increase, in mm  

 a = Size Dep. Logistic - Diam Intercept (a) parameter  

 b = Size Dep. Logistic - Diam Slope (b) parameter  

 c = Size Dep. Logistic - Diam Shape Param 1 (c) parameter  

 d = Size Dep. Logistic - Diam Shape Param 2 (d) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

Assume that the number of years per timestep is X. In order to find the total amount of diameter 

increase for a timestep, the logistic growth equation is calculated X times, with the diameter 

incremented by the amount of diameter increase for the previous year. The total diameter 

increment is the sum of the X individual diameter increments. After applying the amount of 

diameter increase, tree height is allowed to update automatically according to the allometry 

equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied.  

Behavior reference string: size dependent logistic growth  

Logistic growth w/ size dependent asymptote - diam only 

How it works 

This behavior calculates annual diameter increases as:  

 

where  

 Y = amount of diameter increase, in mm  



 a = Size Dep. Logistic - Diam Intercept (a) parameter  

 b = Size Dep. Logistic - Diam Slope (b) parameter  

 c = Size Dep. Logistic - Diam Shape Param 1 (c) parameter  

 d = Size Dep. Logistic - Diam Shape Param 2 (d) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

Assume that the number of years per timestep is X. In order to find the total amount of diameter 

increase for a timestep, the logistic growth equation is calculated X times, with the diameter 

incremented by the amount of diameter increase for the previous year. The total diameter 

increment is the sum of the X individual diameter increments.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-only 

growth behavior applied.  

Behavior reference string: size dependent logistic growth diam only  

Lognormal with exponential shade reduction - height only 

How it works 

This behavior calculates annual height increases as:  

 

where  

 Y = amount of height increase, in cm  

 a = Lognormal - Height Growth Increment at Diam 36, in cm/yr (a) parameter  

 b = Lognormal - Height Shape Parameter (b) parameter  

 c = Lognormal - Height Effect of Shade (c) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

In order to find the total amount of height increase for a timestep, the behavior takes as an input 

the amount of diameter growth increase. Assume that the number of years per timestep is X. The 

amount of diameter increase is divided by X. Then the lognormal growth equation is calculated 



X times, with the diameter incremented by the amount of diameter increase per timestep each 

time. The total height increment is the sum of the X individual height increments.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter-

only growth behavior applied.  

Behavior reference string: lognormal growth height only  

Lognormal with exponential shade reduction - diam with 

auto height 

How it works 

This behavior calculates annual height increases as:  

 

where  

 Y = amount of height increase, in cm  

 a = Lognormal - Diam Growth Increment at Diam 36, in mm/yr (a) parameter  

 b = Lognormal - Diam Shape Parameter (b) parameter  

 c = Lognormal - Diam Effect of Shade (c) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

Assume that the number of years per timestep is X. In order to find the total amount of diameter 

increase for a timestep, the lognormal growth equation is calculated X times, with the diameter 

incremented by the amount of diameter increase for the previous year. The total diameter 

increment is the sum of the X individual diameter increments. After applying the amount of 

diameter increase, tree height is allowed to update automatically according to the allometry 

equations.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior applied.  



Behavior reference string: lognormal growth  

Lognormal with exponential shade reduction - diam only 

How it works 

This behavior calculates annual height increases as:  

 

where  

 Y = amount of height increase, in cm  

 a = Lognormal - Diam Growth Increment at Diam 36, in mm/yr (a) parameter  

 b = Lognormal - Diam Shape Parameter (b) parameter  

 c = Lognormal - Diam Effect of Shade (c) parameter  

 GLI = global light index, as a percentage between 0 and 100, calculated by a light 

behavior  

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults)  

Assume that the number of years per timestep is X. In order to find the total amount of diameter 

increase for a timestep, the lognormal growth equation is calculated X times, with the diameter 

incremented by the amount of diameter increase for the previous year. The total diameter 

increment is the sum of the X individual diameter increments.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a height-only 

growth behavior applied.  

Behavior reference string: lognormal growth diam only  

Stochastic Gap Growth 

This behavior uses a shortcut for simulating gap dynamics with very competitive conditions. 

This behavior causes rapid growth in high light, with a unique "winner"; low light produces no 

growth at all.  

How it works 



This behavior simulates high growth in gap conditions. It relies on the Gap Light grid created by 

the Gap Light behavior to tell it where the gaps are. In this grid, each cell is either in gap (with 

100% GLI) or not in gap (with 0% GLI). If a cell is in gap, a tree in that cell is randomly chosen 

out of all the trees to which the behavior applies to be promoted directly to adult tree status (even 

if it is a seedling). This tree represents the "winner". All other trees in the cell do not grow. In 

cells that are not in gap, no trees grow.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have the Gap Light behavior applied.  

Behavior reference string: Stochastic Gap Growth  

Linear bi-level growth - diam with auto height 

This behavior increments growth according to a simple linear equation, with the possibility of 

two sets of parameters for each species: one for high-light conditions and one for low-light 

conditions. This can also be used alone without the light levels.  

How it works 

The equation used by this behavior to increment growth is:  

Y = (a + b * diam) * T 

where  

 Y = amount of diameter growth in cm 

 a = growth intercept; in high-light conditions, this is the Linear Bi-Level - Intercept for 

High-Light Growth (a) parameter; in low-light conditions, this is the Linear Bi-Level - 

Intercept for Low-Light Growth (a) parameter 

 b = growth slope; in high-light conditions, this is the Linear Bi-Level - Slope for High-

Light Growth (b) parameter; in low-light conditions, this is the Linear Bi-Level - Slope 

for Low-Light Growth (b) parameter 

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults) 

 T = number of years per timestep 

Light levels come from the Storm Light grid produced by the Storm Light behavior. The 

threshold between the use of high-light and low-light parameters is set in the Linear Bi-Level - 

Threshold for High-Light Growth (0 - 100) parameter.  

This behavior can also be used without Storm Light. In this case, only the low-light growth 

parameters are used.  



How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. If you wish to use 

the light-level parameter switch, also use the Storm Light behavior.  

Behavior reference string: linear bilevel growth  

Linear bi-level growth - diam only 

This behavior increments growth according to a simple linear equation, with the possibility of 

two sets of parameters for each species: one for high-light conditions and one for low-light 

conditions. This can also be used alone without the light levels.  

How it works 

The equation used by this behavior to increment growth is:  

Y = (a + b * diam) * T 

where  

 Y = amount of diameter growth in cm 

 a = growth intercept; in high-light conditions, this is the Linear Bi-Level - Intercept for 

High-Light Growth (a) parameter; in low-light conditions, this is the Linear Bi-Level - 

Intercept for Low-Light Growth (a) parameter 

 b = growth slope; in high-light conditions, this is the Linear Bi-Level - Slope for High-

Light Growth (b) parameter; in low-light conditions, this is the Linear Bi-Level - Slope 

for Low-Light Growth (b) parameter 

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults) 

 T = number of years per timestep 

Light levels come from the Storm Light grid produced by the Storm Light behavior. The 

threshold between the use of high-light and low-light parameters is set in the Linear Bi-Level - 

Threshold for High-Light Growth (0 - 100) parameter.  

This behavior can also be used without Storm Light. In this case, only the low-light growth 

parameters are used.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a height-only growth behavior 

applied. If you wish to use the light-level parameter switch, also use the Storm Light behavior.  

Behavior reference string: linear bilevel growth diam only  



Lognormal bi-level growth - height only 

This behavior increments growth according to a simple linear equation, with the possibility of 

two sets of parameters for each species: one for high-light conditions and one for low-light 

conditions. This can also be used alone without the light levels.  

How it works 

The equation used by this behavior to increment growth is:  

 

where  

 Y - amount of height growth in m 

 MG - maximum growth, in meters; in high-light conditions, this is the Lognormal Bi-

Level - Max Growth in High Light (m) parameter; in low-light conditions, this is the 

Lognormal Bi-Level - Max Growth in Low Light (m) parameter 

 X0 - in high-light conditions, this is the Lognormal Bi-Level - X0 for High-Light 

Growth parameter; in low-light conditions, this is the Lognormal Bi-Level - X0 for 

Low-Light Growth parameter 

 Xb - in high-light conditions, this is the Lognormal Bi-Level - Xb for High-Light 

Growth parameter; in low-light conditions, this is the Lognormal Bi-Level - Xb for 

Low-Light Growth parameter 

 H - tree height in meters 

 T - number of years per timestep 

Light levels come from the Storm Light grid produced by the Storm Light behavior. The 

threshold between the use of high-light and low-light parameters is set in the Lognormal Bi-

Level - Threshold for High-Light Growth (0 - 100) parameter.  

This behavior can also be used without Storm Light. In this case, only the low-light growth 

parameters are used.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a diam-only growth behavior 

applied. If you wish to use the light-level parameter switch, also use the Storm Light behavior.  

Behavior reference string: log bilevel growth height only  



Puerto Rico semi-stochastic - diam only 

This behavior combines a deterministic growth function for small trees with completely 

stochastic growth for larger trees. It's meant to be used when a species uses a height growth 

behavior as the primary growth method.  

How it works 

The divide between the two growth functions is defined in the PR - Height Threshold for 

Stochastic Growth (m) parameter. Trees shorter than this use the following function:  

Y = (A * exp(-B * Height)) - Diam 

where:  

 Y = diameter growth for the timestep, in cm 

 a = PR - "a" Parameter for Deterministic Growth parameter 

 b = PR - "b" Parameter for Deterministic Growth parameter 

 Height = tree height in cm AFTER height growth in the current timestep 

 diam = diameter of the tree at which to apply growth (before growth), in cm 

Above the height cutoff, trees are assigned random diameters drawn from a normal distribution. 

The normal distribution is defined by the PR - Mean DBH (cm) for Stochastic Growth and PR 

- DBH Standard Deviation for Stochastic Growth parameters, and represents the distribution 

of DBH values, NOT growth values. The amount of growth for a tree is Y = D' - D, where Y is 

the amount of growth, D' is the new diameter chosen from the normal distribution, and D is the 

previous diameter. This means that growth can be negative. The effect is to create a tree 

population with normally-distributed diameters, where any individual tree may jump from place 

to place within the distribution.  

How to apply it 

This function can be applied to seedlings, saplings, or adults of any species. Any tree using this 

behavior must also use a height-only growth behavior.  

Behavior reference string: PR semi-stochastic diam only  

Puerto Rico storm bi-level growth - diam with auto height 

This behavior increments growth according to two possible growth equations, one to be used in 

low-light conditions and the other to be used in high-light conditions. This behavior was 

originally created for the Puerto Rico model.  

How it works 



Light levels come from the Storm Light grid produced by the Storm Light behavior. The 

threshold between the use of the high-light and low-light functions is set in the PR Storm Bi-

Level - Threshold for High-Light Growth (0 - 100) parameter.  

The function used in low-light conditions is:  

Y = (a + b * diam) * T 

where  

 Y = amount of diameter growth in cm 

 a = PR Storm Bi-Level - Intercept for Low-Light Growth (a) parameter 

 b = PR Storm Bi-Level - Slope for Low-Light Growth (b) parameter 

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults) 

 T = number of years per timestep 

The function used in high-light conditions is:  

H = T * a * diam * e
(-b * N)

 

where  

 H = amount of height growth, in cm 

 a = PR Storm Bi-Level - High-Light "a" parameter 

 b = PR Storm Bi-Level - High-Light "b" parameter 

 diam = diameter (diameter at 10 cm for seedlings and saplings, DBH for adults) 

 N = number of years since the last storm, from the Storm Damage grid produced by the 

Storm disturbance behavior 

 T = number of years per timestep 

H is expressed in centimeters of height growth. This is transformed into a number of cm of 

diameter growth, which is what this behavior passes along. This means that during tree life 

history stage transitions, the height the tree ends up with is not guaranteed to match the height 

calculated by the high-light growth function.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. You must also use 

the Storm disturbance and Storm Light behaviors.  

Behavior reference string: PR storm bilevel growth  

Browsed relative growth behavior - diam with auto height 

This behavior simulates herbivory by allowing trees to grow at different rates when browsed 

versus unbrowsed.  



How it works 

Trees grow according to the relative growth version of the Michaelis-Menton function. The same 

function is used for both browsed and unbrowsed trees, but the parameters are different. The 

function is: 

 

where:  

 Y is the amount of annual relative growth 

 A is the Asymptotic Diameter Growth (A) or Browsed Asymptotic Diameter Growth 

(A) parameter 

 S is the Slope of Growth Response (S) or Browsed Slope of Growth Response (S) 

parameter 

 GLI is the global light index, calculated by a light behavior 

Growth is compounded over multiple timesteps with the equation: 

G = ((Y + 1)
T
 - 1) * diam 

X
 

where:  

 G is the amount of diameter growth for the timestep, in cm 

 diam is the diameter of the tree in cm (at 10 cm height if seedling or sapling, or DBH if 

adult) 

 T is the number of years per timestep 

 X is the Relative Michaelis-Menton Growth - Diameter Exponent or Browsed 

Diameter Exponent parameter 

Whether or not a tree is browsed is determined by the Random browse behavior.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and the Random 

browse behavior applied.  

Behavior reference string: browsed relative growth  

Browsed relative growth behavior - diam only 



This behavior works exactly like the "Browsed relative growth behavior - diam with auto height" 

behavior to calculate an amount of diameter growth.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and the Random 

browse behavior applied. 

Behavior reference string: browsed relative growth diam only  

Michaelis Menton with negative growth - height only 

This behavior uses a modified Michaelis-Menton function to do height growth.  

How it works 

The amount of height growth is calculated as:  

 

where:  

 Y is the amount of height growth for one year, in cm 

 GLI is the light level 

 α is the Michaelis-Menton with Negative Growth - Alpha parameter 

 β is the Michaelis-Menton with Negative Growth - Beta parameter 

 γ is the Michaelis-Menton with Negative Growth - Gamma parameter 

 υ is the Michaelis-Menton with Negative Growth - Phi parameter 

 H is the tree's height in cm 

If the timestep is more than one year long, growth is recalculated for each year of the timestep, 

increasing the height each time.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter 

growth behavior applied. 

Behavior reference string: Michaelis Menten negative growth height only  

Michaelis Menton with photoinhibition - height only 



This behavior uses a modified Michaelis-Menton function to do height growth.  

How it works 

The amount of height growth is calculated as:  

 

where:  

 Y is the amount of height growth for one year, in cm 

 GLI is the light level 

 α is the Michaelis-Menton with Photoinhibition - Alpha parameter 

 β is the Michaelis-Menton with Photoinhibition - Beta parameter 

 D is the Michaelis-Menton with Photoinhibition - D parameter 

 υ is the Michaelis-Menton with Photoinhibition - Phi parameter 

 H is the tree's height in cm 

If the timestep is more than one year long, growth is recalculated for each year of the timestep, 

increasing the height each time.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a light behavior and a diameter 

growth behavior applied. 

Behavior reference string: Michaelis Menten photoinhibition growth height only  

Power growth - height only 

This behavior uses a power function to do height growth.  

How it works 

The amount of height growth is calculated as:  

Y = n H
 υ

 

where:  



 Y is the amount of height growth for one year, in cm 

 n is the Power Height Growth - n parameter 

 υ is the Power Height Growth - Exp parameter 

 H is the tree's height in cm 

If the timestep is more than one year long, growth is recalculated for each year of the timestep, 

increasing the height each time.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a diameter growth behavior 

applied. 

Behavior reference string: power growth height only  

Lagged post harvest growth 

This behavior increments growth as a function of DBH and neighboring basal area, and 

incorporates a lag period after harvesting during which trees acclimate to their post-harvest 

growing conditions. 

How it works 

A tree's potential growth is calculated by:  

PARG = α * exp(-δ * DBH) * exp(-ε BA * exp(-ω * DBH)) 

where:  

 PARG is potential annual radial growth (mm/y) 

 DBH is in cm 

 BA is the basal area (in sq m) of adult trees within the distance given in the Post Harvest 

Growth - NCI Distance (m) parameter 

 α is the Post Harvest Growth - Max Growth Constant parameter, the maximum radial 

growth in millimeters per year 

 δ is the Post Harvest Growth - DBH Growth Effect parameter 

 ε is the Post Harvest Growth - NCI Constant parameter 

 ω is the Post Harvest Growth - DBH NCI Effect parameter 

If no harvest has occurred yet in this run, then the tree's actual growth, ARG, equals PARG. If a 

harvest has occurred at some point during this run, then ARG is calculated by:  

ARG = ARGpre + (PARG - ARGpre) * (1 - exp(-τ * H * t)) 

where:  



 ARG is annual radial growth (mm/y) for the current timestep 

 ARGpre is annual radial growth for the last timestep prior to harvest 

 H is the number of timesteps since the last harvest 

 t is the number of years per timestep 

 τ is the Post Harvest Growth - Time Since Harvest Rate Param parameter 

Annual radial growth ARG is used to calculate timestep diameter growth using  

DG = ARG * t * 2/10 

where t is the number of years per timestep.  

Model forms are based on those in Thorpe et al. (in review, For. Ecol. Manage.).  

How to apply it 

This behavior can be applied to saplings and adults of any species.  

Behavior reference string: lagged post-harvest growth or lagged post-harvest growth diam only  
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Mortality behaviors 

In this document:  

Mortality parameters  

Adult Self Thinning  

Adult Stochastic Mortality  

Aggregated Mortality  

BC Mortality  

Browsed Stochastic Mortality  

Competition Mortality  

Density Self-Thinning Mortality  

Exponential Growth and Resource-Based Mortality  

GMF Mortality  

Growth and Resource-Based Mortality  

Height-GLI Weibull Mortality with Browse  
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The mortality behaviors cause tree death due to natural life cycle causes and competition. Tree 

death due to disturbance is covered by other behaviors.  

Mortality behaviors do not actually remove dead trees from memory. They set a flag which 

marks trees as dead. This is because some other behaviors, such as the Substrate group, have 

specific interest in dead trees. Dead trees are eventually removed from memory by the Dead tree 

remover behavior. It is important to include this behavior in your run to avoid incorrect results in 

behaviors that use dead trees and unacceptably slow model run times.  

Mortality parameters 

 Adult Background Mortality Rate The proportion of trees that die each year, as a value 

between 0 and 1. Used by the Adult stochastic mortality behavior. 

 Adult Self-Thinning Intercept Intercept of the adult self-thinning linear function. Used 

by the Adult self-thinning behavior. 

 Adult Self-Thinning Slope Slope of the adult self-thinning linear function. Used by the 

Adult self-thinning behavior. 

 Competition Mortality Maximum Parameter (max) The maximum relative increment 

of growth subject to mortality. Used by the Competition Mortality behavior. 

 Aggregated Mortality Annual Kill Amount (0-1) The annual mortality rate for a 

mortality episode, as a proportion between 0 and 1. Used by the Aggregated Mortality 

behavior. 

 Aggregated Mortality Clump Size Whether the size of a clump of trees to kill is 

deterministic or chosen from a negative binomial probability distribution. Used by the 

Aggregated Mortality behavior. 

 Aggregated Mortality Clumping Parameter If the size of tree clumps to kill is drawn 

from a negative binomial probability distribution, this is the clumping parameter for the 

distribution. This is not required if a deterministic clump size is used. Used by the 

Aggregated Mortality behavior. 

 Aggregated Mortality Number of Trees To Aggregate Determines the size of the 

clumps of trees killed. If the clump size is deterministic, all clumps will be this size. If the 

size is to be drawn from a negative binomial probability distribution, then this is the mean 

clump size. Used by the Aggregated Mortality behavior. 

 Aggregated Mortality Return Interval (years) The return interval for mortality 

episodes. Used by the Aggregated Mortality behavior. 

 Browsed Juvenile Background Mortality Rate The proportion of browsed trees that 

die each year, as a value between 0 and 1. Used by the Browsed Stochastic Mortality 

behavior. 

 Competition Mortality Shape Parameter (Z) Determines the shape of the mortality 

function. Used by the Competition Mortality behavior. 

 DBH at Onset of Senescence, in cm DBH at which senescence takes effect. Used by the 

Senescence behavior. 



 DBH of Maximum Senescence Mortality Rate, as an integer in cm The DBH at which 

maximum mortality occurs. Trees with a DBH greater than this value experience no 

further increase in the mortality rate. Used by the Senescence behavior. 

 Density Self-Thinning Asymptote (A) The asymptote of the density self-thinning 

function. Used by the Density Self-Thinning Mortality behavior. 

 Density Self-Thinning Density Effect (S) The parameter controlling the density effect 

of the density self-thinning function. Used by the Density Self-Thinning Mortality 

behavior. 

 Density Self-Thinning Diameter Effect (C) The parameter controlling the effect of 

neighbor mean diameter of the density self-thinning function. Used by the Density Self-

Thinning Mortality behavior. 

 Density Self-Thinning Minimum Density for Mortality (#/ha) The minimum density 

of neighbors, in stems/ha, for density self-thinning mortality. A tree with a lower density 

of neighbors than this value will not die. Used by the Density Self-Thinning Mortality 

behavior. 

 Density Self-Thinning Neighborhood Radius, in m The maximum radius, in m, within 

which to search for neighbors to calculate neighbor density for density self-thinning. 

Used by the Density Self-Thinning Mortality behavior. 

 Exponential Growth-Resource - a The mortality at zero growth scaled as a function of 

the resource. Used by the Exponential Growth and Resource-Based Mortality behavior. 

 Exponential Growth-Resource - b The light-dependent mortality parameter. Used by 

the Exponential Growth and Resource-Based Mortality behavior. 

 Exponential Growth-Resource - c The resource-dependent mortality parameter. Used 

by the Exponential Growth and Resource-Based Mortality behavior. 

 Exponential Growth-Resource - d Used by the Exponential Growth and Resource-

Based Mortality behavior. 

 Growth/Resource - Scaling Factor (rho) Scaling factor to reduce survival at the mode 

of the survival probability function. Used by the Growth and Resource-Based Mortality 

behavior. 

 Growth/Resource - Function Mode (mu) Determines the mode of the function along a 

gradient of the resource R (the mode is the optimal niche of a species). Used by the 

Growth and Resource-Based Mortality behavior. 

 Growth/Resource - Survival Increase with Growth (delta) Specifies the increase in 

survival caused by amount of growth. Used by the Growth and Resource-Based Mortality 

behavior. 

 Growth/Resource - Low-Growth Survival Parameter (sigma) Affects the shape of the 

survival probability distribution in low-growth conditions. Used by the Growth and 

Resource-Based Mortality behavior. 

 Height-GLI Weibull - a The "a" parameter in the Weibull function for calculating 

annual mortality. Used by the Height-GLI Weibull Mortality with Browse behavior. 

 Height-GLI Weibull - b The "b" parameter in the Weibull function for calculating 

annual mortality. Used by the Height-GLI Weibull Mortality with Browse behavior. 

 Height-GLI Weibull - c The "c" parameter in the Weibull function for calculating 

annual mortality. Used by the Height-GLI Weibull Mortality with Browse behavior. 

 Height-GLI Weibull - d The "d" parameter in the Weibull function for calculating 

annual mortality. Used by the Height-GLI Weibull Mortality with Browse behavior. 



 Height-GLI Weibull - Max Mortality (0 - 1) The maximum mortality probability for a 

species, expressed as a proportion between 0 and 1. Used by the Height-GLI Weibull 

Mortality with Browse behavior. 

 Height-GLI Weibull - Browsed a The "a" parameter in the Weibull function for 

calculating annual mortality for a browsed tree. Used by the Height-GLI Weibull 

Mortality with Browse behavior. 

 Height-GLI Weibull - Browsed b The "b" parameter in the Weibull function for 

calculating annual mortality for a browsed tree. Used by the Height-GLI Weibull 

Mortality with Browse behavior. 

 Height-GLI Weibull - Browsed c The "c" parameter in the Weibull function for 

calculating annual mortality for a browsed tree. Used by the Height-GLI Weibull 

Mortality with Browse behavior. 

 Height-GLI Weibull - Browsed d The "d" parameter in the Weibull function for 

calculating annual mortality for a browsed tree. Used by the Height-GLI Weibull 

Mortality with Browse behavior. 

 Height-GLI Weibull - Browsed Max Mortality (0 - 1) The maximum mortality 

probability for a browsed tree, expressed as a proportion between 0 and 1. Used by the 

Height-GLI Weibull Mortality with Browse behavior. 

 Include Snags in NCI Calculations Whether or not to include snags when finding 

competitive neighbors for NCI. Used in the NCI mortality behavior. 

 Juvenile Background Mortality Rate The proportion of trees that die each year, as a 

value between 0 and 1. Used by the Juvenile Stochastic Mortality and Browsed 

Stochastic Mortality behaviors. 

 Juvenile Self-Thinning Intercept Intercept of the juvenile self-thinning linear function. 

Used by the Juvenile self-thinning behavior. 

 Juvenile Self-Thinning Slope Slope of the juvenile self-thinning linear function. Used 

by the Juvenile self-thinning behavior. 

 Light-Dependent Mortality Light-dependent mortality. Used by the GMF mortality and 

BC morality behaviors. 

 Logistic Bi-Level - Low-Light "a" The "a" parameter used in low-light conditions. 

Used by the Logistic Bi-Level Mortality behavior. 

 Logistic Bi-Level - Low-Light "b" The "b" parameter used in low-light conditions. 

Used by the Logistic Bi-Level Mortality behavior. 

 Logistic Bi-Level - High-Light "a" The "a" parameter used in high-light conditions. 

Used by the Logistic Bi-Level Mortality behavior. 

 Logistic Bi-Level - High-Light "b" The "b" parameter used in high-light conditions. 

Used by the Logistic Bi-Level Mortality behavior. 

 Logistic Bi-Level - High-Light Mortality Threshold (0-100) The threshold between 

low-light and high-light parameters, as a value between 0 and 100. Used by the Logistic 

Bi-Level Mortality behavior. 

 Maximum DBH for Adult Self-Thinning Maximum DBH at which adult self-thinning 

applies. Above this value, no mortality occurs. Used by the Adult self-thinning behavior. 

 Mortality at Zero Growth Mortality rate at zero growth. Used by the GMF mortality 

and BC morality behaviors. 

 NCI Crowding Effect Slope (C) The slope of the curve for neighbor effects. Used in the 

NCI mortality behavior. 



 NCI Crowding Effect Steepness (D) The steepness of the curve for neighbor effects. 

Used in the NCI mortality behavior. 

 NCI Max Radius of Crowding Neighbors, in m The maximum distance from a target 

tree at which neighbors can have a competitive effect. Used in the NCI mortality 

behavior. 

 NCI Max Survival Probability (0-1) The maximum annual probability of survival, as a 

value between 0 and 1. Used in the NCI mortality behavior. 

 NCI Minimum Neighbor DBH, in cm The minimum DBH for trees of that species to 

compete as neighbors. Used for all neighbor species, not just those using NCI mortality. 

Used in the NCI mortality behavior. 

 NCI Neighbor DBH Effect (alpha) The effect of the DBH of a neighbor tree on its 

competitiveness for a target species. Used in the NCI mortality behavior. 

 NCI Neighbor Distance Effect (beta) The effect of the distance of a neighbor tree on its 

competitiveness for a target species. Used in the NCI mortality behavior. 

 NCI Neighbor Storm Damage (eta) - Complete (0-1) The fraction to which a 

neighbor's competitive effect is reduced when the neighbor has sustained complete storm 

damage. Used in the NCI mortality behavior. 

 NCI Neighbor Storm Damage (eta) - Medium (0-1) The fraction to which a neighbor's 

competitive effect is reduced when the neighbor has sustained medium storm damage. 

Used in the NCI mortality behavior. 

 NCI Shading Effect Coefficient (m) The coefficient in the shading effect equation. Set 

this value to 0 if you do not wish to use shading. Used in the NCI mortality behavior. 

 NCI Shading Effect Exponent (n) The exponent in the shading effect equation. If you 

set the NCI Shading Effect Coefficient (m) parameter to 0, this value is ignored. Used 

in the NCI mortality behavior. 

 NCI Size Effect Mode, in cm The mode of the size effect curve. Used in the NCI 

mortality behavior. 

 NCI Size Effect Variance, in cm The variance of the size effect curve. Used in the NCI 

mortality behavior. 

 NCI Size Sensitivity to NCI (gamma) The sensitivity of a tree's survival probability to 

its DBH. Used in the NCI mortality behavior. 

 NCI Storm Effect - Complete Damage (0-1) The fraction by which a tree's survival 

probability is reduced when it has sustained complete storm damage. Used in the NCI 

mortality behavior. 

 NCI Storm Effect - Medium Damage (0-1) The fraction by which a tree's survival 

probability is reduced when it has sustained medium storm damage. Used in the NCI 

mortality behavior. 

 Species i NCI Lambda The scale of the competitive effect of a neighbor tree's species on 

the target tree's species. Used in the NCI mortality behavior. 

 Post Harvest Skid Mort - Crowding Effect Radius Maximum distance, in m, for 

neighbors to have a competitive effect. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Pre-Harvest Background Mort Rate Annual mortality rate, 

0-1, if no harvest has occurred this run. Used by the  

Post Harvest Skidding Mortality behavior. 



 Post Harvest Skid Mort - Snag Recruitment Background Prob Annual postharvest 

risk of standing death after harvest effects have completely tapered off. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Snag Recruitment Basic Prob Basic probability of standing 

death after harvest. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Snag Recruitment Crowding Effect The effect of 

neighborhood basal area on standing death probability. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Snag Recruitment Rate Param Determines how quickly the 

effects of harvesting on standing death probability taper off. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Snag Recruitment Skidding Effect Effect of harvest 

intensity on postharvest probability of standing death. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Windthrow Background Prob Annual postharvest risk of 

windthrow after harvest effects have completely tapered off. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Windthrow Crowding Effect The effect of neighborhood 

basal area on windthrow probability. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Windthrow Harvest Basic Prob Basic annual probability for 

windthrow after a harvest. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Windthrow Harvest Rate Param Determines how quickly 

the effects of harvesting on windthrow probability taper off. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Windthrow Intensity Effect Intensity effect parameter used 

for determining risk of windthrow. Used by the  

Post Harvest Skidding Mortality behavior. 

 Post Harvest Skid Mort - Windthrow Size Effect Size effect term when determining 

risk of windthrow. Used by the  

Post Harvest Skidding Mortality behavior. 

 Senescence Mortality Alpha Controls the senescence mortality rate. Used by the 

Senescence behavior. 

 Senescence Mortality Beta Controls the senescence mortality rate. Used by the 

Senescence behavior. 

 Stochastic Bi-Level - High-Light Mortality Probability (0-1) The annual probability of 

mortality under high-light conditions, as a proportion between 0 and 1. Used by the 

Stochastic Bi-Level Mortality behavior. 

 Stochastic Bi-Level - High-Light Mortality Threshold (0-100) The threshold between 

low-light and high-light mortality rates, as a value between 0 and 100. Used by the 

Stochastic Bi-Level Mortality behavior. 

 Stochastic Bi-Level - Low-Light Mortality Probability (0-1) The annual probability of 

mortality under low-light conditions, as a proportion between 0 and 1. Used by the 

Stochastic Bi-Level Mortality behavior. 



 Weibull Annual "a" Parameter for Snag Size Class 1 Mortality Weibull annual "a" 

parameter for those trees whose DBH is less than or equal to the value in "Upper DBH of 

snag size class 1". Used by the Weibull snag mortality behavior. 

 Weibull Annual "a" Parameter for Snag Size Class 2 Mortality Weibull annual "a" 

parameter for those trees whose DBH is greater than the value in "Upper DBH of snag 

size class 1" but less than or equal to the value in "Upper DBH of snag size class 2". Used 

by the Weibull snag mortality behavior. 

 Weibull Annual "a" Parameter for Snag Size Class 3 Mortality Weibull annual "a" 

parameter for those trees whose DBH is greater than the value in "Upper DBH of snag 

size class 2". Used by the Weibull snag mortality behavior. 

 Weibull Annual "b" Parameter for Snag Size Class 1 Mortality Weibull annual "b" 

parameter for those trees whose DBH is less than or equal to the value in "Upper DBH of 

snag size class 1". Used by the Weibull snag mortality behavior. 

 Weibull Annual "b" Parameter for Snag Size Class 2 Mortality Weibull annual "b" 

parameter for those trees whose DBH is greater than the value in "Upper DBH of snag 

size class 1" but less than or equal to the value in "Upper DBH of snag size class 2". Used 

by the Weibull snag mortality behavior. 

 Weibull Annual "b" Parameter for Snag Size Class 3 Mortality Weibull annual "b" 

parameter for those trees whose DBH is greater than the value in "Upper DBH of snag 

size class 2". Used by the Weibull snag mortality behavior. 

 Weibull Upper DBH of Snag Size Class 1 The upper DBH value of trees in size class 1. 

Used by the Weibull snag mortality behavior. 

 Weibull Upper DBH of Snag Size Class 2 The upper DBH value of trees in size class 2. 

Trees with a value greater than this are considered to be in size class 3. Used by the 

Weibull snag mortality behavior. 

Adult self thinning 

Self-thinning is a behavior that uses a pseudo-density dependent function designed to increase 

the death rate in dense uniform-age stands. You specify a maximum DBH at which to apply it - 

above this DBH a tree will not die. There is nothing in this behavior which makes it specifically 

for adult trees - the name is to match existing SORTIE conventions.  

How it works 

Self-thinning uses a simple linear function of probability of mortality as a function of DBH, 

assuming the tree is below the maximum DBH at which to apply self-thinning. After evaluating 

this function for a tree, it uses a random number to determine whether the tree dies.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: adultselfthin  



Adult stochastic mortality 

This behavior produces a background mortality rate. Individuals within the pool of trees to which 

this behavior applies are randomly selected to die. There is nothing about this behavior which 

makes it only applicable to adults. The name conforms to old SORTIE standards and allows it to 

be distinguished from the Juvenile stochastic mortality behavior, so that two different rates can 

be applied to two different groups of trees.  

How it works 

For each tree, a random number is compared to that species's Adult Background Mortality 

Rate parameter to determine if it falls in the pool of trees that die.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: adultstochasticmort  

Aggregated Mortality 

Aggregated Mortality is similar to the Adult Stochastic Mortality behavior in that it kills trees 

randomly to match a predetermined mortality rate. However, Aggregated Mortality clumps 

together the deaths in both time and space.  

How it works 

Mortality occurs in discrete episodes, which have an average return interval. For any timestep, 

the probability that a mortality episode will occur is T/RI, where T is the number of years per 

timestep and RI is the Aggregated Mortality Return Interval (years) parameter. Each 

timestep, this behavior uses a random number to decide if a mortality episode occurs. Between 

mortality episodes, this behavior does not kill any trees.  

If a mortality episode occurs, this behavior kills some of the total pool of trees to which it has 

been applied. The base annual mortality rate proportion is given in the Aggregated Mortality 

Annual Kill Amount (0-1) parameter. Since the parameter gives an annual rate, the actual 

mortality rate is 1-(1-AD)
T
, where AD is the annual amount to kill and T is the number of years 

per timestep.  

During a mortality episode, this behavior kills the trees in discrete clumps. The behavior uses a 

random number with each tree in its pool of eligible trees to decide if that tree dies. If it dies, the 

behavior also kills the trees closest to it. Only trees to which this behavior has been applied are 

killed; other neighbors are left alone. The size of these clumps of dead trees can either be 

deterministic or drawn from a negative binomial probability distribution. This option is set in the 

Aggregated Mortality Clump Size parameter. If the size is deterministic, the size of all clumps 



is given in the Aggregated Mortality Number of Trees To Aggregate parameter. If the size is 

from a negative binomial distribution, that parameter gives the mean, u, for the function  

 

where k, the clumping parameter, is the Aggregated Mortality Clumping Parameter 

parameter.  

If the Aggregated Mortality Return Interval (years) and Aggregated Mortality Number of 

Trees To Aggregate parameters are both set to 1, then this behavior functions exactly like the 

Adult Stochastic Mortality behavior.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Only those trees to 

which this behavior has been applied will be killed. This behavior can be combined with other 

mortality behaviors, but for best results, it should be the first one to occur.  

Behavior reference string: Aggregated Mortality  

BC mortality 

BC mortality is a growth-based mortality behavior.  

How it works 

The BC mortality model evaluates the following function to determine the probability of a tree's 

mortality:  

 
 

where:  

 m is the probability of mortality 

 T is the number of years per timestep 

 m1 is the Mortality at Zero Growth parameter 

 m2 is the Light-Dependent Mortality parameter 

 G is amount of radial growth, in mm/yr, added to the tree's diameter during T 

 

BC mortality is described in Kobe and Coates 1997. 



How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a growth behavior applied. 

Behavior reference string: bcmortality  

Browsed Stochastic Mortality 

This simulates the effects of herbivory by allowing different background mortality rates for 

browsed and unbrowsed trees.  

How it works 

Whether or not a tree is browsed is determined by the Random browse behavior. For each tree, if 

it has not been browsed, that species's Juvenile Background Mortality Rate parameter is used; 

if it has been browsed, the species's Browsed Juvenile Background Mortality Rate parameter 

is used. A random number is compared to the appropriate rate to decide if the tree dies. 

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have the Random browse behavior 

applied.  

Behavior reference string: Browsed Stochastic Mortality  

Exponential Growth and Resource-Based Mortality 

This behavior calculates probability of mortality as a function of growth and some second 

resource. The identity of the second resource is unimportant and could be anything, from 

exchangeable calcium levels to soil moisture.  

How it works 

The probability of mortality for a tree is calculated with the following equation:  

Prob = (d + a * R) * exp( -( b + c * R) * G) 

where:  

 Prob is the annual probability of mortality, as a value between 0 and 1 

 R is the amount of the second resource 

 G is the amount of radial growth, in mm/yr 

 a is the Exponential Growth-Resource - a parameter - the mortality at zero growth 

scaled as a function of the resource R 



 b is the Exponential Growth-Resource - b parameter - the light dependent mortality 

 c is the Exponential Growth-Resource - c parameter - the resource dependent mortality 

 d is the Exponential Growth-Resource - d parameter 

The amount of the second resource is captured in a grid object called Resource. Currently it is up 

to you to enter a map of the values for this resource grid; for instructions on how to do this, see 

the Grid Setup Window topic. This behavior does not in any way alter the values in this grid.  

The mortality probability as calculated above is an annual probability. For multi-year timesteps, 

the timestep probability is 1 - (1 - AP)
X
, where AP is the annual probability and X is the number 

of years per timestep. Once a tree's timestep survival probability has been calculated, it is 

compared to a random number to determine whether the tree lives or dies.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a growth behavior applied. You 

must also enter a map of second resource values into the Resource grid.  

Behavior reference string: Exponential growth resource mortality  

GMF mortality 

GMF mortality is a growth-based mortality behavior.  

How it works 

The GMF mortality model evaluates the following function to determine the probability of a 

tree's mortality:  

m = m1*e
-m

2
G
 

 

where:  

 m is the probability of mortality 

 m1 is the Mortality at Zero Growth parameter, for mortality over 2.5 years (see Kobe et 

al 1995) 

 m2 is the Light-Dependent Mortality parameter, for mortality over 2.5 years (see Kobe 

et al 1995) 

 G is amount of radial growth, in mm/yr, added to the tree's diameter this timestep 

The GMF mortality equation is for a 5 year timestep. The mortality parameters are for a 2.5 year 

probability of mortality. To calculate the 5 year probability of mortality, SORTIE uses p' = 1 - (1 

- p)
2
. Once the probability of mortality is calculated for a tree, SORTIE generates a random 

number to which to compare it to determine whether the tree will live or die.  



This model was originally described in Kobe et al 1995.  

How to apply it 

The GMF mortality function assumes a timestep length of five years, so that must be your 

timestep length in order to use this behavior. This behavior can be applied to seedlings, saplings, 

and adults of any species. Any tree species/type combination to which it is applied must also 

have a growth behavior applied.  

Behavior reference string: gmfmortality  

Growth and Resource-Based Mortality 

This behavior calculates probability of survival as a function of growth and some second 

resource. The identity of the second resource is unimportant and could be anything, from 

exchangeable calcium levels to soil moisture.  

How it works 

The probability of survival for a tree is calculated with the following equation:  

 
where:  

 Prob is the annual probability of survival, as a value between 0 and 1 

 R is the amount of the second resource 

 G is the amount of radial growth, in mm/yr 

 ρ is the Growth/Resource - Scaling Factor (rho) parameter, which is a scaling factor to 

reduce survival at the mode of the survival probability function 

 κ is the Growth/Resource - Function Mode (mu) parameter, which determines the 

mode of the function along a gradient of the resource R (this corresponds to the optimal 

niche of a species, meaning where it is the top competitor, the absolute winner of 

competition) 

 δ is the Growth/Resource - Survival Increase with Growth (delta) parameter, which 

specifies the increase in survival caused by amount of growth 

 σ is the Growth/Resource - Low-Growth Survival Parameter (sigma) parameter, 

which affects the shape of the survival probability distribution in low-growth conditions 

The amount of the second resource is captured in a grid object called Resource. Currently it is up 

to you to enter a map of the values for this resource grid; for instructions on how to do this, see 

the Grid Setup Window topic. This behavior does not in any way alter the values in this grid.  



The survival probability as calculated above is an annual probability. For multi-year timesteps, 

the timestep probability is AP
X
, where AP is the annual probability and X is the number of years 

per timestep. Once a tree's timestep survival probability has been calculated, it is compared to a 

random number to determine whether the tree lives or dies.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. Any tree 

species/type combination to which it is applied must also have a growth behavior applied. You 

must also enter a map of second resource values into the Resource grid.  

Behavior reference string: Growth resource mortality  

Juvenile self thinning 

Self-thinning is a behavior that uses a pseudo-density dependent function designed to increase 

the death rate in dense uniform-age stands. Unlike adult self-thinning, there is no upper DBH 

limit applied. There is nothing in this behavior which makes it specifically for juvenile trees - the 

name is to match existing SORTIE conventions.  

How it works 

Self-thinning uses a simple linear function of probability of mortality as a function of DBH. 

After evaluating this function for a tree, it uses a random number to determine whether the tree 

dies.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: juvselfthin  

Juvenile stochastic mortality 

This behavior produces a background mortality rate. Individuals within the pool of trees to which 

this behavior applies are randomly selected to die. There is nothing about this behavior which 

makes it only applicable to juveniles. The name conforms to old SORTIE standards and allows it 

to be distinguished from the Adult stochastic mortality behavior, so that two different rates can 

be applied to two different groups of trees.  

How it works 

For each tree, a random number is compared to that species's Juvenile Background Mortality 

Rate parameter to determine if it falls in the pool of trees that die. 



How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species.  

Behavior reference string: juvstochasticmort  

Senescence 

Senescence mortality provides for an uptick in mortality rates. It is meant to slightly increase the 

death rate among large adult trees.  

How it works 

All trees to which senescence is applied are evaluated for senescence mortality. In practice, trees 

below the onset of senescence DBH very rarely die. The probability of death rises with DBH 

until the DBH of maximum senescence rate is reached, at which point it levels off.  

To assess whether a tree will die due to senescence, the following function is evaluated:  

 
 

where:  

 ms is the probability of mortality 

 α (Senescence Mortality Alpha parameter) and β (Senescence Mortality Beta 

parameter) control the magnitude of the uptick 

 DBH is the tree's DBH, in cm 

 DBHs is the DBH at Onset of Senescence, in cm parameter 

The probability is compared to a random number to determine whether the individual tree will 

die.  

How to apply it 

Senescence may be applied to saplings and adults of any species. It cannot be applied to 

seedlings. 

Behavior reference string: senescence  

Weibull snag mortality behavior 



This behavior controls snag fall. Snags are standing dead trees. Obviously, they can't die again, 

so the word "mortality" is a bit of a misnomer. We call the behavior a mortality behavior because 

it functionally fits in this behavior class.  

Snags that are "killed" by this behavior are considered to have fallen over. If Substrate behaviors 

are enabled, then these fallen trees are available to become new fresh log substrate. Any that are 

not picked up by substrate will be dealt with by the Dead tree remover behavior.  

How it works 

The behavior uses a Weibull function to determine the number of snags of a certain age left 

standing at a given time. The equation is:  

 

where:  

 S is proportion of snags still standing, between 0 and 1  

 a and b are Weibull parameters (Weibull Annual "a" Parameter for Snag Size Class X 

Mortality parameter and Weibull Annual "b" Parameter for Snag Size Class X 

Mortality parameter)  

 T is the snag age in years  

Different sizes of snags fall at different rates. This behavior allows you to define three snag size 

classes and enter different "a" and "b" parameters for each.  

A random number is used against this equation for a given tree to determine if it falls in the 

current timestep.  

How to apply it 

This behavior can be applied to snags of any species.  

Behavior reference string: weibull snag mortality  

NCI mortality 

This behavior uses the effects of neighbor competitiveness to influence tree survival ("NCI" 

stands for neighborhood competition index). A tree's maximum potential probability of survival 

is reduced due to competitiveness and several other possible factors. You can use certain 

parameter values to turn these influences on and off to reflect the conditions appropriate for your 

run.  

How it works 



For a tree, the annual probability of survival is calculated as:  

 

Prob. Survival = Max Survival * Size Effect * Shading Effect * Crowding Effect * Storm Effect 

 

Max Survival is the NCI Max Survival Probability (0-1) parameter. Storm Effect, Shading 

Effect, Size Effect, and Crowding Effect are all optional factors which act to reduce the maximum 

survival probability and will vary depending on the conditions a tree is in. All values are 

bounded between 0 and 1.  

Size Effect is calculated as:  

 

where:  

 DBH is of the target tree, in cm 

 X0 is the NCI Size Effect Mode, in cm parameter 

 Xb is the NCI Size Effect Variance, in cm 

Shading Effect is calculated as:  

 

where:  

 m is the NCI Shading Effect Coefficient (m) parameter 

 n is the NCI Shading Effect Exponent (n) parameter 

 S is the amount of shade cast by neighbors, from 0 (no shade) to 1 (full shade). This value 

should come from the Sail light behavior. 

This effect is not required. To omit the Shading Effect, set the NCI Shading Effect Coefficient 

(m) parameter to 0.  

Crowding Effect is calculated as:  

 

where:  



 C is the NCI Crowding Effect Slope (C) parameter 

 D is the NCI Crowding Effect Steepness (D) parameter 

 DBH is of the target tree, in cm 

 γ is the NCI Size Sensitivity to NCI (gamma) parameter for the target tree's species 

 NCI is this tree's NCI value (equation below) 

The NCI value sums up the competitive effect of all neighbors with a DBH at least that of the 

NCI Minimum Neighbor DBH, in cm parameter, out to a maximum distance set in the NCI 

Max Radius of Crowding Neighbors, in m parameter. The competitiveness of a neighbor 

increases with the neighbor's size and decreases with distance and storm damage to the neighbor 

(optional). The neighbor's species also matters; the effect depends on the relationship between 

the target species and the neighbor species. Seedlings never compete. You set whether or not 

snags compete in the Include Snags in NCI Calculations parameter.  

The crowding effect is optional. You can omit it by setting either the NCI Crowding Effect 

Slope (C) or NCI Max Radius of Crowding Neighbors, in m parameters to 0.  

NCI is calculated as:  

 

where:  

 the calculation sums over j = 1...S species and k = 1...N neighbors of each species of at 

least a DBH of NCI Minimum Neighbor DBH, in cm, out to a distance of NCI Max 

Radius of Crowding Neighbors, in m 
 εk is the storm damage parameter of the kth neighbor, depending on the damage status 

(optional). If the neighbor is undamaged, the value is 1. If the neighbor has medium 

damage, the value is the NCI Neighbor Storm Damage (eta) - Medium (0-1) parameter 

for the target species. If the neighbor has complete damage, the value is the NCI 

Neighbor Storm Damage (eta) - Complete (0-1) parameter for the target species. To 

omit the storm damage term, set all values for the above two parameters to 1. 

 α is the NCI Alpha parameter for the target tree's species 

 β is the NCI Beta parameter for the target tree's species 

 DBHjk is the DBH of the kth neighbor, in cm 

 q is the NCI DBH Divisor (q) parameter. Set this to a value greater than 1 to rescale the 

competitive effects of neighbors 

 ιik is the Species j NCI Lambda parameter for the target species relative to the kth 

neighbor's species  

 distanceik is distance from target to neighbor, in m 

The value of Damage Effect is optional. If you elect not to use storms in your run, set all values 

in the NCI Damage Effect - Medium Storm Damage (0-1) and NCI Damage Effect - 



Complete Storm Damage (0-1) parameters to 1. If you are using storms, then the value of 

Damage Effect depends on the tree's damage category. If the tree is undamaged, Damage Effect 

equals 1. If the tree has medium storm damage, the value is the NCI Damage Effect - Medium 

Storm Damage (0-1) parameter. If the tree has complete storm damage, the value is the NCI 

Damage Effect - Complete Storm Damage (0-1) parameter.  

The survival probability as calculated above is an annual probability. For multi-year timesteps, 

the timestep probability is AP
X
, where AP is the annual probability and X is the number of years 

per timestep. Once a tree's timestep survival probability has been calculated, it is compared to a 

random number to determine whether the tree lives or dies.  

How to apply it 

This behavior can be applied to saplings and adults of any species. It cannot be applied to 

seedlings.  

If the Shading Effect term is activated in the growth equation, then the trees to which this 

behavior is applied must also have a light behavior applied - the Sail light behavior is the one 

designed to work with the NCI behavior. The use of any other light behavior is at your own risk.  

If any storm damage parameters are set to anything other than 1, it is recommended (but not 

required) that you have the Storm damage applier behavior applied.  

Behavior reference string: NCI Mortality  

Competition Mortality 

Competition mortality is a growth-based mortality behavior. It uses the results of the NCI growth 

behavior.  

How it works 

NCI growth in SORTIE is calculated in the following way:  

Growth = Max Growth * Size Effect * Shading Effect * Crowding Effect * Damage Effect 

 

Max Growth is the maximum diameter growth the tree can attain, in cm/yr, entered in the NCI 

Maximum Potential Growth, cm/yr parameter. Size Effect, Shading Effect, Crowding Effect, 

and Damage Effect are all factors which act to reduce the maximum growth rate and will vary 

depending on the conditions a tree is in. Each of these effects is a value between 0 and 1.  

In the Competition mortality behavior, the following measure is used as predictor variable for 

probability of mortality:  

Relative increment = Growth / PG 



 

The relative increment is the ratio between the growth for an individual tree and the maximum 

growth possible for that tree. The Growth is the tree's growth for the previous timestep. PG is 

calculated as follows:  

PG = Max Growth * SE 

where Max Growth is the NCI growth parameter NCI Maximum Potential Growth, cm/yr, and 

SE is the Size Effect. Size Effect is calculated as follows:  

 

where:  

 DBH is of the target tree, in cm 

 X0 is the NCI Size Effect Mode, in cm (X0) NCI growth parameter 

 Xb is the NCI Size Effect Variance, in cm (Xb) NCI growth parameter 

Once the relative increment for an individual tree has been calculated, the probability of 

mortality for that individual is calculated in the following way:  

 

Prob = Z
 relative increment / max

 

 

where:  

 Prob is the probability of mortality 

 Z is the Competition Mortality Shape Parameter (Z) parameter 

 max is the Competition Mortality Maximum Parameter (max) parameter, which 

indicates the maximum relative increment subject to mortality 

  

All trees with a relative increment greater than or equal to max will live.  

How to apply it 

This behavior can be applied to saplings and adults of any species. It cannot be applied to 

seedlings. Any tree species/type combination to which it is applied must also have NCI growth. 

This behavior can only be applied with a one year timestep.  

Behavior reference string: NCI Mortality  



Density Self-Thinning Mortality 

This behavior calculates the probability of mortality of an individual juvenile tree as a function 

of the density and mean diameter of the neighborhood trees. Only neighborhood seedlings and 

saplings are taken into account in this behavior.  

How it works 

The probability of mortality is calculated with a double Michaelis-Menton function:  

 

where:  

 Pm is the probability of mortality for an individual tree 

 density is the density of neighboring seedlings and saplings, in stems/ha, within a radius 

defined in the Density Self-Thinning Neighborhood Radius, in m parameter 

 diam m is the mean diameter of neighbors, measured 10 cm above root collar in cm 

 A is the Density Self-Thinning Asymptote (A) parameter 

 C is the Density Self-Thinning Diameter Effect (C) parameter 

 S is the Density Self-Thinning Density Effect (S) parameter 

If the value of density is less than the value in the Density Self-Thinning Minimum Density for 

Mortality (#/ha) parameter, the tree does not die.  

How to apply it 

This behavior can be applied to seedlings and saplings of any species. It cannot be applied to 

adults. This behavior can only be applied with a one year timestep.  

Behavior reference string: densityselfthinning  

Logistic bi-level mortality 

This behavior calculates the probability of survival according to a logistic equation, with the 

possibility of two sets of parameters for each species: one for high-light conditions and one for 

low-light conditions. This can also be used alone without the light levels.  

How it works 

The equation used by this behavior to calculate survival probability is:  



 

 
 

where  

 p - annual probability of survival 

 a - in high-light conditions, this is the Logistic Bi-Level - High-Light "a" parameter; in 

low-light conditions, this is the Logistic Bi-Level - Low-Light "a" parameter 

 b - in high-light conditions, this is the Logistic Bi-Level - High-Light "b" parameter; in 

low-light conditions, this is the Logistic Bi-Level - Low-Light "b" parameter 

 D - tree diam, in cm; diam10 for seedlings, DBH for others 

If the timestep length is not one year, the actual probability of survival for the timestep is 

calculated as p' = p
 T

, where p is the annual probability of survival, p' is the timestep probability 

of survival, and T is the number of years per timestep. Once the survival probability for the 

timestep is known for a tree, then a random number is compared to this probability to determine 

if the tree lives or dies.  

Light levels come from the Storm Light grid produced by the Storm Light behavior. The 

threshold between the use of high-light and low-light parameters is set in the Logistic Bi-Level - 

High-Light Mortality Threshold (0-100) parameter.  

This behavior can also be used without Storm Light. In this case, only the low-light mortality 

parameters are used.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. If you wish to use 

the light-level parameter switch, also use the Storm Light behavior.  

Behavior reference string: Logistic Bi-Level Mortality  

Stochastic bi-level mortality 

This behavior applies a constant rate of mortality to trees, with different rates for high-light and 

low-light conditions.  

How it works 

Light levels come from the Storm Light grid produced by the Storm Light behavior. The 

threshold between the use of high-light and low-light parameters is set in the Stochastic Bi-

Level - High-Light Mortality Threshold (0-100) parameter.  



For each tree, a random number is compared to that species's probability of mortality to 

determine if it dies. If light levels qualify as high light, the probability of mortality is the value in 

the Stochastic Bi-Level - High-Light Mortality Probability (0-1) parameter; if the light levels 

are low, the probability of mortality is the value in the Stochastic Bi-Level - Low-Light 

Mortality Probability (0-1) parameter.  

If the timestep length is not one year, the probability of mortality is adjusted from an annual 

mortality probability to a timestep probability.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. You must also use 

the Storm Light behavior.  

Behavior reference string: Stochastic Bi-Level Mortality  

Height-GLI Weibull Mortality with Browse 

This behavior calculates the probability of mortality using a Weibull function of tree height and 

GLI (light level). It can also simulate the effects of herbivory by using different parameters for 

browsed and unbrowsed trees.  

How it works 

The same function is used to calculate the probability of mortality for both browsed and 

unbrowsed trees, but the parameters are different. The function is:  

p = Mmax * exp(-a * H 
b
 - c * GLI 

d
) 

where  

 p - annual probability of mortality 

 Mmax - the Height-GLI Weibull - Max Mortality (0 - 1) or Height-GLI Weibull - 

Browsed Max Mortality (0 - 1) parameter 

 a - the Height-GLI Weibull - a or Height-GLI Weibull - Browsed a parameter 

 b - the Height-GLI Weibull - b or Height-GLI Weibull - Browsed b parameter 

 c - the Height-GLI Weibull - c or Height-GLI Weibull - Browsed c parameter 

 d - the Height-GLI Weibull - d or Height-GLI Weibull - Browsed d parameter 

 H - tree height in meters 

 GLI - light level, between 0 and 100% of full sun 

If the timestep length is not one year, the actual probability of mortality for the timestep is 

calculated as p' = 1 - (1 - p)
 T

, where p is the annual probability of mortality, p' is the timestep 

probability of mortality, and T is the number of years per timestep. Once the mortality 

probability for the timestep is known for a tree, then a random number is compared to this 

probability to determine if the tree lives or dies.  



Light levels can come from any of the light behaviors that directly assign a tree its light level. It 

is expected that this is a GLI value, from 0 to 100% of full sun.  

Whether or not a tree is browsed is determined by the Random browse behavior. If the Random 

browse behavior does not apply to a tree, or is not present in the run, the unbrowsed parameters 

are always used. The other parameters can be ignored.  

How to apply it 

This behavior can be applied to seedlings, saplings, and adults of any species. You must also use 

a light behavior. If you wish to include the effects of herbivory, also include the Random browse 

behavior in the run.  

Behavior reference string: Height GLI Weibull Mortality  

Post Harvest Skidding Mortality 

This mortality behavior simulates an increase in mortality after harvesting attributable to 

skidding damage or other effects. The increase in mortality tapers off through time. DBH and 

neighborhood basal area can also affect mortality in this behavior.  

Model forms are based on those in Thorpe et al. 200X (Ecol. Appl. in press).  

How it works 

If no harvest has occurred yet in this run, the probability of dying in a timestep is:  

Prob = 1 - (1 - β)
t
 

where:  

 Prob is the probability of dying before the end of the timestep 

 β is the Post Harvest Skid Mort - Pre-Harvest Background Mort Rate parameter 

 t is the number of years per timestep 

If a harvest has occurred in the tree's cell during the run, the probability of mortality is:  

 

multiplying over years i = 1...t (number of years per timestep);  

Wi=(ρ w + δw * DBH + θw * m - εw * BA) * exp(-τw * (H * t + i)) + ω 



where:  

 Wi is the annual post-harvest risk of windthrow 

 ρw is the Post Harvest Skid Mort - Windthrow Harvest Basic Prob parameter 

 δw is the Post Harvest Skid Mort - Windthrow Size Effect parameter 

 DBH is the tree's DBH in cm 

 θw is the Post Harvest Skid Mort - Windthrow Intensity Effect parameter 

 m is the harvest intensity from the tree's "HarvInten" data member, from the HARP 

external harvesting program (available for download from the SORTIE web site)  

 ε w is the Post Harvest Skid Mort - Windthrow Crowding Effect parameter  

 BA is the neighborhood basal area, in sq m per ha, within a radius set by the Post 

Harvest Skid Mort - Crowding Effect Radius parameter  

 τ w is the Post Harvest Skid Mort - Windthrow Harvest Rate Param parameter  

 H is the number of timesteps since the last harvest in this tree's grid cell 

 t is the number of years per timestep  

 ω is the Post Harvest Skid Mort - Windthrow Background Prob parameter  

and 

Si = (ρs + θ s * m + υ s * BA) * exp (-τ s * (H * t + i)) + ς  

where:  

 Si is the annual postharvest risk of standing death  

 ρs is the Post Harvest Skid Mort - Snag Recruitment Basic Prob parameter  

 θs is the Post Harvest Skid Mort - Snag Recruitment Skidding Effect parameter  

 m is the harvest intensity from the tree's "HarvInten" data member, from the HARP 

external harvesting program (available for download from the SORTIE web site)  

 υs is the Post Harvest Skid Mort - Snag Recruitment Crowding Effect parameter  

 BA is the neighborhood basal area, in sq m per ha, within a radius set by the Post 

Harvest Skid Mort - Crowding Effect Radius parameter  

 τs is the Post Harvest Skid Mort - Snag Recruitment Rate Param parameter  

 H is the number of timesteps since the last harvest in this tree's grid cell 

 t is the number of years per timestep  

 ς is the Post Harvest Skid Mort - Snag Recruitment Background Prob parameter 

How to apply it 

This behavior can be applied to saplings and adults of any species. In order for the harvest 

intensity term to have an effect, the float data member "HarvInten" must be registered for all 

species/type combos to which this behavior is applied, by using the HARP external harvesting 

program along with the Harvest Interface.  

Behavior reference string: postharvestskiddingmortality  
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Substrate behaviors 

In this document:  

Substrate parameters  

Substrate behavior  

Detailed Substrate behavior  

Substrate is what seedlings germinate in - soil, rock, and the organic layers on top. The quality of 

the substrate can make a big difference in a seedling's ability to survive and establish. The 

substrate composition in any one place is constantly shifting and changing as new substrate is 

added to the forest floor and as existing substrate decays. These behaviors keep track of the 

substrate conditions at different locations through time.  

Substrate parameters 

 Boundary Between Log Diam Classes (cm) DBH boundary between the "small" and 

"large" log size classes, in cm. Used by the Detailed Substrate behavior. 

 Clear Cut Large Logs Mean Diameter (cm) After a clear cut harvest, the mean 

diameter of logs in the "large" size class, in cm. This is not required if the Harvest 

behavior is not used. Used by the Detailed Substrate behavior. 

 Clear Cut Small Logs Mean Diameter (cm) After a clear cut harvest, the mean 

diameter of logs in the "small" size class, in cm. This is not required if the Harvest 

behavior is not used. Used by the Detailed Substrate behavior. 

 Clear Cut Proportion of Decayed Logs The proportion of substrate that is decayed logs 

in areas that had a clear cut harvest event, as a value between 0 and 1. This is not required 

if the Harvest behavior is not used. Used by the Substrate behavior. 

 Clear Cut Proportion of Fresh Logs The proportion of substrate that is fresh logs in 

areas that had a clear cut harvest event, as a value between 0 and 1. This is not required if 

the Harvest behavior is not used. Used by the Substrate behavior. 

 Clear Cut Proportion of Scarified Soil The proportion of substrate that is scarified soil 

in areas that had a clear cut harvest event, as a value between 0 and 1. This is not required 

if the Harvest behavior is not used. Used by the Substrate and Detailed Substrate 

behaviors. 

 Clear Cut Proportion of Tip-Up Mounds The proportion of substrate that is tip-up 

mounds substrate in areas that had a clear cut harvest event, as a value between 0 and 1. 

This is not required if the Harvest behavior is not used. Used by the Substrate and 

Detailed Substrate behaviors. 

 Decayed Log Annual Decay Alpha The α exponent in the decay equation , as 

applied to decayed logs. Note that this is annual decay. Used by the Substrate behavior. 



 Decayed Log Annual Decay Beta The β exponent in the decay equation , as 

applied to decayed logs. Note that this is annual decay. Used by the Substrate behavior. 

 Fresh Log Annual Decay Alpha The α exponent in the decay equation , as 

applied to fresh logs. Note that this is annual decay. Used by the Substrate behavior. 

 Fresh Log Annual Decay Beta The β exponent in the decay equation , as 

applied to fresh logs. Note that this is annual decay. Used by the Substrate behavior. 

 Gap Cut Small Logs Mean Diameter (cm) After a gap cut harvest, the mean diameter 

of logs in the "small" size class, in cm. This is not required if the Harvest behavior is not 

used. Used by the Detailed Substrate behavior. 

 Gap Cut Large Logs Mean Diameter (cm) After a gap cut harvest, the mean diameter 

of logs in the "large" size class, in cm. This is not required if the Harvest behavior is not 

used. Used by the Detailed Substrate behavior. 

 Gap Cut Proportion of Decayed Logs The proportion of substrate that is decayed logs 

in areas that had a gap cut harvest event, as a value between 0 and 1. This is not required 

if the Harvest behavior is not used. Used by the Substrate behavior. 

 Gap Cut Proportion of Fresh Logs The proportion of substrate that is fresh logs in 

areas that had a gap cut harvest event, as a value between 0 and 1. This is not required if 

the Harvest behavior is not used. Used by the Substrate behavior. 

 Gap Cut Proportion of Scarified Soil The proportion of substrate that is scarified soil in 

areas that had a gap cut harvest event, as a value between 0 and 1. This is not required if 

the Harvest behavior is not used. Used by the Substrate and Detailed Substrate behaviors. 

Used by the Substrate and Detailed Substrate behaviors. 

 Gap Cut Proportion of Tip-Up Mounds The proportion of substrate that is tip-up 

mounds substrate in areas that had a gap cut harvest event, as a value between 0 and 1. 

This is not required if the Harvest behavior is not used. Used by the Substrate and 

Detailed Substrate behaviors. 

 Initial Conditions Proportion of Decayed Logs The proportion of plot substrate that is 

decayed logs when the run starts, as a value between 0 and 1. If a map of substrate values 

is included in the parameter file (see Adding to a parameter file for information on how to 

do this), then the map values will be used for the initial conditions and this number will 

be ignored. Used by the Substrate behavior. 

 Initial Conditions Proportion of Fresh Logs The proportion of plot substrate that is 

fresh logs when the run starts, as a value between 0 and 1. If a map of substrate values is 

included in the parameter file (see Adding to a parameter file for information on how to 

do this), then the map values will be used for the initial conditions and this number will 

be ignored. Used by the Substrate behavior. 

 Initial Conditions Proportion of Scarified Soil The proportion of plot substrate that is 

scarified soil when the run starts, as a value between 0 and 1. If a map of substrate values 

is included in the parameter file (see Adding to a parameter file for information on how to 

do this), then the map values will be used for the initial conditions and this number will 

be ignored. Used by the Substrate and Detailed Substrate behaviors. 

 Initial Conditions Proportion of Tip-Up Mounds The proportion of plot substrate that 

is tip-up mounds substrate when the run starts, as a value between 0 and 1. If a map of 

substrate values is included in the parameter file (see Adding to a parameter file for 



information on how to do this), then the map values will be used for the initial conditions 

and this number will be ignored. Used by the Substrate and Detailed Substrate behaviors. 

 Initial Large Logs Mean Diameter (cm) For initial conditions, the mean diameter of 

logs in the "large" size class, in cm. Used by the Detailed Substrate behavior. 

 Initial Small Logs Mean Diameter (cm) For initial conditions, the mean diameter of 

logs in the "small" size class, in cm. Used by the Detailed Substrate behavior. 

 Maximum Number of Years that Decay Occurs The number of years that a substrate 

disturbance event has effect before it is deleted - the lifetime of a substrate cohort. Used 

by the Substrate and Detailed Substrate behaviors. 

 Partial Cut Large Logs Mean Diameter (cm) After a partial cut harvest, the mean 

diameter of logs in the "large" size class, in cm. This is not required if the Harvest 

behavior is not used. Used by the Detailed Substrate behavior. 

 Partial Cut Small Logs Mean Diameter (cm) After a partial cut harvest, the mean 

diameter of logs in the "small" size class, in cm. This is not required if the Harvest 

behavior is not used. Used by the Detailed Substrate behavior. 

 Partial Cut Proportion of Decayed Logs The proportion of substrate that is decayed 

logs in areas that had a partial cut harvest event, as a value between 0 and 1. This is not 

required if the Harvest behavior is not used. Used by the Substrate behavior. 

 Partial Cut Proportion of Fresh Logs The proportion of substrate that is fresh logs in 

areas that had a partial cut harvest event, as a value between 0 and 1. This is not required 

if the Harvest behavior is not used. Used by the Substrate behavior. 

 Partial Cut Proportion of Scarified Soil The proportion of substrate that is scarified 

soil in areas that had a partial cut harvest event, as a value between 0 and 1. This is not 

required if the Harvest behavior is not used. Used by the Substrate and Detailed Substrate 

behaviors. 

 Partial Cut Proportion of Tip-Up Mounds The proportion of substrate that is tip-up 

mounds substrate in areas that had a partial cut harvest event, as a value between 0 and 1. 

This is not required if the Harvest behavior is not used. Used by the Substrate and 

Detailed Substrate behaviors. 

 Proportion of Dead that Fall The proportion of the total number of newly dead trees 

that fall each year, as a value between 0 and 1. This does not apply to snags. Used by the 

Substrate behavior. 

 Proportion of Fallen that Uproot The proportion of fallen trees that uproot to create 

new tip-up mound substrate, as a value between 0 and 1. Used by the Substrate and 

Detailed Substrate behaviors. 

 Proportion of Forest Floor Litter/Moss Pool that is Moss The fixed proportion of the 

forest floor litter/moss pool that is moss. Expressed as a value between 0 and 1. Used by 

the Substrate and Detailed Substrate behaviors. 

 Proportion of Snags that Uproot The proportion of "dead" snags that uproot to create 

new tip-up mound substrate, as a value between 0 and 1. Not required if snags are not 

used in the run. Used by the Substrate and Detailed Substrate behaviors. 

 Prop. Live Trees Entering Decay Class X (0-1) The proportion of live trees entering 

each of the five decay classes. The proportion for all five classes together must add up to 

1. Used by the Detailed Substrate behavior. 



 Prop. Snags Entering Decay Class X (0-1) The proportion of snags entering each of the 

five decay classes. The proportion for all five classes together must add up to 1. Used by 

the Detailed Substrate behavior. 

 Scarified Soil Annual Decay Alpha The α exponent in the decay equation , 

as applied to scarified soil. Note that this is annual decay. Used by the Substrate and 

Detailed Substrate behaviors. 

 Scarified Soil Annual Decay Beta The β exponent in the decay equation , as 

applied to scarified soil. Note that this is annual decay. Used by the Substrate and 

Detailed Substrate behaviors. 

 Species Group Which species group (1-3) each species is assigned to. Used by the 

Detailed Substrate behavior. 

 Species Group X Large Class Y Clear Cut Log (0-1) After a clear cut harvest, the 

proportion of substrate area that is large logs of species group X, decay class Y. All clear 

cut values added together must be less than or equal to 1. This is not required if the 

Harvest behavior is not used. Used by the Detailed Substrate behavior. 

 Species Group X Small Class Y Clear Cut Log (0-1) After a clear cut harvest, the 

proportion of substrate area that is small logs of species group X, decay class Y. All clear 

cut values added together must be less than or equal to 1. This is not required if the 

Harvest behavior is not used. Used by the Detailed Substrate behavior. 

 Species Group X Large Class Y Gap Cut Log (0-1) After a gap cut harvest, the 

proportion of substrate area that is large logs of species group X, decay class Y. All gap 

cut values added together must be less than or equal to 1. This is not required if the 

Harvest behavior is not used. Used by the Detailed Substrate behavior. 

 Species Group X Small Class Y Gap Cut Log (0-1) After a gap cut harvest, the 

proportion of substrate area that is small logs of species group X, decay class Y. All gap 

cut values added together must be less than or equal to 1. This is not required if the 

Harvest behavior is not used. Used by the Detailed Substrate behavior. 

 Species Group X Large Class Y Initial Log Prop (0-1) For the initial conditions, the 

proportion of substrate area that is large logs of species group X, decay class Y. All initial 

conditions values added together must be less than or equal to 1. Used by the Detailed 

Substrate behavior. 

 Species Group X Small Class Y Initial Log Prop (0-1) For the initial conditions, the 

proportion of substrate area that is small logs of species group X, decay class Y. All 

initial conditions values added together must be less than or equal to 1. Used by the 

Detailed Substrate behavior. 

 Species Group X Large Class Y Log Decay Alpha The α exponent in the decay 

equation, as applied to large logs of species group X, decay class Y. This value must be a 

negative number. Used by the Detailed Substrate behavior. 

 Species Group X Small Class Y Log Decay Alpha The α exponent in the decay 

equation, as applied to small logs of species group X, decay class Y. This value must be a 

negative number. Used by the Detailed Substrate behavior. 

 Species Group X Large Class Y Log Decay Beta The β exponent in the decay equation, 

as applied to large logs of species group X, decay class Y. Used by the Detailed Substrate 

behavior. 



 Species Group X Small Class Y Log Decay Beta The β exponent in the decay equation, 

as applied to small logs of species group X, decay class Y. Used by the Detailed 

Substrate behavior. 

 Species Group X Large Class Y Partial Cut Log (0-1) After a partial cut harvest, the 

proportion of substrate area that is large logs of species group X, decay class Y. All 

partial cut values added together must be less than or equal to 1. This is not required if 

the Harvest behavior is not used. Used by the Detailed Substrate behavior. 

 Species Group X Small Class Y Partial Cut Log (0-1) After a partial cut harvest, the 

proportion of substrate area that is small logs of species group X, decay class Y. All 

partial cut values added together must be less than or equal to 1. This is not required if 

the Harvest behavior is not used. Used by the Detailed Substrate behavior. 

 Tip-Up Mounds Annual Decay Alpha The α exponent in the decay equation 

, as applied to tip-up mounds substrate. Note that this is annual decay. Used by the 

Substrate and Detailed Substrate behaviors. 

 Tip-Up Mounds Annual Decay Beta The β exponent in the decay equation , 

as applied to tip-up mounds substrate. Note that this is annual decay. Used by the 

Substrate and Detailed Substrate behaviors. 

 Uprooted Tree Radius Increase Factor for Root Rip-Out The amount by which to 

multiply the tree's radius when calculating the size of the new tip-up mounds soil exposed 

by fallen trees (see equation below). This is meant to allow for the effects of roots. Used 

by the Substrate and Detailed Substrate behaviors. 

 Use Directional Tree Fall If true, dead trees fall in a random direction and possibly 

contribute new fresh log across several Substrate grid cells. If false, dead trees collapse 

vertically and contribute all their fresh log area to the cell in which they are rooted. Used 

by the Substrate and Detailed Substrate behaviors. 

Substrate 

This behavior keeps track of six kinds of substrate: forest floor litter, forest floor moss, scarified 

soil, tip-up mounds, decayed logs, and fresh logs. Forest floor litter and forest floor moss form a 

common pool in fixed relative proportion to each other. These six substrates form a cycle. Fresh 

logs decay into decayed logs. Decayed logs, scarified soil, and tip-up mounds decay into forest 

floor litter and moss. (If no new substrate were created, eventually the whole forest would be 

uniformly covered in forest floor substrate.) The creation of new substrate decreases the amount 

of forest floor litter and moss and starts the process over again.  

There are two ways in which new substrate is added: harvest treatments and tree fall. Each kind 

of harvest treatment (partial cut, gap cut, and clear cut) has its own substrate signature, which 

you set in the parameters. The existing substrate proportions after a harvest are erased and 

replaced with this signature.  

The other type of substrate change event, tree fall, allows SORTIE to account for small-scale 

dynamics by allowing some dead trees to fall and create tip-up mounds. When a live tree dies, 

there is a certain probability that the tree will fall at death to create new fresh log substrate. 



Snags marked as "dead" always contribute new fresh log substrate. For both dead snags and live 

trees, there is a certain probability that the tree will expose an area of tip-up mounds substrate. 

Any new substrate created this way is added in to the existing substrate, but does not completely 

replace it like harvest does.  

Substrate relationships 

 

 
Relationships 1, 2, 4, and 6 represent the decay of the different substrates as a function of 

substrate age according to the equation  

 
 

where t is time in years. Graphed, this equation looks like this:  

 

In this diagram, there are two kinds of substrate, A and B. A decays into B according to the 

equation above. The amount of A and B together sum to 1 for this diagram. The curve for "% 

Remaining" is the amount of A. The curve for "% Lost/yr" is the amount of B. When β > 1, the 

rate of loss/time step increases over time (giving an initial lag period when there is little loss of 



the substrate). When β < 1 the substrate disappears most rapidly immediately after substrate 

creation (less likely). β = 1 gives a constant % loss per time step (i.e. exponential decline). (In 

this example, α = 0.0002 and β = 4.)  

Relationship 3 governs the amount of fresh logs created each time step as a result of tree 

mortality. For the purposes of adding new substrate, fallen logs are assumed to be cone-shaped. 

Since they land on their sides, the area of the cone is approximated to a triangle. Thus, each new 

fresh log contributes the following amount of new fresh log area:  

 

FL = (DBH * h)/2 

 

where:  

 FL is new fresh log area, in square meters  

 DBH is the DBH of the fallen tree, in m  

 h is the height of the fallen tree, in m  

A dead adult or sapling as a certain probability of contributing fresh log substrate; this 

probability is specified in the Proportion of Dead that Fall parameter. Snags always add fresh 

log substrate upon their "death".  

How new fresh log area is distributed depends on the value in the Use Directional Tree Fall 

parameter. If false, a dead tree contributes all of its fresh log area into the grid cell where it was 

rooted. In other words, it doesn't fall over so much as vertically collapse. If true, a trees is 

allowed to fall in a random direction. The amount of new fresh log area is distributed over the 

grid cells that the log overlays.  

Relationship 5 governs the amount of newly exposed tip-up mounds created by fallen dead trees. 

For each fallen tree, the amount of new tip-up mounds area is calculated as  

 

OA = π * (r*F)
2
 

 

where  

 OA is the new tip-up mounds area in square meters  

 r is the tree trunk radius in meters  

 F is the Uprooted Tree Radius Increase Factor for Root Rip-Out parameter, which 

accounts for the effects of root disturbance  

A tree contributes all of its new tip-up mounds area to the grid cell where it was rooted. Saplings 

never create tip-up mounds. Fallen adults create new tip-ups with the probability specified in the 

Proportion of Fallen that Uproot parameter; snags contribute at the probability in Proportion 

of Fallen that Uproot.  



Relationship 7 results from harvests only. Scarified soil creation results from the use of 

machinery and skidding during a harvest.  

How it works 

The relative proportions of each kind of substrate are tracked in the Substrate grid. You can 

change this grid's cell resolution. Within each cell, the grid keeps track of each substrate's area as 

a proportion of the total area.  

Each timestep, Substrate looks for harvest events and tree death. It finds harvest events by 

looking in the Harvest grid; it finds dead trees by looking for the flag set by the Mortality 

behaviors. Harvest events completely replace existing substrate with their substrate signatures. 

Each dead tree "rolls the dice" with a random number to determine if it falls, and, if it falls, if it 

exposes tip-up mounds substrate. All the new substrate created by harvest and tree fall is then 

totaled up.  

When there is new substrate in a grid cell, Substrate reduces the other substrate amounts in the 

cell to make way for the amount of new substrate. Then Substrate creates a record of the 

substrate change, called a "cohort." The substrates in a cohort decay as the cohort ages. Cohorts 

have a set lifetime of a certain number of years, which you set in the parameters. After this they 

are deleted. This means that the effects of a substrate change event linger, with decreasing 

intensity, for a number of years after the event occurs.  

The final proportions of scarified soil, tip-up mounds, and fresh logs are found by adding up the 

decayed values in the cohorts. The final proportion of decayed logs is found by adding up the 

amount by which fresh logs have decayed in each cohort. The final proportion of the moss/litter 

pool is whatever grid cell area is left over. The pool is further split into moss and litter by using 

the fixed proportion of each in the pool.  

How to apply it 

Apply Substrate to all trees which can create substrate by becoming fallen logs. This generally 

means that it should be applied to saplings and adults of all species. Substrate cannot be applied 

to seedlings. Any tree species/type combination to which it is applied must also have a mortality 

behavior applied.  

Behavior reference string: substrate  

Detailed Substrate 

This behavior is a modification of the Substrate behavior that primarily incorporates greater 

detail in tracking log cover. In Detailed Substrate, the pool for logs is divided into up to 3 species 

groups, 2 size classes, and 5 decay classes, whereas the Substrate behavior has 1 species/size 

class and 2 decay classes for logs. Also, unlike Substrate, Detailed Substrate is designed to work 

with snag dynamics behaviors that assign data members representing fall or break heights of 

trees and snags. This way, the processes of tree (and snag) breakage and fall are separated from 



their input into the log substrate pool. There is also a change from Substrate to the way 

harvesting adds new substrate, and values for log volume are calculated in addition to projected 

area (cover).  

Like Substrate, Detailed Substrate keeps track of the relative cover of forest floor litter, moss, 

scarified soil, tip-up mounds, and logs each timestep. Unless explained otherwise, the manner in 

which Detailed Substrate calculates and tracks these components is the same as for the Substrate 

behavior.  

Detailed Substrate divides logs into species groups, size classes, and decay classes. Logs in each 

combination of species group, size class, and decay class can have different initial proportions, 

proportions after harvest, and decay parameters from all other types of logs. Each species to 

which this behavior is assigned belongs to one species group (assigned with the Species Group 

parameter). As saplings, adults, and snags enter the substrate pool, they are added to the logs for 

the appropriate species group. Log substrate belongs to one of two size classes defined by 

diameter. The threshold diameter separating the two size classes is defined by the Boundary 

Between Log Diam Classes (cm) parameter. When a sapling, adult, or snag enters the substrate 

pool, the area input to each size class is calculated separately. The species group and size class to 

which log substrate is added do not change over time.  

Log substrate is also divided into 5 decay classes. Over time, decay class 1 logs decay into decay 

class 2 logs, then decay class 3 logs, then decay class 4 logs, then decay class 5 logs, then forest 

floor litter and moss. The relationship among these states, as well as tip-up mounds and scarified 

soil, is depicted in the figure below.  

 



Like in Substrate, decay among the log decay classes and for tip-up mounds and scarified soil 

(relationships 1-5, 7, and 9), is a function of substrate age according to the equation:  

 

 

where t is time in years since the last decay transition. Decay calculations for the 5 log decay 

classes are performed on an annual basis so it is possible to advance by more than one decay 

class in a single multi-year timestep. At the end of each timestep, the age of all logs is rounded to 

the nearest multiple of the timestep duration. This is necessary to keep memory requirements 

manageable.  

Log substrate is created by the processes of tree fall and breakage along the bole (relationship 6). 

Detailed Substrate looks at flags set by mortality and snag dynamics behaviors to determine 

whether a sapling, adult tree, or snag has either fallen or broken to a certain height in the current 

timestep. If so, it adds the appropriate area to the log substrate pool. Like in Substrate, tree boles 

are modeled as cones. The projected horizontal area is therefore a triangle if the top of the tree is 

included, or a trapezoid if only considering the lower section of a tree. New log substrate does 

not need to enter in decay class 1: the Prop. Live Trees Entering Decay Class X (0-1) and 

Prop. Snags Entering Decay Class X (0-1) parameters determine the probability of entering the 

substrate pool in each of the 5 decay classes for both snags and dead saplings/adults.  

Detailed Substrate allows new substrate proportions to be specified following clear cut, gap, and 

partial harvesting. If the total proportion of substrate after harvesting specified by parameters is 

less than 1, the remainder will be distributed in proportion to pre-harvest substrate values. In 

comparison, remaining substrate after harvest is assigned to moss and litter pools in the Substrate 

behavior. This change is designed to allow legacy substrates, such as logs and tip-up mounds, to 

persist after a harvest event.  

In addition to tracking log area, Detailed Substrate also stores the volume of each type of log 

substrate in each grid cell. For new inputs, log volume is calculated as:  

LV = 1/3 * π * (DBH / 2)
2
 * h 

where:  

 LV is new log volume, in m
3
 

 DBH is the DBH of the fallen tree, in m 

 h is the height of the fallen tree, in m 

For initial volume and volume added after harvest:  

LV = 1/3 * π * 100 * PLA * (MDBH / 2) 

where:  



 LV is initial log volume or volume added after harvest, in m
3
/ha 

 PLA is the proportional log area in the grid cell, from 0 to 1 

 MDBH is the mean DBH of logs of that type (either initial or added by harvest). These 

are set with parameters. A reasonable default is values of 0.5 and 1.5 of the diameter 

boundary are used for small and large size classes, respectively 

Log volume differs from log area proportions in that it does not have an upper bound. Each time 

new substrate is added, existing log substrate proportions are reduced so that the total of all 

substrate proportions is still less than or equal to 1. However, new inputs from tree fall and 

breakage do not reduce existing log volume (that is, logs can be on top of each other and still 

contribute to volume but not area). The volume of logs is reduced after harvesting when scarified 

soil is added (that is, log volume is destroyed in the area that is scarified). Log volume also 

decreases as pieces decay from decay class 5 to forest floor litter and moss.  

How it works 

The relative proportions of each kind of substrate are tracked in the Detailed Substrate grid. 

Within each cell, the grid keeps track of each substrate's area as a proportion of the total area, as 

well as volume for each type of log substrate in m
3
/ha. The behavior also summarizes and copies 

values into the Substrate grid for compatibility with other behaviors that use that grid.  

Each timestep, Detailed Substrate looks for harvest events and new tree inputs. It finds harvest 

events by looking in the Harvest grid. Harvest events add new scarified soil, tip-up, and log 

substrate. The behavior finds fallen and broken trees by looking for the flags set by mortality and 

snag dynamics behaviors. Each fallen and broken tree (or snag) "rolls the dice" with a random 

number to determine the log decay class it will enter as substrate. Fallen adult trees and snags 

also use a random number to determine whether they expose tip-up mound substrate. All the new 

substrate created by harvest and tree inputs is then totaled up. When there is new substrate in a 

grid cell, Detailed Substrate reduces the other substrate amounts in the cell to make way for the 

amount of new substrate.  

All existing substrates are decayed each timestep as they age. After they reach their maximum 

lifespan, which is set by parameters, they are deleted. The final proportions of scarified soil, tip-

up, and logs are found by adding up the values representing each substrate age. The final 

proportion of the moss/litter pool is whatever grid cell area is left over. The pool is further split 

into moss and litter by using fixed proportions of each in the pool, as specified by the 

Proportion of Forest Floor Litter/Moss Pool that is Moss parameter.  

How to apply it 

Apply Detailed Substrate to all trees which can create substrate by becoming fallen logs. This 

generally means that it should be applied to adults and snags of all species. Substrate cannot be 

applied to seedlings or saplings. Any tree species/type combination to which it is applied must 

also have a mortality and snag dynamics behavior applied.  

Behavior reference string: detailedsubstrate  
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Dead tree remover behaviors 

This type of behavior performs cleanup by removing dead trees from memory at the appropriate 

time. This function is very important - if it did not occur, then the model would slow 

exponentially as memory filled up and those behaviors that look at recently dead trees would 

start getting strange results. Currently, there is only one.  

Dead tree remover 

How it works 

This behavior looks for the death flag as set by the mortality behaviors. For each tree that it finds 

with that flag, it sends a request to the tree population to "kill" the tree. The reason passed to the 

tree population for the death of the tree is natural death.  

How to apply it 

This behavior should be applied to all tree species and tree types. All trees to which this behavior 

is applied must also have a light behavior applied. This is a signal to this behavior that the trees 

are going to have their data set up in the expected way.  

Behavior reference string: removedead  
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Snag dynamics behaviors 

In this document:  

Snag dynamics parameters  

Snag Decay Class Dynamics behavior  

Snag dynamics parameters 

 Snag Decay Class Dynamics Snag Fall Alpha Snag fall alpha parameter. Used by the 

Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Snag Fall Beta Snag fall beta parameter. Used by the Snag 

Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Snag Fall Eta Snag fall eta parameter. Used by the Snag 

Decay Class Dynamics behavior. 



 Snag Decay Class Dynamics Snag Fall Gamma 2 Snag fall gamma 2 parameter. Used 

by the Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Snag Fall Gamma 3 Snag fall gamma 3 parameter. Used 

by the Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Snag Fall Gamma 4 Snag fall gamma 4 parameter. Used 

by the Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Snag Fall Gamma 5 Snag fall gamma 5 parameter. Used 

by the Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Snag Fall Kappa Snag fall kappa parameter. Used by the 

Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Snag Fall Zeta Snag fall zeta parameter. Used by the Snag 

Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Tree Fall Alpha Tree fall alpha parameter. Used by the 

Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Tree Fall Beta Tree fall beta parameter. Used by the Snag 

Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Tree Fall Delta Tree fall delta parameter. Used by the 

Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Tree Fall Iota Tree fall iota parameter. Used by the Snag 

Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Tree Fall Lambda Tree fall lambda parameter. Used by 

the Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Tree Fall Theta Tree fall theta parameter. Used by the 

Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Live To Class 1 Prob (0-1) Probability of a snag that did 

not fall moving from live (killed this timestep) to decay class 1. Used by the Snag Decay 

Class Dynamics behavior. 

 Snag Decay Class Dynamics Live To Class 2 Prob (0-1) Probability of a snag that did 

not fall moving from live (killed this timestep) to decay class 2. Used by the Snag Decay 

Class Dynamics behavior. 

 Snag Decay Class Dynamics Live To Class 3 Prob (0-1) Probability of a snag that did 

not fall moving from live (killed this timestep) to decay class 3. Used by the Snag Decay 

Class Dynamics behavior. 

 Snag Decay Class Dynamics Live To Class 4 Prob (0-1) Probability of a snag that did 

not fall moving from live (killed this timestep) to decay class 4. Used by the Snag Decay 

Class Dynamics behavior. 

 Snag Decay Class Dynamics Live To Class 5 Prob (0-1) Probability of a snag that did 

not fall moving from live (killed this timestep) to decay class 5. Used by the Snag Decay 

Class Dynamics behavior. 

 Snag Decay Class Dynamics Class 1 To Class 1 Prob (0-1) Probability of a snag that 

did not fall remaining in decay class 1. Used by the Snag Decay Class Dynamics 

behavior. 

 Snag Decay Class Dynamics Class 1 To Class 2 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 1 to decay class 2. Used by the Snag Decay Class 

Dynamics behavior. 



 Snag Decay Class Dynamics Class 1 To Class 3 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 1 to decay class 3. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 1 To Class 4 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 1 to decay class 4. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 1 To Class 5 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 1 to decay class 5. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 2 To Class 2 Prob (0-1) Probability of a snag that 

did not fall remaining in decay class 2. Used by the Snag Decay Class Dynamics 

behavior. 

 Snag Decay Class Dynamics Class 2 To Class 3 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 2 to decay class 3. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 2 To Class 4 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 2 to decay class 4. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 2 To Class 5 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 2 to decay class 5. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 3 To Class 3 Prob (0-1) Probability of a snag that 

did not fall remaining in decay class 3. Used by the Snag Decay Class Dynamics 

behavior. 

 Snag Decay Class Dynamics Class 3 To Class 4 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 3 to decay class 4. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 3 To Class 5 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 3 to decay class 5. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 4 To Class 4 Prob (0-1) Probability of a snag that 

did not fall remaining in decay class 4. Used by the Snag Decay Class Dynamics 

behavior. 

 Snag Decay Class Dynamics Class 4 To Class 5 Prob (0-1) Probability of a snag that 

did not fall moving from decay class 4 to decay class 5. Used by the Snag Decay Class 

Dynamics behavior. 

 Snag Decay Class Dynamics Class 5 To Class 5 Prob (0-1) Probability of a snag that 

did not fall remaining in decay class 5. This value is always 1. Used by the Snag Decay 

Class Dynamics behavior. 

 Snag Decay Class Dynamics Maximum Snag Break Height Maximum height at which 

snags break. The actual height is a random draw between this value and the minimum. 

Used by the Snag Decay Class Dynamics behavior. 

 Snag Decay Class Dynamics Minimum Snag Break Height Minimum height at which 

snags break. The actual height is a random draw between this value and the maximum. 

Used by the Snag Decay Class Dynamics behavior. 



Snag Decay Class Dynamics 

This behavior controls transitions among snag decay classes and snag falls. There are two fall 

models, one that applies to trees that die in the current time step (and may fall without become a 

snag), and one that applies to pre-existing snags. Fall probability is a function of tree size, decay 

class, neighborhood basal area, and recent harvest activity. Trees and snags that do not fall are 

run through a snag decay class transition matrix.  

Model forms are based on those in Vanderwel et al. 2006.  

How it works 

Trees that died in the current timestep have a certain probability of falling before the end of the 

current timestep. (Note that trees that die in a mortality episode do NOT count as trees that died 

in the current timestep, but as existing snags.) The behavior represents the probability of falling 

before the end of the timestep as:  

 
 

f(x) = α + βspp + δ DBH + ζ BA + η H + ι (DBH * H) 

where:  

 Pr(fall) is the probability of the tree falling 

 α is the Snag Decay Class Dynamics Tree Fall Alpha parameter 

 βspp is the Snag Decay Class Dynamics Tree Fall Beta parameter for the tree's species 

 DBH is the DBH in cm 

 δ is the Snag Decay Class Dynamics Tree Fall Delta parameter 

 ζ is the Snag Decay Class Dynamics Tree Fall Theta parameter 

 BA is the basal area (m2/ha) of live trees in the current tree's cell of the Snag Decay Class 

Dynamics Basal Area grid 

 η is the Snag Decay Class Dynamics Tree Fall Iota parameter 

 H is whether (1) or not (0) a harvest occurred this timestep 

 ι is the Snag Decay Class Dynamics Tree Fall Lambda parameter 

For snags that were created in a previous timestep, the behavior represents the probability of 

falling during the timestep as:  

 
 

f(x) = α + βspp + γdc + δ ln(DBH) + ε ln(DBH)
2
 + θ BAH 



where:  

 Pr(fall) is the probability of the snag falling 

 α is the Snag Decay Class Dynamics Snag Fall Alpha parameter 

 βspp is the Snag Decay Class Dynamics Snag Fall Beta parameter for the tree's species 

 γdc is the Snag Decay Class Dynamics Snag Fall Gamma X parameter, where X is the 

snag's decay class 

 DBH is the DBH in cm 

 δ is the Snag Decay Class Dynamics Snag Fall Zeta parameter 

 ε is the Snag Decay Class Dynamics Snag Fall Eta parameter 

 θ is the Snag Decay Class Dynamics Snag Fall Kappa parameter 

 BAH is the basal area (m2/ha) of harvested trees in the current snag's cell of the Snag 

Decay Class Dynamics Basal Area grid 

Trees and snags that fall are removed completely from SORTIE and are not available for 

processes such as substrate.  

If a tree or snag does not fall, it's condition at the end of the timestep will be represented by a 

snag decay class. Decay class 1 is the least decayed condition and decay class 5 is the most 

decayed. Parameters should be entered to specify the probability of going from a live tree or one 

of five decay classes to each of the higher decay classes over a five year timestep, given that the 

snag is still standing. The transition probabilities for each initial condition must sum to 1.  

For all models, parameter values should correspond to the probability of fall for a five-year 

timestep. The behavior will re-scale the probability of fall for other timestep lengths if necessary.  

Basal area amounts are tracked in the Snag Decay Class Dynamics Basal Area grid. Each 

timestep, the amount of basal area, in square meters per hectare, is totaled across all species for 

live trees (live adults and adults that died in the current timestep) and harvested trees. The size of 

the grid cells is approximately 400 square meters. A tree's neighborhood basal area is the value 

in the grid cell where the tree is located.  

How to apply it 

This behavior can be applied to adults and snags of any species. It should be executed after 

mortality and dead tree remover behaviors have been applied in each timestep.  

Behavior reference string: snag decay class dynamics  
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Disperse behaviors 



In this document:  

Seed randomization  

Disperse parameters  

Non-spatial disperse behavior  

Masting non-spatial disperse behavior  

Spatial disperse behaviors  

--Non-gap spatial disperse behavior  

--Gap spatial disperse behavior  

--Masting spatial disperse behavior  

Disperse behaviors create and distribute tree seeds around the plot. Dispersal is the first step in 

seedling recruitment.  

Seed totals for different species are stored in the Dispersed Seeds grid. You can change this 

grid's cell resolution. Each of the disperse behaviors adds seeds to this grid. The Establishment 

behaviors decide which seeds in the grid turn into new seedlings.  

For these behaviors, "parent trees" refers to trees over the minimum reproductive DBH for a 

species. These are the only trees which can contribute new seeds to the plot. 

While there is support in the model for seeds to act as individuals (see Trees), these seeds are not 

individuals but merely numbers in a grid. You could not, for instance, create a list of individual 

seed positions. 

Seed randomization 

The numbers of seeds added by the disperse behaviors can be randomized. You choose how 

randomization will be applied. If the seed distribution is deterministic, no randomization is done. 

Otherwise, you can choose a probability distribution function and the number of seeds is treated 

as the mean of that function. You may need to supply additional parameters, depending on the 

probability distribution function you choose. This randomization applies to the seeds from all 

disperse behaviors that you have chosen. 

There are four choices for probability distribution functions: the normal, the lognormal, the 

Poisson, and the negative binomial. 

The normal distribution is: 

 
 

where σ is the function standard deviation. Mean is zero.  

The lognormal distribution is: 



 
 

where ζ is the function mean and σ is the standard deviation.  

The Poisson distribution is: 

 
 

where λ is the function mean.  

The negative binomial distribution is: 

 
 

where u is the function mean and k is the clumping parameter. This is Equation 3.103 from 

Hilborn and Mangel.  

Disperse parameters 

 Beta for Stumps The β value for stumps. Stumps use the same probability distribution 

function as the live members of their species. Only required if a behavior is being applied 

to stumps. Used by the Gap spatial disperse and Non-gap spatial disperse behaviors. 

 Canopy Function Used The probability distribution function to be used to distribute 

seeds in canopy conditions. For the behaviors Non-gap spatial disperse, and Masting 

spatial disperse, these PDFs are always the ones used. Used by the Non-gap spatial 

disperse, Gap spatial disperse and Masting spatial disperse behaviors. 

 Gap Function Used The probability distribution function to be used to distribute seeds in 

gap conditions. Used by the Gap spatial disperse behavior. 

 Intercept of Mean Non-Spatial Seed Rain, seeds/m
2
/yr The intercept of the non-spatial 

seed rain function. This is the bath seed rain term. Set this value to zero to turn off bath 

non-spatial seed rain. Used by the Non-spatial disperse behavior. 

 Lognormal Canopy Annual STR The annual STR value (Standardized Total Recruits, 

or all seeds produced by a 30 cm DBH tree in one year) for the lognormal function under 

canopy conditions (see equation below). This is only required if the canopy probability 

distribution function is lognormal. Used by the Gap spatial disperse and Non-gap spatial 

disperse behaviors. (In the case of the last, the canopy probability distribution function is 

the only one used for a species.) 

 Lognormal Canopy Beta The β for the lognormal function under canopy conditions (see 

equation below). This is only required if the canopy probability distribution function is 

lognormal. Used by the Gap spatial disperse and Non-gap spatial disperse behaviors. 



 Lognormal Canopy X0 The mean of the lognormal function under canopy conditions, or 

under non-masting conditions in the case of Masting spatial disperse (see equation 

below). This is only required if the canopy probability distribution function is lognormal. 

Used by the Gap spatial disperse and Non-gap spatial disperse behaviors. 

 Lognormal Canopy Xb The standard deviation of the lognormal function under canopy 

conditions, or under non-masting conditions in the case of Masting spatial disperse (see 

equation below). This is only required if the canopy probability distribution function is 

lognormal. Used by the Gap spatial disperse and Non-gap spatial disperse behaviors. 

 Lognormal Gap Annual STR The annual STR value (Standardized Total Recruits, or 

all seeds produced by a 30 cm DBH tree in one year) for the lognormal function under 

gap conditions (see equation below). This is only required if the gap probability 

distribution function is lognormal. Used by the Gap spatial disperse behavior. 

 Lognormal Gap Beta The β for the lognormal function under gap conditions (see 

equation below). This is only required if the gap probability distribution function is 

lognormal. Used by the Gap spatial disperse behavior. 

 Lognormal Gap X0 The mean of the lognormal function under gap conditions (see 

equation below). This is only required if the gap probability distribution function is 

lognormal. Used by the Gap spatial disperse behavior. 

 Lognormal Gap Xb The standard deviation of the lognormal function under gap 

conditions (see equation below). This is only required if the gap probability distribution 

function is lognormal. Used by the Gap spatial disperse behavior. 

 Mast NS Disperse - Binomial P (Mast Chance) "p" value for the binomial distribution 

used to randomly decide whether to mast each timestep. Used by the Masting non-spatial 

disperse behavior. 

 Mast NS Disperse - Masting Group Species in the same group always mast together. If 

all the group numbers are different, then each species masts separately. The actual 

numbers do not matter, just whether species have identical numbers. Used by the Masting 

non-spatial disperse behavior. 

 Mast NS Disperse - Mast Inv. Gauss. Mu Mu parameter for the inverse Gaussian 

distribution for choosing seeds in masting conditions. Values are only required for those 

species using this distribution when masting. Used by the Masting non-spatial disperse 

behavior. 

 Mast NS Disperse - Mast Inv. Gauss. Lambda Lambda parameter for the inverse 

Gaussian distribution for choosing seeds in masting conditions. Values are only required 

for those species using this distribution when masting. Used by the Masting non-spatial 

disperse behavior. 

 Mast NS Disperse - Non-Mast Inv. Gauss. Mu Mu parameter for the inverse Gaussian 

distribution for choosing seeds in non-masting conditions. Values are only required for 

those species using this distribution when not masting. Used by the Masting non-spatial 

disperse behavior. 

 Mast NS Disperse - Non-Mast Inv. Gauss. Lambda Lambda parameter for the inverse 

Gaussian distribution for choosing seeds in non-masting conditions. Values are only 

required for those species using this distribution when not masting. Used by the Masting 

non-spatial disperse behavior. 



 Mast NS Disperse - Mast Normal Mean Mean parameter for the normal distribution for 

choosing seeds in masting conditions. Values are only required for those species using 

this distribution when masting. Used by the Masting non-spatial disperse behavior. 

 Mast NS Disperse - Mast Normal Standard Deviation Standard deviation parameter 

for the normal distribution for choosing seeds in masting conditions. Values are only 

required for those species using this distribution when masting. Used by the Masting non-

spatial disperse behavior. 

 Mast NS Disperse - Non-Mast Normal Mean Mean parameter for the normal 

distribution for choosing seeds in non-masting conditions. Values are only required for 

those species using this distribution when not masting. Used by the Masting non-spatial 

disperse behavior. 

 Mast NS Disperse - Non-Mast Normal Standard Deviation Standard deviation 

parameter for the normal distribution for choosing seeds in non-masting conditions. 

Values are only required for those species using this distribution when not masting. Used 

by the Masting non-spatial disperse behavior. 

 Mast NS Disperse - PDF Masting Conditions Which probability distribution to use to 

choose number of seeds during masting events. Used by the Masting non-spatial disperse 

behavior. 

 Mast NS Disperse - PDF Non-Masting Conditions Which probability distribution to 

use to choose number of seeds when not masting. Used by the Masting non-spatial 

disperse behavior. 

 Masting Disperse - Masting Beta The β value under masting conditions. Used by the 

Masting spatial disperse behavior. 

 Masting Disperse - Masting CDF "a" The "a" value in the cumulative density function 

that is used to decide when masting events occur. Used by the Masting spatial disperse 

behavior. 

 Masting Disperse - Masting CDF "b" The "b" value in the cumulative density function 

that is used to decide when masting events occur. Used by the Masting spatial disperse 

behavior. 

 Masting Disperse - Masting Group Species in the same group always mast together. If 

all the group numbers are different, then each species masts separately. The actual 

numbers do not matter, just whether species have identical numbers. Used by the Masting 

spatial disperse behavior. 

 Masting Disperse - Masting Lognormal X0 The mean of the lognormal function under 

masting conditions. This is only required for a species if the canopy probability 

distribution function for that species is lognormal. Used by the Masting spatial disperse 

behavior. 

 Masting Disperse - Masting Lognormal Xb The standard deviation of the lognormal 

function under masting conditions. This is only required for a species if the canopy 

probability distribution function for that species is lognormal. Used by the Masting 

spatial disperse behavior. 

 Masting Disperse - Masting STR Mean The mean annual STR value under masting 

conditions. If the Masting Disperse - STR Draw PDF is Deterministic, then this is the 

STR value used. Used by the Masting spatial disperse behavior. 



 Masting Disperse - Masting STR Standard Deviation The standard deviation of the 

STR value under masting conditions. If the Masting Disperse - STR Draw PDF is 

Deterministic, then this value is not used. Used by the Masting spatial disperse behavior. 

 Masting Disperse - Mast Proportion Participating (0-1) The proportion of all adults 

for a species that participate in disperse during a masting timestep, as a value between 0 

and 1. Used by the Masting spatial disperse behavior. 

 Masting Disperse - Non-Masting Beta The β value under non-masting conditions. Used 

by the Masting spatial disperse behavior. 

 Masting Disperse - Non-Masting STR Mean The mean annual STR value under non-

masting conditions. If the Masting Disperse - STR Draw PDF is Deterministic, then 

this is the STR value used. Used by the Masting spatial disperse behavior. 

 Masting Disperse - Non-Masting STR Standard Deviation The standard deviation of 

the STR value under non-masting conditions. If the Masting Disperse - STR Draw PDF 

is Deterministic, then this value is not used. Used by the Masting spatial disperse 

behavior. 

 Masting Disperse - Non-Mast Proportion Participating (0-1) The proportion of all 

adults for a species that participate in disperse during a non-masting timestep, as a value 

between 0 and 1. Used by the Masting spatial disperse behavior. 

 Masting Disperse - Masting Weibull Dispersal The dispersal value for the weibull 

function under masting conditions. This is only required for a species if the canopy 

probability distribution function for that species is weibull. Used by the Masting spatial 

disperse behavior. 

 Masting Disperse - Masting Weibull Theta The θ for the weibull function under 

masting conditions. This is only required for a species if the canopy probability 

distribution function for that species is weibull. Used by the Masting spatial disperse 

behavior. 

 Masting Disperse - Stochastic STR Draw Frequency If the STR value is stochastic, 

this determines whether a new value is generated once per species per timestep or once 

per tree per timestep. If the Masting Disperse - STR Draw PDF is Deterministic, then 

this value is not used. Used by the Masting spatial disperse behavior. 

 Masting Disperse - STR Draw PDF Whether the STR value should be deterministic, or 

generated each timestep using a normal or lognormal distribution. Used by the Masting 

spatial disperse behavior. 

 Maximum Parent Trees Allowed in Gap Cell Maximum number of trees above the 

minimum DBH for reproduction that are allowed in a grid cell for that cell to still have 

gap status (as opposed to closed canopy). Used by the Gap spatial disperse behavior. 

 Minimum DBH for Reproduction, in cm The minimum DBH at which a tree can 

reproduce. This value does not have to match the Minimum adult DBH. Used by all 

disperse behaviors. 

 Seed Distribution The distribution method to be applied to seeds (randomization). Used 

by all disperse behaviors. Choices are:  

o Deterministic - no randomization. 

o Poisson - use the number of seeds as the mean in a Poisson probability 

distribution function. See the equation above. 



o Normal - use the number of seeds as the mean in a normal probability distribution 

function. You must then supply a standard deviation for the function. See the 

equation above. 

o Lognormal - use the number of seeds as the mean in a lognormal probability 

distribution function. You must then supply a standard deviation for the function. 

See the equation above. 

o Negative binomial - use the number of seeds as the mean in a negative binomial 

probability distribution function. You must then supply a clumping parameter. 

See the equation above. 

 Seed Dist. Clumping Parameter (Neg. Binomial) If you have chosen the negative 

binomial probability distribution function for "Seed distribution", this is the clumping 

parameter of the function, in seeds per m
2
. If you have not chosen that PDFs, then this 

parameter is not required. Used by all disperse behaviors. 

 Seed Dist. Std. Deviation (Normal or Lognormal) If you have chosen the normal or 

lognormal probability distribution functions for "Seed distribution", this is the standard 

deviation of the function, in seeds per m
2
. If you have not chosen these PDFs, then this 

parameter is not required. Used by all disperse behaviors. 

 Slope Mean Non-Spatial Seed Rain, seeds/m
2
/ha of BA/yr The slope of the non-spatial 

seed rain function. This is the basal-area-dependent seed rain term. Set this value to zero 

to turn off basal-area-dependent non-spatial seed rain. Used by the Non-spatial disperse 

behavior. 

 STR for Stumps The annual STR value (Standardized Total Recruits, or all seeds 

produced by a 30 cm DBH tree in one year) for stumps. Stumps use the same probability 

distribution function as the live members of their species. Only required if a behavior is 

being applied to stumps. Used by the Non-gap spatial disperse, Gap spatial disperse 

behaviors. 

 Weibull Canopy Annual STR The annual STR value (Standardized Total Recruits, or 

all seeds produced by a 30 cm DBH tree in one year) for the Weibull function under 

canopy conditions (see equation below). This is only required if the canopy probability 

distribution function is Weibull. Used by the Gap spatial disperse and Non-gap spatial 

disperse behaviors. (In the case of the last, the canopy probability distribution function is 

the only one used for a species.) 

 Weibull Canopy Beta The β for the Weibull function under canopy conditions (see 

equation below). This is only required if the canopy probability distribution function is 

Weibull. Used by the Gap spatial disperse and Non-gap spatial disperse behaviors. (In the 

case of the last, the canopy probability distribution function is the only one used for a 

species.) 

 Weibull Canopy Dispersal The dispersal value for the Weibull function under canopy 

conditions, or under non-masting conditions in the case of Masting spatial disperse (see 

equation below). This is only required if the canopy probability distribution function is 

Weibull. Used by the Gap spatial disperse, Non-gap spatial disperse and Masting spatial 

disperse behaviors. 

 Weibull Canopy Theta The θ for the Weibull function under canopy conditions, or 

under non-masting conditions in the case of Masting spatial disperse (see equation 

below). This is only required if the canopy probability distribution function is Weibull. 

Used by the Gap spatial disperse, Non-gap spatial disperse and Masting spatial disperse 



behaviors. (In the case of the last, the canopy probability distribution function is the only 

one used for a species.) 

 Weibull Gap Annual STR The annual STR value (Standardized Total Recruits, or all 

seeds produced by a 30 cm DBH tree in one year) for the Weibull function under gap 

conditions (see equation below). This is only required if the gap probability distribution 

function is Weibull. Used by the Gap spatial disperse behavior. 

 Weibull Gap Beta The β value for the Weibull function under gap conditions (see 

equation below). This is only required if the gap probability distribution function is 

Weibull. Used by the Gap spatial disperse behavior. 

 Weibull Gap Dispersal The dispersal value for the Weibull function under gap 

conditions (see equation below). This is only required if the gap probability distribution 

function is Weibull. Used by the Gap spatial disperse behavior. 

 Weibull Gap Theta The θ value for the Weibull function under gap conditions (see 

equation below). This is only required if the gap probability distribution function is 

Weibull. Used by the Gap spatial disperse behavior. 

Non-spatial disperse 

The "non-spatial" in non-spatial disperse refers to the fact that this behavior ignores the location 

of parent trees and scatters seeds uniformly across the plot. Non-spatial disperse has two 

components: basal-area-dependent seed rain and non-density-dependent (bath) seed rain, the two 

of which are independent and can be used together or separately. For basal-area-dependent seed 

rain, the number of seeds added is in direct proportion to the amount of basal area of parent trees 

of a given species. Bath seed rain adds a constant number of seeds each timestep, even if there 

are no parent trees of that species in the plot. 

How it works 

Non-spatial disperse calculates how many seeds to distribute as: 

ι = κ*BA + θ 

 

where:  

 ι is the mean number of seeds per m
2
 

 κ is the Slope Mean Non-Spatial Seed Rain, seeds/m2/ha of BA/yr parameter 

 BA is the basal area of the parent species in m
2
 

 θ is the Intercept of Mean Non-Spatial Seed Rain, seeds/m2/yr parameter 

From this, the number of seeds per grid cell of the Dispersed Seeds grid is calculated, and then 

that number is added to each grid cell.  

In the equation above, κ is the basal-area-dependent seed rain term. Setting this value to zero 

turns off density-dependent seed rain. θ is the bath seed rain term. Setting this value to zero turns 

off bath seed rain.  



How to apply it 

Apply this behavior to adults of the species you wish to use non-spatial disperse.  

Behavior reference string: non spatial disperse  

Spatial disperse behaviors 

Spatial disperse behaviors rely on the location and size of parent trees to determine the number 

and placement of seeds. The placement of the seeds is controlled by a probability distribution 

function. You can choose between the Weibull and lognormal functions. 

The Weibull function is as follows: 

 
 

where,  

 
 

and where:  

 Ri is the density (#/m2) of seedlings at a given point i 

 STR, the "standardized total recruits", is the number of seedling recruits produced by a 30 

cm DBH parent tree (the Weibull Canopy Annual STR or Weibull Gap Annual STR 

parameters) 

 DBHk is the DBH in cm of the k = 1…T parent trees within a specified radius of location i 

 D is a species-specific dispersal parameter (the Weibull Canopy Dispersal or Weibull 

Gap Dispersal parameters) 

 mik is the distance (in meters) from point i to the kth parent tree 

 ζ and β are disperse parameters (the Weibull Canopy Theta or Weibull Gap Theta and 

Weibull Gap Beta or Weibull Canopy Beta parameters) 

 

The lognormal function is as follows: 

 
 

where,  



 
 

and where:  

 Ri is the density (#/m2) of seedlings at a given point i 

 STR, the "standardized total recruits", is the number of seedling recruits produced by a 30 

cm DBH parent tree (the Lognormal Canopy Annual STR or Lognormal Gap Annual 

STR parameters) 

 DBHk is the DBH in cm of the k = 1…T parent trees within a specified radius of location i 

 mik is the distance (in meters) from point i to the kth parent tree 

 X0 is the mean of the function (the Lognormal Canopy X0 or Lognormal Gap X0 

parameters) 

 Xb is the standard deviation of the function (the Lognormal Canopy Xb or Lognormal 

Gap Xb parameters) 

 β is a disperse parameter (the Lognormal Canopy Beta or Lognormal Gap Beta 

parameters) 

 

The maximum distance that seeds are allowed to disperse is the length of the grid in the longest 

direction, up to a maximum of 1000 meters. Because of the torus shape of the plot, a seed 

deposited at the very limit of the distance could end up back underneath the parent tree. For this 

reason, if you are using a very flat dispersal kernel, you may wish to consider a non-spatial 

disperse method.  

The normalizer (Equation 3 of Ribbens et al 1994) serves two functions. It reduces parameter 

correlation between STR and the dispersion parameter (D); and scales the distance-dependent 

dispersion term so that STR is in meaningful units - i.e. the total # of seedlings produced in the 

entire seedling shadow of a 30 cm DBH parent tree.  

Non-gap spatial disperse 

Non-gap spatial disperse is called "non-gap" to distinguish it from "gap" disperse. The "non-gap" 

means that forest cover is ignored.  

How it works 

For each tree greater than reproductive age, the number of seeds produced is calculated as 

seeds = STR*(DBH/30)
β
 

These seeds are cast in random azimuth directions from the tree, and at random distances that 

conform to the chosen probability distribution function.  



How to apply it 

Apply this behavior to all trees of at least the minimum reproductive age for your chosen species. 

If the minimum reproductive age is less than the Minimum adult DBH, be sure to apply this 

behavior to saplings as well as adults. In the parameters, choose the appropriate probability 

distribution function for each species under "Canopy function used".  

This behavior can be used to simulate the suckering of stumps. Apply this behavior to tree type 

"stump" of your chosen species. Stumps reproduce like other parent trees. They use the same 

probability distribution function and parameters as live members of their species, but they get 

their own β and STR values so that they can produce different numbers of seeds.  

Behavior reference string: non-gap disperse  

Gap spatial disperse 

Gap spatial disperse takes forest cover into account when determining the number and placement 

of seeds. The two possible forest covers are gap and closed canopy. A "gap" is defined as a cell 

in the Dispersed Seeds grid with no more adults than the value of the "Maximum adults allowed 

in gap cell" parameter, above.  

How it works 

The behavior starts each timestep by updating the forest cover of each cell (gap or canopy). It 

counts all trees above the minimum DBH for reproduction in each cell and compares that 

number to the Maximum parent trees allowed in gap cell parameter. The behavior will count 

trees of all species to determine gap status. However, if it finds a tree of a species that is not one 

of the ones this behavior is assigned to, it will use the tree's minimum adult DBH parameter 

instead of the minimum DBH for reproduction.  

For each tree greater than the reproductive age, the number of seeds produced is calculated as  

seeds = STR*(DBH/30)
β
 

 

using the higher of gap or canopy STR along with its matching β.  

Each seed is given a random azimuth angle. It is then given a random distance that conforms to 

the probability distribution function of the current forest cover of the parent. Once the seed has 

an azimuth and a distance, the function determines which grid cell it should drop in.  

Once the seed has a target grid cell, that cell's cover is checked. Then the seed's survival is 

evaluated. If the seed is in the cover type with the higher STR, it automatically survives. 

Otherwise, a random number is compared to the ratio of the lower STR to the higher STR to 

determine if it survives.  



If the seed survives, it may need to be repositioned. If both parent and seed are under closed 

canopy, the seed is dropped where it is. If the parent is in gap and seedling is in canopy, a new 

distance is calculated as though the parent was also in canopy. The shortest of the two distances 

is used to determine where the seed lands. If the seed lands in a gap cell, the behavior "walks 

out" the line of the seed's path from parent to target landing cell, checking each intermediate grid 

cell's cover along the way. If any of the grid cells in the line are under canopy cover, the seed 

drops in the first canopy cell it reaches.  

How to apply it 

Apply this behavior to all trees of at least the minimum reproductive age for your chosen species. 

If the minimum reproductive age is less than the Minimum adult DBH, be sure to apply this 

behavior to saplings as well as adults. In the parameters, choose the appropriate probability 

distribution function for each species for each forest cover type.  

This behavior can be used to simulate the suckering of stumps. Apply this behavior to tree type 

"stump" of your chosen species. Stumps reproduce like other parent trees, except they always 

assume they are in a gap. They use the same probability distribution function and parameters as 

live members of their species, but they get their own β and STR values so that they can produce 

different numbers of seeds.  

Behavior reference string: gap disperse  

Masting spatial disperse behavior 

This behavior is a variant of the Non-gap spatial disperse behavior that adds masting and more 

stochasticity in seed production.  

How it works 

Deciding when to mast. For each timestep, the probability of masting for each species is 

calculated from the following cumulative distribution function:  

 

where:  

 y is the probability of masting 

 X is the number of years since last mast 

 a is the Masting Disperse - Masting CDF "a" parameter 

 b is the Masting Disperse - Masting CDF "b" parameter 



When the run starts, it is assumed a masting last event took place in timestep -1. A random 

number is used to determine whether a mast occurs in the current timestep. Disperse happens the 

same way in mast and non-mast timesteps, but the parameters used are different.  

Species may be organized into groups to create synchrony in masting. The Masting Disperse - 

Masting Group parameter allows you to assign group numbers to species. The actual value of 

the group number is not important. It only matters if more than one species has the same number. 

If one species in a group masts, all species in that group do. Each group's mast decision is made 

separately, so sometimes more than one group may mast at a time. If all species have a different 

group number, then they all mast independently of one another.  

Which trees disperse. Of the group of trees eligible to disperse (those with DBHs above the 

value in the Minimum DBH for Reproduction, in cm parameter), some can be randomly 

selected to participate in disperse. The proportion dispersing is set in Masting Disperse - Mast 

Proportion Participating (0-1) for mast timesteps, and Masting Disperse - Non-Mast 

Proportion Participating (0-1) for non-mast timesteps. The group of trees participating is 

chosen again each timestep. No adjustment is made to the number of seeds produced per tree. 

Fewer trees participating in disperse means fewer total seeds will be produced.  

STR stochasticity. The STR value may be randomized each timestep. Use the Masting 

Disperse - STR Draw PDF parameter to choose from a normal or lognormal probability 

distribution. You can then set the mean and standard deviations for each species, which are 

different in masting and non-masting timesteps. You can also leave the STR value deterministic, 

in which case the mean STR value is used directly.  

If you choose to use a stochastic STR, the STR value can be generated once per species per 

timestep, or once per tree per timestep. If the value is generated once per species, all individuals 

of that species use the same STR value that timestep.  

Once the behavior has decided whether masting occurs, and what the STR values are, then 

disperse proceeds exactly as described in the Non-gap spatial disperse behavior.  

How to apply it 

Apply this behavior to all trees of at least the minimum reproductive age for your chosen species. 

If the minimum reproductive age is less than the Minimum adult DBH, be sure to apply this 

behavior to saplings as well as adults.  

Behavior reference string: masting spatial disperse  

Masting non-spatial disperse behavior 

This behavior adds stochasticity to basic seed rain by simulating masting and basic inter - year 

variation in seed production. 

How it works 



Deciding when to mast. Each timestep, each species may mast or not. Mast is determined by 

making a random draw from a binomial distribution, with the "p" value for the distribution set 

using the Mast NS Disperse - Binomial P (Mast Chance) parameter. Masting decisions are 

made completely independently for each species (except in the case of masting groups; more on 

those later). 

The number of seeds, in seeds per square meter, is then drawn from a second probability 

distribution. The distribution choices are normal and inverse Gaussian. A species can use 

different distributions for mast and non-mast timesteps. You choose the distributions using the 

Mast NS Disperse - PDF Masting Conditions and Mast NS Disperse - PDF Non-Masting 

Conditions parameters. You then set up the values for the different distributions using the 

appropriate parameters. You do not need to set values for distributions that a species does not 

use. 

Once the number of seeds per square meter has been established for a species, that quantity of 

seed is distributed evenly across the plot. The presence or absence of parent trees of that species 

makes no difference to the number of seeds. 

To simulate synchrony in masting, species can be collected into masting groups. The decision to 

mast or not to mast using the binomial distribution is performed once for each group, using the 

first species in the group's "p" value. The number of seeds per square meter is established as for a 

single species; but those seeds are divided amongst the group's species according to the relative 

basal area of adults of each species in the plot. If there are no trees of any of the group's species, 

the seeds are divided equally amongst the species. 

How to apply it 

Apply this behavior to adults of the species you wish to use.  

Behavior reference string: masting non spatial disperse  
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Seed predation behaviors 

Seed predation occurs after seed dispersal has occurred and serves to reduce the number of seeds 

by simulating seed consumption by predators.  

In this document:  

Seed predation parameters  

Functional response seed predation behavior  

Neighborhood seed predation behavior  



Functional response seed predation behavior (linked)  

Neighborhood seed predation behavior (linked)  

Seed predation parameters 

 Func Resp - Demographic Efficiency, Season 1 The seed predator population 

demographic efficiency for season 1. Used by the Functional response seed predation 

behavior. 

 Func Resp - Demographic Efficiency, Season 2 The seed predator population 

demographic efficiency for season 2. Used by the Functional response seed predation 

behavior. 

 Func Resp - Density Dependent Coeff, Season 1 The coefficient describing the effect 

that density-dependent factors have on the predator population instantaneous rate of 

change, in season 1. Used by the Functional response seed predation behavior. 

 Func Resp - Density Dependent Coeff, Season 2 The coefficient describing the effect 

that density-dependent factors have on the predator population instantaneous rate of 

change, in season 2. Used by the Functional response seed predation behavior. 

 Func Resp - Foraging Efficiency The predator population foraging efficiency for each 

seed species. Used by the Functional response seed predation behavior. 

 Func Resp - Keep Predator Densities Between Timesteps If true, this means that the 

final predator density at the end of the behavior mini-model run is the initial density for 

the next mini-model run. If false, every time the behavior mini-model runs, it is re-

initialized with the value of the "Predator initial density - num/sq m" parameter. Used by 

the Functional response seed predation behavior. 

 Func Resp - Max Decline Rate, Season 1, predators/week The maximum rate of 

decline in the predator population in the absence of any food, in predators per week, for 

season 1. Used by the Functional response seed predation behavior. 

 Func Resp - Max Decline Rate, Season 2, predators/week The maximum rate of 

decline in the predator population in the absence of any food, in predators per week, for 

season 2. Used by the Functional response seed predation behavior. 

 Func Resp - Max Intake Rate - seeds per predator per day The maximum number of 

seeds of each species that can be eaten by one predator in one day. Used by the 

Functional response seed predation behavior. 

 Func Resp - Number of Weeks in Which Seedfall Occurs The number of weeks at the 

beginning of the behavior mini-model run that seedfall occurs. Used by the Functional 

response seed predation behavior. 

 Func Resp - Predator Initial Density - num/sq m The initial density of the predator 

population, in numbers per m
2
. This will be used the first time this behavior is run. 

Whether this density is used for subsequent behavior mini-model runs depends on the 

value of the "Keep Predator Densities Between Timesteps" parameter. Used by the 

Functional response seed predation behavior. 

 Func Resp - Proportion of Seeds Germinating Each Week During the period that 

germination occurs, this is the fraction of the seed pool that is removed due to seed 

germination. Expressed as a value between 0 and 1. Used by the Functional response seed 

predation behavior. 



 Func Resp - Seed Predation Output Filename, If Desired The filename where the 

mini-model will store its intermediate results for later analysis, if desired. This value is 

not required. Used by the Functional response seed predation behavior. 

 Func Resp - Week Germination Begins The week during the behavior mini-model run 

that germination begins to occur. If you do not want germination to occur, set this value 

greater than or equal to the "Weeks to run seed predation model (1 - 52)" parameter. This 

value must be between 0 and 52. Used by the Functional response seed predation 

behavior. 

 Func Resp - Week Season 2 Begins Used by the Functional response seed predation 

behavior. 

 Func Resp - Weeks to Run Seed Predation Model (1 - 52) The number of weeks 

(timesteps) to run the behavior's mini-model. This number must be between 1 and 52. 

Used by the Functional response seed predation behavior. 

 (Lnk) Func Resp - Demographic Efficiency, Season 1 The seed predator population 

demographic efficiency for season 1. Used by the Functional response seed predation 

(linked) behavior. 

 (Lnk) Func Resp - Demographic Efficiency, Season 2 The seed predator population 

demographic efficiency for season 2. Used by the Functional response seed predation 

(linked) behavior. 

 (Lnk) Func Resp - Density Dependent Coeff, Season 1 The coefficient describing the 

effect that density-dependent factors have on the predator population instantaneous rate 

of change, in season 1. Used by the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Density Dependent Coeff, Season 2 The coefficient describing the 

effect that density-dependent factors have on the predator population instantaneous rate 

of change, in season 2. Used by the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Foraging Efficiency The predator population foraging efficiency for 

each seed species. Used by the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Keep Predator Densities Between Timesteps If true, this means 

that the final predator density at the end of the behavior mini-model run is the initial 

density for the next mini-model run. If false, every time the behavior mini-model runs, it 

is re-initialized with the value of the "Predator initial density - num/sq m" parameter. 

Used by the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Max Decline Rate, Season 1, predators/week The maximum rate of 

decline in the predator population in the absence of any food, in predators per week, for 

season 1. Used by the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Max Decline Rate, Season 2, predators/week The maximum rate of 

decline in the predator population in the absence of any food, in predators per week, for 

season 2. Used by the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Max Intake Rate - seeds per predator per day The maximum 

number of seeds of each species that can be eaten by one predator in one day. Used by 

the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Number of Weeks in Which Seedfall Occurs The number of weeks 

at the beginning of the behavior mini-model run that seedfall occurs. Used by the 

Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Predator Initial Density - num/sq m The initial density of the 

predator population, in numbers per m
2
. This will be used the first time this behavior is 



run. Whether this density is used for subsequent behavior mini-model runs depends on 

the value of the "Keep Predator Densities Between Timesteps" parameter. Used by the 

Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Proportion of Seeds Germinating Each Week During the period 

that germination occurs, this is the fraction of the seed pool that is removed due to seed 

germination. Expressed as a value between 0 and 1. Used by the Functional response seed 

predation (linked) behavior. 

 (Lnk) Func Resp - Seed Predation Output Filename, If Desired The filename where 

the mini-model will store its intermediate results for later analysis, if desired. This value 

is not required. Used by the Functional response seed predation (linked) behavior. 

 (Lnk) Func Resp - Week Germination Begins The week during the behavior mini-

model run that germination begins to occur. If you do not want germination to occur, set 

this value greater than or equal to the "Weeks to run seed predation model (1 - 52)" 

parameter. This value must be between 0 and 52. Used by the Functional response seed 

predation (linked) behavior. 

 (Lnk) Func Resp - Week Season 2 Begins Used by the Functional response seed 

predation (linked) behavior. 

 (Lnk) Func Resp - Weeks to Run Seed Predation Model (1 - 52) The number of weeks 

(timesteps) to run the behavior's mini-model. This number must be between 1 and 52. 

Used by the Functional response seed predation (linked) behavior. 

 Neighborhood Predation - Counts For Masting? Determines which species are 

included when totaling up seed numbers to determine whether or not masting has 

occurred. Used by the Neighborhood seed predation behavior. 

 Neighborhood Predation - Mast Event Decision Method Determines how masting is 

decided. If this is set to "Seed threshold", then masting events occur when seed levels are 

above a set threshold. If this is set to "Ask disperse", then masting has occurred if any of 

the applicable species masted as determined by the masting disperse behaviors. Used by 

the Neighborhood seed predation behavior. 

 Neighborhood Predation - Masting "p0" The "p0" term in the seed offtake equation 

under masting conditions. Used by the Neighborhood seed predation behavior. 

 Neighborhood Predation - Species i Masting "pn" The "pn" term for species i in the 

seed offtake equation under masting conditions. Used by the Neighborhood seed 

predation behavior. 

 Neighborhood Predation - Masting Seed Density, #/m2/yr The density of edible seed 

that indicates masting has occurred. Used by the Neighborhood seed predation behavior. 

 Neighborhood Predation - Minimum Neighbor DBH (cm) The minimum DBH of 

trees to be included when calculating the basal area composition of the neighborhood. 

Used by the Neighborhood seed predation behavior. 

 Neighborhood Predation - Neighbor Search Radius (m) The radius to search for trees 

when calculating the basal area composition of the neighborhood. Used by the 

Neighborhood seed predation behavior. 

 Neighborhood Predation - Non-Masting "p0" The "p0" term in the seed offtake 

equation under non-masting conditions. Used by the Neighborhood seed predation 

behavior. 



 Neighborhood Predation - Species i Non-Masting "pn" The "pn" term for species i in 

the seed offtake equation under non-masting conditions. Used by the Neighborhood seed 

predation behavior. 

 (Lnk) Neighborhood Predation - "p0" The "p0" term in the seed offtake equation when 

in linked mode. Used by the Neighborhood seed predation behavior (linked) behavior. 

 (Lnk) Neighborhood Predation - Species i "pn" The "pn" term for species i in the seed 

offtake equation when in linked mode. Used by the Neighborhood seed predation 

behavior (linked) behavior. 

 (Lnk) Neighborhood Predation - Minimum Neighbor DBH (cm) The minimum DBH 

of trees to be included when calculating the basal area composition of the neighborhood, 

when in linked mode. Used by the Neighborhood seed predation behavior (linked) 

behavior. 

 (Lnk) Neighborhood Predation - Neighbor Search Radius (m) The radius to search 

for trees when calculating the basal area composition of the neighborhood, when in 

linked mode. Used by the Neighborhood seed predation behavior (linked) behavior. 

Functional response seed predation 

This behavior simulates functional response seed predation, where the number of predators is a 

function of the amount of food that has been consumed. Since seed predator life cycles are often 

very short, this behavior runs as a mini-model within the context of the larger simulation. It 

simulates weekly timesteps of seed fall, seed consumption, and predator response for as much of 

the year as the user desires. The mini-model simulates a single year, which starts at the beginning 

of seed fall. It is possible to define two seasons during the year with different parameters for seed 

consumption. All species are assumed to drop seeds at the same time, at a constant rate. You set 

the number of weeks that seedfall should occur. Once seedfall is over, there are no new additions 

to the predator food pool. There is then an optional period of germination in which the food pool 

of seeds is further reduced by some proportion of those remaining seeds germinating into 

seedlings (seedlings cannot be eaten). Once the model has finished running, the leftover seeds 

that were not consumed by predators, or those seeds that escaped through germination, are 

available as input to the Establishment behaviors.  

How it works 

The behavior's mini-model begins with the number of seeds of each species to which it is applied 

that are available in each cell of the Dispersed Seeds grid. Each cell gets its own run of the mini-

model. The pool of seeds in one cell for all species to which this behavior applies is treated as a 

single food pool for one year's time (even if the model timestep length is greater than one year). 

For all the species to which this behavior is applied, the seeds are assumed to be equally 

available; however, each species can have its own parameters for actual consumption rate. The 

initial number of predators is calculated from the Predator initial density - num/sq m 

parameter or, if the mini-model has run before and the Preserve predator densities between 

SORTIE timesteps parameter is set to true, from the final density of the last mini-model run.  

The behavior mini-model run begins at the part of the year in which seedfall occurs. The number 

of seeds in the seed rain is the total seed pool, which is evenly divided over the user-defined seed 



rain length. The predator population has as a food source the number of seeds added during the 

current week's rain (if the rain is going on) plus any leftover seeds from previous weeks which 

have not been consumed. Beginning at a certain week in the spring, the number of seeds 

available to the mice is further reduced by a certain percentage each week to simulate 

germination. Once germination begins, it continues until the predator model finishes running. In 

order to correctly calculate mouse consumption and ensure that the seeds which germinate are 

actually available later, the behavior keeps track of the seeds actually consumed; it is this number 

which is subtracted from total seeds at the end.  

Seed offtake for each week is calculated as  

O = Σ ( IRs * N ) 

 

where  

 0 is offtake (total number of seeds consumed) 

 IRs is per capita seed offtake for each species 

 N is the number of predators 

Per capita seed offtake for a single seed species is  

IRs = cs(1 - e
-(S*D))

 * ps 

 

where  

 cs is the Func Resp - Max Intake Rate - seeds per predator per day parameter for that 

seed species 

 S is the number of seeds per predator per day 

 D is the Func Resp - Foraging Efficiency parameter 

 ps is the proportion of the total seed pool made up by that species 

Predator response to food availability can be different for two seasons in the year. The dividing 

line between the seasons is given with the Func Resp - Week Season 2 Begins parameter. If you 

want a uniform response with no seasonal differences, you can set this value to 1 or 52, or set the 

predator response parameters to be the same for both seasons.  

The number of predators in each cell's population is calculated as  

 

Nt = Nt-1 * e
r
t-1 

 

where  

 Nt is number of predators for the current timestep  

 Nt-1 is number of predators in the previous timestep  

 rt-1 is instantaneous rate of change in predator abundance for the previous timestep  

The instantaneous rate of change per week, r, is calculated as  



r = (a + d * Σ ( IRs ) + g*N) / 12  

 

where  

 a is the Func Resp - Max Decline Rate, Season 1 (or 2), predators/week parameter  

 d is the Func Resp - Demographic Efficiency, Season 1 (or 2) parameter  

 g is the Func Resp - Density Dependent Coeff, Season 1 (or 2) parameter  

 N is number of predators per hectare  

How to apply it 

This behavior may be applied to seeds of any species. Any species to which it is applied must 

also have a Disperse behavior applied as well.  

Behavior reference string: functional response seed predation  

Functional response seed predation (linked) 

How it works 

This behavior is used together with the Neighborhood seed predation behavior (linked) behavior. 

The two behaviors work together to model seed predation.  

This behavior performs the functional response model in almost exactly the same way as the 

Functional response seed predation behavior. However, instead of removing the eaten seeds, it 

calculates a whole-plot offtake rate for the group of species to which it has been applied. This 

rate is always for the plot as a whole, not for individual cells of the seed grid. This offtake rate is 

then available for use by the Neighborhood seed predation behavior (linked) behavior, and no 

further action is taken.  

This behavior can be used in the same run with the non-linked version of this behavior. The two 

sets of species are kept completely separate, and there are two separate sets of parameters.  

How to apply it 

This behavior may be applied to seeds of any species. Any species to which it is applied must 

also have a Disperse behavior applied as well. Presumably, the Neighborhood seed predation 

behavior (linked) behavior will be applied to the same set of species, and should be placed after 

this behavior in the ordered list of model behaviors.  

Behavior reference string: linked functional response seed predation  

Neighborhood seed predation 



This simulates seed predation as a function of tree neighborhood and masting events. The same 

equations are used to calculate the amount of seed eaten, but there are different parameters for 

masting and non-masting timesteps. Masting events can be determined in one of two ways: by 

seed levels rising above a threshold that you set, or by masting having occurred as defined by 

one of the masting disperse behaviors.  

How it works 

Masting timesteps are those with a heavy density of edible seeds. The first step in a given time 

step is deciding whether or not masting is occurring. There are two methods available for making 

the masting decision. You set your chosen method using the Neighborhood Predation - Mast 

Event Decision Method parameter.  

If the event decision method is set to "Seed threshold", masting events occur whenever seed 

density rises above a certain threshold. You set the threshold for this density in the 

Neighborhood Predation - Masting Seed Density, #/m2/yr parameter. You then set which 

species are included in the mast count with the Neighborhood Predation - Counts For 

Masting? parameter. (Species which do not count towards masting may still be predated.) The 

seed density is set as an annual average so the density will be calculated the same way for 

different-length timesteps. If the total plotwide average annual seed density is greater than this 

value, the timestep is treated as a masting timestep. Only those seeds of species to which this 

behavior applies are considered in the density.  

If the event decision method is set to "Ask disperse", masting events occur whenever any of the 

species to which this behavior applies masts according to either the Masting non-spatial disperse 

behavior or the Masting spatial disperse behavior. You can use either of these behaviors, both of 

them, or neither (in which case masting never occurs). If any species to which this behavior is 

applied has masted with either behavior, then this is a masting time step.  

If there are no adult trees in the plot, then masting does not occur according to either method.  

The seeds in each grid cell of the Dispersed Seeds grid are treated separately for predation, 

according to their local neighborhood composition. The relative basal area of each species is 

calculated, from the total basal area of individuals within Neighborhood Predation - Neighbor 

Search Radius (m) meters of the grid cell center that have a DBH greater than Neighborhood 

Predation - Minimum Neighbor DBH (cm). The amount of seed eaten for each species is 

calculated as:  

 

where Y is the proportion of that species' seed that is eaten, and p0 is either the Neighborhood 

Predation - Masting "p0" or the Neighborhood Predation - Non-Masting "p0" parameter for 

that species. X is calculated as follows:  



 

where pn is either the Neighborhood Predation - Species i Masting "pn" or the Neighborhood 

Predation - Species i Non-Masting "pn" of species n, and RBAn is the relative basal are of 

species n.  

The eaten seeds are removed from the Dispersed Seeds grid.  

In order to make results more verifiable, Neighborhood Seed Predation produces a grid called 

Neighborhood Seed Predation. This grid stores the pre predation seed rain and amount of seeds 

eaten for each cell in the Dispersed Seeds grid. This grid has no effect on calculations but can be 

saved in the output file for review.  

How to apply it 

This behavior may be applied to seeds of any species. Any species to which it is applied must 

also have a Disperse behavior applied as well.  

Behavior reference string: Neighborhood Seed Predation  

Neighborhood seed predation (linked) 

How it works 

This behavior is used together with the Functional response seed predation behavior (linked) 

behavior. The two behaviors work together to model seed predation.  

The actual amount of seed eaten is calculated by the Functional response seed predation behavior 

(linked) behavior. This behavior then distributes the offtake according to neighborhood 

composition.  

The behavior begins by calculating the Y values for each grid cell as in the non-linked version 

(masting is ignored - there is only one set of parameters). Then the Y values are adjusted so that 

their mean is equal to the amount of whole-plot offtake Z as calculated by the Functional 

response seed predation behavior (linked). The adjustments are made as follows:  

1. Calculate logit(Z) 

2. Calculate the logit(Ys) and subtract the minimum value from each (as well as the 

logit(Z)) so they will all be positive 

3. Average the logit(Y)s 

4. Divide logit(Z) by average logit(Y) to get a correction factor 

5. Multiply each logit(Y) by the correction factor 

6. Add back the same minimum value formerly subtracted 



7. Back transform logit(Y) to Y and use when removing seeds 

Then the seeds are removed according to the adjusted Y values.  

This behavior can be used in the same run with the non-linked version of this behavior. The two 

sets of species are kept completely separate, and there are two separate sets of parameters.  

This behavior may be applied to seeds of any species. Any species to which it is applied must 

also have a Disperse behavior applied, as well as the Functional response seed predation 

behavior (linked). This behavior should be placed after that behavior in the ordered list of model 

behaviors.  

In order to make results more verifiable, Neighborhood Seed Predation produces a grid called 

Neighborhood Seed Predation. This grid stores the pre predation seed rain and amount of seeds 

eaten for each cell in the Dispersed Seeds grid. This grid has no effect on calculations but can be 

saved in the output file for review.  

Behavior reference string: Linked Neighborhood Seed Predation  
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Establishment behaviors 

In this document:  

Establishment parameters  

Substrate Dependent Seed Survival No Gap Status  

Substrate Dependent Seed Survival With Gap Status  

Substrate Based Seed Survival With Microtopography  

Light Dependent Seed Survival  

Storm Light Dependent Seed Survival  

Density Dependent Seed Survival  

Proportional Seed Survival  

Seed Establishment  

Establishment with Microtopography  

Establishment behaviors assess seed survival and create new seedlings from seeds. Establishment 

behaviors do not create or distribute the seeds. The Disperse behaviors perform that function.  

The seed survival behaviors act to reduce the number of seeds based on various environmental 

effects. They can be used alone or in combination. Once they have completed their work, the 

number of surviving seeds can be turned into seedlings by either the Seed Establishment or 

Establishment with Microtopography behaviors.  

Establishment parameters 



 Beam Fraction of Global Radiation The fraction of total solar radiation that is direct 

beam radiation (as opposed to diffuse). Expressed as a value between 0 and 1. See Light 

Behaviors for more on GLI calculations. Used by the Light Dependent Seed Survival 

behavior. 

 Clear Sky Transmission Coefficient Used to determine the amount of solar radiation 

seen at the plot location. See Light Behaviors for more on GLI calculations. Used by the 

Light Dependent Seed Survival behavior. 

 First Day of Growing Season for GLI Light Calculations The first day of the growing 

season, as a Julian day (number between 1 and 365). Seeds only get light during the 

growing season. See Light Behaviors for more on GLI calculations. Used by the Light 

Dependent Seed Survival behavior. 

 Fraction Seeds Germinating on Canopy Decayed Logs The proportion of those seeds 

that land on decayed logs under canopy conditions that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed Survival 

No Gap Status and Substrate Dependent Seed Survival With Gap Status behaviors. 

 Fraction Seeds Germinating on Canopy Fresh Logs The proportion of those seeds that 

land on fresh logs under canopy conditions that survive to become seedlings. Expressed 

as a value between 0 and 1. Used by the Substrate Dependent Seed Survival No Gap 

Status and Substrate Dependent Seed Survival With Gap Status behaviors. 

 Fraction Seeds Germinating on Canopy Forest Floor Litter The proportion of those 

seeds that land on forest floor litter under canopy conditions that survive to become 

seedlings. Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed 

Survival No Gap Status and Substrate Dependent Seed Survival With Gap Status 

behaviors. 

 Fraction Seeds Germinating on Canopy Forest Floor Moss The proportion of those 

seeds that land on forest floor moss under canopy conditions that survive to become 

seedlings. Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed 

Survival No Gap Status and Substrate Dependent Seed Survival With Gap Status 

behaviors. 

 Fraction Seeds Germinating on Canopy Scarified Soil The proportion of those seeds 

that land on scarified soil under canopy conditions that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed Survival 

No Gap Status and Substrate Dependent Seed Survival With Gap Status behaviors. 

 Fraction Seeds Germinating on Canopy Tip-Up The proportion of those seeds that 

land on tip-up mounds substrate under canopy conditions that survive to become 

seedlings. Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed 

Survival No Gap Status and Substrate Dependent Seed Survival With Gap Status 

behaviors. 

 Fraction Seeds Germinating on Gap Decayed Logs The proportion of those seeds that 

land on decayed logs under gap conditions that survive to become seedlings. Expressed 

as a value between 0 and 1. Used by the Substrate Dependent Seed Survival With Gap 

Status behavior. 

 Fraction Seeds Germinating on Gap Fresh Logs The proportion of those seeds that 

land on fresh logs under gap conditions that survive to become seedlings. Expressed as a 

value between 0 and 1. Used by the Substrate Dependent Seed Survival With Gap Status 

behavior. 



 Fraction Seeds Germinating on Gap Forest Floor Litter The proportion of those seeds 

that land on forest floor litter under gap conditions that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed Survival 

With Gap Status behavior. 

 Fraction Seeds Germinating on Gap Forest Floor Moss The proportion of those seeds 

that land on forest floor moss under gap conditions that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed Survival 

With Gap Status behavior. 

 Fraction Seeds Germinating on Gap Scarified Soil The proportion of those seeds that 

land on scarified soil under gap conditions that survive to become seedlings. Expressed as 

a value between 0 and 1. Used by the Substrate Dependent Seed Survival With Gap 

Status behavior. 

 Fraction Seeds Germinating on Gap Tip-Up The proportion of those seeds that land on 

tip-up mounds substrate under gap conditions that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Dependent Seed Survival 

With Gap Status behavior. 

 Fraction Seeds Germinating on Ground Decayed Logs The proportion of those seeds 

that land on decayed logs ground substrate that survive to become seedlings. Expressed 

as a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Ground Forest Floor Litter The proportion of those 

seeds that land on forest floor litter ground substrate that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Ground Forest Floor Moss The proportion of those 

seeds that land on forest floor moss ground substrate that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Ground Fresh Logs The proportion of those seeds that 

land on fresh logs ground substrate that survive to become seedlings. Expressed as a 

value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Ground Scarified Soil The proportion of those seeds 

that land on scarified soil ground substrate that survive to become seedlings. Expressed as 

a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Ground Tip-Up The proportion of those seeds that 

land on tip-up ground substrate that survive to become seedlings. Expressed as a value 

between 0 and 1. Used by the Substrate Based Seed Survival With Microtopography 

behavior. 

 Fraction Seeds Germinating on Mound Decayed Logs The proportion of those seeds 

that land on decayed logs mound substrate that survive to become seedlings. Expressed as 

a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Mound Forest Floor Litter The proportion of those 

seeds that land on forest floor litter mound substrate that survive to become seedlings. 



Expressed as a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Mound Forest Floor Moss The proportion of those 

seeds that land on forest floor moss mound substrate that survive to become seedlings. 

Expressed as a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Mound Fresh Logs The proportion of those seeds that 

land on fresh logs mound substrate that survive to become seedlings. Expressed as a 

value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Mound Scarified Soil The proportion of those seeds 

that land on scarified soil mound substrate that survive to become seedlings. Expressed as 

a value between 0 and 1. Used by the Substrate Based Seed Survival With 

Microtopography behavior. 

 Fraction Seeds Germinating on Mound Tip-Up The proportion of those seeds that land 

on tip-up mound substrate that survive to become seedlings. Expressed as a value 

between 0 and 1. Used by the Substrate Based Seed Survival With Microtopography 

behavior. 

 GLI of Optimum Establishment, 0-100 The GLI value of optimum survival for seeds, 

as a value between 0 and 100. Used by the Light Dependent Seed Survival behavior. 

 Height in m At Which to Calculate GLI The height, in meters, at which to calculate 

GLI at the center of each grid cell. Used by Light Dependent Seed Survival behavior. 

 Last Day of Growing Season for GLI Light Calculations The last day of the growing 

season, as a Julian day (number between 1 and 365). Seeds only get light during the 

growing season. See Light Behaviors for more on GLI calculations. Used by the Light 

Dependent Seed Survival behavior. 

 Light Extinction Coeff of Complete Damage Trees (0-1) The fraction of light 

transmitted by the crowns of trees with complete Storm damage. Not required if storms 

are not used. Expressed as a value between 0 and 1. If storms are used, a value must be 

supplied for every species. See Light Behaviors for more on GLI calculations. Used by 

the Light Dependent Seed Survival behavior. 

 Light Extinction Coeff of Medium Damage Trees (0-1) The fraction of light 

transmitted by the crowns of trees with medium Storm damage. Not required if storms 

are not used. Expressed as a value between 0 and 1. If storms are used, a value must be 

supplied for every species. See Light Behaviors for more on GLI calculations. Used by 

the Light Dependent Seed Survival behavior. 

 Light Extinction Coeff of Undamaged Trees (0-1) The fraction of light transmitted by 

the crowns of regular live trees (and if storms are being used, trees with no Storm 

damage). Expressed as a value between 0 and 1. A value must be supplied for every 

species. See Light Behaviors for more on GLI calculations. Used by the Light Dependent 

Seed Survival behavior. 

 Mean Height of Fresh Log Substrate, in m The mean height of fresh log substrate, in 

meters. Used by the Establishment with Microtopography behavior. 

 Mean Height of Mounds, in m The mean height of mounded areas, in meters. Used by 

the Establishment with Microtopography behavior. 



 Minimum Solar Angle for GLI Calculations, in rad This is the minimum angle at 

which sunlight is seen, in radians. Below this value the sky is assumed to be dark due to 

shading neighbors. See Light Behaviors for more on GLI calculations. Used by the Light 

Dependent Seed Survival behavior. 

 Number of Altitude Sky Divisions for GLI Light Calculations Number of grid cells 

into which the sky is divided from horizon to zenith, for the purpose of calculating light 

direction. See Light Behaviors for more on GLI calculations. Used by the Light 

Dependent Seed Survival behavior. 

 Number of Azimuth Sky Divisions for GLI Light Calculations Number of grid cells 

into which the sky is divided around the horizon, for the purpose of calculating light 

direction. See Light Behaviors for more on GLI calculations. Used by the Light 

Dependent Seed Survival behavior. 

 # Years Respite from Fern Shading for Seeds on Fresh Logs The maximum number 

of years that seeds can get respite from fern shading, as implemented by the Beer's law 

light filter behavior. Used by the Establishment with Microtopography behavior. 

 Proportion Germinating Between 0 and 1 The proportion of seeds of a species that 

survive germination, as a value between 0 and 1. Used by the Proportional Seed Survival 

behavior. 

 Proportion of Plot Area that is Mound The proportion of plot area that is mound area, 

as opposed to ground area. Expressed as a value between 0 and 1. Used by the Substrate 

Based Seed Survival With Microtopography behavior. 

 Slope of Density Dependence The slope of the density dependence function for 

determining how many seedlings establish per square meter (c in the equations below). 

Used by the Density Dependent Seed Survival behavior. 

 Slope of Dropoff Above the Optimum GLI The slope of the line describing the drop off 

in seedling survival as a function of GLI above the optimum GLI. Used by the Light 

Dependent Seed Survival behavior. 

 Slope of Dropoff Below Optimum GLI The slope of the line describing the dropoff in 

seedling survival as a function of GLI below the optimum GLI. Used by the Light 

Dependent Seed Survival behavior. 

 Steepness of Density Dependence The steepness of the density dependence function for 

determining how many seedlings establish per square meter (δ in the equations below). 

Used by the Density Dependent Seed Survival behavior. 

 Snag Age Class 1 Light Extinction Coefficient (0-1) Fraction of light transmitted 

through the snag tree crown for each species. Applies to those snags whose age is less 

than or equal to "Upper age (yrs) of snag light extinction class 1". Expressed as a fraction 

between 0 and 1. If your run does not work with snags, you can ignore this. Otherwise, a 

value must be provided for all species. Used by the Light Dependent Seed Survival 

behavior. 

 Snag Age Class 2 Light Extinction Coefficient (0-1) Fraction of light transmitted 

through the snag tree crown for each species. Applies to those snags whose age is greater 

than "Upper age (yrs) of snag light extinction class 1", but is less than or equal to "Upper 

age (yrs) of snag light extinction class 2". Expressed as a fraction between 0 and 1. If 

your run does not work with snags, you can ignore this. Otherwise, a value must be 

provided for all species. Used by the Light Dependent Seed Survival behavior. 



 Snag Age Class 3 Light Extinction Coefficient (0-1) Fraction of light transmitted 

through the snag tree crown for each species. Applies to those snags whose age is greater 

than "Upper age (yrs) of snag light extinction class 2". Expressed as a fraction between 0 

and 1. If your run does not work with snags, you can ignore this. Otherwise, a value must 

be provided for all species. Used by the Light Dependent Seed Survival behavior. 

 Standard Deviation of Fresh Log Substrate Height, in m The standard deviation of 

height of fresh log substrate, in meters. Used by the Establishment with Microtopography 

behavior. 

 Standard Deviation of Mound Height, in m The standard deviation of the height of 

mounded areas, in meters. Used by the Establishment with Microtopography behavior. 

 Upper Age (Yrs) of Snag Light Extinction Class 1 The upper age limit, in years, 

defining the first age class of snag light extinction. Snags with an age less than or equal to 

this age have a light extinction coefficient matching "Snag age class 1 light extinction 

coefficient". If your run does not work with snags, you can ignore this. Used by the Light 

Dependent Seed Survival behavior. 

 Upper Age (Yrs) of Snag Light Extinction Class 2 The upper age limit, in years, 

defining the second age class of snag light extinction. Snags with an age greater than the 

upper limit for size class 1, but less than or equal to this age, have a light extinction 

coefficient matching "Snag age class 2 light extinction coefficient". Snags with an age 

greater than this value are in age class three. If your run does not work with snags, you 

can ignore this. Used by the Light Dependent Seed Survival behavior. 

Substrate Dependent Seed Survival No Gap Status 

This behavior assesses seed survival based on substrate conditions.  

How it works 

The behavior takes the substrate composition of each grid cell in the Substrate grid and converts 

it into a single number for each species, called the substrate favorability index. The favorability 

index is the sum of the proportions of each substrate multiplied by the proportion of seeds that 

germinate on that substrate. This index represents the proportion of total seeds of that species 

that are expected to survive in that area of the plot. This index is stored in the grid Substrate 

Favorability. (In the parameters list, above, the proportions used are the canopy proportions.)  

The behavior then goes through each grid cell in the Dispersed Seeds grid and assesses the 

survival for the seeds of those species to which it applies. This behavior starts by giving each 

seed a random temporary location within the Dispersed Seeds grid cell. Then, it retrieves the 

substrate favorability at that point from the Substrate Favorability grid. It then compares a 

random number to the substrate favorability to determine whether the seed lives. This method 

ensures that we can assess substrate favorabilities correctly when the Dispersed Seeds and 

Substrate grids have different grid cell resolutions.  

Once this process is complete, the number of surviving seeds for each species is assigned back to 

the Dispersed Seeds grid.  



How to apply it 

This behavior may be applied to seeds of any species. A species to which this is applied must 

also have a Disperse behavior applied. Also, the Substrate behavior must be used in the run.  

Behavior reference string: No Gap Substrate Seed Survival  

Substrate Dependent Seed Survival With Gap Status 

This behavior assesses seed survival as a function of both the substrate composition of the grid 

cells in which seeds land and the cells' forest cover (gap or canopy). This behavior allows for 

different germination favorability for substrates under the two forest covers.  

How it works 

The behavior takes the substrate composition of each grid cell in the Substrate grid and converts 

it into a single number for each species, called the substrate favorability index. The favorability 

index is the sum of the proportions of each substrate multiplied by the proportion of seeds that 

germinate on that substrate under that cell's cover (canopy or gap). This index represents the 

proportion of total seeds of that species that are expected to survive in that area of the plot. This 

index is stored in the grid Substrate Favorability.  

The behavior then goes through each grid cell in the Dispersed Seeds grid and assesses the 

survival for the seeds of those species to which it applies. This behavior starts by giving each 

seed a random temporary location within the Dispersed Seeds grid cell. Then, it retrieves the 

substrate favorability at that point from the Substrate Favorability grid. It then compares a 

random number to the substrate favorability to determine whether the seed lives. This method 

ensures that we can assess substrate favorabilities correctly when the Dispersed Seeds and 

Substrate grids have different grid cell resolutions.  

Once this process is complete, the number of surviving seeds for each species is assigned back to 

the Dispersed Seeds grid.  

How to apply it 

This behavior may be applied to seeds of any species. A species to which this is applied must 

also have the Gap spatial disperse behavior applied. Also, the Substrate behavior must be used in 

the run.  

Behavior reference string: Gap Substrate Seed Survival  

Substrate Based Seed Survival With Microtopography 

This behavior assesses seed survival based on substrate conditions, allowing for site 

microtopography to influence seed survival. In this scenario, the plot is divided into small-scale 



mounds. The portion of the plot that is slightly elevated is "mound". The portion of the plot 

between the mounds, at lower elevation, is "ground". The size of the mounds and their height is 

not important.  

How it works 

The area of the plot that is "mound" and the area that is "ground" are in fixed relative proportion 

to each other. This fixed proportion is entered in the Proportion of Plot Area that is Mound 

parameter. Each grid cell in the Substrate grid has been divided by the Substrate behavior into 

six substrate types; each of those types is further divided into "mound" and "ground" according 

to the fixed proportion, making twelve total substrate types. For example, if 20% of a grid cell's 

area is forest floor litter, and 60% of the plot area is mound, then the area of the grid cell that is 

forest floor litter mound substrate is 12% and the area of grid cell that is forest floor litter ground 

substrate is 8%.  

The behavior takes the substrate composition of each grid cell in the Substrate grid, calculates 

the amount of the twelve substrate types, and converts it into a single number for each species, 

called the substrate favorability index. The favorability index is the sum of the proportions of 

each substrate multiplied by the proportion of seeds that germinate on that substrate. This index 

represents the proportion of total seeds of that species that are expected to survive in that area of 

the plot. This index is stored in the grid Substrate Favorability.  

The behavior then goes through each grid cell in the Dispersed Seeds grid and assesses the 

survival for the seeds of those species to which it applies. This behavior starts by giving each 

seed a random temporary location within the Dispersed Seeds grid cell. Then, it retrieves the 

substrate favorability at that point from the Substrate Favorability grid. It then compares a 

random number to the substrate favorability to determine whether the seed lives. This method 

ensures that we can assess substrate favorabilities correctly when the Dispersed Seeds and 

Substrate grids have different grid cell resolutions.  

Once this process is complete, the number of surviving seeds for each species is assigned back to 

the Dispersed Seeds grid.  

How to apply it 

This behavior may be applied to seeds of any species. A species to which this is applied must 

also have a Disperse behavior applied. Also, the Substrate behavior must be used in the run.  

Behavior reference string: Microtopographic Substrate Seed Survival  

Light Dependent Seed Survival 

This behavior assesses seed survival as a function of the Global Light Index (GLI) of the location 

in which a seed lands. Light level calculations can take into account the change in light blocking 

by snags and trees with storm damage, if desired.  



The effects of light levels on seed survival is graphed as: 

 

How it works 

To assess the effects of light level on the number of seeds that survive, this behavior calculates 

the GLI at the center of each grid cell in the Dispersed Seeds grid at the height specified in the 

Height in m At Which to Calculate GLI parameter (value is in meters). The calculation 

proceeds exactly as described in the Light Behaviors. In order to perform these GLI calculations, 

this behavior requires its own copy of the key GLI setup parameters.  

If you wish to use storms in your run, this behavior can take into account the fact that storm-

damaged trees may have different light extinction coefficients. These light extinction coefficients 

are specified in the Light Extinction Coeff of Complete Damage Trees (0-1) and Light 

Extinction Coeff of Medium Damage Trees (0-1) parameters.  

Once GLI has been calculated, the proportion of seeds that survive for a given species is 

calculated as:  

 If GLI < GLIopt, LE = 1 - (Slo(GLIopt - GLI)) 

 If GLI = GLIopt, LE = 1 

 If GLI > GLIopt, LE = 1 - (Shi(GLI - GLIopt)) 

where  

 GLI is the GLI at the center of the Dispersed Seeds grid cell at the height in the Height in 

m At Which to Calculate GLI parameter 

 GLIopt is the GLI of Optimum Establishment, 0-100 parameter 

 Slo is the Slope of Dropoff Below Optimum GLI parameter 

 Shi is the Slope of Dropoff Above the Optimum GLI parameter 

Once the proportion of seeds that survive at the given GLI has been calculated, this value is 

multiplied by the number of seeds to reduce them by the proper amount. The new reduced 

number of seeds is put back in the Dispersed Seeds grid.  

How to apply it 



Apply this behavior to seeds of your desired species. Any species to which it is applied must also 

have a Disperse behavior applied. Storm damage is optional.  

Behavior reference string: Light Dependent Seed Survival  

Storm Light Dependent Seed Survival 

This behavior assesses seed survival as a function of the light level of the location in which a 

seed lands. Light level calculations are performed by the Storm Light behavior. (This behavior is 

exactly like Light Dependent Seed Survival except for the method of light level calculation.)  

The effects of light levels on seed survival is graphed as: 

 

How it works 

To assess the effects of light level on the number of seeds that survive, this behavior retrieves the 

light level from the Storm Light grid that corresponds to the point in the center of each Dispersed 

Seeds grid cell.  

The proportion of seeds that survive for a given species is calculated as:  

 If GLI < GLIopt, LE = 1 - (Slo(GLIopt - GLI)) 

 If GLI = GLIopt, LE = 1 

 If GLI > GLIopt, LE = 1 - (Shi(GLI - GLIopt)) 

where  

 GLI is the light level at the center of the Dispersed Seeds grid cell 

 GLIopt is the GLI of Optimum Establishment, 0-100 parameter 

 Slo is the Slope of Dropoff Below Optimum GLI parameter 

 Shi is the Slope of Dropoff Above the Optimum GLI parameter 



Once the proportion of seeds that survive at the given light level has been calculated, this value is 

multiplied by the number of seeds to reduce them by the proper amount. The new reduced 

number of seeds is put back in the Dispersed Seeds grid.  

How to apply it 

Apply this behavior to seeds of your desired species. Any species to which it is applied must also 

have a Disperse behavior and the Storm Light behavior applied.  

Behavior reference string: Storm Light Dependent Seed Survival  

Density Dependent Seed Survival 

This behavior assesses seed survival as a function of the local density of conspecific seeds.  

How it works 

This behavior takes the seeds that have been dispersed to each grid cell of the Dispersed Seeds 

grid and calculates how many will become survive. The number of seeds that survives is 

calculated as  

 

Rsp = Ssp * exp(-c * Densp
δ
) 

 

where:  

 Rsp is the number of surviving seeds of a given species in the seed grid cell 

 Ssp is the original number of seeds of that species in that grid cell 

 Densp is the density of seeds (number per square meter) of that species in that grid cell 

 c is the Slope of Density Dependence parameter 

 δ is the Steepness of Density Dependence parameter 

Once the number of surviving seeds has been determined, the behavior assigns that number back 

to the Dispersed Seeds grid cell. If there is only one seed in a grid cell, it always survives.  

How to apply it 

Apply this behavior to seeds of your desired species. Any species to which it is applied must also 

have any disperse behavior applied. 

Behavior reference string: Density Dependent Seed Survival  

Proportional Seed Survival 



This behavior reduces the number of seeds by a set amount.  

How it works 

In each cell of the Dispersed Seeds grid, this multiples the number of seeds present by the 

Proportion Germinating Between 0 and 1 parameter, reducing the total number available. The 

new number of seeds is placed back in the Dispersed Seeds grid.  

How to apply it 

Apply this behavior to seeds of any species. Any species to which this is applied must have a 

Disperse behavior applied as well. 

Behavior reference string: germination  

Seed Establishment 

This behavior converts seeds into seedlings.  

How it works 

This behavior goes through each grid cell in the Dispersed Seeds grid and, for each species to 

which this behavior applies, converts each seed into a seedling. The seedlings are randomly 

placed within the grid cell area and have a slightly randomized value of New seedling diameter 

at 10 cm.  

How to apply it 

Apply this behavior to seeds of any species. A species to which this is applied must also have a 

Disperse behavior applied.  

Behavior reference string: Establishment  

Establishment with Microtopography 

This behavior germinates seeds into seedlings. It simulates microtopography in the plot and 

assigns new seedlings a rooting height as a function of the type of substrate on which they land 

(from the Substrate behavior). This behavior is designed to work with both the Substrate and the 

Beer's law light filter behaviors to simulate shading by ferns. The rooting height that seedlings 

get influences the amount of light they receive. Seeds that land on fresh logs, in addition, are 

eligible for a respite from the Beer's law light filter behavior.  

How it works 



Each timestep, the behavior starts by getting the substrate proportions for each cell of the 

Dispersed Seeds grid. The six substrate types are further divided into mound and non-mound 

types of each according to the Proportion of Ground Area that is Mound parameter. The 

relative proportions of the different kinds of substrate are thus the same on mound and non-

mound areas.  

The seeds in the Dispersed Seeds grid cell are then divided up among the substrate types in that 

cell according to their proportions relative to each other (so if 60% of the cell area is mound 

forest floor moss, that's the substrate type that 60% of the seeds land on). A seedling is created 

from each seed. Seedlings are randomly placed within their seed grid cell area and have a 

slightly randomized value of New seedling diameter at 10 cm.  

Each seedling then gets a rooting height according to the substrate type upon which it has 

germinated. If it has germinated on fresh logs, its rooting height is a random number drawn from 

a normal distribution controlled by the Mean Height of Fresh Log Substrate, in m and 

Standard Deviation of Fresh Log Substrate Height, in m parameters (no distinction is made 

between mound and non-mound fresh logs). If it's on a mound substrate, its rooting height is a 

random number drawn from a normal distribution controlled by the Mean Height of Mounds, in 

m and Standard Deviation of Mound Height, in m parameters. If it's on a non-mound 

substrate, its rooting height is zero.  

If a seedling germinates on fresh log, it has the chance of getting a respite from the effects of the 

Beer's law light filter behavior, which it expects to simulate fern shading. Fallen logs crash 

through the fern layer, and it takes a while for the ferns to grow back over the top of the log. This 

length of time is the maximum possible respite length, and is set in the # Years Respite from 

Fern Shading for Seeds on Fresh Logs parameter. Substrate keeps track of the age of its fresh 

log cohorts, so that it is possible to randomly assign the seedling to a fresh log of a specific age, 

given the relative proportions of various-aged fresh log cohorts. The age of the log is subtracted 

from the maximum respite length, and this value is assigned to the seedling. Thus a log that fell 

this timestep would give a seedling the maximum respite, whereas a much older log may not 

give any respite at all.  

How to apply it 

Apply this behavior to seeds of your desired species. Any species to which it is applied must also 

satisfy the following requirements:  

 A disperse behavior must be applied 

 The Substrate behavior must be applied 

 The Beer's Law light filter behavior must be applied 

Behavior reference string: Micro Establishment  
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Planting behaviors 

Planting 

Planting directly creates new seedlings. When you create a new planting, you specify the 

timestep in which to plant, the species to plant and the relative amount of each, whether new 

seedling spacing is gridded or random, how many seedlings to plant and how far apart (if 

gridded), and the area of the plot to plant. You can create as many plantings as you like.  

How it works 

Planting keeps track of planting events to perform in a private grid. Each timestep that there is a 

planting, the behavior begins by determining whether the planting is gridded or random.  

If the planting is random, the total number of seedlings to plant is calculated by multiplying the 

total seedling density by the area to plant. Then that number of seedlings is scattered randomly 

around the plant area. If the planting is gridded, each grid cell in the plant area is planted 

individually. In each cell is placed the number of seedlings that can fit at the specified spacing. 

Since each 8 meter by 8 meter grid cell is planted individually, large spacing distances may 

result in a very low number of seedlings being planted; at a 6 meter spacing, for instance, only 

one seedling per cell would be planted. For best results, the distance between seedlings should 

divide evenly into 8 meters.  

Each seedling's species is determined by comparing a random number to the relative abundance 

of each species. This means that the species distribution may not be exactly what was specified, 

but the larger the number of seedlings the more accurate the species distribution will be.  

The plant behavior outputs what it did each timestep into the Planting Results grid. If you wish to 

review the results of the grid, save it in a detailed output file.  

How to apply it 

You can apply planting in one of two ways. You can create new planting treatments using the 

Edit Episodic Events Window by choosing the "Edit->Episodic events" option from the main 

SORTIE window. If you have existing harvest regime files with planting data from previous 

versions of SORTIE, you can input them into your run as well. For instructions on how to do 

this, see the Adding to a parameter file topic.  

Behavior reference string: plant  
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In this document:  

Analysis parameters  

Carbon Value behavior  

Dimension Analysis behavior  

Foliar Chemistry behavior  

Merchantable Timber Value behavior  

Partitioned DBH Biomass behavior  

Partitioned Palm Biomass behavior  

Ripley's K Calculator behavior  

Relative Neighborhood Density Calculator behavior  

Storm Killed Partitioned DBH Biomass behavior  

Storm Killed Partitioned Palm Biomass behavior  

Tree Bole Volume calculator behavior  

Tree Age behavior  

Tree Volume Calculator behavior  

Analysis behaviors are those whose only purpose is to prepare data for output. They do not 

change model state, such as growing trees or updating grid values. They assemble, calculate, or 

analyze data for the user.  

Analysis parameters 

 Bole Volume Form Class, 60% - 100% Calculates the amount of taper to the top of the 

first 16-foot log in a tree. This is the diameter at the top of that log, as a percentage of 

DBH between 60 and 100. Used by the Tree Bole Volume Calculator behavior. 

 Bole Volume Parameter (b0) The b0 parameter for the bole volume equation. Used by 

the Tree Bole Volume Calculator behavior. 

 Bole Volume Parameter (b1) The b1 parameter for the bole volume equation. Used by 

the Tree Bole Volume Calculator behavior. 

 Bole Volume Parameter (b2) The b2 parameter for the bole volume equation. Used by 

the Tree Bole Volume Calculator behavior. 

 Bole Volume Parameter (b3) The b3 parameter for the bole volume equation. Used by 

the Tree Bole Volume Calculator behavior. 

 Bole Volume Parameter (b4) The b4 parameter for the bole volume equation. Used by 

the Tree Bole Volume Calculator behavior. 

 Bole Volume Parameter (b5) The b5 parameter for the bole volume equation. Used by 

the Tree Bole Volume Calculator behavior. 

 Carbon Value - Carbon Amount of Biomass (0-100%) The percentage of biomass that 

is carbon, as a value between 0 and 100. Used by the Carbon Value behavior. 

 Carbon Value - Price Per Metric Ton Carbon The price per metric ton of carbon. The 

currency is unimportant. Used by the Carbon Value behavior. 

 Dimension Analysis Biomass Units The units of biomass that the chosen biomass 

equation is expected to produce, based on the parameters entered. SORTIE-ND will use 

this to convert the biomass value to metric tons (Mg). Used by the Dimension Analysis 

behavior. 



 Dimension Analysis Correction Factor The correction factor needed by some biomass 

equations that calculate ln(biomass), log10(biomass), or log100(biomass). This value is 

ignored if the value for the Dimension Analysis: Use Correction Factor? parameter for 

this species is false. Used by the Dimension Analysis behavior. 

 Dimension Analysis DBH Units The units of DBH that are appropriate to the biomass 

equation coefficients being entered. SORTIE-ND will convert a tree's DBH to these units 

before calculating biomass. Used by the Dimension Analysis behavior. 

 Dimension Analysis Equation ID The biomass equation ID to use when calculating 

biomass for a particular species. Used by the Dimension Analysis behavior. 

 Dimension Analysis Parameter (a) The value for a in a biomass equation. The 

appropriate value and units for this parameter depend on the values entered in the 

Dimension Analysis Equation ID, Dimension Analysis DBH Units, and Dimension 

Analysis Biomass Units parameters. Used by the Dimension Analysis behavior. 

 Dimension Analysis Parameter (b) The value for b in a biomass equation. The 

appropriate value and units for this parameter depend on the values entered in the 

Dimension Analysis Equation ID, Dimension Analysis DBH Units, and Dimension 

Analysis Biomass Units parameters. Used by the Dimension Analysis behavior. 

 Dimension Analysis Parameter (c) The value for c in a biomass equation. Whether this 

parameter is used, and the appropriate value and units for this parameter, depend on the 

values entered in the Dimension Analysis Equation ID, Dimension Analysis DBH 

Units, and Dimension Analysis Biomass Units parameters. Used by the Dimension 

Analysis behavior. 

 Dimension Analysis Parameter (d) The value for d in a biomass equation. Whether this 

parameter is used, and the appropriate value and units for this parameter, depend on the 

values entered in the Dimension Analysis Equation ID, Dimension Analysis DBH 

Units, and Dimension Analysis Biomass Units parameters. Used by the Dimension 

Analysis behavior. 

 Dimension Analysis Parameter (e) The value for e in a biomass equation. Whether this 

parameter is used, and the appropriate value and units for this parameter, depend on the 

values entered in the Dimension Analysis Equation ID, Dimension Analysis DBH 

Units, and Dimension Analysis Biomass Units parameters. Used by the Dimension 

Analysis behavior. 

 Dimension Analysis: Use Correction Factor? Whether or not the chosen biomass 

equation requires a correction factor to be multiplied by the result. Used by the 

Dimension Analysis behavior. 

 Foliar Chemistry - Cellulose Concentration The proportion of foliar dry weight (0-1) 

that is acid detergent cellulose. Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - Fiber Concentration The proportion of foliar dry weight (0-1) that 

is acid detergent fiber. Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - Foliar Weight (a) The "a" parameter in the equation for foliar dry 

weight. Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - Foliar Weight (b) The "b" parameter in the equation for foliar dry 

weight. Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - Lignin Concentration The proportion of foliar dry weight (0-1) that 

is acid detergent lignin. Used by the Foliar Chemistry behavior. 



 Foliar Chemistry - N Concentration The proportion of foliar dry weight (0-1) that is N. 

Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - P Concentration The proportion of foliar dry weight (0-1) that is P. 

Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - Phenolics Concentration The proportion of foliar dry weight (0-1) 

that is phenolics. Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - SLA Concentration The proportion of foliar dry weight (0-1) that is 

specific leaf area. Used by the Foliar Chemistry behavior. 

 Foliar Chemistry - Tannins Concentration The proportion of foliar dry weight (0-1) 

that is tannins. Used by the Foliar Chemistry behavior. 

 Merchantable Timber Value Form Class The form class of the species. Valid values 

are 78, 79, 80, 81, 84, and 85. Used by the Merchantable Timber Value behavior 

behavior. 

 Merchantable Timber Value Price / 1000 Board Feet The price per thousand board 

feet for each species. The currency used doesn't matter. Used by the Merchantable 

Timber Value behavior behavior. 

 Partitioned DBH Biomass - Bole Slope (a) The slope in the linear biomass equation for 

boles. Used by the Partitioned DBH Biomass behavior. 

 Partitioned DBH Biomass - Bole Intercept (b) The intercept in the linear biomass 

equation for boles. Used by the Partitioned DBH Biomass behavior. 

 Partitioned DBH Biomass - Branch Slope (a) The slope in the linear biomass equation 

for branches. Used by the Partitioned DBH Biomass behavior. 

 Partitioned DBH Biomass - Branch Intercept (b) The intercept in the linear biomass 

equation for branches. Used by the Partitioned DBH Biomass behavior. 

 Partitioned DBH Biomass - Leaf Slope (a) The slope in the linear biomass equation for 

leaves. Used by the Partitioned DBH Biomass behavior. 

 Partitioned DBH Biomass - Leaf Intercept (b) The intercept in the linear biomass 

equation for leaves. Used by the Partitioned DBH Biomass behavior. 

 Partitioned Palm Biomass - Leaf Slope (a) The slope in the linear biomass equation for 

leaves. Used by the Partitioned Palm Biomass behavior. 

 Partitioned Palm Biomass - Leaf Intercept (b) The intercept in the linear biomass 

equation for leaves. Used by the Partitioned Palm Biomass behavior. 

 Partitioned Palm Biomass - Bole Slope (a) The slope in the linear biomass equation for 

boles. Used by the Partitioned Palm Biomass behavior. 

 Partitioned Palm Biomass - Bole Intercept (b) The intercept in the linear biomass 

equation for boles. Used by the Partitioned Palm Biomass behavior. 

 Relative Neighborhood Density - Maximum Distance (m) The maximum distance out 

to which to calculate Relative Neighborhood Density Index (Ω) values. Used by the 

Relative Neighborhood Density Calculator behavior. 

 Relative Neighborhood Density - Distance Increment (m) The distance increments at 

which the Relative Neighborhood Density Index (Ω) will be calculated. Smaller 

increments mean a smoother curve but also more processing time. Used by the Relative 

Neighborhood Density Calculator behavior. 

 Ripley's K - Maximum Distance (m) The maximum distance out to which to calculate 

K values. Used by the Ripley's K Calculator behavior. 



 Ripley's K - Distance Increment (m) The distance increments at which K will be 

calculated. Smaller increments mean a smoother curve but also more processing time. 

Used by the Ripley's K Calculator behavior. 

 Taper Equation Initial Multiplier (a0) The a0 parameter in the taper equation below. 

Used by the Tree Volume Calculator behavior. 

 Taper Equation DBH Exponent (a1) The a1 parameter in the taper equation below. 

Used by the Tree Volume Calculator behavior. 

 Taper Equation Height Exponent (a2) The a2 parameter in the taper equation below. 

Used by the Tree Volume Calculator behavior. 

 Taper Equation X Exponent 1 (b1) The b1 parameter in the taper equation below. Used 

by the Tree Volume Calculator behavior. 

 Taper Equation X Exponent 2 (b2) The b2 parameter in the taper equation below. Used 

by the Tree Volume Calculator behavior. 

 Taper Equation X Exponent 3 (b3) The b3 parameter in the taper equation below. Used 

by the Tree Volume Calculator behavior. 

 Taper Equation X Exponent 4 (b4) The b4 parameter in the taper equation below. Used 

by the Tree Volume Calculator behavior. 

 Taper Equation X Exponent 5 (b5) The b5 parameter in the taper equation below. Used 

by the Tree Volume Calculator behavior. 

 Taper Equation X Exponent 6 (b6) The b6 parameter in the taper equation below. Used 

by the Tree Volume Calculator behavior. 

 Diameter-Outside-Bark Constant (a1) The a1 parameter in the equation for calculating 

tree diameter outside bark, below. Used by the Tree Volume Calculator behavior. 

 Diameter-Outside-Bark First Degree Parameter (a2) The a2 parameter in the equation 

for calculating tree diameter outside bark, below. Used by the Tree Volume Calculator 

behavior. 

 Diameter-Outside-Bark Second Degree Parameter (a3) The a3 parameter in the 

equation for calculating tree diameter outside bark, below. Used by the Tree Volume 

Calculator behavior. 

 Height to Begin Calculating Trunk Volume, in cm The height at which volume 

calculations begin. For merchantable volume calculations, this can be thought of as the 

stump height. The height is height off the ground in cm. 

 Minimum Trunk Diameter for Volume Calculations, in cm The trunk diameter (inside 

the bark) at which volume calculations end. For merchantable volume calculations, this is 

the minimum usable trunk diameter. The diameter is in cm. 

 Trunk Segment Length for Volume Calculations, in m The length, in m, of segments 

into which the tree trunk is divided for volume calculations. A smaller value means a 

greater degree of accuracy; a larger value means a faster processing time. 

Carbon Value 

This behavior calculates the amount of carbon per species and its value.  

How it works 



This behavior relies on the Dimension Analysis behavior to calculate each tree's biomass in 

metric tons. It then multiplies this value by the Carbon Value - Carbon Amount of Biomass 

(0-100%) parameter to find each tree's amount of carbon in metric tons. This behavior finds the 

total amount of carbon in each species, and then multiplies it by the Carbon Value - Price Per 

Metric Ton Carbon to find each species' carbon value.  

Both the amount of carbon, in metric tons, for each species and the value of that carbon are saved 

in a grid called Carbon Value. You can save these values in a detailed output file for analysis.  

How to apply it 

Apply this behavior to saplings, adults, or snags of any species. These trees must also use the 

Dimension Analysis behavior. This behavior does not automatically create output. Once you 

have added this behavior to your run, the Detailed output setup window for trees will have a tree 

data member called "Mg Carbon", which has each tree's amount of carbon in metric tons. Also, 

the Detailed output grid setup window will list the Carbon Value grid. You can then view the 

contents of this grid as a table using SORTIE's data visualization system.  

Behavior reference string: Carbon Value Calculator  

Dimension Analysis 

This behavior calculates the biomass of trees based on DBH. This approach comes from Jenkins 

et al, 2004.  

How it works 

The paper above outlines 9 different biomass equations in Table 6, as follows:  

ID Equation 

1 log10 biomass = a + b * (log10(dia
 c
)) 

2 ln biomass = a + b * dia + c * (ln(dia 
d
)) 

3 ln biomass = a + b * ln(dia) + c * (d + (e * ln(dia))) 

4 biomass = a + b * dia + c * (dia
 d

) 

5 biomass = a + (b * dia) + c * (dia
 2

) + d * (dia
 3

) 

6 biomass = a * (exp(b + (c * ln(dia)) + (d * dia))) 

7 biomass = a + ((b * (dia
 c
)) / ((dia

 c
) + d)) 

8 log100 biomass = a + (b * log10(dia)) 



9 ln biomass = ln(a) + (b * ln(dia)) 

In all equations, dia is DBH. You choose the equation ID that you wish to use for each species.  

There are many different published parameters using the equation forms above, which use a 

range of different units. Thus, you specify what units dia (that is, DBH) is in, and what units of 

biomass the equation is expected to produce. The possible DBH units are millimeters (mm), 

centimeters (cm), and inches (in); the possible biomass units are grams (g), kilograms (kg), and 

pounds (lb). This behavior handles all unit conversions so that biomass is appropriately 

calculated. The final biomass values are reported in metric tons (Mg).  

For those equations that calculate log10, log100, or ln biomass, some papers specify a correction 

factor to remove bias that may be introduced when biomass is calculated. If you wish, you may 

use such a correction factor. Set the value of the Dimension Analysis: Use Correction Factor? 

parameter to "true", then specify the appropriate correction factor in the Dimension Analysis 

Correction Factor parameter. This value is multiplied by the final biomass value.  

How to apply it 

Apply this behavior to saplings, adults, or snags of any species, and enter parameters in the 

Parameter edit window. This behavior does not automatically create output. Once you have 

added this behavior to your run, the Detailed output setup window for trees will have a tree data 

member called "Tree Biomass". Add this to your detailed output file to output biomass in metric 

tons (Mg). You can then view charts and graphs with the resulting volume data using data 

visualization on your detailed output file.  

Behavior reference string: tree biomass calculator  

Foliar Chemistry 

This behavior calculates chemistry components as a function of DBH. The components 

calculated are N, P, specific leaf area (SLA), percent acid detergent fiber, percent acid detergent 

cellulose, percent acid detergent lignin, percent condensed tannins, and total phenolics.  

How it works 

For each tree, the foliar dry weight is calculated as:  

F = a * DBH 
b
 

where  

 F = foliar dry weight in kg 

 a = the Foliar Chemistry - Foliar Weight (a) parameter  

 b = the Foliar Chemistry - Foliar Weight (b) parameter  



 DBH = tree's DBH in cm  

For each component, the amount is the tree's foliar dry weight multiplied by the parameter for 

that component's concentration.  

The weight of each component, in metric tons, is summed for each species and saved in a grid 

called Foliar Chemistry. You can save these values in a detailed output file for analysis. You of 

course can skip any of the components by entering 0's for their concentration parameter values.  

How to apply it 

Apply this behavior to saplings, adults, or snags of any species. This behavior does not 

automatically create output. Once you have added this behavior to your run, the Detailed output 

grid setup window will list the Foliar Chemistry grid. You can then view the contents of this grid 

as a table using SORTIE's data visualization system.  

Behavior reference string: Foliar Chemistry  

Merchantable Timber Value 

This behavior calculates the value of merchantable timber.  

How it works 

The value for each tree is calculated by finding out its volume in board feet, and multiplying that 

by the price for its species. The price is held in the Merchantable Timber Value Price / 1000 

Board Feet parameter. The currency used doesn't matter. The tree's final value is placed in a tree 

data member called "Merchantable Value". The total value for each species is saved in a grid 

called Merchantable Timber Value. You can save these values in a detailed output file for 

analysis.  

The volume of merchantable timber in a tree depends on its size and form class. These control 

how many 16-foot logs there are in a tree, and how many board feet of timber (assuming 0.25-

inch thickness) those logs can create. The form class is entered in the Merchantable Timber 

Value Form Class parameter.  

The behavior begins by finding out how many 16-foot logs the tree can provide in its bole. The 

base of the bole is the top of the cut stump; the top of the bole is the merchantable height. This 

behavior defines the merchantable height as the height at which the trunk diameter inside the 

bark tapers to 60% of DBH. The behavior tries fitting in as many 16-foot logs as possible before 

the 60% taper occurs. The amount of taper at the top of the first 16-foot log is established by the 

tree's form class. A species's form class is the percentage of DBH to which the bole has tapered 

at the top of the first 16-foot log.  

Then the behavior determines how many more logs the tree contains. The amount of taper at the 

top of the first 16-foot log is subtracted from the DBH, to see how much taper is left before the 



60% merchantable-height diameter is reached. There is no formula that establishes clearly how 

many logs will fit; the behavior uses a trial-and-error approach taken from Messavage and 

Girard, 1956. This paper includes the table below for upper-log taper for trees of various DBH 

and bole heights. The behavior uses this table to determine the maximum number of logs it can 

fit into the taper available.  

Trees below 10 inches of DBH contain no merchantable timber and have a value of zero. Trees 

greater than 40 inches of DBH are treated like 40-inch trees.  

Once the behavior figures out how many 16-foot logs a tree contains, it uses another set of 

tables, based on form class, to determine how many board-feet of timber the tree contains. These 

tables are also from Messavage and Girard, 1956, and are shown below.  

Average upper-log taper (inches) in 16-foot logs  

DBH 

(in) 

2-

log 

tree 

3-log 

tree 
4-log tree 5-log tree 6-log tree 

2d 

log 

2d 

log 

3d 

log 

2d 

log 

3d 

log 

4th 

log 

2d 

log 

3d 

log 

4th 

log 

5th 

log 

2d 

log 

3d 

log 

4th 

log 

5th 

log 

6th 

log 

10 1.4 1.2 1.4 --- --- --- --- --- --- --- --- --- --- --- --- 

12 1.6 1.3 1.5 1.1 1.4 1.9 --- --- --- --- --- --- --- --- --- 

14 1.7 1.4 1.6 1.2 1.5 2 --- --- --- --- --- --- --- --- --- 

16 1.9 1.5 1.7 1.2 1.6 2.1 --- --- --- --- --- --- --- --- --- 

18 2 1.6 1.8 1.3 1.7 2.2 --- --- --- --- --- --- --- --- --- 

20 2.1 1.7 1.9 1.4 1.8 2.4 1.1 1.6 2.2 2.9 --- --- --- --- --- 

22 2.2 1.8 2 1.4 2 2.5 1.1 1.7 2.3 2.9 --- --- --- --- --- 

24 2.3 1.8 2.2 1.5 2.2 2.6 1.1 1.8 2.4 3.1 --- --- --- --- --- 

26 2.4 1.9 2.3 1.5 2.3 2.7 1.1 1.9 2.5 3.2 --- --- --- --- --- 

28 2.5 1.9 2.5 1.6 2.4 2.8 1.2 1.9 2.6 3.3 0.9 1.4 2.1 3.2 4.4 

30 2.6 2 2.6 1.7 2.5 3 1.2 2 2.7 3.5 0.9 1.4 2.1 3.2 4.5 

32 2.7 2 2.7 1.7 2.5 3.1 1.2 2.1 2.9 3.7 1 1.4 2.1 3.2 4.6 

34 2.8 2.1 2.7 1.8 2.5 3.3 1.3 2.1 3 3.8 1 1.4 2.2 3.3 4.7 

36 2.8 2.1 2.8 1.8 2.6 3.4 1.3 2.2 3 3.9 1.1 1.5 2.2 3.3 4.9 



38 2.9 2.1 2.8 1.9 2.6 3.4 1.3 2.2 3.1 3.9 1.1 1.5 2.3 3.4 5.1 

40 2.9 2.2 2.8 1.9 2.7 3.4 1.4 2.3 3.2 4 1.2 1.5 2.4 3.5 5.3 

 

Volume (board feet) by number of usable 16 foot logs 

Form Class 78:  

DBH (inches) 1 log 2 logs 3 logs 4 logs 5 logs 6 logs 

10 36 59 73 --- --- --- 

11 46 76 96 --- --- --- 

12 56 92 120 137 --- --- 

13 67 112 147 168 --- --- 

14 78 132 174 200 --- --- 

15 92 156 208 242 --- --- 

16 106 180 241 285 --- --- 

17 121 206 278 330 --- --- 

18 136 233 314 374 --- --- 

19 154 264 358 427 --- --- 

20 171 296 401 480 542 --- 

21 191 332 450 542 616 --- 

22 211 368 500 603 691 --- 

23 231 404 552 663 714 --- 

24 251 441 605 723 782 --- 

25 275 484 665 800 865 --- 

26 299 528 725 877 1,021 --- 

27 323 572 788 952 1,111 --- 

28 347 616 850 1,027 1,201 1,358 

29 375 667 920 1,112 1,308 1,488 

30 403 718 991 1,198 1,415 1,619 

31 432 772 1,070 1,299 1,526 1,754 

32 462 826 1,149 1,400 1,637 1,888 

33 492 880 1,226 1,495 1,750 2,026 

34 521 934 1,304 1,590 1,864 2,163 

35 555 998 1,394 1,702 2,000 2,312 

36 589 1,063 1,485 1,814 2,135 2,461 

37 622 1,124 1,578 1,926 2,272 2,616 

38 656 1,186 1,670 2,038 2,410 2,771 



39 694 1,258 1,769 2,166 2,552 2,937 

40 731 1,329 1,868 2,294 2,693 3,103 

 

Form Class 79:  

DBH (inches) 1 log 2 logs 3 logs 4 logs 5 logs 6 logs 

10 38 61 77 --- --- --- 

11 48 78 100 --- --- --- 

12 58 96 124 141 --- --- 

13 70 117 153 176 --- --- 

14 82 138 182 211 --- --- 

15 95 160 214 252 --- --- 

16 108 183 246 292 --- --- 

17 124 212 286 340 --- --- 

18 140 240 325 388 --- --- 

19 158 272 370 442 --- --- 

20 176 305 414 496 561 --- 

21 196 342 464 558 636 --- 

22 216 378 514 621 710 --- 

23 238 418 571 687 792 --- 

24 260 458 628 753 875 --- 

25 282 499 685 826 960 --- 

26 305 540 742 899 1,046 --- 

27 331 588 810 980 1,144 --- 

28 357 635 877 1,061 1,242 1,404 

29 385 686 948 1,148 1,350 1,537 

30 413 737 1,020 1,235 1,458 1,670 

31 444 792 1,100 1,338 1,572 1,808 

32 474 848 1,181 1,440 1,685 1,945 

33 506 907 1,265 1,544 1,808 2,094 

34 538 966 1,349 1,647 1,932 2,244 

35 570 1,026 1,435 1,754 2,000 2,384 

36 602 1,087 1,521 1,860 2,189 2,525 

37 638 1,154 1,620 1,980 2,338 2,694 

38 674 1,220 1,720 2,101 2,488 2,862 

39 712 1,292 1,822 2,232 2,632 3,031 



40 750 1,365 1,923 2,362 2,775 3,200 

 

Form Class 80:  

DBH (inches) 1 log 2 logs 3 logs 4 logs 5 logs 6 logs 

10 39 63 80 --- --- --- 

11 49 80 104 --- --- --- 

12 59 98 127 146 --- --- 

13 71 120 156 181 --- --- 

14 83 141 186 216 --- --- 

15 98 166 221 260 --- --- 

16 112 190 256 305 --- --- 

17 128 219 296 354 --- --- 

18 144 248 336 402 --- --- 

19 162 281 382 457 --- --- 

20 181 314 427 512 580 --- 

21 201 350 478 575 656 --- 

22 221 387 528 638 732 --- 

23 244 428 586 706 816 --- 

24 266 469 644 773 899 --- 

25 290 514 706 852 992 --- 

26 315 558 767 931 1,086 --- 

27 341 606 836 1,014 1,185 --- 

28 367 654 904 1,096 1,284 1,453 

29 396 706 977 1,184 1,394 1,588 

30 424 758 1,050 1,272 1,503 1,723 

31 454 814 1,132 1,376 1,618 1,862 

32 485 870 1,213 1,480 1,733 2,001 

33 518 930 1,298 1,586 1,858 2,152 

34 550 989 1,383 1,691 1,984 2,304 

35 585 1,055 1,477 1,806 2,124 2,458 

36 620 1,121 1,571 1,922 2,264 2,612 

37 656 1,188 1,672 2,044 2,416 2,783 

38 693 1,256 1,772 2,167 2,568 2,954 

39 732 1,330 1,874 2,300 2,714 3,127 

40 770 1,403 1,977 2,432 2,860 3,300 



 

Form Class 81:  

DBH (inches) 1 log 2 logs 3 logs 4 logs 5 logs 6 logs 

10 40 65 82 --- --- --- 

11 50 82 106 --- --- --- 

12 60 100 130 150 --- --- 

13 72 122 160 186 --- --- 

14 85 144 190 221 --- --- 

15 100 170 228 268 --- --- 

16 115 197 265 316 --- --- 

17 132 226 306 366 --- --- 

18 148 256 346 415 --- --- 

19 166 290 392 471 --- --- 

20 185 323 439 527 598 --- 

21 206 360 492 592 676 --- 

22 227 398 544 656 754 --- 

23 250 439 602 724 838 --- 

24 272 480 659 791 923 --- 

25 298 528 726 877 1,024 --- 

26 324 575 793 963 1,124 --- 

27 351 624 863 1,047 1,226 --- 

28 378 674 933 1,131 1,327 1,502 

29 406 726 1,006 1,220 1,438 1,640 

30 435 779 1,080 1,310 1,549 1,777 

31 466 836 1,162 1,416 1,666 1,918 

32 497 892 1,245 1,522 1,784 2,059 

33 530 953 1,332 1,628 1,910 2,214 

34 563 1,014 1,419 1,734 2,037 2,368 

35 600 1,084 1,518 1,859 2,188 2,534 

36 637 1,154 1,618 1,984 2,338 2,700 

37 674 1,223 1,721 2,109 2,494 2,874 

38 712 1,292 1,824 2,234 2,649 3,049 

39 751 1,366 1,928 2,368 2,796 3,224 

40 790 1,441 2,032 2,502 2,944 3,399 

 

Form Class 84:  



DBH (inches) 1 log 2 logs 3 logs 4 logs 5 logs 6 logs 

10 43 71 91 --- --- --- 

11 54 91 118 --- --- --- 

12 66 111 145 168 --- --- 

13 80 135 178 208 --- --- 

14 93 159 212 248 --- --- 

15 108 185 249 295 --- --- 

16 123 211 286 342 --- --- 

17 142 244 332 398 --- --- 

18 160 277 377 453 --- --- 

19 180 314 428 524 --- --- 

20 200 351 479 576 657 --- 

21 223 392 537 649 744 --- 

22 246 434 595 722 830 --- 

23 271 480 660 798 925 --- 

24 296 525 724 873 1,020 --- 

25 322 572 790 958 1,118 --- 

26 347 619 855 1,042 1,217 --- 

27 376 673 932 1,136 1,331 --- 

28 406 727 1,010 1,230 1,445 1,636 

29 438 786 1,092 1,330 1,569 1,790 

30 470 844 1,173 1,429 1,693 1,943 

31 504 907 1,265 1,546 1,823 2,101 

32 538 970 1,357 1,664 1,953 2,259 

33 574 1,037 1,453 1,782 2,096 2,431 

34 611 1,104 1,549 1,901 2,240 2,603 

35 647 1,173 1,648 2,023 2,387 2,766 

36 683 1,242 1,746 2,145 2,534 2,929 

37 724 1,318 1,859 2,284 2,706 3,123 

38 765 1,393 1,972 2,422 2,877 3,317 

39 808 1,476 2,088 2,570 3,042 3,512 

40 851 1,558 2,203 2,719 3,208 3,706 

 

Form Class 85:  

DBH (inches) 1 log 2 logs 3 logs 4 logs 5 logs 6 logs 



10 45 74 94 --- --- --- 

11 56 94 122 --- --- --- 

12 68 114 150 173 --- --- 

13 82 138 184 214 --- --- 

14 95 163 217 254 --- --- 

15 111 191 257 304 --- --- 

16 127 219 297 355 --- --- 

17 146 252 342 412 --- --- 

18 164 285 388 468 --- --- 

19 184 322 440 531 --- --- 

20 205 360 492 594 678 --- 

21 228 402 550 667 765 --- 

22 251 444 609 740 852 --- 

23 276 490 675 818 950 --- 

24 302 537 741 895 1,047 --- 

25 330 588 812 986 1,153 --- 

26 357 638 882 1,076 1,259 --- 

27 387 693 961 1,172 1,374 --- 

28 417 745 1,040 1,267 1,490 1,689 

29 448 807 1,122 1,368 1,616 1,844 

30 481 866 1,205 1,469 1,741 1,999 

31 516 930 1,298 1,588 1,874 2,160 

32 550 993 1,391 1,706 2,006 2,321 

33 587 1,061 1,488 1,827 2,150 2,495 

34 624 1,129 1,586 1,948 2,294 2,669 

35 663 1,204 1,692 2,080 2,454 2,846 

36 702 1,278 1,797 2,212 2,614 3,022 

37 744 1,355 1,912 2,352 2,788 3,219 

38 785 1,432 2,027 2,493 2,962 3,416 

39 828 1,515 2,144 2,644 3,130 3,614 

40 872 1,598 2,260 2,795 3,298 3,813 

How to apply it 

Apply this behavior to saplings, adults, or snags of any species, and enter parameters in the 

Parameter edit window. This behavior does not automatically create output. Once you have 



added this behavior to your run, the Detailed output setup window for trees will have a tree data 

member called "Merchantable Value". Add this to your detailed output file to output volume in 

cubic feet. You can also use the Detailed output grid setup window to save the data members in 

the Merchantable Timber Value grid, which contains the total value for each species. You can 

then view the contents of this grid as a table using SORTIE's data visualization system.  

Behavior reference string: Merch Value Calculator  

Partitioned DBH Biomass 

This behavior calculates biomass as a linear function of DBH, partitioned into leaf, branch, and 

bole biomass.  

How it works 

The mass of all components is calculated using the same equation, but using different 

parameters. The equation is:  

Bioi = ai * DBH + bi 

where  

 Bioi = biomass in kg dry weight of the component in question 

 ai = the "a" parameter for the component 

 bi = the "b" parameter for the component 

 DBH = tree's DBH in cm  

The amount of each type of biomass, in metric tons, for each species is saved in a grid called 

Partitioned Biomass. You can save these values in a detailed output file for analysis. You of 

course can skip any of the components by entering 0's for their parameter values.  

How to apply it 

Apply this behavior to saplings, adults, or snags of any species. This behavior does not 

automatically create output. Once you have added this behavior to your run, the Detailed output 

grid setup window will list the Partitioned Biomass grid. You can then view the contents of this 

grid as a table using SORTIE's data visualization system.  

Behavior reference string: Partitioned DBH Biomass  

Partitioned Palm Biomass 

This behavior calculates biomass as a linear function of tree height, partitioned into leaf and bole 

biomass.  



How it works 

The biomass of leaves and boles is calculated using the same equation, but using different 

parameters. The equation is:  

Bioi = ai * Height + bi 

where  

 Bioi = biomass in kg dry weight of either leaves, branches, or the bole 

 ai = either the Partitioned Palm Biomass - Leaf Slope (a) or Partitioned Palm 

Biomass - Bole Slope (a) parameters 

 bi = either the Partitioned Palm Biomass - Leaf Intercept (b) or Partitioned Palm 

Biomass - Bole Intercept (b) parameters 

 Height = tree's height in meters  

The amount of each type of biomass, in metric tons, for each species is saved in a grid called 

Partitioned Biomass. You can save these values in a detailed output file for analysis.  

How to apply it 

Apply this behavior to saplings, adults, or snags of any species. This behavior does not 

automatically create output. Once you have added this behavior to your run, the Detailed output 

grid setup window will list the Partitioned Biomass grid. You can then view the contents of this 

grid as a table using SORTIE's data visualization system.  

Behavior reference string: Partitioned Height Biomass  

Relative Neighborhood Density Calculator 

This behavior calculates the relative neighborhood density index (Ω) as described in Condit et al 

2000. Ω is a measure of the aggregation of a species. It is the average density of conspecific 

neighbors at a certain distance divided by the overall density of trees in the plot. A perfectly 

random distribution of individuals for a species would result in Ω = 1. Ω > 1 at short distances 

indicates species aggregation. Ω < 1 at short distances indicates spacing among individuals.  

How it works 

Ω values are calculated for each species for a succession of distances out to a maximum. For 

each tree, the conspecific neighbors are counted in an ring described by the radii x to Δx. This 

value is divided by the area of the ring to get the density of neighbors at that distance. This 

density is averaged over all trees of each species. This average density of neighbors at a given 

distance is then relativized by dividing by the density of that species across the plot.  



 

where:  

 Ω is the relative neighborhood density at distance x to Δx for a species 

 Nx is the total number of conspecific neighbors for that species found between x and Δx 

 T is the total number of saplings and adults of that species in the plot 

 Ax is the area of the ring x + Δx 

 den is the total plot density for trees of that species 

The size of the distance increment, x, is given in the Relative Neighborhood Density - Distance 

Increment (m) parameter. The maximum distance out to which to calculate Ω is given in the 

Relative Neighborhood Density - Maximum Distance (m) parameter.  

Only saplings and adult trees are included in Ω calculations.  

The resulting Ω values are stored in the Relative Neighborhood Density grid.  

How to apply it 

Add this behavior to your run. There is no need to apply it to specific tree species or types. 

Indeed, any such specifications will be ignored. This behavior does not automatically create 

output. Once you have added this behavior to your run, the Detailed output grid setup window 

will list the Relative Neighborhood Density grid. Save all the data members of this grid. You can 

then view the Ω values as a line graph and use the graph to save the Ω values as a text file.  

Behavior reference string: Condit's Omega  

Ripley's K Calculator 

This behavior calculates the Ripley's K function for all trees in the plot as well as for the 

members of each species.  

How it works 

The Ripley's K function is a measure of the way trees are spatially distributed across the plot. K 

values are calculated repeatedly for a succession of distances out to a maximum, giving a curve. 

The Ripley's K statistic for a given distance t is calculated as:  



 

where:  

 K(t) is the K value at distance t 

 A is the plot area in square meters 

 X is the number of pairs of trees in the plot less than t meters apart 

 n is the total number of trees in the plot 

The size of the distance increment is given in the Ripley's K - Distance Increment (m) 

parameter. The maximum distance out to which to calculate K is given in the Ripley's K - 

Maximum Distance (m) parameter. Most Ripley's K formulas come with a term for edge 

correction, which is not needed in SORTIE-ND as the plot has no edges. (See the SORTIE-ND 

Plot topic for more on the plot's shape.)  

Only saplings and adult trees are included in K calculations.  

The K values are calculated for all trees in the plot as well as for individual species. In the case 

of an individual species, X is the number of pairs of trees of that species, and n is the total 

number of trees of that species.  

The resulting K values are stored in the Ripley's K grid.  

How to apply it 

Add this behavior to your run. There is no need to apply it to specific tree species or types. 

Indeed, any such specifications will be ignored. This behavior does not automatically create 

output. Once you have added this behavior to your run, the Detailed output grid setup window 

will list the Ripley's K grid. Save all the data members of this grid. You can then view the K 

values as a line graph and use the graph to save the K values as a text file.  

Behavior reference string: Ripley's K  

Storm Killed Partitioned DBH Biomass 

This behavior calculates biomass of trees killed in storms as a linear function of DBH, 

partitioned into leaf, branch, and bole biomass.  

How it works 

Biomass is calculated in exactly the same way and using the same parameters as for the 

Partitioned DBH Biomass behavior, except it only calculates the biomass of those trees killed by 

the Storm killer behavior.  



How to apply it 

Apply this behavior to saplings, adults, or snags of any species. This behavior does not 

automatically create output. Once you have added this behavior to your run, the Detailed output 

grid setup window will list the Storm Killed Partitioned Biomass grid. You can then view the 

contents of this grid as a table using SORTIE's data visualization system.  

Behavior reference string: Storm Killed Partitioned DBH Biomass  

Storm Killed Partitioned Palm Biomass 

This behavior calculates biomass of trees killed in storms as a linear function of tree height, 

partitioned into leaf and bole biomass.  

How it works 

Biomass is calculated in exactly the same way and using the same parameters as for the 

Partitioned Palm Biomass behavior, except it only calculates the biomass of those trees killed by 

the Storm killer behavior.  

How to apply it 

Apply this behavior to saplings, adults, or snags of any species. This behavior does not 

automatically create output. Once you have added this behavior to your run, the Detailed output 

grid setup window will list the Storm Killed Partitioned Biomass grid. You can then view the 

contents of this grid as a table using SORTIE's data visualization system.  

Behavior reference string: Storm Killed Partitioned Height Biomass  

Tree Age 

This behavior calculates tree age.  

How it works 

The age of a tree, in years, is kept in a tree data member called "Tree Age" and updated each 

timestep. If this behavior is after the establishment behaviors, new seedlings will have an age 

equal to one timestep on the timestep they are created.  

Some trees can be created at the beginning of a run, either in a tree map or to provide a specified 

initial tree density. These trees are given an age of 10000, so they can be easily distinguished 

from trees created during a run. If a tree map is provided and the trees are specifically given an 

age in the map, that age is kept and they are not re-assigned an age of 10000.  

This behavior may not be applied to snags, since they have a different age counter.  



How to apply it 

Apply this behavior to the trees for which you want to track age. You can then save the "Tree 

Age" data in a detailed output file for analysis.  

Behavior reference string: Tree Age Calculator  

Tree Bole Volume Calculator 

This behavior calculates merchantable tree volume. Make sure to distinguish between this 

behavior and the other tree volume behavior.  

How it works 

Tree volume is calculated as follows:  

V = b0 + (b1 * DBH 
b2

) + (b3 * DBH 
b4

 * Height 
b5

) 

 

where:  

 V = gross volume in cubic feet 

 Height = bole length in feet, as a multiple of 16 (for usable 16-foot logs) 

 DBH = DBH in inches 

 b0 - b5 are the following parameters: Bole Volume Parameter (b0), Bole Volume 

Parameter (b1), Bole Volume Parameter (b2), Bole Volume Parameter (b3), Bole 

Volume Parameter (b4), and Bole Volume Parameter (b5) 

The bole length is the number of 16-foot logs the tree can provide, in feet (i.e. 3 logs = bole 

length of 48 feet). The base of the bole is the top of the cut stump; the top of the bole is the 

merchantable height. This behavior defines the merchantable height as the height at which the 

trunk diameter inside the bark tapers to 60% of DBH.  

To determine at what bole length the merchantable height occurs, the behavior tries fitting in as 

many 16-foot logs as possible before the 60% taper occurs. The amount of taper at the top of the 

first 16-foot log is established by the form classes. A species's form class is the percentage of 

DBH to which the bole has tapered at the top of the first 16-foot log. This value is entered as the 

Bole Volume Form Class, 60% - 100% parameter.  

Then the behavior determines how many more logs the tree contains. The amount of taper at the 

top of the first 16-foot log is subtracted from the DBH, to see how much taper is left before the 

60% merchantable-height diameter is reached. There is no formula that establishes clearly how 

many logs will fit; the behavior uses a trial-and-error approach taken from Messavage and 

Girard, 1956. This paper includes the table below for upper-log taper for trees of various DBH 

and bole heights. The behavior uses this table to determine the maximum number of logs it can 

fit into the taper available.  



Trees below 10 inches of DBH have no volume. Trees greater than 40 inches of DBH are treated 

like 40-inch trees.  

DBH 

(in) 

2-

log 

tree 

3-log 

tree 
4-log tree 5-log tree 6-log tree 

2d 

log 

2d 

log 

3d 

log 

2d 

log 

3d 

log 

4th 

log 

2d 

log 

3d 

log 

4th 

log 

5th 

log 

2d 

log 

3d 

log 

4th 

log 

5th 

log 

6th 

log 

10 1.4 1.2 1.4 --- --- --- --- --- --- --- --- --- --- --- --- 

12 1.6 1.3 1.5 1.1 1.4 1.9 --- --- --- --- --- --- --- --- --- 

14 1.7 1.4 1.6 1.2 1.5 2 --- --- --- --- --- --- --- --- --- 

16 1.9 1.5 1.7 1.2 1.6 2.1 --- --- --- --- --- --- --- --- --- 

18 2 1.6 1.8 1.3 1.7 2.2 --- --- --- --- --- --- --- --- --- 

20 2.1 1.7 1.9 1.4 1.8 2.4 1.1 1.6 2.2 2.9 --- --- --- --- --- 

22 2.2 1.8 2 1.4 2 2.5 1.1 1.7 2.3 2.9 --- --- --- --- --- 

24 2.3 1.8 2.2 1.5 2.2 2.6 1.1 1.8 2.4 3.1 --- --- --- --- --- 

26 2.4 1.9 2.3 1.5 2.3 2.7 1.1 1.9 2.5 3.2 --- --- --- --- --- 

28 2.5 1.9 2.5 1.6 2.4 2.8 1.2 1.9 2.6 3.3 0.9 1.4 2.1 3.2 4.4 

30 2.6 2 2.6 1.7 2.5 3 1.2 2 2.7 3.5 0.9 1.4 2.1 3.2 4.5 

32 2.7 2 2.7 1.7 2.5 3.1 1.2 2.1 2.9 3.7 1 1.4 2.1 3.2 4.6 

34 2.8 2.1 2.7 1.8 2.5 3.3 1.3 2.1 3 3.8 1 1.4 2.2 3.3 4.7 

36 2.8 2.1 2.8 1.8 2.6 3.4 1.3 2.2 3 3.9 1.1 1.5 2.2 3.3 4.9 

38 2.9 2.1 2.8 1.9 2.6 3.4 1.3 2.2 3.1 3.9 1.1 1.5 2.3 3.4 5.1 

40 2.9 2.2 2.8 1.9 2.7 3.4 1.4 2.3 3.2 4 1.2 1.5 2.4 3.5 5.3 

How to apply it 

Apply this behavior to saplings, adults, or snags of any species, and enter parameters in the 

Parameter edit window. This behavior does not automatically create output. Once you have 

added this behavior to your run, the Detailed output setup window for trees will have a tree data 

member called "Tree Bole Volume". Add this to your detailed output file to output volume in 



cubic feet. You can then view charts and graphs with the resulting volume data using data 

visualization on your detailed output file.  

Behavior reference string: tree bole volume calculator  

Tree Volume Calculator 

This behavior calculates the volume of tree trunks. It can be used to find both merchantable 

volume and total volume. Make sure to distinguish between this behavior and the other tree 

volume behavior.  

How it works 

Tree volume is estimated by dividing the trunk into segments, and calculating the volume of each 

segment. You control where the trunk starts and stops, and the length of segments used.  

Trunks start at the value in the Height to Begin Calculating Trunk Volume, in cm parameter. 

To calculate merchantable volume, set this to the average stump height. To calculate total 

volume, set this to zero. Trunks end when their diameter inside the tree bark becomes smaller 

than the volume in the Minimum Trunk Diameter for Volume Calculations, in cm parameter. 

For merchantable volume, set this to the minimum usable diameter. For total volume, set this to 

zero.  

Trunks are divided into segments for volume calculations. The length of these segments is set in 

the Trunk Segment Length for Volume Calculations, in m parameter. Setting this to a smaller 

value increases the accuracy of the calculations. Setting this to a larger value increases the speed 

at which the calculations are made. The total tree's volume is the sum of the volumes of each of 

the segments. Any segments whose beginning or ending diameter is less than the value in the 

Minimum Trunk Diameter for Volume Calculations, in cm parameter are not included in the 

volume total.  

The volume of a tree trunk segment is found as follows:  

V = ((A1 + A2) / 2) * l 

 

where:  

 A1 is the cross-sectional area at the bottom of the trunk segment, in square meters 

 A2 is the cross-sectional area at the top of the trunk segment, in square meters 

 V is the volume of the trunk segment, in cubic meters 

 l is the length of the trunk segment (value in the Trunk Segment Length for Volume 

Calculations, in m parameter) 

The cross-sectional area of a tree trunk at a particular point above the ground (such as at the 

beginning or end of a trunk segment) is calculated as:  



A = π(d / 2)
2
 

where A is the cross-sectional area, in square meters, and d is the diameter of the tree inside the 

bark at that height, in meters.  

To find the diameter of the tree trunk inside the bark at a particular height above the ground, the 

taper equation is used. (This equation comes from Kozak (2004) Forest Chronicle 80: 507 - 515; 

it's the "2002 model"). The equation is:  

 

where:  

 Xi = (1 - (hi / H)
1/3

) / (1 - p
1/3

) 

 Qi = 1 - (hi / H)
1/3

) 

 p = 1.3 / H 

 zi = hi / H (proportional height above the ground) 

 D is the outside bark diameter, in cm, at breast height (1.35 m) (equation below) 

 H is the total tree height (m) 

 hi is the height from the ground (m) at which to calculate the diameter inside the bark 

 di is the inside bark diameter at hi height from ground (cm) 

 a0 is the Taper Equation Initial Multiplier (a0) parameter 

 a1 is the Taper Equation DBH Exponent (a1) parameter 

 a2 is the Taper Equation Height Exponent (a2) parameter 

 b1 is the Taper Equation X Exponent 1 (b1) parameter 

 b2 is the Taper Equation X Exponent 2 (b2) parameter 

 b3 is the Taper Equation X Exponent 3 (b3) parameter 

 b4 is the Taper Equation X Exponent 4 (b4) parameter 

 b5 is the Taper Equation X Exponent 5 (b5) parameter 

 b6 is the Taper Equation X Exponent 6 (b6) parameter 

SORTIE-ND considers its DBH parameter to be diameter without bark. To find the diameter 

outside the bark, the equation is:  

D = a1 + a2DBH + a3DBH
2
 

where:  

 D is the diameter outside the bark, in cm 

 DBH is the diameter inside the bark, in cm (SORTIE's DBH) 

 a1 is the Diameter-Outside-Bark Constant (a1) parameter 

 a2 is the Diameter-Outside-Bark First Degree Parameter (a2) parameter 

 a3 is the Diameter-Outside-Bark Second Degree Parameter (a3) parameter 



Important note. The math in this behavior is particularly susceptible to producing extreme 

numbers if the parameters are not chosen very carefully. These extreme numbers (incredibly 

large or small numbers) will crash SORTIE if they happen, and cannot be guarded against ahead 

of time. Be very careful when selecting parameters, and test your parameters to ensure they 

produce sensible results for a wide range of tree sizes. If you have problems with SORTIE 

crashing, try verifying that this behavior is the problem by removing it from the run and trying 

again. If you can verify that this behavior is the problem, carefully re-examine your parameters.  

How to apply it 

Apply this behavior to saplings, adults, or snags of any species, and enter parameters in the 

Parameter edit window. This behavior does not automatically create output. Once you have 

added this behavior to your run, the Detailed output setup window for trees will have a tree data 

member called "Tree Volume". Add this to your detailed output file to output volume in cubic 

meters. You can then view charts and graphs with the resulting volume data using data 

visualization on your detailed output file.  

Behavior reference string: tree volume calculator  
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Grids 

In this document:  

Defining grid cell size  

Viewing and using grid maps  

A grid is a structure for holding model data that varies across space. You can picture a grid by 

thinking of a spreadsheet. Each cell in the spreadsheet holds a distinct value which is identified 

by location coordinates (row and column numbers). Behaviors use grids to store data and to 

share it between behaviors.  

Defining grid cell size 

Grids are always exactly the same size as the plot. Grids have an X and a Y axis, which match 

the orientation and size of the plot's axes. Each cell within the grid is a rectangle with a separate 

X and Y size. If the chosen grid cell sizes do not divide evenly into the X and Y plot lengths, the 

length of the cells in the last rows in each direction will be the remainder value. Grids can, and 

usually do, carry more than one value per cell. Grid cell size applies to all values in the grid. The 

amount of memory required for a grid cell is proportional to the number of total values it holds, 

which is the number of values per cell multiplied by the number of cells.  

For most grids, you can define the size of the cells in the X and Y directions by using the Grid 

setup window. You do not have to choose the size of a grid's cells; all grids have default values. 



However, there are times when it makes sense to adjust these values. When choosing a cell size, 

you should pick the largest possible value that adequately captures the resolution of the process 

being modeled, to minimize the model's memory requirements and maximize its speed. If you 

have a set of behaviors that work together and you are defining cell sizes for multiple grids, 

picking even multiples of a number for different grids (such as 2, 4, 8...) will help maximize the 

efficiency of data transfer between them.  

Viewing and using grid maps 

During the simulation, the model can write out a grid map (the data in a grid) into a detailed 

output file. You can choose what you would like saved from a grid by using the Output setup 

window.  

Things you can do with grid maps:  

 Look at graphical representations of grid maps. To do this, use the model's data 

visualization capabilities. 

 Use them as initial conditions. Since grid values help represent the internal "state" of the 

model, you can add grid maps to a parameter file for use as initial conditions on another 

run. For more information, see Adding to a parameter file. 

 Look at the values, edit them, and print them out. To do this, use the Grid setup window. 

25-Jan-2005 01:02 PM  

Grid list 

In this document:  

Average Light grid  

Basal Area Light grid  

Carbon Value grid  

Competition Harvest Results grid  

Detailed Substrate grid  

Detailed Substrate calcs grid  

Dispersed Seeds grid  

Foliar Chemistry grid  

Gap Light grid  

GLI Map grid  

Harvest Results grid  

Merchantable Timber Value grid  

Mortality Episode Results grid  

Neighborhood Seed Predation grid  

Partitioned Biomass grid  

Planting Results grid  

Quadrat GLI grid  

Relative Neighborhood Density grid  



Resource grid  

Ripley's K grid  

Seed Predators grid  

Snag Decay Class Dynamics Basal Area grid  

Storm Damage grid  

Storm Killed Partitioned Biomass grid  

Storm Light grid  

Storm Susceptibility grid  

Substrate grid  

Substrate calcs grid  

Substrate Favorability grid  

Windstorm Results grid  

Years Since Last Harvest grid  

For more on what grids are, see Grids. 

Average Light 

This grid is created by the Average Light behavior. It contains the averages of the values of the 

GLI Map grid. It is important to set the cell sizes of the two grids exactly as you want them. The 

default grid cell resolution is set to 8 m X 8 m.  

Data in the grid 

Data member name Description 

GLI Average GLI value 

Basal Area Light 

This grid is created by the Basal Area Light behavior. Each grid cell holds tree basal area data 

and a light level. The grid cell resolution defaults to 8 m X 8 m. You can set whatever new 

resolution you wish.  

Data in the grid 

Data member name Description 

Light The light level as calculated by the Basal Area Light behavior 

Conifer Basal Area 
The basal area, in square meters, of conifers that count towards the light 

calculation 

Angiosperm Basal The basal area, in square meters, of angiosperms that count towards the 



Area light calculation 

Carbon Value 

This grid is created by the Carbon Value behavior. It holds the amount of carbon and the value of 

that carbon for each species. This grid has one cell for the whole plot. It will ignore any changes 

you make to the resolution. If this grid's data is saved in a detailed output file, you can view the 

contents of this grid as a table using SORTIE's data visualization system.  

Data in the grid 

Data member name Description 

Mg of Carbon for Species X The amount of carbon in the plot for Species X, in metric tons 

Carbon Value for Species X The value of the carbon for Species X 

Competition Harvest Results 

This grid is created by the Competition Harvest behavior. This is where data on competition 

harvest results is stored. The data is stored raw - no conversion to per-hectare amounts.  

The default grid cell resolution is set to one grid cell for the entire plot. You can set whatever 

new resolution you wish.  

Data in the grid 

Data member name Description 

Cut Density, species x Number of trees cut in the current timestep for the given species 

Cut Basal Area, species x Total basal area cut in the current timestep for the given species 

DetailedSubstrate 

This grid is created by the Detailed Substrate behavior. The grid holds the relative proportions of 

the various substrate types. If the Harvest behavior is present for the run, then this grid's 

resolution must match the Harvest Results grid. Otherwise, it defaults to a cell resolution of 8 m 

X 8 m, which you can change. This grid holds packages with a different data structure from the 

main grid to track Substrate cohorts.  

Data in the grid 



Data member name Description 

Proportion of scarified soil The proportion of the grid cell area that is scarified soil 

Proportion of forest floor The proportion of the grid cell area that is forest floor 

Proportion of tip-up 

mounds 
The proportion of the grid cell area that is tip-up mounds 

Total Log 
Total logs, expressed as a proportion between 0 and 1. The sum of 

all log proportions 

Total Log Volume Total log volume, in m3 per ha. The sum of all log volumes 

Prop Sp Group X Small 

Decay Y 

Species group X, decay class Y small logs, as a proportion 

between 0 and 1 

Prop Sp Group X Large 

Decay Y 

Species group X, decay class Y large logs, as a proportion between 

0 and 1 

Vol Sp Group X Small 

Decay Y 
Species group X, decay class Y small log volume in m3 per ha 

Vol Sp Group X Large 

Decay Y 
Species group X, decay class Y large log volume in m3 per ha 

 

Packages:  

Data member name Description 

Substrate cohort age The age of the substrate cohort, in timesteps 

Substrate cohort new scarified soil 

substrate 

The proportion of cell area that is scarified soil added in 

this cohort 

Substrate cohort new tip-up 

mounds substrate 

The proportion of cell area that is tip-up mounds substrate 

added in this cohort 

Detailed Substrate calcs 

This grid is called "detailedsubstratecalcs" and is created by the Detailed Substrate behavior. 

This grid is used for intermediate calculations when calculating the values in the Detailed 

Substrate grid. The grid cell resolution must match Detailed Substrate's.  

Data in the grid 

Data member name Description 



Amount of new tip-up 

mounds 
New tip-up mounds area by grid cell, in square meters 

New Log Area Sp Group X 

Small Decay Y 

Area of new small logs added this timestep for species group X, 

decay class Y, in square meters 

New Log Area Sp Group X 

Large Decay Y 

Area of new large logs added this timestep for species group X, 

decay class Y, in square meters 

Prop Sp Group X Small 

Decay Y Timestep Z 

Fresh small logs added Z timesteps ago for species group X, 

decay class Y, as a proportion of grid cell area 

Prop Sp Group X Large 

Decay Y Timestep Z 

Fresh large logs added Z timesteps ago for species group X, 

decay class Y, as a proportion of grid cell area 

Dispersed Seeds 

This grid is created by the Disperse behaviors. It holds the number of seeds of each species that 

have been created by dispersal. This grid defaults to a cell resolution of 8 m X 8 m, which you 

can change.  

Data in the grid 

Data member name Description 

Number of seeds for 

Species X 
The number of seeds in each grid cell belonging to Species X 

Gap status 
Whether the cell is in gap (true) or under closed canopy (false). Only 

used if there are behaviors which use forest cover. 

Adult tree count 
The count of adult trees, for determining gap status. Only used if there 

are behaviors which use forest cover. 

Foliar Chemistry 

This grid is created by the Foliar Chemistry behavior. This is where the amount of different 

foliar chemistry components is stored. All data is stored raw, no conversion to per-hectare 

amounts. 

The grid cell resolution is set to 8 m X 8 m. You can change this to whatever you wish. 

Data in the grid 



Data member name Description 

Kg N for [species X] Amount of N for species X, in kg 

Kg P for [species X] Amount of P for species X, in kg 

Kg SLA for [species X] Amount of SLA for species X, in kg 

Kg Lignin for [species X] Amount of lignin for species X, in kg 

Kg Fiber for [species X] Amount of fiber for species X, in kg 

Kg Cellulose for [species X] Amount of cellulose for species X, in kg 

Kg Tannins for [species X] Amount of tannins for species X, in kg 

Kg Phenolics for [species X] Amount of phenolics for species X, in kg 

Gap Light 

This grid is created by the Gap Light behavior. Each grid cell holds the cell's gap status, either 

TRUE or FALSE. The grid cell resolution defaults to 8 m X 8 m. You can set whatever new 

resolution you wish.  

Data in the grid 

Data member name Description 

Is Gap Whether (TRUE) or not (FALSE) that grid cell has gap status 

GLI Map 

This grid is created by the GLI Map Creator behavior. The grid holds a GLI value in each cell. 

The grid cell resolution defaults to 8 m X 8 m. You can set whatever new resolution you wish.  

Data in the grid 

Data member name Description 

GLI GLI value, as a percentage of full sun between 0 and 100 

Harvest Results 



This grid is created by the Harvest behavior. This is where data on harvest results is stored. The 

data is stored raw - no conversion to per-hectare amounts.  

The grid cell resolution is set to 8 m X 8 m. You cannot change the grid cell resolution for this 

grid.  

Data in the grid 

Data member name Description 

Harvest Type 
Type of harvest that occurred in the current timestep, or -1 if 

none has occurred 

Cut Density, species x, cut 

range y 

Number of trees cut in the current timestep for the given 

species and cut range 

Cut Basal Area, species x, cut 

range y 

Total basal area cut in the current timestep for the given species 

and cut range 

Merchantable Timber Value 

This grid is created by the Merchantable Timber Value behavior. It holds the merchantable 

timber value for each species. This grid has one cell for the whole plot. It will ignore any 

changes you make to the resolution. If this grid's data is saved in a detailed output file, you can 

view the contents of this grid as a table using SORTIE's data visualization system.  

Data in the grid 

Data member name Description 

Value for Species X The merchantable timber value for Species X 

Mortality Episode Results 

This grid is created by the Episodic Mortality behavior. This is where data on planned mortality 

episode results is stored. The data is stored raw - no conversion to per-hectare amounts.  

The grid cell resolution is set to 8 m X 8 m. You cannot change the grid cell resolution for this 

grid.  

Data in the grid 

Data member name Description 



Cut Density, species x, cut 

range y 

Number of trees killed in the current timestep for the given 

species and cut range 

Cut Basal Area, species x, cut 

range y 

Total basal area killed in the current timestep for the given 

species and cut range 

Neighborhood Seed Predation 

This grid is created by the Neighborhood Seed Predation and Neighborhood Seed Predation 

(linked) behaviors. This grid stores the seed rain before predation and the amount of seeds eaten. 

The grid resolution must match the Dispersed Seeds grid. All data is stored raw, no conversion to 

per hectare amounts. 

Data in the grid 

Data member 

name 
Description 

Pre-predation 

seeds for species 

x 

Number of seeds of species x in the grid cell before predation. Note that if a 

species is not subject to seed predation, its value may show up here as zero 

despite having seeds present. Its seeds are not missing, just ignored.  

Proportion seeds 

eaten for species 

x 

Proportion of the seeds of species x eaten this timestep, as a value between 0 

and 1. 

Partitioned Biomass 

This grid is created by the Partitioned DBH Biomass and Partitioned Palm Biomass behaviors. 

This is where the amount of biomass is stored, partitioned into leaf, bole, and branch (if 

applicable) biomass. All data is stored raw, no conversion to per-hectare amounts. 

The grid cell resolution is set to 8 m X 8 m. You can change this to whatever you wish. The grid 

is shared by the two behaviors mentioned above, so changing it for one changes it for both. 

Data in the grid 

Data member name Description 

Mg Leaf Biomass for [species X] Amount of leaf biomass for species X, in Mg 

Mg Bole Biomass for [species X] Amount of bole biomass for species X, in Mg 

Mg Branch Biomass for [species X] Amount of branch biomass for species X, in Mg 



Mg Leaf Palm Biomass for [species X] Amount of palm leaf biomass for species X, in Mg 

Mg Bole Palm Biomass for [species X] Amount of palm bole biomass for species X, in Mg 

Planting Results 

This grid is created by the Planting behavior. This is where data on planting results is stored. The 

data is stored raw - no conversion to per-hectare amounts.  

The grid cell resolution is set to 8 m X 8 m. You cannot change the grid cell resolution for this 

grid.  

Data in the grid 

Data member name Description 

Planted Species X Number of trees of Species X cut in the current timestep 

Quadrat GLI 

This grid is created by the Quadrat-based GLI Light behavior. The grid holds a GLI value in 

each cell ("quadrat" being a term previously used in SORTIE to describe small grid cells). The 

grid cell resolution defaults to 2 m X 2 m. You can set whatever new resolution you wish.  

Data in the grid 

Data member 

name 
Description 

GLI 
GLI value, or -1 if there were no trees to which to assign a GLI value in 

that grid cell 

Relative Neighborhood Density 

This grid holds values for the Relative Neighborhood Density (Ω) statistic as calculated by the 

Relative Neighborhood Density Calculator behavior. The grid holds an Ω value for each distance 

increment for each species. This can be a great many values. The grid cell resolution is always 

set to one cell covering the entire plot. You cannot change this.  

Data in the grid 



Data member 

name 
Description 

Max Distance 
Maximum distance to which to calculate Ω, in meters. Including this in the 

output is not necessary but will improve the SORTIE graphing capability. 

Distance Inc 
How often to calculate Ω, in meters. Including this in the output is not 

necessary but will improve the SORTIE graphing capability. 

Species X Dist Y 

Omega Value 

The Ω value for Species X at the Yth distance increment. This is not 

necessarily the distance in meters. 

Resource 

This grid holds values for a second growth resource for use by the Double resource relative 

growth and Growth and Resource-Based Mortality behaviors. The actual identity of the resource 

is unknown and unimportant. The grid holds a value for resource level in each cell and it is 

assumed that the units scale appropriately to the parameters for the growth behavior. The grid 

cell resolution defaults to 8 m X 8 m. You can set whatever new resolution you wish.  

Data in the grid 

Data member name Description 

Resource Resource amount, in whatever units are appropriate 

Ripley's K 

This grid holds values for the Ripley's K statistic as calculated by the Ripley's K Calculator 

behavior. The grid holds a K value for each distance increment for each species. This can be a 

great many values. The grid cell resolution is always set to one cell covering the entire plot. You 

cannot change this.  

Data in the grid 

Data member 

name 
Description 

Max Distance 
Maximum distance to which to calculate K, in meters. Including this in the 

output is not necessary but will improve the SORTIE graphing capability. 

Distance Inc 
How often to calculate K, in meters. Including this in the output is not 

necessary but will improve the SORTIE graphing capability. 



All Species Dist 

Y K Value 

The K value for all plot trees at the Yth distance increment. This is not 

necessarily the distance in meters. 

Species X Dist Y 

K Value 

The K value for Species X at the Yth distance increment. This is not 

necessarily the distance in meters. 

Seed Predators grid 

This grid is created by the Functional response seed predation behavior. It holds the number of 

seed predators in each seed grid at the end of the predation model run. This grid's resolution must 

match that of "Dispersed Seeds".  

Data in the grid 

Data member name Description 

Number Predators The number of predators in each grid cell. 

Snag Decay Class Dynamics Basal Area grid 

This grid is created by the Snag Decay Class Dynamics behavior. It holds the amount of basal 

area for live and cut trees. Maps and grid resolution changes for this grid are not honored.  

Data in the grid 

Data member 

name 
Description 

Live BA Per Ha The amount of basal area, in square meters per hectare, of live adults. 

Cut BA Per Ha 
The amount of basal area, in square meters per hectare, of trees harvested 

this timestep. 

Storm Damage 

This grid is created by the Storm disturbance behavior. Each grid cell holds a storm damage 

index between 0 and 1. The grid resolution default is 8 m X 8 m. You can change this to 

whatever you wish, but if you are also using the grid Storm Susceptibility, the resolutions must 

match.  

Data in the grid 



Data member 

name 
Description 

Damage Index 
The mean storm damage index for all storms occurring in the past timestep, 

from 0 (no damage) to 1 (total damage) 

Time Since Last 

Storm 

The number of years since the last storm occurred in this cell. The last storm 

is any storm at all of any strength. 

 

Packages:  

Data member name Description 

Single Storm Damage Index Storm damage index for a single storm event 

Storm Killed Partitioned Biomass 

This grid is created by the Storm Killed Partitioned DBH Biomass and Storm Killed Partitioned 

Palm Biomass behaviors. This is where the amount of biomass is stored, partitioned into leaf, 

bole, and branch (if applicable) biomass. All data is stored raw, no conversion to per-hectare 

amounts. 

The grid cell resolution is set to 8 m X 8 m. You can change this to whatever you wish. The grid 

is shared by the two behaviors mentioned above, so changing it for one changes it for both. 

Data in the grid 

Data member name Description 

Mg Leaf Biomass for [species X] Amount of storm-killed leaf biomass for species X, in Mg 

Mg Bole Biomass for [species X] Amount of storm-killed bole biomass for species X, in Mg 

Mg Branch Biomass for [species X] 
Amount of storm-killed branch biomass for species X, in 

Mg 

Mg Leaf Palm Biomass for [species 

X] 

Amount of storm-killed palm leaf biomass for species X, 

in Mg 

Mg Bole Palm Biomass for [species 

X] 

Amount of storm-killed palm bole biomass for species X, 

in Mg 

Storm Light 



This grid is created by the Storm Light behavior. Each grid cell holds a light level value. The 

grid cell resolution defaults to 8 m X 8 m. You can set whatever new resolution you wish.  

Data in the grid 

Data member name Description 

Light The light level as calculated by the Storm Light behavior 

Storm Susceptibility 

This grid is created by the Storm disturbance behavior. Each grid cell holds a storm susceptibility 

index between 0 and 1. The grid resolution default is 8 m X 8 m. You can change this to 

whatever you wish, but if you are also using the grid Storm Damage, the resolutions must match.  

Data in the grid 

Data member 

name 
Description 

Susceptibility 
A storm damage susceptibility for each cell, from 0 (not susceptible to 

damage) to >1 (very susceptible to damage) 

Substrate 

This grid is created by the Substrate behavior. The grid holds the relative proportions of the 

various substrate types. If the Harvest behavior is present for the run, then this grid's resolution 

must match the Harvest Results grid. Otherwise, it defaults to a cell resolution of 8 m X 8 m, 

which you can change. This grid holds packages with a different data structure from the main 

grid to track Substrate cohorts.  

Data in the grid 

Data member name Description 

Proportion of scarified soil The proportion of the grid cell area that is scarified soil 

Proportion of forest floor The proportion of the grid cell area that is forest floor 

Proportion of tip-up mounds The proportion of the grid cell area that is tip-up mounds 

Proportion of fresh logs The proportion of the grid cell area that is fresh logs 

Proportion of decayed logs The proportion of the grid cell area that is decayed logs 



 

Packages:  

Data member name Description 

Substrate cohort age The age of the substrate cohort, in timesteps 

Substrate cohort new scarified soil 

substrate 

The proportion of cell area that is scarified soil added in 

this cohort 

Substrate cohort new tip-up 

mounds substrate 

The proportion of cell area that is tip-up mounds substrate 

added in this cohort 

Substrate cohort new fresh logs 
The proportion of cell area that is fresh logs added in this 

cohort 

Substrate calcs 

This grid is called "substratecalcs" and is created by the Substrate behavior. This grid is used for 

intermediate calculations when calculating the values in the Substrate grid. The grid cell 

resolution must match Substrate's.  

Data in the grid 

Data member 

name 
Description 

Amount of new 

tip-up mounds 
New tip-up mounds area by grid cell, in square meters 

Fresh logs X 

timesteps ago 

Fresh logs added X timesteps ago up to the value in the Substrate parameter 

"Maximum number of years that decay occurs" (converted to timesteps), as a 

proportion of grid cell area 

Substrate favorability 

This grid is created by either the Substrate Dependent Seed Survival No Gap Status or the 

Substrate Dependent Seed Survival With Gap Status behavior. It holds the proportion of seeds 

expected to germinate on the substrate composite of the grid cell. The cell resolution must match 

the "Substrate" grid, above.  

Data in the grid 

Data member name Description 



Favorability Index - Species 

X 

The proportion of seeds of Species X expected to germinate in 

that cell 

Windstorm Results 

This grid is created by the Windstorm behavior. It holds information on what windstorms 

happened during each timestep. This grid has one cell for the whole plot. It will ignore any 

changes you make to the resolution.  

The data is held in grid packages. There is one package for each storm event. No package means 

no storms. If this grid's data is saved in a detailed output file, you can view the contents of this 

grid as a table using SORTIE's data visualization system.  

Data in the grid 

There is one of these for each storm event.  

Data member name Description 

Storm Severity The severity of the storm that occurred, between 0 and 1 

Basal Area Dead For Species X The basal area killed in this storm for Species X 

Density Dead For Species X The number of stems killed in this storm for Species X 

Years Since Last Harvest 

This grid is created by the Lagged post harvest growth and Post Harvest Skidding Mortality 

behaviors. Each grid cell holds the time since a harvest last occurred in that cell. The grid cell 

resolution defaults to 8 m X 8 m. You can set whatever new resolution you wish.  

Data in the grid 

Data member name Description 

Time Time since last harvest  

LastUpdated The timestep the grid was last updated 

Last updated: 08-Jun-2009 09:20 AM  

The parameter file 



In this document:  

What is a parameter file?  

Contents of a parameter file  

Editing a parameter file  

Validating a parameter file  

Making a human-readable copy of the parameter file  

What is a parameter file? 

A parameter file is a document containing all the data that the model needs to perform a 

simulation. It is in the XML data format and is written in plain text. Parameter files have a .xml 

extension.  

Contents of a parameter file 

A parameter file is as long as it needs to be, depending on how you want to set up your run. At 

the least, the parameter file must specify the length of the run (see Run Setup), describe the plot, 

define the tree species and their attributes, list the behaviors in the order in which they will run, 

and provide whatever data the behaviors need.  

In addition, parameter files can contain very detailed initial conditions in the form of maps of 

tree and grid data. This data is normally produced in detailed output files. For more on how to 

add this data to a parameter file, see Adding to a parameter file.  

Editing a parameter file 

The SORTIE-ND model interface is designed to give you all the tools you need to create and 

modify your parameter files. You are welcome to view and modify the new parameter files 

directly, if you wish. They can be opened in any text editor. Be warned, however, that with the 

XML data format, this is an extremely daunting task and you will never actually need to do it.  

For detailed instructions on creating a new parameter file from scratch, see the Creating a 

parameter file topic. To edit existing parameter files, you can use the different choices in the Edit 

menu (Tree Setup to set up the basics of the tree population, Grid Layer Setup to configure grids, 

Model flow to specify the behaviors to use and in what order, Parameters to provide parameter 

values, and Output options to set up reporting.  

Validating a parameter file 

In order to run, a parameter file must be complete and all data in it valid. As you edit a parameter 

file, the part that you are editing will be validated as part of the edit process. It is certainly 

possible, however, to be working with a parameter file that has a problem of some sort, 

especially if you started with an existing parameter file instead of from scratch. The file will be 

validated before you run it, but if you want to do a double-check beforehand, you can either save 

it from the File menu or view all its parameters in the Parameters window and then click OK. 

These methods may not catch every problem, but they will catch most of them.  



Making a human-readable copy of the parameter file 

The parameter file is in the XML data format and is not easily readable by humans. The model 

can make you tab-delimited text versions of your data that you can open in any text editor or 

spreadsheet program. Unfortunately, there is currently no support for outputting all data at once. 

If your parameter file contains both parameters and maps, you must convert them separately.  

To save your parameter values, use the Edit->Parameters window. To save grid map values, use 

the Edit->Grid layer setup window. Files you save in this way are for your reference only. They 

cannot be used as input.  
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Detailed output files 

In this document:  

What is a detailed output file?  

Contents of a detailed output file  

Subplots of a detailed output file  

Viewing the data in a detailed output file  

Detailed output files as input to other runs  

For more on output, including a guide on what to save, see the topic Output in SORTIE.  

What is a detailed output file? 

The model saves its detailed output in a detailed output file. A simulation's detailed output file is 

in fact a collection of individual files packaged together. Within the detailed output package are 

two types of files: a copy of the parameter file originally used to perform the run, and individual 

timestep files, which hold the saved data for each timestep. All the files are written in plain text 

in the XML data format.  

Contents of a detailed output file 

Detailed output timestep files are collections of map files that you set up using the Edit->Output 

setup window. They are identified by having "_x" added to the filename, where "x" is the 

timestep number. The parameter file copy is given the detailed output package's filename. Each 

file produced is then compressed using the GZIP program, and all the files for a single run are 

put into an archive file using the TAR program. The detailed output output for a single run is one 

file with a ".gz.tar" extension.  

For example: if the parameter file "testpar.xml" was used to run 5 timesteps, with a detailed 

output file to be saved named "my detailed output", at the end of the run there would be a file 

named "my detailed output.gz.tar". This TAR archive would contain the following files:  



 "my detailed output.gz" - a copy of the "testpar.xml" parameter file  

 "my detailed output_0.gz" - the data saved after setup occurred, before the model started 

running. These are the initial conditions.  

 "my detailed output_1.gz" - the data saved after the first timestep had run  

 "my detailed output_2.gz" - the data saved after the second timestep had run  

 "my detailed output_3.gz" - the data saved after the third timestep had run  

 "my detailed output_4.gz" - the data saved after the fourth timestep had run  

 "my detailed output_5.gz" - the data saved after the fifth timestep had run  

The ".gz" extension indicates that these files are compressed. If uncompressed, the ".gz" 

extension would be replaced with ".xml".  

Detailed output files are very flexible and can contain any subset of the model's underlying tree 

and grid data. You pick each individual piece of data that you wish to save, and the frequency 

with which you wish to save it. The data can be saved at any interval from every timestep to only 

at the first and last timesteps, and each piece of data has its own save frequency. You can use this 

to cut down on detailed output file size. Data you are less interested in can be saved less 

frequently.  

Subplots of a detailed output file 

Sometimes you might want to track a portion of the plot separately from the rest of it. You can 

do this by defining subplots when you set up your detailed output file. When you do this, your 

SORTIE run will produce a detailed output file for the whole plot, and one for each subplot you 

define (up to five). They will all contain the same kinds of data.  

Only tree data can be "subplotted". If grid data is saved, the whole grid will always be saved. It is 

easy to work with only a portion of a grid's data by, for example, printing out the grid using the 

Grid Setup window.  

To create subplots, click the button that says "Set up subplots..." on the Setup detailed output file 

window.  

Viewing the data in a detailed output file 

The Data visualization capabilities of the model interface allow you to see your data graphically. 

If you want the data raw to do your own analysis, you can save the contents of individual maps 

within the detailed output files as tab-delimited text. Using the example above, here's how you 

would use a spreadsheet to read map data from timestep three of the "my detailed output.gz.tar" 

detailed output file:  

1. To give context to the map data, you must load the original parameter file using File-

>Open file. Form the run above, either "testpar.xml" could be used, or its copy in the 

detailed output file, "my detailed output.xml". If you choose the file "my detailed 

output.gz.tar" from "File->Open file", you can choose the file "my detailed output.xml" 

within it. 



2. Load the individual timestep file using File->Open file and choosing "my detailed 

output.gz.tar". You will be able to choose the individual timestep file within it. 

3. Use the Grid layer setup option or the Tree setup in the Edit menu to save the files as tab-

delimited text. You can then open it from your spreadsheet application or a text editor. 

Detailed output files as input to other runs 

The maps in a detailed output timestep file can be used as initial conditions on a subsequent run, 

provided that they are compatible with the parameter file being used. Here are the requirements 

for a detailed output map file to be loaded with a parameter file different from its original file:  

 The parameter file must have the same species as the parameter file used to create the 

detailed output file.  

 The Plot dimensions must be the same.  

 Each map that you want to use must make sense as a complete dataset. For instance, you 

cannot do a run with a tree map in which you have saved the X coordinates of trees but 

not the Y coordinates. (You don't have to use all the maps in the file - more on this later.)  

 If any behavior-specific data was saved for trees, those same behaviors must be enabled 

for the current run. (For more, see the tree data member list topic.)  

The detailed output file can be used to completely save the state of the model. If your detailed 

output file saves everything, you could start a new analysis using any timestep of a previous 

analysis as the starting point. In order to save a complete detailed output file, use the "Save 

Everything" button on the Setup detailed output file window.  

To load a detailed output file as initial conditions, first load the parameter file. Then, using "File-

>Open File", choose the detailed output file. A window will open showing the sub-files within 

the detailed output file, one per timestep as described above. Double-click the timestep you want 

to load. You can either replace existing data or add to it. If you choose to add data, if an existing 

tree map is loaded, those trees will be combined with the new tree map. Grid values will be 

overwritten either way. If you don't want to use all the maps, you can erase those for individual 

grids and trees using the Edit menu options Grid layer setup and Tree setup.  
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Summary output files 

For more on output, including a guide on what to save, see the topic Output in SORTIE.  

The summary output file contains basic summary data for each timestep in the run. It is exactly 

like it was in previous versions of SORTIE. You choose what data you want SORTIE to save 

using "Edit->Output options". The choices are:  

 Adult tree relative basal area (Adult Rel BA) 

 Adult tree absolute basal area (Adult Abs BA) 



 Adult tree relative density (Adult Rel Den) 

 Adult tree absolute density (Adult Abs Den) 

 Sapling relative basal area (Sapl Rel BA) 

 Sapling absolute basal area (Sapl Abs BA) 

 Sapling relative density (Sapl Rel Den) 

 Sapling absolute density (Sapl Abs Den) 

 Seedling absolute density (Sdl Abs Den) 

 Snag tree relative basal area (Snag Rel BA) 

 Snag tree absolute basal area (Snag Abs BA) 

 Snag tree relative density (Snag Rel Den) 

 Snag tree absolute density (Snag Abs Den) 

Basal area is in square meters per hectare, and density is in numbers per hectare. Relative values 

are in proportions. Each data type is calculated separately for each species, and absolute data 

types also include a total across species. For a definition of the different tree types, see the Trees 

topic.  

You can define areas within the plot to track separately. These are called subplots. These 

subplots do not have to be continuous, and you can define more than one. In order to define 

subplots, use the Edit Subplot window. The output options you choose for the main window will 

apply to the subplots too. You cannot define separate options for them.  

Output files are saved as tab-delimited text files with a ".out" extension. You can open them in 

almost any spreadsheet or word processing program. There is a column for each species for each 

data type. Each timestep is one row. If you have defined subplots, there is a row for each subplot 

for each timestep.  

You can view graphs of summary output files using SORTIE's data visualization functions.  
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Detailed output map files 

In this document:  

What are maps?  

Maps as output  

Maps as input  

Creating your own map analyses  

What are maps? 

Maps are files listing individual values for trees and grids. Tree maps list individual trees and 

their attributes (X and Y coordinates, height, etc). Grid maps list some or all of the values held in 

each grid cell.  



Usually, maps are produced as part of detailed output files. These maps are written in the XML 

data format in plain text. They can be opened directly in a text editor, but due to the data format, 

it is probably not useful to do so.  

Maps as output 

The maps represent the model's data in a semi-raw state. You can feed the maps of a detailed 

output file directly into the Data visualizer in order to view them graphically.  

Maps as input 

If you have all of the tree and grid data from the model as maps, you have the complete data set 

upon which the simulation was based. This means you can use maps to recreate all or part of the 

model state and use it as a starting point for a new simulation, possibly with different parameter 

values. For more information on how to add map data to a parameter file, see Adding to a 

parameter file.  

If you wish to directly enter values for trees and grids, you can do so. For grids, you can enter or 

change grid values using the Grid layer setup window. Trees have their own tab-delimited text 

file format. For details on this format, see tab-delimited tree maps. Text files can either be 

incorporated into parameter files (the preferred method) or have only a filename added. The 

second method is used when the tree map is very large, which can crash the SORTIE XML file 

reading system.  

Creating your own map analyses 

If you would like to take the map data and analyze it in other ways, you can have the model 

interface output the values into a tab-delimited text format. For grid maps, you can do this in the 

Edit menu by choosing Grid layer setup; for tree maps, choose Tree Setup. (See those topics for 

exact instructions.) The tab-delimited text format is for your own use. SORTIE cannot accept it 

as input.  
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Tab-delimited tree maps 

You can use tab-delimited tree maps to directly enter tree map data. Tab-delimited text means 

that columns of data are separated by tabs. You can save files of this type in many programs, 

particularly spreadsheet programs like Microsoft Excel.  

Requirements for using tree maps 

Tree maps can be loaded into SORTIE-ND only if there is a parameter file loaded as well. The 

data in the tree map is expected to match the parameter file.  



Files must be in plain text with a ".txt" extension.  

Using tree maps 

Once you have prepared a tree map file according to the format below, and once you have loaded 

a compatible parameter file, use the "File->Open file" command to load your tab-delimited tree 

map file. If you save your parameter file after this point, the tree map will be included in it. To 

work with the tree map trees further, including removing them, use the Manage tree maps 

window.  

SORTIE-ND will not alter your tab-delimited tree map file.  

Tree map format 

Here is an example of a tree map:  

X Y Species Type Diam Height 

10.34 62.1 Maple Seedling 0.24 0 

9.33838 88.9771 Beech Sapling 4.567 0 

5.73746 5.16968 Hemlock Adult 15.887 15.3 

127.039 146.606 Beech Snag 35.41 28.7 

122.571 14.06372 Oak Sapling 2.91 0 

9.31396 50.0366 Maple Adult 23.554 14.82 

The first row in the file is assumed to be column headers and is ignored by SORTIE-ND.  

Each subsequent row is the data for one tree. Trees can appear in any order. There is no limit to 

the number of trees.  

The first two columns are the X and Y coordinates of the tree. In the SORTIE-ND coordinate 

system, the origin is at the southwest corner of the plot. X increases to the east; Y to the north. 

There are no negative numbers. If there are trees outside the plot boundaries, you are warned of 

this; if you elect to continue loading the file, those trees are discarded.  

The third column is species. The species names must match those that appear in the parameter 

file. SORTIE-ND will reject a tree map with an unrecognized species name. To find out what the 

species names are for your parameter file, use the Edit species list window to view the list. (Case 

is important.)  

The fourth column is tree life history stage. Possible values are "Seedling", "Sapling", "Adult", 

and "Snag". (Case is unimportant.)  



The fifth column is tree diameter in cm. If the life history stage is "Seedling", this value is the 

diameter at 10 cm height. For all other types, this is DBH. If the diameter value and the life 

history stage do not match, diameter takes precedence. For instance: if the parameter file 

specifies that the minimum adult DBH is 10 cm, and the tree map contains a tree designated as a 

"sapling" with a diameter of 15 cm, then SORTIE-ND will create an adult with a DBH of 15.  

The sixth column is tree height in meters. If this value is set to 0, SORTIE-ND will use the 

allometry equations to calculate tree height. If this value is non-zero, then this height is assigned 

to the tree, even if the allometric equations would produce a different result. This feature is 

useful if you intend to use growth behaviors that separately increment diameter and height for 

your trees. When in doubt, use 0.  

Converting pre-6.0 SORTIE tree map files 

If you have a tree map file from before SORTIE 6.0, you can simply copy and paste the columns 

with the following exception: The old version of SORTIE has reversed coordinate axes. So paste 

the old "X" values into the new "Y" column, and vice versa.  
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Files from versions of SORTIE prior to 6.01 

If you used previous versions of SORTIE, you may have a collection of files you used for runs. 

This version of SORTIE can read some of those files. (If you have not used previous versions of 

SORTIE, this topic is probably irrelevant for you.) Supported file types:  

 Harvest regime files (.hvr). A harvest regime file is a specification for harvest and 

planting for a run. A harvest regime file can be read in once a parameter file has been 

loaded. The parameter file must have the same species, and in the same order, as the file 

originally used to create the harvest regime file. In addition, the loaded parameter file 

must have a number of timesteps at least as large as the timestep of the last harvest or 

planting event. The old versions of SORTIE relied upon a hard-wired grid cell area for 

the harvest and planting specifications, while the new version may have a different 

resolution. SORTIE will make the conversion, but the areas of harvest and/or planting 

may be slightly different afterwards. To read a harvest regime file, use "File->Open file". 

 Output files (.out). Old output files can be viewed in the data visualization functions of 

the model.  

Parameter files (.par). SORTIE-ND versions up to 6.04 support these parameter files. Later 

versions, including this one, do NOT support .par files. You can download and install a version 

of SORTIE-ND up to 6.04, and read this topic in its user manual for instructions on how to 

import your file. You can then save it into a SORTIE-ND parameter file, which can be opened 

by later SORTIE-ND versions.  



Tree map files (.stmf). The format for tree map files from older versions of SORTIE is no 

longer supported. However, SORTIE-ND does support a different tab-delimited tree map file 

format. It is easy to manually convert any old .stmf files to the new format using a spreadsheet 

program such as Microsoft Excel.  

All other file types are unsupported.  
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Data Visualization 

SORTIE runs produce output, which you can then use the SORTIE interface to view graphically. 

You can view both kinds of output files, summary files and detailed output files. SORTIE 

analyzes the contents of files that it is given and lets you know what it is capable of doing with 

that data. For more on output, including a guide on what to save, see the topic Output in 

SORTIE. In this document:  

 

Loading an output file for data visualization  

Displaying the data from a file  

Viewing a chart's raw data  

Viewing charts from a run as it progresses  

Tips  

For details on the chart types available, see Output Chart Types.  

Loading an output file for data visualization 

You can load a file by choosing the menu option "File->Open Run Output". Choose the file you 

want to view, either a summary output file with a ".out" extension, or a detailed output file with a 

".gz.tar" extension. The file name will appear at the top of the main SORTIE window in the list 

that says "Open output files". You can have as many files open as you wish.  

Displaying the data from a file 

Choose a file in the list marked "Open output files" at the top of the main SORTIE window. 

SORTIE will analyze the contents of the file and show you what it can display in the list marked 

"Chart choices for this file". The chart choices are broken apart by type. There may not be a 

choice for every type of chart. Choose the chart you want to display and click the "Draw Chart" 

button. The chart will appear in the main SORTIE window. You can open as many charts as you 

wish. A legend also opens for each file that applies to all its chart windows.  

The legends for detailed output files have an extra set of controls marked "Timestep" at the 

bottom. Use the arrows to step back and forth through the timesteps. As you step through and 



watch a chart, pay attention to axis ranges. The data visualizer is meant to analyze each dataset it 

charts and optimize the chart accordingly. It does not attempt to keep the view consistent.  

Viewing a chart's raw data 

You can save the raw data used to make any chart to a tab-delimited text file (suitable for 

viewing in spreadsheet programs). Use the File->Save menu option that appears on all charts, or 

press Ctrl-S. You can take this raw data to reproduce and adjust the chart in other graphing 

applications. If you have saved a summary output file, be aware that this file already contains all 

its data in a tab-delimited text format; you can open this file directly if you wish.  

Viewing charts from a run as it progresses 

You can view the output from a run as it progresses. SORTIE will keep a set of open charts 

updated with the results of the latest timestep. Here's how to use this feature:  

1. Since SORTIE data visualization can only display the contents of output files, the first 

step in using this feature is to set up some output files to view. You can see more on 

individual chart types here, so you can save the appropriate data for the charts you're 

interested in seeing. For more on the output file types and how to set them up, see either 

the summary files or the detailed output files topics.  

2. Once you have completed a parameter file for your run and have set up your output, the 

next step is to create some output for SORTIE to analyze. A simple way to do this is to 

click the "Run one timestep" button (the one on the main window with two right-facing 

triangles). When SORTIE has completed the timestep, the message bar at the bottom of 

the window will display a message indicating that the run has paused. You can also run 

the model using "Model->Run" from the main menu or the Run button (with the single 

right-facing arrow); you can pause the run at any point to start viewing data.  

3. To view the output of the current run, it is recommended that you first pause the run. 

(This ensures that the model is not trying to write new output to the files at the same time 

as it is trying to open them to be read.) Then, click the "View run output" button. 

SORTIE will load the output files from the current run and analyze them to determine 

what charts you can view.  

4. Open the charts you wish to view (see Displaying the data from a file. If a chart you want 

is not listed for any output file, it means that the data it requires is not being saved. You 

must stop the run, change your output options, and start a new run.  

5. Start the model running again. As the model completes each timestep, it will update any 

open charts (while it does this, you may see a message that the model is paused at the 

bottom of the screen; this is normal). You can open new charts or close existing ones at 

any point in the run (again, pausing is recommended before opening new charts).  

Note: While displaying a current run's output is a useful feature, it is not the most efficient way 

to do a run. If you do not actually need to keep tabs on a run's progress, or if you are satisfied 

with the way a current run is going, allow it to run without open charts. The run will execute 

much faster. If you currently have charts open for a run, you can use the menu command "File-



>Close run output file" to close each of the run's output files. Once all output files are closed, the 

run will switch back to the more efficient mode.  

Tips 

The data visualizer can only show you what you have saved from the run. If you do not save any 

data for a particular species in a detailed output file, for instance, that species won't show up in 

any charts you open, even if there were many individuals of that species in the run. If your data 

does not look the way you expect it to, start by carefully examining your output settings to make 

sure you actually saved everything you meant to.  

Have patience when working with detailed output files. When you move through timesteps, 

change charts, and open new charts, the data visualizer often must go back and sift through the 

detailed output file for the data it needs. With large files and long runs this can be very time 

consuming. If you have an idea of the charts you want to work with, it will be faster if you only 

save the data needed to create those charts.  
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Output Chart Types 

When you create output files, you can use SORTIE's data visualization capabilities to look at 

their data in various ways. SORTIE has several chart types that it can create from detailed output 

files and summary output files. The chart types that you can view depend on the data you have 

saved in your output files.  

 

Customizing, saving, and printing the charts  

Extracting the data to perform your own analyses  

Line graphs  

Histograms  

Tree maps  

Grid maps  

Tables  

Customizing, saving, and printing the charts 

The main SORTIE window acts as a desktop for the chart windows displayed. They can be 

minimized, maximized, moved, and resized within the window. You can close them using the X 

button in the top right. You will notice that the legends have check boxes next to each species 

name, along with a color box. Unchecking the box next to a species removes it from all of that 

file's charts. Clicking on the color next to the species name lets you choose a new color for that 

species.  



The charts themselves can also be modified by right-clicking on them. You can reset axis ranges 

and zoom in and out. You can save the graph as a separate image file in PNG format by choosing 

"Save As", and you can also send the graph to a printer.  

Extracting the data to perform your own analyses 

If you want to perform your own analysis of the data in a detailed output file, you can translate it 

into tab-delimited text files that you can then open with a spreadsheet. See the topic detailed 

output files for instructions on how to do this.  

Line graphs 

You can produce several kinds of line graphs. Four kinds of line graphs: absolute density, 

relative density, absolute basal area, and relative basal area, can be produced from either 

summary output files or detailed output output files. If you know you want to look at these 

graphs, you should save a summary output file. The graphing performance will be significantly 

better. Another set of line graphs, absolute volume and relative volume, can be created via the 

detailed output file.  

If you are saving a summary output file and have defined subplot areas, the line graphs will also 

be available for each subplot in addition to the whole plot. Subplots are not available in detailed 

output files.  

In order to view basal area and density graphs from a summary output file, save data for each 

kind of graph you want to see in the Summary output setup window. To view these graphs from 

a detailed output output file, save the "DBH" tree data member for saplings, adults, or snags, or 

the "Diam 10" tree data member for seedlings. For more on how to save these tree data members, 

see the Setup tree save options window.  

To view volume graphs, in the detailed output file, save the Tree Volume tree data member for 

your chosen tree types. To access this tree member, you must add the Tree volume calculator 

behavior to your run.  

A line graph may also be created for the contents of a few grids.  

Histograms 

The visualizer can produce a histogram for most tree and grid values in a detailed output file. 

Tree-based histograms display the number of trees per hectare for each species that fall into each 

of several value groupings for a piece of data. For instance, a height histogram that divided 

height into one meter increments would show how many trees of each species were from 0 - 1 

meters in height, from 1 - 2 meters in height, etc. Grid-based histograms display the number of 

grid cells that fall into the groupings.  

The visualizer attempts to optimize the histogram for the data it is displaying. You can further 

customize the display of the histogram to suit your data. You have your choice of logarithmic or 



linear Y axis. You can also redivide the data by specifying the number of bins into which the 

data is divided, and the size of each bin.  

The visualizer defaults to recalculating the bin size for each timestep in order to best display the 

data, so keep an eye on the bin size as you step through the timesteps. If you change the bin size 

or number of bins, the visualizer will preserve your changes.  

Tree map 

A tree map is available when you have saved the X, Y, and DBHs of trees in a detailed output 

file. The tree map does not display seedlings.  

The size of the tree circles corresponds to the size of its DBH, NOT its crown radius. The color 

matches the species in the legend. The sizes of the circles relative to each other accurately reflect 

the different DBH values, but their absolute size is meaningless. If a tree is quite small, it may 

not show up on the map. You can change the minimum DBH to make sure that all the trees that 

you are interested in are displayed. If your trees do not show up well, you can change the circle 

sizes. To do this, enter a new value for the "DBH Scale Factor" and click the "Update Map" 

button. Larger values make the tree circles bigger; smaller values make them smaller.  

Clicking and dragging on the tree map zooms in. Once you have zoomed, you can restore the 

original scale by clicking the button marked "Restore Original View". If you are zoomed, you 

can scroll around the map in each of the four directions by clicking the arrow buttons 

surrounding the map.  

Grid maps 

Maps are available for almost any kind of grid value. The values are shown in grayscale. Maps 

of boolean values (true/false) will be displayed as black (false) and white (true); any other kind 

of numerical value allows you to adjust the grayscale for best viewing with the controls to the 

left of the map.  

 Min brightness - the darkest color that shows up on the map, as a value between 0 and 

255. This defaults to pure black (value of 0).  

 Min value - the minimum grid value where the grayscale starts. Any grid values below 

this value will show up the min brightness color. This defaults to the smallest value for 

the map.  

 Knee brightness - the color that corresponds to the knee value, as a value between 0 and 

255. The knee brightness defaults to gray halfway between black and white.  

 Knee value - the grid value corresponding to the knee brightness color. This defaults to 

halfway between the minimum and maximum grid values. If the map does not show a lot 

of contrast, this may be because the values are not evenly distributed between the 

minimum and the maximum grid values. If the map is too dark, set the knee value lower; 

if it's too light, set it higher.  

 Max brightness - the lightest color that shows up on the map, as a value between 0 and 

255. This defaults to pure white (value of 255).  



 Max value - the maximum grid value where the grayscale ends. Any grid values above 

this value will show up the max brightness color. This defaults to the largest value for the 

map.  

The color lightness increases linearly with map value from the minimum to the knee, and linearly 

again from the knee to the maximum.  

Once you have adjusted your display values, click the "Update" button. Updating can be slow. If 

you can't see a difference, try minimizing and then restoring the chart window; this guarantees 

that it has refreshed.  

Tables 

An overview table is available for both summary output files and detailed output files. This table 

shows basal area and density information for each tree life history stage. In the case of a 

summary output file, only the data that you saved in the summary output file setup window are 

shown. For a detailed output file, data is shown for each tree species and life history stage for 

which you have saved at least DBH (or diameter at 10 cm for seedlings). If you know you want 

to look at this table type, you should save a summary output file. The graphing performance will 

be significantly better.  

When you save DBH data (and optionally, height), you can also view stand tables. These show 

density or basal area data broken out by DBH size classes that you define.  

When you save DBH and tree volume (from the Tree volume calculator behavior), you can view 

a stock table with tree volume broken out by DBH size classes that you define. In addition, the 

stock table displays the Mean Annual Increment (MAI), which is calculated as MAI = 

Volume(T)/(number of years per timestep * T) for a given timestep T, and the volume per year 

for each timestep (for those trees that contributed to the table); and if you have saved height data, 

the average of the 10 tallest trees in the plot (not just the 10 tallest trees who have provided data 

to the table).  

Detailed output files can display specialized tables for the following grids:  

 Harvest Results 

 Mortality Episode Results 

 Carbon Value 

 Merchantable Timber Value 

 Windstorm Results 

 Partitioned Biomass 

 Storm Killed Partitioned Biomass 

 Storm Damage 

 Foliar Chemistry 

If you wish to view these tables, set up your detailed output file to save all the data from your 

chosen grids.  
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Further reading 

A reference list, along with many reprints, is available at www.sortie-nd.org.  

Glossary 

Adult tree: A tree whose DBH is at least the minimum DBH for adulthood. See the trees topic 

for more.  

Allometry: The relationships between various aspects of a tree's size and shape. See the 

allometry topic for more.  

Basal area: The cross-sectional area of a tree trunk at 1.35 meters (DBH).  

Batch: Grouping SORTIE runs together to automatically run consecutively. See the batch topic 

for more.  

BC: British Columbia - Date Creek area, central BC. One of the primary SORTIE field sites. 

Submodels often contain a version whose simulations are based on field data from BC and are 

thus intended primarily to simulate BC conditions.  

Behavior: A unit of work in the model which makes calculations and updates tree and grid data. 

A simulation consists of a chosen list of behaviors working in sequence. A behavior usually 

corresponds to a biological process. See the behaviors topic for more.  

Canopy: The branches and leaves of a tree. Synonymous with crown.  

Clear cut: A type of harvest.  

Crown: The branches and leaves of a tree. Synonymous with canopy.  

DBH: Diameter at Breast Height. The diameter of a tree's trunk at a height of 1.35 meters.  

Deterministic: Not random; predictable.  

Diameter at 10 cm: The diameter of a tree taken at a height of ten centimeters.  

Fisheye photograph: A photograph taken with a fisheye lens, which captures a complete 

hemisphere in two dimensions. A fisheye photograph taken of the sky would see from horizon to 

horizon in all directions. See the light behaviors topic.  

http://www.sortie-nd.org/


Gap: A small open area in a forest canopy.  

Gap cut: A type of harvest.  

GLI: Global Light Index. A measure of the amount of light that reaches a certain point in space, 

expressed as a percentage of full sun. See the light behaviors topic.  

GMF: Great Mountain Forest, northwestern Connecticut. One of the primary SORTIE field 

sites. Submodels often contain a version whose simulations are based on field data from GMF 

and are thus intended primarily to simulate GMF conditions.  

Grid: A way of storing data in SORTIE that varies over space. Grids are the same size as the 

plot and contain cells which can each contain several values. See the grids topic for more.  

Grid cell: A single area in a grid object.  

Harvest: Logging.  

Julian day: A method for expressing dates. The days in the year are numbered consecutively 

from 1 to 365.  

Juvenile tree: A seedling or sapling tree which has not yet reached adult status. See the trees 

topic for more.  

Parameter file: A file with all of the settings and data needed to run SORTIE. See the parameter 

file topic for more.  

Partial cut: A type of harvest.  

Plot: SORTIE's underlying dimensions. See the plot topic for more.  

Quadrat: A small grid cell.  

Recruitment: The process by which seeds become seedlings.  

Release: When a suppressed juvenile tree is exposed to higher light conditions, it is released. 

Release is characterized by a rapid increase in growth rate. See the growth behaviors topic for 

more.  

Run: The process of the model receiving input and performing calculations for a specified 

number of timesteps. Synonymous with simulation.  

Sapling: A tree at least 1.35 meters in height with a DBH less than the minimum adult DBH. See 

the trees topic for more.  

Seedling: A tree less than 1.35 meters tall. See the trees topic for more.  



Senescence: The slight increase in tree mortality seen among very old, very large trees. See the 

mortality behaviors topic for more.  

Short output file: A type of output file which provides summary data for a run. Synonymous 

with summary output file. See the summary output file topic.  

Silviculture: Forestry science. The management of tree harvesting and planting.  

Simulation: The process of the model receiving input and performing calculations for a 

specified number of timesteps. Synonymous with run.  

Stochastic: Chaotic, random. Stochastic processes in SORTIE generally make heavy use of the 

random number generator.  

Submodel: In previous versions of the model, these were pieces of the SORTIE model designed 

to do a specific task in the simulation.  

Subplot: A subarea of the plot chosen by the user. This subarea is tracked separately during data 

analysis.  

Substrate: What seedlings germinate in - soil and the organic layers on top of it. See the 

substrate behaviors topic.  

Summary output file: A type of output file which provides summary data for a run. 

Synonymous with short output file. See the summary output file topic.  

Suppression: When juvenile trees are in persistently low light conditions, their growth slows 

considerably. This is suppression. Different species have different tolerances for suppression; 

some will die, while some can tolerate being suppressed for decades. See the growth behaviors 

topic for more.  

Tab-delimited text file: An ASCII text file organized as a table, with columns separated by tabs 

and rows separated by returns.  

Timestep: The basic unit of time in SORTIE. Timesteps are defined in years in the parameter 

file. The basic run cycle is repeated once per timestep. See the run setup and progression topic.  

Torus: A donut shape. This is the shape of the forest in SORTIE. See the plot topic.  
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Software license 

This program is free software; you can redistribute it and/or modify it under the terms of the 

GNU General Public License as published by the Free Software Foundation; either version 2 of 

the License, or (at your option) any later version.  

This program is distributed in the hope that it will be useful, but WITHOUT ANY 

WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR 

A PARTICULAR PURPOSE. See the GNU General Public License for more details.  

Data license 

You may use the SORTIE-ND software for any purpose, including the creation of data for 

publication in a scientific book or journal. One of the primary goals of scientific experiments is 

replicability of results. Therefore, if you have modified the SORTIE-ND software, you may not 

publish data from it using the names "SORTIE" or "SORTIE-ND" unless you do one of the 

following: 1) send a copy of the source code of your changes back to the SORTIE-ND team at 

the Institute of Ecosystem Studies for inclusion in the standard version or 2) publish enough 

detail about your changes so that they could be replicated by a reasonably proficient 

programmer.  

This product includes software developed by the Apache Software Foundation 

(http://www.apache.org/).  

GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991 

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 

59 Temple Place - Suite 330, Boston, MA 02111-1307, USA 

 

Everyone is permitted to copy and distribute verbatim copies of this license document, but 

changing it is not allowed.  

Preamble 

The licenses for most software are designed to take away your freedom to share and change it. 

By contrast, the GNU General Public License is intended to guarantee your freedom to share and 

change free software--to make sure the software is free for all its users. This General Public 

License applies to most of the Free Software Foundation's software and to any other program 

whose authors commit to using it. (Some other Free Software Foundation software is covered by 

the GNU Library General Public License instead.) You can apply it to your programs, too.  

http://www.apache.org/


When we speak of free software, we are referring to freedom, not price. Our General Public 

Licenses are designed to make sure that you have the freedom to distribute copies of free 

software (and charge for this service if you wish), that you receive source code or can get it if 

you want it, that you can change the software or use pieces of it in new free programs; and that 

you know you can do these things.  

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights 

or to ask you to surrender the rights. These restrictions translate to certain responsibilities for you 

if you distribute copies of the software, or if you modify it.  

For example, if you distribute copies of such a program, whether gratis or for a fee, you must 

give the recipients all the rights that you have. You must make sure that they, too, receive or can 

get the source code. And you must show them these terms so they know their rights.  

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license 

which gives you legal permission to copy, distribute and/or modify the software.  

Also, for each author's protection and ours, we want to make certain that everyone understands 

that there is no warranty for this free software. If the software is modified by someone else and 

passed on, we want its recipients to know that what they have is not the original, so that any 

problems introduced by others will not reflect on the original authors' reputations.  

Finally, any free program is threatened constantly by software patents. We wish to avoid the 

danger that redistributors of a free program will individually obtain patent licenses, in effect 

making the program proprietary. To prevent this, we have made it clear that any patent must be 

licensed for everyone's free use or not licensed at all.  

The precise terms and conditions for copying, distribution and modification follow.  

TERMS AND CONDITIONS FOR COPYING, 

DISTRIBUTION AND MODIFICATION 

0. This License applies to any program or other work which contains a notice placed by the 

copyright holder saying it may be distributed under the terms of this General Public License. The 

"Program", below, refers to any such program or work, and a "work based on the Program" 

means either the Program or any derivative work under copyright law: that is to say, a work 

containing the Program or a portion of it, either verbatim or with modifications and/or translated 

into another language. (Hereinafter, translation is included without limitation in the term 

"modification".) Each licensee is addressed as "you".  

Activities other than copying, distribution and modification are not covered by this License; they 

are outside its scope. The act of running the Program is not restricted, and the output from the 

Program is covered only if its contents constitute a work based on the Program (independent of 

having been made by running the Program). Whether that is true depends on what the Program 

does.  



1. You may copy and distribute verbatim copies of the Program's source code as you receive it, 

in any medium, provided that you conspicuously and appropriately publish on each copy an 

appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to 

this License and to the absence of any warranty; and give any other recipients of the Program a 

copy of this License along with the Program.  

You may charge a fee for the physical act of transferring a copy, and you may at your option 

offer warranty protection in exchange for a fee.  

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work 

based on the Program, and copy and distribute such modifications or work under the terms of 

Section 1 above, provided that you also meet all of these conditions:  

 a) You must cause the modified files to carry prominent notices stating that you changed 

the files and the date of any change. 

 b) You must cause any work that you distribute or publish, that in whole or in part 

contains or is derived from the Program or any part thereof, to be licensed as a whole at 

no charge to all third parties under the terms of this License. 

 c) If the modified program normally reads commands interactively when run, you must 

cause it, when started running for such interactive use in the most ordinary way, to print 

or display an announcement including an appropriate copyright notice and a notice that 

there is no warranty (or else, saying that you provide a warranty) and that users may 

redistribute the program under these conditions, and telling the user how to view a copy 

of this License. (Exception: if the Program itself is interactive but does not normally print 

such an announcement, your work based on the Program is not required to print an 

announcement.)  

These requirements apply to the modified work as a whole. If identifiable sections of that work 

are not derived from the Program, and can be reasonably considered independent and separate 

works in themselves, then this License, and its terms, do not apply to those sections when you 

distribute them as separate works. But when you distribute the same sections as part of a whole 

which is a work based on the Program, the distribution of the whole must be on the terms of this 

License, whose permissions for other licensees extend to the entire whole, and thus to each and 

every part regardless of who wrote it.  

Thus, it is not the intent of this section to claim rights or contest your rights to work written 

entirely by you; rather, the intent is to exercise the right to control the distribution of derivative 

or collective works based on the Program.  

In addition, mere aggregation of another work not based on the Program with the Program (or 

with a work based on the Program) on a volume of a storage or distribution medium does not 

bring the other work under the scope of this License.  

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object 

code or executable form under the terms of Sections 1 and 2 above provided that you also do one 

of the following:  



 a) Accompany it with the complete corresponding machine-readable source code, which 

must be distributed under the terms of Sections 1 and 2 above on a medium customarily 

used for software interchange; or, 

 b) Accompany it with a written offer, valid for at least three years, to give any third party, 

for a charge no more than your cost of physically performing source distribution, a 

complete machine-readable copy of the corresponding source code, to be distributed 

under the terms of Sections 1 and 2 above on a medium customarily used for software 

interchange; or, 

 c) Accompany it with the information you received as to the offer to distribute 

corresponding source code. (This alternative is allowed only for noncommercial 

distribution and only if you received the program in object code or executable form with 

such an offer, in accord with Subsection b above.)  

The source code for a work means the preferred form of the work for making modifications to it. 

For an executable work, complete source code means all the source code for all modules it 

contains, plus any associated interface definition files, plus the scripts used to control 

compilation and installation of the executable. However, as a special exception, the source code 

distributed need not include anything that is normally distributed (in either source or binary 

form) with the major components (compiler, kernel, and so on) of the operating system on which 

the executable runs, unless that component itself accompanies the executable.  

If distribution of executable or object code is made by offering access to copy from a designated 

place, then offering equivalent access to copy the source code from the same place counts as 

distribution of the source code, even though third parties are not compelled to copy the source 

along with the object code.  

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided 

under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program 

is void, and will automatically terminate your rights under this License. However, parties who 

have received copies, or rights, from you under this License will not have their licenses 

terminated so long as such parties remain in full compliance.  

5. You are not required to accept this License, since you have not signed it. However, nothing 

else grants you permission to modify or distribute the Program or its derivative works. These 

actions are prohibited by law if you do not accept this License. Therefore, by modifying or 

distributing the Program (or any work based on the Program), you indicate your acceptance of 

this License to do so, and all its terms and conditions for copying, distributing or modifying the 

Program or works based on it.  

6. Each time you redistribute the Program (or any work based on the Program), the recipient 

automatically receives a license from the original licensor to copy, distribute or modify the 

Program subject to these terms and conditions. You may not impose any further restrictions on 

the recipients' exercise of the rights granted herein. You are not responsible for enforcing 

compliance by third parties to this License.  



7. If, as a consequence of a court judgment or allegation of patent infringement or for any other 

reason (not limited to patent issues), conditions are imposed on you (whether by court order, 

agreement or otherwise) that contradict the conditions of this License, they do not excuse you 

from the conditions of this License. If you cannot distribute so as to satisfy simultaneously your 

obligations under this License and any other pertinent obligations, then as a consequence you 

may not distribute the Program at all. For example, if a patent license would not permit royalty-

free redistribution of the Program by all those who receive copies directly or indirectly through 

you, then the only way you could satisfy both it and this License would be to refrain entirely 

from distribution of the Program.  

If any portion of this section is held invalid or unenforceable under any particular circumstance, 

the balance of the section is intended to apply and the section as a whole is intended to apply in 

other circumstances.  

It is not the purpose of this section to induce you to infringe any patents or other property right 

claims or to contest validity of any such claims; this section has the sole purpose of protecting 

the integrity of the free software distribution system, which is implemented by public license 

practices. Many people have made generous contributions to the wide range of software 

distributed through that system in reliance on consistent application of that system; it is up to the 

author/donor to decide if he or she is willing to distribute software through any other system and 

a licensee cannot impose that choice.  

This section is intended to make thoroughly clear what is believed to be a consequence of the 

rest of this License.  

8. If the distribution and/or use of the Program is restricted in certain countries either by patents 

or by copyrighted interfaces, the original copyright holder who places the Program under this 

License may add an explicit geographical distribution limitation excluding those countries, so 

that distribution is permitted only in or among countries not thus excluded. In such case, this 

License incorporates the limitation as if written in the body of this License.  

9. The Free Software Foundation may publish revised and/or new versions of the General Public 

License from time to time. Such new versions will be similar in spirit to the present version, but 

may differ in detail to address new problems or concerns.  

Each version is given a distinguishing version number. If the Program specifies a version number 

of this License which applies to it and "any later version", you have the option of following the 

terms and conditions either of that version or of any later version published by the Free Software 

Foundation. If the Program does not specify a version number of this License, you may choose 

any version ever published by the Free Software Foundation.  

10. If you wish to incorporate parts of the Program into other free programs whose distribution 

conditions are different, write to the author to ask for permission. For software which is 

copyrighted by the Free Software Foundation, write to the Free Software Foundation; we 

sometimes make exceptions for this. Our decision will be guided by the two goals of preserving 



the free status of all derivatives of our free software and of promoting the sharing and reuse of 

software generally.  

NO WARRANTY 

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO 

WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE 

LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS 

AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY 

OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED 

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 

PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND 

PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE 

DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR 

CORRECTION.  

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN 

WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY 

MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE 

LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, 

INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR 

INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF 

DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU 

OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY 

OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 

ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

END OF TERMS AND CONDITIONS 

www.gnu.org  

http://www.gnu.org/

